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Selecting a birthdate
1. Choose the        icon.
2. Select a month and year.    The calendar for that month appears.
3. Select the traveler's birthdate from the calendar.    The selected date appears in the 

date field.



Selecting a date
1. Choose the        icon. The calendar for the current month appears.
2. Select a month, then select the desired date.    The selected date appears in the date 

field.
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    About United Connection

As employee owners of United Airlines, we would like to welcome you to 
United Connection... the most technologically 
advanced, customer-driven reservation system on the market.

You're in control
You've been telling us that you want to take control of your travel planning.    United 
Connection lets you do exactly that, by providing a direct connection to the same extensive, 
up-to-the-minute fare and schedule information available to travel agencies and airlines.
With United Connection, you can:

· Make reservations with over 500 airlines, 50 rental car companies, and 30,000 hotel 
properties worldwide.

· Save your travel preferences in one or more profiles, then let United Connection use 
those preferences to streamline your travel planning.

· Purchase your ticket online and choose a delivery option.    If you are flying on United or 
United Express, you may have the option of choosing Electronic Ticket.    This option 
eliminates paper tickets by storing your ticket electronically in United Airlines' 
reservation system.

· Get up-to-the-minute flight status information, including arrival and departure times and 
gates for United and United Express flights.

· Check United Mileage Plus  account balance information.

The power of United Connection begins and ends with you... see for yourself all the good 
things that can happen when you take control of your travel plans!

See also
Contents
Getting Started 



    Will I be charged for using United Connection
?

The only cost associated with using United Connection will be any connection time charges 
assessed by your service provider in accordance with the terms of your agreement with that 
provider.
Some service providers give you unlimited online access for a flat monthly fee.    Others 
charge by the minute once you exceed a certain number of hours each month.    If you 
choose Internet Service Provider, MSN, or CompuServe, contact your service provider if you 
are unsure about your billing arrangement.
Currently, there is no charge for using the United Airlines Network except for the cost of the 
telephone call to the network (usually a local call).    United reserves the right to change this 
policy at any time in the future.

See also
Contents
Choosing a United Connection service provider 



    The Welcome Window
When you start United Connection , the Welcome Window appears. This window displays 
five icons. Click on one of the icons to display the corresponding option.

Click on one of the icons below to see a description of that option.

See also
Displaying the Welcome Window 
Getting Started 



Personal Profiles
Click on this icon to access the Traveler Editor, which lets you create customized travel 
profiles for yourself and others. Just tell us your preferences for flights, rental cars, and 
hotel accommodations... we'll forward the information when you reserve your trip!

See also
Using the Traveler Editor 



Travel Planning
Click on this icon to access the Itinerary Window and begin planning a trip. You select 
travelers for your itinerary, then add flights by checking availability or shopping for a low 
fare. Add a rental car and hotel accommodations and you're ready to reserve your trip!

See also
Overview of the Itinerary Window 



Mileage Plus
Click on this icon to review Mileage Plus account information for yourself or other 
travelers.

Note: You'll need to register with United Connection  in order to use this option. To review Mileage Plus 
information for a traveler you must enter their Mileage Plus number in the Traveler Editor.

See also
Reviewing Mileage Plus  Summary information 



Flight Status
Click on this icon to check the status of a specific flight. Complete, up-to-the-minute 
information (including gate numbers) is available for United and United Express flights 
leaving within 48 hours. Schedule information is provided for all other flights.

See also
Checking flight status 



United Information
Click on this icon to get the latest information from United Airlines, including special offers,
exciting promotions, and new features.

See also
Reviewing United Information 



Show at Startup
Click in this box to remove the X if you do not wish to see the Welcome Window each time 
you start United Connection . If this option is not selected, the Itinerary Window appears 
automatically at startup.

See also
Displaying the Welcome Window 



    Getting Started

The first time you use United Connection , you'll need to:

· Register with United Connection.    If you are not already a Mileage Plus  member you will
be instantly enrolled and assigned an account number.
From the Tools menu, choose Registration.

· Use the Traveler Editor to enter traveler information and create profiles by specifying 
flight, car, and hotel preferences for yourself and other travelers.
From the Tools menu, choose Traveler Editor.

When you're ready to create an itinerary, you:

Select travelers for the itinerary from those listed 
in the Traveler Editor.    You select a traveler by 
choosing one of that traveler's profiles. 

Choose the TRAVELERS icon from the toolbar.

Add flights.    You can select flights based on 
schedule, or use FareShopper  to find low fares
for your itinerary.

Choose the ADD FLIGHT icon from the toolbar.

Add rental cars.    You select the company you 
want to rent from at your destination, then choose
a car type and rate.

Choose the ADD CAR icon from the toolbar.

Add hotel accommodations.    You specify a city 
and reference point, then select the hotel, room 
type, and room rate that meets your needs.

Choose the ADD HOTEL icon from the toolbar.

Reserve your itinerary by selecting a ticketing 
option and (if you wish to guarantee your airfare) 
paying for your ticket online with a credit card.

Choose the RESERVE icon from the toolbar.

See also
Overview of the Itinerary Window
United Connection menus
The United Connection toolbar
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    Registering with United Connection

You will need to register before you can begin using United Connection.    The United 
Connection Registration Wizard makes this process quick and easy by guiding you through 
the following steps:

· Choosing a United Connection service provider

· Setting up your modem (if necessary)

· Entering dialing information (if necessary)

· Providing your name, phone number, and Mileage Plus  number
(if you don't have a Mileage Plus number one will be instantly assigned to you)

· Connecting to the reservation system

· Entering a password

· Providing credit card information

Note    Until you register, the Registration Wizard appears automatically each time you start United Connection.    If 
you do not choose to register immediately, you can access the Registration Wizard at any time by choosing 
Registration from the Tools menu.

See also
Will I be charged for using United Connection? 
Registration and Communication Options 



    Choosing a United Connection
 service provider

The service provider you choose determines how you will connect to the reservation system. 
United Connection provides access to the reservation system in one of two ways: via the 
Internet, or using the United Airlines Network (a private telephone network).    You can use 
any Internet Service Provider with whom you have an account, including MSN The Microsoft 
Network  and CompuServe

.    Service provider options include:
Internet Service Provider
MSN The Microsoft Network
CompuServe
United Airlines Network

The first three options allow users to connect to the reservation system via the Internet.    
See Connecting via the Internet for additional information.    If you do not have access to any
of these service providers, choose the United Airlines Network.
Note    United Connection uses Secure Sockets Layer encryption for all Internet communications.

Choosing a United Connection service provider:
1. The Choose United Connection Service Provider dialog box displays a list of available 

service providers.    Highlight the service provider you want to use.
Note    The default service provider is United Airlines Network.

2. To continue, choose OK.

See also
Will I be charged for using United Connection? 
Registering with United Connection  

Registration and Communication Options 
Changing your United Connection  service provider 



Setting up your modem

You may or may not need to setup your modem during registration, depending on the United
Connection  service provider you choose and your version of Windows.
Internet Service Provider/MSN/CompuServe. If you choose one of these as your United 
Connection service provider, you will NOT need to set up your modem during registration.    
Your modem setup is handled through the service provider you selected.
United Airlines Network. If you choose this service provider, you will need to setup your 
modem during registration.    This process varies, depending on your version of Windows.    
Choose one of the following options for more information.

          Windows 95 modem setup  
          Windows 3.1/3.11/NT 3.51 modem setup  

See also
Registering with United Connection  

Registration and Communication Options 



Windows 95 modem setup

Note    This information applies to United Airlines Network users only.

If you chose United Airlines Network as your United Connection  service provider, you will 
need to select the modem you want to use.    The Choose Modem dialog box appears 
automatically in the Registration Wizard.

To setup your modem during registration:
1. In the Choose Modem dialog box, select the modem you want to use with United 

Connection.    If you have more than one modem installed, click on the arrow to display a 
list of installed modems and select the modem you want to use.

2. To change your COM port, baud rate, speaker volume, and other settings, choose the 
Properties button.    The Windows 95 Modem Properties dialog box appears.
Note    If you need help on the Modem Properties dialog, click the "?" button in the upper right corner of the 
dialog box, then click on an area of the dialog box to get help for that area.

3. To continue, choose OK.

See also
Setting up your modem 
Registering with United Connection  

Choose Modem dialog box 
Registration and Communication Options 



Windows 3.1/3.11/NT 3.51 modem setup

Note    This information applies to United Airlines Network users only.

If you chose United Airlines Network as your United Connection  service provider, you will 
need to setup your modem by choosing the modem vendor and model and specifying the 
correct modem settings (COM port, baud rate, etc.).    The Modem Type and Modem Settings 
dialog boxes appear automatically in the Registration Wizard.

To setup your modem during registration:
1. In the Modem Type dialog box, scroll down the Vendor list and select the company that 

makes your modem.
2. In the Modem list, select the modem that matches (or most closely matches) the modem

you will be using.
Note    If you cannot find an exact match for your modem, select Hayes or Hayes-Compatible from the Vendor list
and choose the most appropriate modem.

3. Choose Next.    The Modem Settings dialog box appears.
4. Complete the modem settings as follows:

In this field You can

COM Port Select the communications port used by your 
modem.    The default is COM1.

Find Port Choose this button if you are not sure which COM 
port your modem is using.
Note    If you have an external modem, be sure to 
turn on the modem before selecting this option.

Modem Speed Select the modem speed (baud rate) for your 
modem.    The default is 9600.

Speaker Volume Move the slide control left or right to adjust your 
modem speaker volume.

Initialization String When you select a modem, United Connection 
automatically supplies the appropriate initialization 
string for that modem.    Modify the initialization 
string only if your modem has special features or 
commands that you want to enable.    See your 
modem manual for details.

5. To validate the selected modem settings, choose the Test Settings button.    United 
Connection will check the settings and inform you of any problems.

6. After choosing your modem settings, choose Next to continue.

See also
Setting up your modem 
Registering with United Connection  

Modem Settings dialog box 
Registration and Communication Options 





Checking modem status while you are connected
(Windows 95)

Windows 95 users can display real-time modem information while they are connected.

To check modem status while you are connected:
1. Once you are connected to the reservation system, a small modem icon appears in the 

Windows 95 status bar.    
Note    If the modem icon does not appear in the Windows 95 status bar, choose Communications/Modem 
Settings from the Tools menu in United Connection .    Choose the Properties button, then select the Options tab
and make sure that the "Display modem status" option is checked.

2. Double-click on this icon to display the modem status dialog box.

3. This dialog box shows you the number of bytes sent and received, the speed at which 
the modem is communicating, and the number of minutes you have been connected.
Note    With data compression, your modem may be able to transmit and receive data at speeds higher than its 
maximum rated speed.    You set the maximum speed in the General tab of the Modem Properties dialog box.    
See Changing Windows 95 modem settings for more information.

4. After reviewing the information, choose the OK button to close the dialog box.

See also
Choose Modem dialog box 
Registration and Communication Options 



Entering dialing information

Note    This information applies to United Airlines Network users only.

If you chose United Airlines Network as your United Connection  service provider, you will 
need to enter dialing information and choose access telephone numbers.    The Dialing 
Information dialog box appears automatically in the Registration Wizard.

To enter dialing information during registration:
1. In the Dialing Information dialog box, complete the appropriate fields.

In this field You can

Location Name Enter a name for your current location.    For 
example, Home or Work.

Area Code at this 
Location

Enter the three-digit area code for this location.

Always dial area 
code

Check this box if you need to dial an area code for 
all calls (even calls within your own area code).

Dialing Prefix Enter or select the prefix(es) you need to dial from 
this location.    Dialing prefixes include the code 
needed to get an outside line, or the code needed to
disable Call Waiting.
Note    If you are entering more than one code, 
separate the codes with a comma.

Dialing Suffix Enter any number you need to dial after the primary 
(or backup) access number is dialed.    For example,
when you place a long distance call from work, you 
might need to dial an authorization number to 
complete the call.

Long Distance Enter the number you need to dial before dialing 
long-distance from this location (usually 1).

Dialing Method Choose Tone or Pulse Dialing.    The default is Tone 
Dialing (used by touch-tone phones).

Calling Card Type
(Windows 95 only)

If you will be using a calling card from this location, 
select your calling card provider.
Note    If your calling card provider is not listed, you 
can enter your access number(s) in this field.    If you
enter a series of numbers, be sure to separate the 
numbers with commas.

Calling Card 
Number
(Windows 95 only)

If you will be using a calling card from this location, 
enter the calling card number.

Primary Number In the Primary field, type the three-digit area code 
for this location and press the down arrow key.    
Access numbers for that area code are displayed in 
the list.
Select an access number.    Modem speeds are 
displayed next to each number.    Choose a number 
that use the highest speed supported by your 



modem.    Do not select an access number whose 
modem speed is faster than your modem.
Note    If you are not sure which access number to 
select, call the 800 number displayed on the dialog 
box for assistance.

Backup Number Select a backup access number just as you selected
a primary number.    United Connection 
automatically dials the backup number if the primary
number is busy or does not respond.

2. After completing your dialing information, choose Next to continue.

See also
Dialing Information dialog box 
Registering with United Connection  

Registration and Communication Options 



    Entering personal information
During registration, you are asked to enter your name, phone number, and Mileage Plus  
number (if you are already a Mileage Plus member).    The Personal Information dialog box 
appears automatically in the Registration Wizard.

To enter personal information during registration:
1. In the Personal Information dialog box, complete the fields as follows:

In this field You can

Title Select a title (optional).

First Name and 
Last Name

Enter your first and last names.

Business Phone Enter your business telephone number.

Home Phone Enter your home telephone number.
Note    At least one phone number is required.    
Include the area code with the phone number, for 
example: (555) 123-4567.

Mileage Plus 
Account

Enter your Mileage Plus account number.    This is 
the number that appears on your Mileage Plus card. 
Important: Do not enter any spaces or dashes 
between the numbers.
If you are not a Mileage Plus member, leave this 
field blank.    United Connection  will instantly enroll 
you in the Mileage Plus program and assign an 
account number automatically.

2. After entering your personal information, choose Next.
Note    When you choose Next, United Connection establishes a connection to the reservation system to 
complete the registration process.    If you are using an external modem, make sure that your modem is plugged 
in to a power source and turned on.

See also
Personal Information dialog box 
Registering with United Connection  

Registration and Communication Options 



    Connecting during registration
United Connection  must establish a connection to the reservation system in order to 
complete the registration process.    The Registration Wizard connects automatically and 
displays the progress of the connection in a status bar.    Refer to Troubleshooting if you 
experience any problems connecting.
Important: If you chose Internet Service Provider, MSN, or CompuServe, see Connecting via
the Internet for additional information.

See also
Registering with United Connection  

Registration and Communication Options 



    Connecting via the Internet
United Connection  provides online access to the reservation system in one of two ways: via
the Internet, or using the United Airlines Network (a private telephone network).    When you 
choose Internet Service Provider, MSN, or CompuServe, you will be accessing the reservation
system via the Internet.
Note    United Connection uses Secure Sockets Layer encryption for all Internet Service Provider communications.

Establishing an Internet connection
When United Connection needs to connect to the reservation system, it will attempt to 
establish an Internet connection.    If an Internet channel is already open, United Connection 
will automatically use the open channel to connect to the reservation system (whether or 
not this channel corresponds to the United Connection service provider you have specified).
If an Internet channel is not open, United Connection will request one and displays a 
message if any further action is required.    Some Internet Service Providers (for example, 
MSN and CompuServe) automatically launch their dialer when an Internet connection is 
required.    Others require you to launch the dialer yourself.    If you are unable to establish an
Internet connection, see Internet connection problems.
Note to Windows 95 users: Windows 95 automatically launches your Internet dialer when a connection is required.   
If you have more than one Internet dialer, it uses the default dialer.    To override this default, you should launch the 
dialer you want to use before starting United Connection.

Disconnecting from the Internet
Disconnecting from the reservation system in United Connection (or even exiting United 
Connection) does not automatically disconnect you from the Internet.    Because your 
Internet connection is managed by your service provider's dialer, you will need to access the
dialer to disconnect from the Internet.

See also
Choosing a United Connection service provider 
Connecting to the reservation system 



dialer
A user interface, normally provided to you by your Internet Service Provider, that allows 
you to establish a connection to the Internet via that provider.    The dialer manages the 
communications link between your modem and your Internet Service Provider.



    Entering a password
You need to enter a password during registration.    This password will control access to your 
information on the reservation system.    The Enter Password dialog box appears 
automatically in the Registration Wizard.
Note    If you forget your password, please call the United Connection Support Desk at 1-800-4UA-CNXN to obtain a 
new one.

To enter a password during registration:
1. In the Password field, type the password you want to use.    The password must be 6 to 

10 characters long and can include both letters and numbers.    Do not use symbols or 
spaces.

2. In the Verify Password field, re-type your password.
3. To save your password and continue, choose OK.

See also
Registering with United Connection  

Registration and Communication Options 



    Entering registration credit card information
You are asked to enter credit card information during registration.    Credit card information is
required for address verification.    The Registration Credit Card Information dialog box 
appears automatically in the Registration Wizard.
Note    If you have already registered on another computer and are using the same United Connection  service 
provider, the Registration Wizard displays the credit card information you entered during the previous registration.    
Please verify that this information is accurate before continuing.

To enter credit card information during registration:
1. In the Registration Credit Card Information dialog box, complete the fields as follows:

In this field You can

Card Name Enter a descriptive name for the credit card.    For 
example, Citibank Visa Card.

Type of Card Select the credit card type you are entering.

Account Number Enter the credit card account number.    Important: 
Do not enter spaces or dashes between the 
numbers.    For your security, the account number 
will not be displayed after credit card validation is 
complete.

Expiration Date Enter the credit card expiration date using the 
format MM/YY or MM/DD/YY.    For example, 12/99 
or 12/31/99.

Series Number If you selected the American Express/Optima card, 
a Series Number field appears.    Enter the four-digit 
credit card series number (also referred to as the 
CID, or Customer ID).

Company Refer to your credit card statement.    If your 
company name appears on the statement, enter that
name exactly as it is shown.    Otherwise, leave this 
field blank.

Address, City, 
State, and Zip

Enter YOUR address exactly as it is shown on the 
credit card statement.

2. After entering your credit card information, choose Next to continue.

See also
Registration Credit Card Information dialog box 
Registering with United Connection  

Registration and Communication Options 



Choose Modem dialog box
(Windows 95)

Note    This information applies to United Airlines Network users only.

If you chose United Airlines Network as your United Connection  service provider, you will 
need to specify your modem settings (COM port, modem speed, etc.) during registration.    
The Choose Modem dialog box appears automatically in the Registration Wizard.    After 
registration, you can access this dialog box from the Tools menu by choosing 
Communications/Modem Settings.

Dialog Box Options

Choose a modem for United Connection to use:
Displays a list of the modems you have setup in Windows 95.    Choose the modem you 
want to use for United Connection.
Note    To setup additional modems in Windows 95, choose Settings/Control Panel from the Start menu, then 
double-click on the Modems icon.

Properties button
Choose this button to display the Windows 95 Modem Properties dialog box, which allows 
you to change your COM port, baud rate, speaker volume, and other modem settings.
Note    If you need help on the Modem Properties dialog, click the "?" button in the upper right corner of the dialog 
box, then click on an area of the dialog box to get help for that area. 

See also
Windows 95 modem setup 
Registering with United Connection  

Changing Windows 95 modem settings 
Registration and Communication Options 



 Modem Type dialog box
(Windows 3.1/3.11/NT 3.51)

Note    This information applies to United Airlines Network users only.

If you chose United Airlines Network as your United Connection  service provider, you will 
need to identify your modem vendor and model during registration.    The Modem Type 
dialog box appears automatically in the Registration Wizard.    After registration, you can 
access this dialog box from the Tools menu by selecting Communications/Modem Settings, 
then choosing the Select Modem button.

Dialog Box Options

Vendor
Displays a list of modem companies in alphabetical order.    After you select a vendor, a list 
of modems manufactured by that company appears in the Modem list.

Modem
Display a list of modems manufactured by the selected vendor.    Select the modem you 
will be using to access the reservation system.
Note    If you cannot find an exact match for your modem, choose a similar modem (one manufactured by the same
vendor).    If you cannot find a similar modem, select Hayes-Compatible from the Vendor list.

See also
Windows 3.1/3.11/NT 3.51 modem setup 
Registering with United Connection  

Changing Windows 3.1/3.11/NT 3.51 modem settings 
Registration and Communication Options 



Modem Settings dialog box
(Windows 3.1/3.11/NT 3.51)

Note    This information applies to United Airlines Network users only.

If you chose United Airlines Network as your United Connection  service provider, you will 
need to specify your modem settings (COM port, modem speed, etc.) during registration.    
The Modem Settings dialog box appears automatically in the Registration Wizard.

Dialog Box Options

COM Port
Select the communications port your modem is using.    The default is COM1.

Find Port
Choose this button if you are not sure which COM port your modem is using.
Note    If you have an external modem, be sure to turn on the modem before selecting this option.

Modem Speed
Select the highest speed (baud rate) at which your modem operates.    The default is 9600.

Speaker Volume
Move the slide control left or right to adjust your modem speaker volume.

Initialization String
Displays the default initialization string for the selected modem.    You can modify the 
initialization string if your modem has special features or commands that you want to 
enable.    See your modem manual for details.

Test Settings button
Choose this button to validate the selected modem settings.    United Connection will check
each setting and inform you of any problems.

See also
Windows 3.1/3.11/NT 3.51 modem setup 
Registering with United Connection  

Registration and Communication Options 



Dialing Information dialog box

Note    This information applies to United Airlines Network users only.

If you chose United Airlines Network as your United Connection  service provider, you will 
need to enter dialing information and choose access telephone numbers.    The Dialing 
Information dialog box appears automatically in the Registration Wizard.    After registration, 
you can access this dialog box from the Tools menu by selecting Communications/Dialing 
Information.

Dialog Box Options

Location Name
Enter a name for your location.    For example, Home or Work.

Area Code at this Location
Enter the three-digit area code for this location.

Always dial area code
Check this box if you need to dial an area code for all calls (even calls within your own area
code).

Dialing Prefix
Enter or select any prefix(es) you need to dial from this location.    Dialing prefixes can 
include either or both of the following codes:
· The code needed to get an outside line (usually 9)
· The code needed to disable Call Waiting (for example, *70)
Note    If you enter more than one code, separate each with a comma.

Dialing Suffix
Enter any number you need to dial after the primary (or backup) access number is dialed. 
For example, when you place a long distance call from your workplace, you might need to 
dial an authorization number to complete the call.

Long Distance
Enter or select the number you need to dial before dialing a long-distance area code from 
your location (usually 1).

Dialing Method
Choose Tone or Pulse Dialing.    The default is Tone Dialing (used by touch-tone phones).

Calling Card Type (Windows 95 only)
If you will be using a calling card from this location, select your calling card provider. 
Note    If your calling card provider is not listed, you can enter your access number(s) in this field.    If you enter a 
series of access numbers, be sure to separate the numbers with commas.

Calling Card Number (Windows 95 only)
If you will be using a calling card from this location, enter the calling card number.

Primary



Select a primary access number to dial from location.    To display a list of available 
numbers for your area code, type the three-digit area code and click on the down arrow.
A modem speed (baud rate) is displayed next to each access number.    Choose an access 
number that uses the highest speed supported by your modem.    Do not select an access 
number whose modem speed is faster than your modem.
Tip    If you are not sure which access number to select, call the 800 number displayed on the dialog box to speak 
with a customer service representative.

Backup
Select a backup access telephone number for your location.

See also
Entering dialing information 
Registering with United Connection  

Adding a dialing location 
Changing dialing information 
Registration and Communication Options 



    Personal Information dialog box
During registration, you are asked to enter your name, phone number, and Mileage Plus  
number (if you are already a Mileage Plus member).    The Personal Information dialog box 
appears automatically in the Registration Wizard.

Dialog Box Options

Title
Select a title (optional).

First Name and Last Name
Enter your first and last names in the fields provided.

Business Phone and Home Phone
Enter your business phone number and/or your home phone number in the fields provided.
Each phone number must include the area code, for example: (555) 123-4567.
Note    You must provide at least one phone number (Business or Home).

Mileage Plus Account
Enter your Mileage Plus  account number.    Do not enter spaces or dashes between the 
numbers.    If you do not have a Mileage Plus number, leave this field blank and a number 
will be assigned to you.
Important    After registration is complete, you will not be able to change the Mileage Plus 
account number entered during registration.

See also
Entering personal information 
Registering with United Connection  

Registration and Communication Options 



    Registration Credit Card Information dialog box
You are asked to enter credit card information during registration.    Credit card information is
required for address verification.    The Registration Credit Card Information dialog box 
appears automatically in the Registration Wizard.    After registration, you can access this 
dialog box from the Tools menu by selecting Registration, then choosing the Edit Card 
button.
Note    Refer to Troubleshooting if you experience credit-card related problems during registration.

Dialog Box Options

Card Name
Enter a descriptive name for the registration credit card.    For example, Citibank Visa Card.

Type of Card
Select the type of credit card you want to use to register with United Connection .    United
Connection accepts only the following credit cards for registration purposes: Discover, 
Visa, MasterCard, American Express/Optima, and Diners Club.
Note    You may use additional credit cards for the purchase of air, car, and hotel reservations. You enter these 
credit cards in your personal profile.    See Entering payment credit card information for details.    United Connection
accepts all of the following credit cards for travel purchases: Discover, Visa, MasterCard, American 
Express/Optima, Diners Club, United Airlines Travel Card, Universal Air Travel Plan, Carte Blanche, EnRoute, and 
Japan Credit Bureau.

Account Number
Enter the credit card account number.    Do not enter any spaces or dashes between the 
numbers.    To prevent unauthorized access, United Connection will not display the account 
number after credit card validation is complete.

Expiration Date
Enter the credit card expiration date using the format MM/YY or MM/DD/YY.    For example, 
12/99 or 12/31/99.    You must update the expiration date when a new credit card is issued.

Series Number
If you selected American Express/Optima, the Series Number field appears.    Enter the 
four-digit credit card series number (also referred to as the CID, or Customer ID) in the 
Series Number field.

Your address (as shown on credit card statement)
Note    This is the address is the address to which the credit card company mails your statements.    To ensure 
accuracy, please refer to a statement from your credit card company when completing the following fields.

Company
If your company name appears on the credit card statement, enter that name exactly as it 
is shown.    Otherwise, leave this field blank.

Address
Enter your street address exactly as it appears on the credit card statement.

City



Enter your city name as it appears on the credit card statement.

State
Enter or select your state.
Note    To quickly scroll through the State list, type the first letter of a state abbreviation.    The list scrolls to the first 
state beginning with that letter.

Zip
Enter your 5- or 9-digit zip code.

See also
Entering credit card information during registration 
Changing your registration credit card information 
Updating the registration credit card expiration date 
Registering with United Connection  

Registration and Communication Options 



    United Connection Registration dialog box
You access the United Connection Registration dialog box if you want to view or change your
registration information, including registration credit card information.    To display the United
Connection Registration dialog box, choose Registration from the Tools menu.

Dialog Box Options

Title
Displays the title you selected during registration (optional).

First Name and Last Name
Displays your first and last name as entered during registration.
Note    If you need to change your name after registration (for example, due to marriage), you must contact Mileage
Plus  directly.    See Changing the name of the registered user for more information.

Business Phone and Home Phone
Displays the business and/or home phone numbers you entered during registration.

Mileage Plus Account
Displays the Mileage Plus  account number you entered (or were assigned) during 
registration.    You cannot change this number after registration.

Registration Credit Card and Address
Displays the credit card name and address you entered during registration.    To change 
your credit card information, choose the Edit Card button.

Edit Card button
Choose this button to display the Registration Credit Card Information dialog box.    You use
this dialog box to edit your registration credit card information.

Agreement button
Choose this button to display the United Connection Terms and Conditions dialog box, 
which contains the terms and conditions of United Connection  use.

See also
Changing your registration information 
Registration and Communication Options 



    Establish Connection dialog box
You use the Establish Connection dialog box to request a connection to the reservation 
system.
Important: If you choose Internet Service Provider, MSN, or CompuServe, see Connecting 
via the Internet for additional information.

How to display the Establish Connection dialog box

Dialog Box Options

Mileage Plus Account
Displays the Mileage Plus  account number you entered or received during registration.    
This field is read-only.

Password
Enter your password.
Note    If you select the Remember Password option, United Connection  will supply your password automatically 
each time the dialog box appears.

Remember this password for next time
Select this option if you want United Connection to supply your password automatically 
each time the dialog box appears.

Calling From (United Airlines Network only)
Select the location that you are calling from.
· To choose a different location, click on the down arrow to display a list of available 

locations.
· To add or edit a dialing location, choose the Dialing Info button.

Modem button (United Airlines Network only)
Choose this button to change your modem settings or select a different modem.    
Depending on your operating system, one of the following dialog boxes appears:
Windows 95: Choose Modem dialog box
Windows 3.1/3.11/NT 3.51: Modem Settings dialog box

Dialing Info button (United Airlines Network only)
Choose this button to display the Dialing Locations dialog box, which allows you to add, 
edit, or delete a dialing location.

Connect button
Choose this button to connect to the reservation system.    A dialog box displays the status 
of the connection process.

See also
Connecting to the reservation system 
Changing your password 
Registration and Communication Options 





To display the Establish Connection dialog box:
· From the File menu, choose Connect To Reservation System.

Note    The Establish Connection dialog box appears automatically whenever United Connection  requires a 
connection to the reservation system.    This happens when you open an itinerary with Selected or Reserved 
items, or if you request flight, car, or hotel information and are not already connected.



Dialing Locations dialog box

Note    This information applies to United Airlines Network users only.

The Dialing Locations dialog box displays a list of locations and the primary access 
telephone numbers to be dialed from those locations.    You use this dialog box to add, edit, 
or delete a dialing location.

How to display the Dialing Locations dialog box

Dialog Box Options

Location Name
Displays the names of all dialing locations.

Primary Number
Displays the primary access telephone number associated with each dialing location.    This
is the first number that United Connection  will dial when attempting to connect to the 
reservation system from that location.

Add button
Choose this button to add a new dialing location.    The Dialing Information dialog box 
appears.

Edit button
Choose this button to edit the selected dialing location.    The Dialing Information dialog 
box appears.

Delete button
Choose this button to delete the selected dialing location.

See also
Adding a dialing location 
Changing dialing information 
Registration and Communication Options 



To display the Dialing Locations dialog box:
· From the Tools menu, choose Communications/Dialing Information.

Note    You can also display the Dialing Locations dialog box by choosing the Dialing Info button in the 
Establish Connection dialog box.



Modem Settings dialog box
(Windows 3.1/3.11/NT 3.51)

Note    This information applies to United Airlines Network users only.

You access the Modem Settings dialog box to view or change your modem settings.    This 
includes the modem manufacturer and type, COM port, modem speed (baud rate), speaker 
volume, and other settings.    If you're not sure whether you have selected the correct 
modem settings, choose the Test Settings button to validate the settings immediately.

How to display the Modem Settings dialog box

Dialog Box Options

Vendor
Displays the modem manufacturer selected in the Modem Type dialog box. 

Modem
Displays the modem selected in the Modem Type dialog box.

Select Modem button
Choose this button to display the Modem Type dialog box, which allows you to select or 
change your modem vendor and model.

COM Port
Select the communications port your modem is using.    The default is COM1.

Find Port
Choose this button if you are not sure which COM port your modem is using.
Note    If you have an external modem, be sure to turn on the modem before selecting this option.

Modem Speed
Select the highest speed (baud rate) at which your modem operates.    The default is 9600.

Speaker Volume
Move the slide control left or right to adjust your modem speaker volume.

Initialization String
Displays the default initialization string for the selected modem.    You can modify the 
initialization string if your modem has special features or commands that you want to 
enable.    See your modem manual for details.

Time-Out
Select a time-out interval.    This is the number of seconds United Connection  will wait 
before canceling when attempting to connect to the reservation system.    The default is 60
seconds.

Test Settings button
Choose this button to validate the selected modem settings.    United Connection will check
each setting and inform you of any problems.



See also
Changing Windows 3.1/3.11/NT 3.51 modem settings 
Registration and Communication Options 



To display the Modem Settings dialog box:
· From the Tools menu, choose Communication/Modem Settings.

Note    You can also display this dialog box by choosing the Modem button in the Establish Connection dialog 
box.



    Mileage Plus
 Enrollment dialog box

If you did not enter a Mileage Plus number in the Personal Information dialog box, United 
Connection  instantly enrolls you in the Mileage Plus Frequent Flyer Program and displays 
your Mileage Plus account number.    Please make a note of it.    After registration, your 
Mileage Plus number appears in the Establish Connection dialog box... choose Connect To 
Reservation System from the File menu to display this dialog box.    After receiving a new 
Mileage Plus number, you must wait 1-3 days before you will be able to register United 
Connection on another computer.
Note    If you were already a Mileage Plus member and received a new account number accidentally, you will need to 
contact Mileage Plus to deactivate one of the accounts.    See Registration problems for more information.

See also
Registering with United Connection  

Registration and Communication Options 



    Changing your registration information

Changing your personal information 

Changing your registration credit card information

Updating your credit card expiration date 

Changing your password 

See also
Registration and Communication Options 



Adding a dialing location

Note    This information applies to United Airlines Network users only.

In order to connect to the reservation system using the United Airlines Network, you need to 
enter dialing information and select telephone access numbers for your location.    Dialing 
information is initially requested during registration.    You can create additional dialing 
locations if you will be using the same computer at more than one location (for example, if 
you have a laptop computer).

To add a dialing location:
1. From the Tools menu, choose Communications/Dialing Information.

The Dialing Locations dialog box displays a list of your current dialing locations and the 
primary access numbers associated with them.

2. Choose the Add button.    The Dialing Information dialog box appears.
3. Complete the fields as follows:

In this field You can

Location Name Enter a name for your location.    For example, 
Home or Work.

Area Code at this 
Location

Enter the three-digit area code for this location.

Always dial area 
code

Check this box if you need to dial an area code for 
all calls (even calls within your own area code).

Dialing Prefix Enter or select the prefix(es) you need to dial from 
this location.    Dialing prefixes include the code 
needed to get an outside line, or the code needed to
disable Call Waiting.
Note    If you are entering more than one code, 
separate the codes with a comma.

Dialing Suffix Enter any number you need to dial after the primary 
(or backup) access number is dialed.    For example,
when you place a long distance call from work, you 
might need to dial an authorization number to 
complete the call.

Long Distance Enter the number you need to dial before dialing 
long-distance from this location (usually 1).

Dialing Method Choose Tone or Pulse Dialing.    The default is Tone 
Dialing (used by touch-tone phones).

Calling Card Type
(Windows 95 only)

If you will be using a calling card from this location, 
select your calling card provider.
Note    If your calling card provider is not listed, you 
can enter your access number(s) in this field.    If you
enter a series of numbers, be sure to separate the 
numbers with commas.

Calling Card 
Number

If you will be using a calling card from this location, 
enter the calling card number.



(Windows 95 only)

Primary Number In the Primary field, type the three-digit area code 
for this location and press the down arrow key.    
Access numbers for that area code are displayed in 
the list.
Select an access number.    Modem speeds are 
displayed next to each number.    Choose a number 
that use the highest speed supported by your 
modem.    Do not select an access number whose 
modem speed is faster than your modem.
Note    If you are not sure which access number to 
select, call the 800 number displayed on the dialog 
box for assistance.

Backup Number Select a backup access number just as you selected
a primary number.    United Connection  
automatically dials the backup number if the primary
number is busy or does not respond.

4. To save your dialing information and return to the Dialing Locations dialog box, choose 
OK.    The new location name and primary access number are displayed.

5. Choose OK again to close the Dialing Locations dialog box.

See also
Changing dialing information 
Dialing Locations dialog box 
Dialing Information dialog box 
Registration and Communication Options 



Call Waiting
If your telephone service includes Call Waiting, be sure to disable this option by entering 
or selecting the appropriate code in the Dialing Prefix field.    Contact your telephone 
service provider if you are not sure which code to use.    If you do not disable Call Waiting 
when you connect to the reservation system, incoming calls could cause United 
Connection  to disconnect.



Changing your modem settings

Note    This information applies to United Airlines Network users only.

In order to connect to the reservation system using the United Airlines Network, you need to 
specify your modem type and select modem settings.    Modem information is initially 
requested during registration, but can be changed at a later time.    Different modem 
settings dialogs are displayed for Windows 95 and Windows 3.1/3.11/NT 3/51 users.

          Changing Windows 95 modem settings   
          Changing Windows 3.1/3.11/NT 3.51 modem settings   

Note    You cannot change modem settings while you are connected.

See also
Choose Modem dialog box 
Modem Settings dialog box 
Registration and Communication Options 



Changing Windows 95 modem settings

Note    This information applies to United Airlines Network users only.

To change your modem settings in Windows 95:
1. From the Tools menu, choose Communications/Modem Settings.    The Choose Modem 

dialog box appears.
2. To select a different installed modem, click on the arrow to display a list of modems and 

select the modem you want to use.
Note    The modems that appear in this list are the modems that you have installed in Windows 95.    To setup 
additional modems in Windows 95, choose Settings/Control Panel from the Start menu, then double-click on the 
Modems icon.

3. To change your COM port, baud rate, speaker volume, and other modem settings, choose
the Properties button.    The Windows 95 Modem Properties dialog box appears.
Note    If you need help on the Modem Properties dialog, click the "?" button in the upper right corner of the 
dialog box, then click on an area of the dialog box to get help for that area.

4. To save your changes and close the dialog box, choose OK.

See also
Changing your modem settings 
Checking modem status while you are connected 
Choose Modem dialog box 
Registration and Communication Options 



Changing Windows 3.1/3.11/NT 3.51 modem settings

Note    This information applies to United Airlines Network users only.

To change your modem settings in Windows 3.1/3.11/NT 3.51:
1. From the Tools menu, choose Communications/Modem Settings.    The Modem Settings 

dialog box appears.
Note    You can also display this dialog box by choosing the Modem button in the Establish Connection dialog 
box.

2. To select a different modem, choose the Select Modem button.    The Modem Type dialog 
box appears.
a. In the Vendor list, select the company that makes your modem.    A list of modems 

manufactured by that vendor appears in the Modem list.
b. Select your modem from the list.    If you cannot find your modem, select a similar 

modem from the same vendor or choose Hayes-Compatible from the Vendor list.
c. Choose OK.    The Modem Settings dialog box appears.

3. Change your modem settings as needed:

In this field You can

COM Port Select the communications port used by your 
modem.    The default is COM1.

Find Port Choose this button if you are not sure which COM 
port your modem is using.
Note    If you have an external modem, be sure to 
turn on the modem before selecting this option.

Modem Speed Select the modem speed (baud rate) for your 
modem.    The default is 9600.

Speaker Volume Move the slide control left or right to adjust your 
modem speaker volume.

Initialization String When you select a modem, United Connection  
automatically supplies the appropriate initialization 
string for that modem.    Modify the initialization 
string only if your modem has special features or 
commands that you want to enable.    See your 
modem manual for details.

Time-Out Select a time-out interval.    This is the number of 
seconds United Connection waits before canceling 
when attempting to connect to the reservation 
system.    The default is 60 seconds.

4. To validate the selected modem settings, choose the Test Settings button.    United 
Connection will check each setting and inform you of any problems.

5. To save your changes and close the Modem Settings dialog box, choose OK.

See also
Changing your modem settings 



Modem Settings dialog box
Modem Type dialog box 
Registration and Communication Options 



    Changing your personal information
If necessary, you can change the information you entered when you registered with United 
Connection .
Note    See below for more information about changing your name.

To change your registration information:
1. From the Tools menu, choose Registration.    The United Connection Registration dialog 

box appears.
2. Change your registration information as needed:

In this field You can

Title Select a title (optional).

First Name and 
Last Name

Enter your first and last names.

Note    If you need to change your name after 
registration (for example, due to marriage), you 
must contact Mileage Plus  directly.    See 
Changing the name of the registered user for more 
information.

Business Phone Enter your business telephone number.

Home Phone Enter your home telephone number.

Mileage Plus 
Account

Displays    your Mileage Plus account number.    You 
cannot change your account number after 
registration.

3. To change your registration credit card information, choose the Edit Card button.    See 
Changing your registration credit card information for more information.

4. When you are finished, choose OK.
The Establish Connection dialog box appears.    Next, you need to connect to the 
reservation system so that United Connection can update your registration information.

5. Choose the Connect button to connect to the reservation system.    A message appears 
once your registration information has been updated.

See also
United Connection Registration dialog box 
Registration and Communication Options 



    Viewing United Connection
 terms and conditions

The United Connection Terms and Conditions dialog box appears automatically during 
installation.    Acceptance of the terms stated in this license agreement are required for 
installation and use of United Connection.    You can review these terms at any time.

To view the terms and conditions:
1. From the Tools menu, choose Registration.    The United Connection Registration dialog 

box appears.
2. Choose the Agreement button.    The Terms and Conditions dialog box appears.
3. Scroll through the license agreement to read the terms.    When you have reviewed the 

terms, choose OK.    The United Connection Registration dialog box appears.
4. Choose OK to close the United Connection Registration dialog box.

See also
United Connection Registration dialog box 
Registration and Communication Options    



    Connecting to the reservation system

You will need to connect to United Airlines' reservation system whenever United Connection
needs send or receive information.    For example, you will need to connect when you open a 
reserved itinerary, or if you request flight, car, or hotel information.    You request a 
connection in the Establish Connection dialog box.
Note    The Establish Connection dialog box appears automatically whenever United Connection requires a 
connection to the reservation system.    To display this dialog box at any other time, choose Connect To Reservation 
System from the File menu.

To connect to the reservation system:
1. In the Password field, type your password.

Note    If you want United Connection to supply your password each time this dialog box appears, select the 
Remember This Password For Next Time option.

2. If you are connecting via the United Airlines Network:
a. Verify the location displayed in the Calling From field.    Click on the arrow to display a 

list of the locations you have entered.
b. To change your dialing information or create a new dialing location, choose the 

Dialing Info button.    The Dialing Locations dialog box appears.
c. To change your modem settings, choose the Modem button.    The Modem Settings 

dialog box appears.
3. When you are ready to connect to the reservation system, choose the Connect button.    

A dialog box displays the status of the connection process.
Important: If you choose Internet Service Provider, MSN, or CompuServe, see 
Connecting via the Internet for additional information.

To disconnect from the reservation system:
· From the File menu, choose Disconnect From Reservation System.

If you are connected to the reservation system and do not request information for a 
period of 10 minutes, United Connection will ask if you wish to remain connected.    If you
do not respond within 60 seconds, you will be disconnected automatically.
Important    If you are connecting to the reservation system via the Internet, disconnecting from the reservation 
system in United Connection (or even exiting United Connection) does not automatically disconnect you from the
Internet.    Because your Internet connection is managed by your service provider's dialer, you will need to access
the dialer to disconnect from the Internet.

Electronic software updates
Periodically, updates to the United Connection software will be released electronically.    
When this occurs, a message prompting you to download the software will appear after you 
connect to the reservation system.    Some updates will be mandatory, others optional.    
Follow the on-screen instructions to download the software.

See also
Establish Connection dialog box 



Choosing a United Connection service provider 
Registration and Communication Options 



    Changing your registration credit card information
Follow the steps below if you need to update your registration credit card information, or if 
you want to select a different credit card.
Note    Have a credit card statement available for reference when you enter this information.

To change your registration credit card information:
1. From the Tools menu, choose Registration.    The United Connection Registration dialog 

box appears.    Choose the Edit Card button.
2. Make any necessary changes in the Registration Credit Card Information fields:

In this field You can

Card Name Enter a descriptive name for the credit card.    For 
example, Citibank Visa Card.

Type of Card Select the credit card type you are entering.

Account Number Enter the credit card account number.    Important: 
Do not enter spaces or dashes between the 
numbers.    For your security, the account number 
will not be displayed after credit card validation is 
complete.

Expiration Date Enter the credit card expiration date using the 
format MM/YY or MM/DD/YY.    For example, 12/99 
or 12/31/99.

Series Number If you selected the American Express/Optima card, 
a Series Number field appears.    Enter the four-digit 
credit card series number (also referred to as the 
CID, or Customer ID).

Company Refer to your credit card statement.    If your 
company name appears on the statement, enter that
name exactly as it is shown.    Otherwise, leave this 
field blank.

Address, City, 
State, and Zip

Enter YOUR address exactly as it is shown on the 
credit card statement.

3. When the changes to your credit card information are complete, choose OK.    The United 
Connection Registration dialog box appears.

4. Choose OK again.    The Establish Connection dialog box appears.    Choose Connect to 
connect to the reservation system and update your registration credit card information.

See also
Updating the registration credit card expiration date 
Registration Credit Card Information dialog box 
Registration and Communication Options 



    Changing the name of the registered user
If you change your name after registering with United Connection  (for example, due to 
marriage), you will need to contact Mileage Plus

 and change your Mileage Plus account information, then update your registration 
information in United Connection.
Note    If you request a name change by phone, the change will be made within 2 to 3 days.    If you request a name 
change by mail, the change will be made within 7 to 10 days.

To change the registered user's name:
1. Call or write Mileage Plus to request a name change for your account.    Refer to your 

Mileage Plus membership information for details.
After the change to your Mileage Plus account has taken effect, follow the steps below to 
change your name in United Connection.

2. From the Tools menu, choose Registration.    The United Connection Registration dialog 
box appears.

3. If your first name has changed, enter the new name in the First Name field.
4. If your last name has changed, enter the new name in the Last Name field.
5. Choose OK.    The Establish Connection dialog box appears.
6. Choose the Connect button to connect to the reservation system and initiate the name 

change request.

See also
United Connection Registration dialog box 
Registration and Communication Options 



    Updating the registration credit card expiration date
When your registration credit card is reissued with a new expiration date, you must update 
the information in United Connection .    On the first day of the month in which the credit 
card is due to expire, United Connection will begin reminding you to change the expiration 
date.    After the credit card expires, you will not be able to connect to the reservation system
until you enter the new expiration date (or provide a different credit card).

To update the expiration date for your registration credit card:
1. From the Tools menu, choose Registration.    The United Connection Registration dialog 

box appears.
2. Choose the Edit Card button.    The Registration Credit Card Information dialog box 

appears.
3. In the Expiration Date field, enter the new expiration date for that credit card using the 

format MM/YY or MM/DD/YY.    For example, 12/99 or 12/31/99.
4. Choose OK.    The United Connection Registration dialog box appears.
5. Choose OK again.    The Establish Connection dialog box appears.
6. Choose the Connect button to connect to the reservation system and update your credit 

card expiration date.

See also
Changing your registration credit card information 
Registration Credit Card Information dialog box 
Registration and Communication Options 



    Changing your password
To help prevent unauthorized access to your itineraries, a password must be provided each 
time you connect to the reservation system.    You can change your password at any time.

To change your password:
1. From the Tools menu, choose Change Password.    The Change Password dialog box 

appears.
2. In the Old Password field, type your current password.

Note    If you have forgotten your password, please call the United Connection Support Desk at 1-800-4UA-
CNXN to obtain a new one.

3. In the New Password field, type the new password you want to use.
The password must be 6 to 10 characters long and can include letters and numbers.    Do 
not use symbols or spaces.

4. In the Retype New Password field, re-type your new password.
5. To save your new password and continue, choose OK.

See also
Registration and Communication Options 



Changing your dialing information

Note    This information applies to United Airlines Network users only.

You can change your dialing information at any time.    For example, you would need to 
change this information if your area code changed, or if you wanted to select a different 
telephone access number in your area.    If you add Call Waiting to your telephone service, 
you should specify the code needed to disable that option.

To change your dialing information:
1. From the Tools menu, choose Communications/Dialing Information.    The Dialing 

Locations dialog box appears.
2. Highlight the location you want to change and choose the Edit button.    The Dialing 

Information dialog box appears.
3. Change your Dialing Information as needed:

In this field You can

Location Name Enter a name for your current location.    For 
example, Home or Work.

Area Code at this 
Location

Enter the three-digit area code for this location.

Always dial area 
code

Check this box if you need to dial an area code for 
all calls (even calls within your own area code).

Dialing Prefix Enter or select the prefix(es) you need to dial from 
this location.    Dialing prefixes include the code 
needed to get an outside line, or the code needed to
disable Call Waiting.
Note    If you are entering more than one code, 
separate the codes with a comma.

Dialing Suffix Enter any number you need to dial after the primary 
(or backup) access number is dialed.    For example,
when you place a long distance call from work, you 
might need to dial an authorization number to 
complete the call.

Long Distance Enter the number you need to dial before dialing 
long-distance from this location (usually 1).

Dialing Method Choose Tone or Pulse Dialing.    The default is Tone 
Dialing (used by touch-tone phones).

Calling Card Type
(Windows 95 only)

If you will be using a calling card from this location, 
select your calling card provider.
Note    If your calling card provider is not listed, you 
can enter your access number(s) in this field.    If you
enter a series of numbers, be sure to separate the 
numbers with commas.

Calling Card 
Number
(Windows 95 only)

If you will be using a calling card from this location, 
enter the calling card number.



Primary Number In the Primary field, type the three-digit area code 
for this location and press the down arrow key.    
Access numbers for that area code are displayed in 
the list.
Select an access number.    Modem speeds are 
displayed next to each number.    Choose a number 
that use the highest speed supported by your 
modem.    Do not select an access number whose 
modem speed is faster than your modem.
Note    If you are not sure which access number to 
select, call the 800 number displayed on the dialog 
box for assistance.

Backup Number Select a backup access number just as you selected
a primary number.    United Connection  
automatically dials the backup number if the primary
number is busy or does not respond.

4. To save your dialing information and return to the Dialing Locations dialog box, choose 
OK.    Choose OK again to close the Dialing Locations dialog box.

See also
Adding a dialing location 
Dialing Information dialog box 
Registration and Communication Options 

 



    Creating Itineraries
The Itinerary Window 

Creating and managing itineraries
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    Overview: Creating an itinerary
Creating a new itinerary
When you open United Connection , a new (empty) itinerary automatically appears in the 
Itinerary Window.    By default, United Connection gives this itinerary the name ITIN1.    You 
may also open a new itinerary by choosing New from the File menu.

Selecting travelers
The first thing you need to do when creating an itinerary is select travelers.    Choose the 
Travelers icon from the toolbar, then select the travelers you want to include in this itinerary. 
See Selecting travelers for an itinerary for additional information.

Adding itinerary items
After selecting all of the travelers you want to include in the itinerary, you are ready to begin
adding flights, rental cars, and hotel accommodations.    Select one of the options below for 
more information about that topic.
Adding flights
Adding rental cars
Adding hotel accommodations

Important    Do not begin selecting itinerary items (flights, rental cars, or hotel accommodations) until you have 
finalized the list of travelers for this itinerary.    If you add or remove travelers after selecting itinerary items, you will 
need to re-select all of those items.

Reserving your itinerary
When you are ready to reserve your itinerary, choose the Reserve icon from the toolbar.    
The Pricing Summary dialog box appears.    After you review the costs associated with your 
itinerary, you choose a ticketing option and (if you wish) pay for your tickets online with a 
credit card.    See Reserving your itinerary for more information.

Saving your itinerary
You must save your itinerary file before exiting United Connection.
Note that saving an itinerary file does NOT reserve that itinerary.    When you save an 
itinerary file, you are storing a copy of that itinerary in the specified directory on your 
computer's hard drive.    In order to reserve your flights, rental cars, and/or hotel 
accommodations, you must select Reserve from the toolbar.
To save your itinerary file, choose Save (or Save As) from the File menu and enter the 
required information.    See Saving an itinerary for more information.

See also
The Itinerary Window



    Creating a new itinerary
You create an itinerary by opening a new (empty) Itinerary Window.

To create a new itinerary, do one of the following:
· Start United Connection .    A new itinerary automatically appears in the Itinerary 

Window.
· From the File menu, choose New.    United Connection will close the current itinerary and 

open a new one.    If you have not saved changes to the current itinerary, you are 
prompted to do so at this time.

See also
The Itinerary Window
Saving an itinerary 
Opening an itinerary 



    Changing an itinerary
Before an itinerary is reserved, you can make any changes you wish without incurring a 
service charge.    This includes adding, deleting, or modifying flights, rental cars, and hotel 
rooms, or changing service requests.    Once an itinerary has been reserved, certain 
restrictions apply.    Choose one of the options below for more information about that type of 
change.

Note    If you chose to pick up your ticket at your preferred Apollo travel agency you will not be able to modify or 
cancel your itinerary through United Connection  once it has been reserved.    To make any changes to this type of 
itinerary, please contact your travel agency directly.

Flights
Changing flight reservations
Canceling a reserved flight
Changing or canceling flight service requests

Cars
Changing rental car reservations
Canceling a reserved rental car

Hotels
Changing hotel reservations
Canceling a reserved hotel room

See also
Deleting itinerary items 
Canceling a reserved itinerary 



Changing flight reservations

Before an itinerary is ticketed, you can change or delete flights in that itinerary without 
incurring a service charge or cancellation penalty.    If you make a change that affects the 
current airfare, United Connection  will immediately display the new fare in the Itinerary 
Window.    Remember that your airfare is not guaranteed until you pay for your ticket.

Changing flights in a ticketed itinerary
If you change flights in an itinerary that has already been ticketed (as indicated in the 
Notices area of the Itinerary Window), the following conditions apply:
· Changing flights in a ticketed itinerary may result in a fare difference and/or service 

charge.    Contact the appropriate airline(s) for more information.
· United Connection cannot re-price a ticketed itinerary.    To get the revised fare, contact 

your ticket provider (United Airlines Reservations or your preferred Apollo travel agency).
· After changing a ticketed itinerary, you will need to take your ticket to a United Airlines 

airport ticket office or city ticket office for exchange.

Important    You will not be able to change flights under certain conditions.    See Restrictions on changing and 
canceling flights for more information.

To change a flight:
1. Open the itinerary that contains the flight you want to change.
2. In the Itinerary Window, double-click on the flight to be changed.    The Edit Flight dialog 

box appears.
This dialog box displays the flight planning information you entered.    If a flight has been 
selected, it also displays the airline and flight number, departure and arrival information, 
and service class.

3. If you wish, you can edit the Plan Information displayed at the top of the dialog box to 
choose a different origin, destination, date, or time.

4. To find available flights, choose the Find Flights button.    See Selecting flights based on 
schedule for more information.

5. To view or edit flight service requests, choose the Requests button.    See Changing or 
canceling flight service requests for more information.

6. To view flight details, choose the Details button.    See Viewing flight details for more 
information.

7. To save your changes and return to the Itinerary Window, choose OK.
8. If you have made changes to a reserved itinerary, you will need to re-reserve that 

itinerary.    See Reserving your itinerary for more information.
Note    When you re-reserve a ticketed itinerary, you will not be able to change your ticketing option or payment 
credit card.

To delete a Planned or Selected flight:



1. Open the itinerary that contains the flight you want to delete.
2. In the Itinerary Window, highlight the flight to be deleted.
3. From the Edit menu, choose Delete (or simply press the Delete key).
4. To save your itinerary, choose Save from the File menu.

See also
Changing an itinerary 
Canceling a reserved flight 
Canceling a reserved itinerary 



Canceling a reserved flight

Follow these steps to cancel a flight that you reserved through United Connection .    If the 
itinerary has not been ticketed, United Connection will re-price the itinerary and display the 
new fare.    Note that the previous ticketing deadline still applies.
Important    You will not be able to cancel flights under certain conditions.    See Restrictions on changing and 
canceling flights for more information.

Canceling flights in a ticketed itinerary
If the itinerary has already been ticketed (as indicated in the Notices area of the Itinerary 
Window), the following conditions apply to cancellations:
· A cancellation fee may be charged  please call the airlines for details.
· United Connection cannot re-price a ticketed itinerary.    To get the revised fare, contact 

your ticket provider (United Airlines Reservations or your preferred Apollo travel agency).
· After canceling the flight(s), you will need to take your ticket to a United Airlines airport 

ticket office or city ticket office for exchange.

To cancel a reserved flight:
1. Open the reserved itinerary that contains the flight(s) you want to cancel.
2. In the Itinerary Window, highlight the flight to be canceled.
3. From the Edit menu, choose Delete (or simply press the Delete key).
4. Choose the Reserve icon from the toolbar.    The Pricing Summary dialog box appears.
5. Choose the Reserve button.

If the itinerary has not yet been ticketed, you will need to re-select a ticketing option and
credit card.    These dialog boxes do not appear for ticketed itineraries.

6. In the Confirm Reservation dialog box, choose Finish to send the revised itinerary to the 
reservation system.    The Confirmation dialog box appears.    Choose OK.

See also
Changing an itinerary 
Changing flight reservations 
Canceling a reserved itinerary 



Restrictions on changing and canceling flights:
You will not be able to change or cancel flights under the following circumstances:

· If you chose to pick up the ticket at your preferred Apollo travel agency.    To make a 
change to this itinerary, please contact your travel agency directly.

· If the itinerary is in the process of being ticketed.
· If certain pricing modifications have occurred in the reservation system.
· If the status of any flight is Waitlisted or Unavailable.
· If any flights are undergoing a schedule change.
· If the itinerary includes more than four travelers.
· If the first flight in the itinerary has already departed.

If flights cannot be changed or canceled, United Connection  will display a message 
informing you whom to contact for assistance with your reservation.



Changing or canceling flight service requests

Choose one of the following topics for more information about changing or canceling the 
corresponding flight service request:

Changing a seat assignment 
Changing a meal request 
Changing a wheelchair request 

See also
Changing an itinerary 
Changing flight reservations 
Canceling a flight reservation



    Changing rental car reservations
Before you reserve an itinerary, you can modify or delete any Planned or Selected rental car 
in that itinerary.    Once you reserve a rental car, you must contact the rental company 
directly if you want to make any changes to that reservation.
Note    You can cancel any rental car that you reserved through United Connection .    See Canceling a reserved 
rental car for more information.

To change a Planned or Selected rental car:
1. Open the itinerary that contains the rental car you want to change.
2. In the Itinerary Window, double-click on the rental car to be changed.    The Edit Car 

dialog box appears.
This dialog box displays the rental car planning information you entered.    If a rental car 
has been selected, it also displays the rental company and car type.

3. If you wish, you can edit the Plan Information displayed at the top of the dialog box.
4. To find rental companies with available cars, choose the Find Cars button.    See Selecting

a rental car company for more information.
5. To view or edit service requests for a Selected car, choose the Requests button.    See 

Requesting rental car services for more information.
6. To view rental car company details for a Selected rental car, choose the Details button.    

See Viewing rental car company details for more information.
7. To return to the Itinerary Window, choose OK.
8. To save your itinerary, choose Save from the File menu.

To delete a Planned or Selected rental car:
1. Open the itinerary that contains the rental car you want to delete.
2. In the Itinerary Window, highlight the rental car to be deleted.
3. From the Edit menu, choose Delete (or simply press the Delete key).
4. To save your itinerary, choose Save from the File menu.

See also
Changing an itinerary 
Canceling a reserved rental car 
Canceling a reserved itinerary 



    Canceling a reserved rental car
Follow these steps to cancel a rental car reservation that you made through United 
Connection .    Cancellation fees may apply.    For more information about rental company 
cancellation policies, display the Rental Car Company Details dialog box for that rental car or
contact the rental company directly.    See Viewing rental car company details for more 
information.

To cancel a reserved rental car:
1. Open the reserved itinerary that contains the rental car you want to cancel.
2. In the Itinerary Window, highlight the rental car to be canceled.
3. From the Edit menu, choose Delete (or simply press the Delete key).
4. Choose the Reserve icon from the toolbar.    The Pricing Summary dialog box appears.
5. Choose the Reserve button.    The Confirm Reservation dialog box appears.
6. To send the cancellation information to the reservation system, choose Finish.    The 

Confirmation dialog box appears.    Choose OK.

See also
Changing an itinerary 
Changing rental car reservations 
Canceling a reserved itinerary 



    Changing hotel reservations
Before you reserve an itinerary, you can modify or delete any Planned or Selected hotel 
room in that itinerary.    Once you reserve a hotel room, you must contact the hotel directly if
you want to make any changes to your reservation.
Note    You can cancel any hotel room that you reserved through United Connection .    See Canceling a reserved 
hotel room for more information.

To change a Planned or Selected hotel room:
1. Open the itinerary that contains the hotel room you want to change.
2. In the Itinerary Window, double-click on the hotel room to be changed.    The Edit Hotel 

dialog box appears.
This dialog box displays the hotel planning information you entered.    If you have 
selected a hotel room, it also displays the hotel name, address, phone number, and rate.

3. If you wish, you can edit the Plan Information displayed at the top of the dialog box.
4. To find hotel with available rooms, choose the Find Hotels button.    See Selecting a hotel 

for more information.
5. To view or edit service requests for a Selected hotel, choose the Requests button.    See 

Requesting hotel services for more information.
6. To view hotel details for a Selected hotel room, choose the Details button.    See Viewing 

hotel details for more information.
7. To return to the Itinerary Window, choose OK.
8. To save your itinerary, choose Save from the File menu.

To delete a Planned or Selected hotel room:
1. Open the itinerary that contains the hotel room you want to delete.
2. In the Itinerary Window, highlight the hotel room to be deleted.
3. From the Edit menu, choose Delete (or simply press the Delete key).
4. To save your itinerary, choose Save from the File menu.

See also
Changing an itinerary 
Canceling a reserved hotel room 
Canceling a reserved itinerary 



    Canceling a reserved hotel room
Follow these steps to cancel a hotel reservation that you made through United Connection . 
Cancellation fees may apply.    For more information about hotel cancellation policies, display
the Hotel Details dialog box for that hotel room or contact the hotel directly.    See Viewing 
hotel details for more information.

To cancel a hotel reservation:
1. Open the reserved itinerary that contains the hotel room you want to cancel.
2. In the Itinerary Window, highlight the hotel room to be canceled.
3. From the Edit menu, choose Delete (or simply press the Delete key).
4. Choose the Reserve icon from the toolbar.    The Pricing Summary dialog box appears.
5. Choose the Reserve button.    The Confirm Reservation dialog box appears.
6. To send the cancellation information to the reservation system, choose Finish.    The 

Confirmation dialog box appears.    Choose OK.

See also
Changing an itinerary 
Changing hotel reservations 
Canceling a reserved itinerary 



    Deleting itinerary items
Before an itinerary is reserved, you can delete any Planned or Selected item (flight, rental 
car, or hotel room) in that itinerary.
Once an itinerary has been reserved, you will need to cancel any reservations you do not 
want to keep.    In some cases cancellation penalties may apply  contact the appropriate 
airline, rental company, or hotel for information about their cancellation policy.    You may 
also choose one of the topics listed below for additional information.

To delete a Planned or Selected item:
1. Open the itinerary that contains the item you want to delete.
2. In the Itinerary Window, highlight the flight, car, or hotel to be deleted.
3. From the Edit menu, choose Delete (or simply press the Delete key).
4. To save your itinerary, choose Save from the File menu.

See also
Canceling a reserved flight 
Canceling a reserved rental car 
Canceling a reserved hotel room 
Canceling a reserved itinerary 



    Deleting itinerary files
When you save an itinerary, United Connection  stores the itinerary file on your computer 
system using the file extension .ITN.    By default, these files are stored in the United 
Connection directory which was created during installation.
You should maintain a reserved itinerary file until travel is complete.    You can delete the 
itinerary file using the Windows File Manager (or whatever method you normally use to 
remove files from your system).
Note    If you delete a reserved itinerary file from    your system before travel has begun, you can retrieve a copy of 
that itinerary from the reservation system.    See Retrieving an itinerary from the reservation system for more 
information.

See also
Canceling a reserved itinerary 
Saving an itinerary 



    Overview: Selecting travelers
When you want to create an itinerary, the first thing you need to do is select the travelers 
who will be included in the trip.    You can select up to four travelers for each itinerary.    Note 
that an itinerary does not have to include the United Connection  registered user.    You also 
specify one traveler as the "primary" traveler.    At your option, United Connection can use 
the primary traveler's preferences to find flights, cars, and hotels.

Notes:
· If you want to create a new traveler, or change information for an existing traveler, you 

can access the Traveler Editor directly from the Select Travelers dialog box.    See Using 
the Traveler Editor for more information.

· Once you select specific flights, cars, or hotel rooms in an itinerary, you will not be able 
to add or remove travelers in that itinerary, or edit information for the current travelers.

· A credit card is required to reserve an itinerary (even if you are not purchasing your 
tickets online). If you have not entered credit card information for at least one person in 
the Traveler Editor you will be prompted to do so at this time.

· Infant travelers (under the age of two) may share a seat with a parent or guardian.    Each
adult may share a seat with only one infant.    See Seating options for infants for more 
information.

· You cannot create an itinerary that includes unaccompanied minors (children under the 
age of 12).    Under these circumstances, please contact the airline directly.

Changing travelers in an itinerary
If you add or remove travelers after selecting one or more itinerary items (flights, rental 
cars, and/or hotel accommodations), you will need to re-select all of those items.    Once your
itinerary has been reserved, you cannot add or remove travelers through United Connection

.    See Changing travelers in an itinerary for more information.

See also
Selecting travelers for an itinerary 
Select Travelers dialog box



    Selecting travelers for an itinerary
When you want to create an itinerary, the first thing you need to do is select travelers.
Note    Once you select specific flights, cars, or hotel rooms in an itinerary, you will not be able to add or remove 
travelers in that itinerary, or edit information for the current travelers.

To select travelers for an itinerary:
1. In the Itinerary Window, choose the Travelers icon from the toolbar. The Select Travelers 

dialog box appears.
The Travelers and Profiles list displays the names and profiles of all travelers specified in 
the Traveler Editor.

2. Select a traveler by highlighting the profile you want to use for that traveler.    (A suitcase
icon appears in front of each profile name.)
The traveler and profile name will appear in the Travelers And Profiles For This Itinerary 
list.    Repeat this process for each traveler you want to include in your itinerary.

3. If you want to include a traveler that is not shown in the Travelers And Profiles list, you 
must supply this traveler's identification and preference information.    Choose the 
Traveler Editor button, then create a new traveler entry and profile.

4. In the Primary Traveler field, select the traveler you want to designate as the primary 
traveler.    At your option, United Connection  will use the primary traveler's preferences 
to find flights, cars, and hotels.

5. To remove a selected traveler, highlight that traveler in the Travelers And Profiles list and
choose the Remove button.

6. When you choose an infant traveler (under the age of two), a Sharing Seat With Adult 
option appears next to the infant's name.    Select this option if you want the infant to 
share a seat with a parent or guardian.    See Seating options for infants for more 
information.
Note    Each adult may share a seat with only one infant.

7. To return to the Itinerary Window, choose OK.    The names of the selected travelers 
appear in the Travelers list.

See also
Overview: Selecting travelers 
Select Travelers dialog box 
Using the Traveler Editor



    Changing travelers in an itinerary
Adding or removing travelers in an itinerary will make it necessary for you to re-select all 
flights, rental cars, and hotels in that itinerary.    For this reason, we recommend that you do 
not begin selecting itinerary items until you have finalized the list of travelers.
Note    To change travelers in a ticketed itinerary, please contact the airline directly.

To change travelers in an itinerary:
1. From the File menu, choose Open and select the itinerary you want to change.
2. In the toolbar, choose the Travelers icon.    The Select Travelers dialog box appears.
3. To remove a traveler, highlight that traveler's name in the Travelers And Profiles For This 

Itinerary list and choose the Remove button.
4. To add a traveler, highlight the profile you want to use for that traveler in the Travelers 

and Profiles list.
5. To return to the Itinerary Window, choose OK.    Notice that the status of all itinerary 

items is Planned.
6. Re-select each planned flight, rental car, and hotel room.    To reserve your itinerary, 

choose the Reserve icon from the toolbar.

See also
Selecting travelers for an itinerary 
Reserving your itinerary
Select Travelers dialog box 



    Seating options for infants
Two seating options are available for infants (under the age of 2):
· Reserving a seat for the infant
· Having the infant share a seat with a parent or guardian

Note    Each adult may share a seat with only one infant.

Sharing Seat With Adult option
When you add an infant traveler to an itinerary, a Sharing Seat With Adult option appears 
next to the infant's name in the Select Travelers dialog box.    Select this option to have the 
infant share a seat with a parent or guardian.    If you do not select the Sharing Seat With 
Adult option, you will need to purchase a seat for the infant.

Note    You will not be able to reserve your seats through United Connection  if your itinerary includes more than one
infant who will be sharing a seat.    Safety guidelines require that you contact the airline directly for your seat 
assignments.

Airfare considerations
On domestic U.S. flights, infants sharing a seat with an adult fly free of charge.    On 
international flights, infants sharing a seat with an adult pay 10% of the adult fare.
If you choose to purchase a seat for an infant, a special fare may or may not be available.    If
a special fare is not available for the infant, the adult fare will be charged.

Changing the Sharing Seat With Adult option
You can change an infant's seating arrangement by selecting or de-selecting the Sharing 
Seat With Adult option.    However, doing so will make it necessary to re-select all your 
flights.    To change an infant's seating option after your itinerary has been ticketed, please 
contact the airline directly.

See also
Selecting travelers for an itinerary 
Select Travelers dialog box 
Selecting seats 



    Select Travelers dialog box
You access the Select Travelers dialog box to choose travelers for this trip.    You also specify 
one traveler as the "primary" traveler.    At your option, United Connection  can use the 
primary traveler's preferences to find flights, cars, and hotels.
Note    Once you select specific flights, cars, or hotel rooms in an itinerary, you will not be able to add or remove 
travelers in that itinerary, or edit information for the current travelers.

How to display the Select Travelers dialog box

Dialog Box Options

Travelers And Profiles
Displays the names and profiles of all travelers entered in the Traveler Editor.    To select a 
traveler, highlight the profile you want to use for that traveler.    The selected traveler's 
name and profile appear in the Travelers And Profiles For This Itinerary list.

Travelers And Profiles For This Itinerary
Displays the list of travelers currently selected for this itinerary.    Each itinerary can include
up to four travelers.

Sharing Seat With Adult
If you select an infant traveler (under the age of two), the Sharing Seat With Adult option 
appears next to the infant's name in the Travelers And Profiles For This Itinerary list.    
Select this option if you want the infant to share a seat with a parent or guardian.    Do not 
select this option if you want to purchase a seat for the infant.    See Seating options for 
infants for more information.
Note    Each adult may share a seat with only one infant.

Primary Traveler
Select the traveler you want to designate as the primary traveler.    At your option, United 
Connection will use the primary traveler's preferences to find flights, cars, and hotels.    By 
default, United Connection uses the first adult traveler selected for this itinerary.

Traveler Editor button
Choose this button if you want to add a new traveler, or edit information for an existing 
traveler.    The Traveler Editor dialog box appears.    See Using the Traveler Editor for more 
information.

Remove button
Choose this button to remove the highlighted traveler from the Travelers And Profiles For 
This Itinerary list.    Note that removing travelers will make it necessary for you to re-select 
all flights, rental cars, and hotels in your itinerary.    If your itinerary has been ticketed, you 
will need to contact the airline directly to add or remove travelers.    See Changing 
travelers in an itinerary for more information.

See also
Selecting travelers for an itinerary 
Selecting seats 





To display the Select Travelers dialog box:
· From the Itinerary Window toolbar, choose the Travelers icon.    The Select Travelers 

dialog box appears.



    Overview of the Itinerary Window
The Itinerary Window is the first window that appears when you start United Connection .    
All planning activities begin and end at the Itinerary Window 

 so take a few minutes to familiarize yourself with its contents.
Click on an area of the window below to see a description of that area.
See The Itinerary Window for more information.



Title bar
Displays the name of the current itinerary.



Menu bar
Choose one of the menus below to get more information about that menu.



System Menu icon
Choose this icon to display a list of System Menu options.



Minimize icon
Choose this icon to minimize the United Connection  window.



Maximize icon
Choose this icon to maximize the United Connection  window.



TRAVELERS icon
Choose this icon to add travelers to your itinerary.    See Selecting travelers for an itinerary
for more information.



ADD FLIGHT icon
Choose this icon to add a flight to your itinerary.    See Planning a flight for more 
information.



ADD CAR icon
Choose this icon to add a rental car to your itinerary.    See Planning a rental car for more 
information.



ADD HOTEL icon
Choose this icon to add hotel accommodations to your itinerary.    See Planning a hotel 
stay for more information.



FIND icon
Highlight a flight, rental car, or hotel item, then choose this icon to view availability for the
selected item.



FARESHOP icon
Choose this icon to use the FareShopper  option.    See Using FareShopper
 for more information.



RESERVE icon
Choose this icon when you are ready to reserve your itinerary.    See Reserving your 
itinerary for more information.



CANCEL icon
Choose this icon to cancel your itinerary.    See Canceling a reserved itinerary for more 
information.



PRINT icon
Choose this icon to print your itinerary.    See Printing an itinerary for more information.



Travelers area
Displays the names of all travelers in the current itinerary.    Each itinerary can include up 
to four travelers.    The primary traveler's name appears at the top of the list.    See 
Selecting travelers for an itinerary for more information.



Totals area
Displays the following totals:
· Total airfare for all travelers on all selected flights
· Estimated total for all car rentals
· Estimated total for all hotel reservations
· Total Mileage Plus  flight miles for all United and United Express flights in the itinerary
See Totals for more information about each type of total.



Notices area
Displays information relating to the current itinerary, including:
· The itinerary name
· The flight confirmation number (if flights are reserved)
· The ticketing deadline (if flights are reserved but not ticketed)
See Notices for a full list of items that can appear in the Notices area.



Status column
Displays the status of each item.    See Flight status, Rental car status, or Hotel status for 
more information.

Note    To re-size a column, use the mouse to drag the column divider left or right.



Date/Time column
Flights: Displays the departure and arrival dates and times.
Cars: Displays the pick-up and drop-off dates and times.
Hotels: Displays the check-in and check-out dates.

Note    To re-size a column, use the mouse to drag the column divider left or right.



Location column
Flights: Displays the origin and destination airports. 
Cars: Displays the pick-up/drop-off location. 
Hotels: Displays the hotel location. 

Note    To re-size a column, use the mouse to drag the column divider left or right.



Details column
Flights: Displays service class and seat assignments. 
Cars: Displays the car type and rate. 
Hotels: Displays the room type and rate. 

Note    To re-size a column, use the mouse to drag the column divider left or right.



Itinerary items
Displays all flights, rental cars, and hotel reservations included in your itinerary, in 
date/time order.    Click on each column heading to see a description of the information 
displayed in that column.

Note    To re-size a column, use the mouse to drag the column divider left or right.



Status bar
Displays the following information:
· A description of each toolbar icon (when you point to that icon)
· A description of each menu option (when you highlight that option)
· The current date and time
· CONNECTED or NOT CONNECTED (indicates whether you are connected to the 

reservation system)



    The Itinerary Window
The Itinerary Window is the starting point for all United Connection  activities.    From here, 
you can edit traveler profiles... view Mileage Plus

 account information... get actual flight status information for today's flights... and, of 
course, plan an itinerary.
The Itinerary Window lets you see all itinerary information at a glance.    It shows you the 
names of the selected travelers, the total current flight cost and flight miles, and detailed 
information for each flight, rental car, and hotel reservation you have included in your 
itinerary.
Each area of the Itinerary Window is described below.    For an illustration of the Itinerary 
Window, see Overview of the Itinerary Window. 

Window Options

Menu Bar
All United Connection menus appear in the menu bar at the top of the Itinerary Window.    
See United Connection  menus for more information about each menu and its options.

Toolbar
A toolbar at the top of the Itinerary Window provides immediate access to the most 
important United Connection features and functions.    See Using the toolbar for 
information about each icon.

Travelers
The names of all travelers in the current itinerary appear on the left side of the Itinerary 
Window.    Each itinerary can include up to four travelers.    The primary traveler's name 
appears at the top of the list.    See Selecting travelers for an itinerary for more 
information.

Totals
The following totals are displayed in the center of the Itinerary Window:

Flight Cost
Total airfare for all travelers on all selected flights.
Hotel Estimate
Estimated total for all hotel reservations.
Car Estimate
Estimated total for all car rentals.
MP Flight Miles
Total Mileage Plus flight miles for all United and United Express flights in the itinerary.

See Totals for more information about each type of total.

Notices
Displays information relating to the current itinerary, including:
· The itinerary name
· The flight confirmation number (if flights are reserved)
· The ticketing deadline (if flights are reserved but not ticketed)



See Notices for a full list of items that can appear in the Notices area.

Itinerary Items
All flights, rental cars, and hotel reservations included in your itinerary are displayed in the
lower half of the Itinerary Window, in date/time order.    The following information is 
provided for each itinerary item:

Status
Displays the status of each item.    For example, Planned, Selected, Reserved, or 
Ticketed.    See Flight status, Rental car status, or Hotel status for more information.
Date and Time
Flights: Displays the departure and arrival dates and times.
Cars: Displays the pick-up and drop-off dates and times.
Hotels: Displays the check-in and check-out dates.
Location
Flights: Displays the origin and destination airports.
Cars: Displays the pick-up/drop-off location.
Hotels: Displays the hotel location.
Details
Flights: Displays service class and seat assignments.
Cars: Displays the car type and rate.
Hotels: Displays the room type and rate.

Status Bar
The following information is displayed in a status bar along the bottom of the Itinerary 
Window:
· A description of each toolbar icon (when you point to that icon)
· A description of each menu option (when you highlight that option)
· The current date and time
· CONNECTED or NOT CONNECTED (indicates whether you are connected to the 

reservation system)



    The toolbar
The toolbar at the top of the Itinerary Window includes icons for many United Connection  
features.    Each icon is described below.

Choose this icon to add travelers to your itinerary.    See Selecting travelers for an itinerary 
for more information.

Choose this icon to add a flight to your itinerary.    See Planning a flight for more information.

Choose this icon to add a rental car to your itinerary.    See Planning a rental car for more 
information.

Choose this icon to add hotel accommodations to your itinerary.    See Planning a hotel for 
more information.

Highlight a flight, rental car, or hotel item, then choose this icon to view availability for the 
selected item.

Choose this icon to use the FareShopper  option.    See Using FareShopper
 for more information.

Choose this icon when you are ready to reserve your itinerary.    See Reserving your itinerary 
for more information.

Choose this icon to cancel your itinerary.    See Canceling a reserved itinerary for more 
information.

Choose this icon to print a copy of your itinerary.    See Printing an itinerary for more 
information.

See also
Overview of the Itinerary Window 



    United Connection
 menus

United Connection includes six menus.    Choose one of the menus below to get more 
information about that menu.



    File menu
Choose an option in the menu below to see a description of that option.

See also
United Connection  menus 



New option
Choose this option to create a new itinerary file.    An empty Itinerary Window is displayed.

See also
Creating a new itinerary 



Open option
Choose this option to open an existing itinerary file.    The Open dialog box appears.

See also
Opening an itinerary



Retrieve From Reservation System option
Choose this option to retrieve a reserved itinerary from the reservation system.    The 
Retrieve From Reservation System dialog box appears.

See also
Retrieving an itinerary from the reservation system



Save option
Choose this option to save the open itinerary file.    If you have not yet saved the open file, 
the Save As dialog box appears.

See also
Saving an itinerary 



Save As option
Choose this option to save an itinerary file for the first time, or to save the open file using 
a different name.

See also
Saving an itinerary 



Print Preview option
Choose this option to view a trip report of itinerary in Print Preview mode.

See also
Viewing an itinerary in Print Preview mode



Print option
Choose this option to print your itinerary.    The Print dialog box appears.

Shortcut: Choose the PRINT icon from the toolbar.

See also
Printing an itinerary 



Print Setup option
Choose this option to setup your printer.    The Print Setup dialog box appears.

See also
Using the Print Setup option 



Recently Used Files option
Displays the names of the last four itinerary files you opened.    Choose a file name to open
that file.



Connect To Reservation System option
Choose this option to connect to the reservation system.    The Establish Connection dialog
box appears.
Note    The Establish Connection dialog box appears automatically whenever United Connection  requires a 
connection to the reservation system.

See also
Connecting to the reservation system 



Disconnect From Reservation System
Choose this option to disconnect from the reservation system.

See also
Connecting to the reservation system 



Exit option
Choose this option to exit United Connection .    If you have not saved the open itinerary 
you will be prompted to do so before exiting.



    Edit menu
Choose an option in the menu below to see a description of that option.

See also
United Connection  menus 



Copy option
Choose this option to place a trip report of the current itinerary on the Windows Clipboard. 
You can then Paste this information into other Windows applications that support the Paste
command.

See also
Viewing an itinerary in Print Preview mode 
Printing an itinerary 



Delete option
Choose this option to delete the selected itinerary item.

See also
Deleting itinerary items 



Edit option
Highlight a flight, car, or hotel item in the Itinerary Window, then choose this option to 
display the Plan dialog box for that item.

See also
Add Flight dialog box 
Add Car dialog box 
Add Hotel dialog box 



Find option
Highlight a selected flight, car, or hotel item in the Itinerary Window, then choose this 
option to display the Select dialog box for that item.

See also
Select Flight dialog box 
Select Rental Car Company dialog box 
Select Hotel dialog box 



    View menu
Choose an option in the menu below to see a description of that option.

See also
United Connection  menus 



Toolbar option
Choose this option to display the toolbar at the top of the Itinerary Window.    A  appears 
next to this item when it is selected.

See also
The toolbar 



Status Bar option
Choose this option to display the status bar at the bottom of the Itinerary Window.    A  
appears next to this item when it is selected.

See also
Status bar 



Electronic Ticket Information option
Choose this option to display electronic ticket receipt information for the current itinerary.   
This option is only available if you chose Electronic Ticket as your ticketing option when 
you reserved the current itinerary.

See also
Electronic ticketing 
Electronic Ticket Information dialog box



    Itinerary menu
Choose an option in the menu below to see a description of that option.

See also
United Connection  menus 



Select Travelers option
Choose this option to select travelers for the current itinerary.    The Select Travelers dialog
box appears.

Shortcut: Choose the TRAVELERS icon from the toolbar.

See also
Selecting travelers for an itinerary 



Add Flight option
Choose this option to add a flight to your itinerary.    The Add Flight dialog box appears.

Shortcut: Choose the ADD FLIGHT icon from the toolbar.

See also
Planning a flight 



Add Car option
Choose this option to add a rental car to your itinerary.    The Add Car dialog box appears.

Shortcut: Choose the ADD CAR icon from the toolbar.

See also
Planning a rental car 



Add Hotel option
Choose this option to add a hotel room to your itinerary.    The Add Hotel dialog box 
appears.

Shortcut: Choose the ADD HOTEL icon from the toolbar.

See also
Planning a hotel stay 



FareShopper  option
Choose this option to find flights using FareShopper .    The Select FareShopper

 Fares dialog box appears.
Shortcut: Choose the FARESHOP icon from the toolbar.

See also
Using Fare Shopper 



Reserve option
Choose this option to reserve your itinerary.    The Pricing Summary dialog box appears.

Shortcut: Choose the RESERVE icon from the toolbar.

Note    Before choosing Reserve, make sure that you have selected all of the flights, rental cars, and hotel 
accommodations you want to include in your itinerary.

See also
Reserving your itinerary 



Cancel Reservation option
Choose this option to cancel your itinerary.

Shortcut: Choose the CANCEL icon from the toolbar.

See also
Canceling a reserved itinerary 



    Tools menu
Choose an option in the menu below to see a description of that option.

See also
United Connection  menus 



Traveler Editor option
Choose this option to add, delete, or edit traveler and profile information.    The Traveler 
Editor dialog box appears.

See also
Adding a traveler 
Adding a profile 
Using the Traveler Editor 



Flight Status option
Choose this option to view flight status information.    The Flight Status dialog box appears.

See also
Checking flight status 



Mileage Plus  Summary option
Choose this option to view Mileage Plus account balance information for a traveler.    The 
Mileage Plus Summary dialog box appears.

See also
Reviewing Mileage Plus Summary information 



Compute Mileage Plus  Miles option
Choose this option to calculate Mileage Plus miles between two airports.    The Mileage Plus
Miles dialog box appears.

See also
Computing Mileage Plus miles between cities 



United Ticketing Offices option
Choose this option to find a United ticketing office location in your area.    The United 
Ticketing Offices dialog box appears.

See also
Finding United ticketing locations 



United Information option
Choose this option to view information about promotions, vacation packages, and other 
special offers from United Airlines.    The United Information dialog box appears.

See also
Reviewing United Information 



System Options option
Choose this option to specify your system option settings.    The System Options dialog box
appears.

See also
Reviewing system options 



Communications option
Choose this option to view or edit your communications options.    The following menu 
options appear:

See also
Adding a dialing location 
Connecting to the reservation system 



Registration option
Choose this option to review or edit your registration information.    The United Connection 
Registration dialog box appears.

See also
Changing your registration information 



Change Password option
Choose this option to change your password.    The Change Password dialog box appears.

See also
Changing your password 



    Help menu
Choose an option in the menu below to see a description of that option.

See also
United Connection  menus 



Contents option
Choose this option to display the Contents window for United Connection Help.



Search For Help On option
Choose this option to display the Search dialog box for United Connection Help.



Technical Support option
Choose this option to view information about contacting the United Connection Support 
Desk.

See also
United Connection Technical Support 



About United Connection option
Choose this option to view version information for United Connection .



    Totals
Four totals are displayed in the center of the Itinerary Window.    They are: Flight Cost, Car 
Estimate, Hotel Estimate, and MP Flight Miles.    These totals are updated automatically each 
time you add, remove, or modify an item in your itinerary.    Each total is described below.

Flight Cost
Displays the total airfare for all selected flights. This is the cost for all travelers.    A 
breakdown of the total cost by traveler is displayed in the Fare/Rules tab of the Pricing 
Summary dialog box.    To display this dialog box, select Reserve from the toolbar.    United 
Connection  will not display a flight total if:
· Changes are made to a ticketed itinerary
· The itinerary is canceled

Car Estimate
Displays the estimated total for all car rentals.    This is only an estimate, and does not 
include all possible fees that might be charged.    The rate for each rental car appears in the 
lower half of the Itinerary Window, along with other information for that car.    United 
Connection will not be able to display a total rental car estimate if:
· The itinerary includes car rentals priced in different currencies.
· The discount program option is selected for one or more car rentals.
· The itinerary has been reserved.    However, the rates for each rental car still appear in 

the lower half of the Itinerary Window.

Hotel Estimate
Displays the estimated total for all hotel reservations.    This is only an estimate, and does 
not include all possible fees that might be charged.    The rate for each individual hotel 
appears in the lower half of the Itinerary Window, along with other information for that hotel.
United Connection will not be able to display a total hotel estimate if:
· The itinerary includes hotels priced in different currencies
· The discount program option is selected for one or more hotels

MP Flight Miles
Displays the total Mileage Plus  flight miles for all United and United Express flights in the 
itinerary.    This is the total number of flight miles that will be awarded to each Mileage Plus 
member in the itinerary once travel has been completed.
Note    A minimum of 500 flight miles is awarded for each United and United Express flight (even if the actual flight 
mileage is less).    For Shuttle by United flights, the actual flight mileage is awarded.



    Notices
The following information can appear in the Notices area:
· The itinerary name.
· The flight confirmation number (if flights have been reserved).
· The ticketing deadline (if flights have been reserved but not ticketed).
· If you cancel a rental car or hotel reservation, the cancellation number is displayed.
· If you ticket the itinerary through an Apollo travel agency, you are advised to contact 

that agency if you need to change or cancel your itinerary.

· "Your air travel has been ticketed."
This message appears once the itinerary has been ticketed.    You can ticket your itinerary
immediately through United Connection  by paying online with a credit card.    See 
Ticketing options for more information.

· "This itinerary has been canceled."
This message appears if the itinerary is canceled, either by the user or by the reservation
system. The reservation system will cancel an itinerary if it has not been ticketed by the 
ticketing deadline.

· "This itinerary does not exist in the reservation system."
This message appears if the itinerary has expired (this normally occurs within 24 hours 
after the last flight has been flown).

· Fare restrictions.    After an itinerary has been reserved, the fare restrictions associated 
with that itinerary are displayed.    These can include one or more of the following:

Message Description

"This is a non-refundable fare" The fare is non-refundable.

"Cancellation fee applies" A fee will be charged if the itinerary is 
canceled.

"Minimum stay required" The fare applies to travel that meets 
the minimum stay requirements (for 
example, over a weekend).

"Maximum stay required" The fare applies to travel that meets 
the maximum stay requirements (for 
example, not more than 60 days)

"Flight-specific fare" The fare applies to specific flights 
only (for example, flights at certain 
times of day).

"Advance purchase required" Tickets must be purchased a set 
number of days before departure.

"Change/cancellation fees 
apply"

A fee will be charged if the itinerary is 
changed or canceled.





    Flight Status
The following status options apply to flights:

Planned You have entered planning information in the Add Flight dialog box, but have 
not yet selected a specific flight.    Planning information includes origin, 
destination, departure date, and departure time.

Selected You have selected a specific flight, but have not yet reserved that flight.

Reserved You have reserved the flight, but have not yet paid for your ticket.    If you do 
not pay for your ticket online, your airfare is not guaranteed and your 
reservation will be canceled unless your ticket is purchased before the 
ticketing deadline (normally 24-72 hours after you reserve your itinerary).    
The actual ticketing deadline will appear in the Notices area of the Itinerary 
Window.

Ticketed Your itinerary has been ticketed and your airfare is guaranteed.

Modified You have changed one or more seat, meal, or special service requests for the 
flight but have not yet reserved the change(s).

Requested The flight has been requested but is not yet confirmed.

Waitlisted All travelers in the itinerary are waitlisted for the selected flight.

Unavailable The flight you requested is unavailable.



    Rental car status
The following status options apply to rental cars:

Planned You have entered planning information in the Add Car dialog box, but have not
yet selected a specific car.    Planning information includes the pick-up airport, 
pick-up date and time, and drop-off date and time.

Selected You have selected a specific rental car, but have not yet reserved that car.

Reserved Your rental car reservation has been confirmed.

Requested The rental car has been requested but is not yet confirmed.

Unavailable The rental car you requested is unavailable.



    Hotel status
The following status options apply to hotel accommodations:

Planned You have entered planning information in the Add Hotel dialog box, but have 
not yet selected specific hotel accommodations.    Planning information 
includes a location (city or airport), a reference point (for example, 
Downtown), check-in date, and check-out date.

Selected You have selected specific hotel accommodations, but have not yet reserved 
those accommodations.

Reserved Your hotel reservation has been confirmed.

Requested The hotel room has been requested but is not yet confirmed.

Unavailable The hotel room you requested is unavailable.

 



    Reservations and Ticketing
Overview

Reserving your itinerary 

Selecting a ticketing option 

Electronic ticketing

Selecting a credit card 

Guaranteeing hotel rooms 

Confirming your reservation 



    Overview: Reserving your itinerary
After you have finished selecting flights, rental cars, and hotel accommodations, you are 
ready to reserve your itinerary and send the information to the reservation system.
When you reserve your itinerary, you:
· Review the flights, rental cars, and hotel rooms you have selected.
· Choose a ticketing option (if your itinerary includes flights).
· Choose a credit card.

¨ If you chose a ticketing option that requires you to pay for your ticket online, your 
airfare will be charged to the selected credit card.

¨ If you chose a ticketing option that does not require immediate payment, the credit 
card will NOT be charged.

Note    The billing address of the selected credit card is used a contact address.

· Enter a descriptive name for the itinerary (up to 15 characters).
· Finalize your reservation.    United Connection  sends the itinerary to the reservation 

system for processing and displays the response.

Before reserving your itinerary, make sure that the status of all items in the Itinerary 
Window is SELECTED.    You cannot reserve an itinerary that includes PLANNED items.
If you make any changes to your itinerary after reserving, you will need to reserve the 
itinerary again to update the information in the reservation system.    For example, you 
might want to add a rental car, or change your seat assignment on a flight.

See also
Reserving your itinerary 
Selecting a ticketing option 
Selecting a credit card 
Guaranteeing hotel rooms 
Confirming your reservation 



    Reserving your itinerary
In order to reserve an itinerary you'll need to select a ticketing option, specify a credit card, 
and enter a descriptive name.    When you're ready to finalize your itinerary, United 
Connection  sends the information to the reservation system for processing.
Note    When you re-reserve a ticketed itinerary, you will not be able to change your ticketing option or payment credit 
card.

To reserve an itinerary:
1. In the Itinerary Window, make sure that you have selected all of the flights, rental cars, 

and hotel accommodations you want to include in your itinerary.
2. Choose the Reserve icon from the toolbar.    The Pricing Summary dialog box appears.

Depending on the type of itinerary items you chose, this dialog box can include up to 
four tabs: Fares/Rules, Flights, Cars, and Hotels.    Select each tab to view the information 
displayed on that tab.

3. When you are satisfied with the information displayed in the Pricing Summary dialog box,
choose the Reserve button to continue.    The Ticketing Options dialog box appears.

4. Highlight a ticketing option to see more information about that option in the Description 
area.    Select a ticketing option, then choose Next>.    The Payment Method And Delivery 
Address dialog box appears.

5. In the Choose A Credit Card From This Traveler field, select the person who will be paying
for the ticket.    If you are not paying for your ticket now, select the individual you want to
designate as the contact person.
Note    The person you select does not have to be included in the itinerary.

6. Select one of that individual's credit cards.
· If you chose a ticketing option that requires you to pay for your ticket online, the 

airfare will be charged to the selected credit card.
· If you chose a ticketing option that does not require immediate payment, the credit 

card will NOT be charged (the billing address is used as a contact address).
7. Choose the Next> button.    The Confirm Reservation dialog box appears.
8. Review your itinerary one last time, then enter a descriptive name for the itinerary (up to

15 characters, including spaces).
9. When you are ready to confirm your reservation, choose the Finish button.    United 

Connection sends your itinerary to the reservation system.
10. The Confirmation dialog box displays the response from the reservation system.    Review

this information carefully, then choose Done to return to the Itinerary Window.

Note    Airlines do not release their inventory until you confirm your reservation.    Therefore, it is possible that the 
flights and/or fare that you selected will no longer be available.    If this occurs, United Connection displays a message
informing you of your options.

See also
Selecting a ticketing option 



Selecting a credit card 
Guaranteeing hotel rooms 
Confirming your reservation 



    Changing Acceptable Fare Restrictions
From the Pricing Summary dialog box, you can change the fare restrictions associated with 
the current itinerary and then re-price the itinerary.    For example, you can increase the 
number of acceptable fare restrictions to see if a lower fare is available.    (Lower fares 
generally have more fare restrictions associated with them.)

To change the Acceptable Fare Restrictions for this flight:
1. In the Itinerary Window, choose the Reserve icon.    The Pricing Summary dialog box 

appears.
2. Select the Flight tab.    This tab displays information for each flight in your itinerary.
3. Choose the Restrictions button.    The Flight Preferences dialog box appears.

Note    Because you have already selected your flights, you cannot change the Preferred Airlines and Preferred 
Service Class options.

4. In the Acceptable Fare Restrictions fields, select the fare restrictions you are willing to 
accept when pricing your flights.    These include:
· Minimum Stay Required
· Maximum Stay Required
· Advance Purchase Required
United Connection  will look for fares based on the specified fare restrictions.    If no 
available fare meets all of the selected restrictions, United Connection will return a less 
restrictive fare (it will never return a more restrictive fare).

Tip    To find low fares, select all fare restrictions.

5. If you want to save the new fare restrictions in the primary traveler's profile, choose the 
Update Profile button (this is optional).

6. To apply the new fare restrictions to your itinerary, choose OK.
7. When prompted to re-price the airfare portion of the itinerary, choose Yes.    The updated 

airfare appears in the Pricing Summary dialog.
8. When you are satisfied with the airfare for your itinerary, choose Reserve to continue.

See also
Flight tab 
Flight Preferences dialog box 
Pricing Summary dialog box 



    Selecting a ticketing option
If your itinerary includes flights, you need to indicate how you want to receive your ticket.    
United Connection  provides up to five ticketing options, depending on your itinerary and 
the information you provided.    Three of the ticketing options require that you pay for your 
ticket online with a credit card.    The other two ticketing options do not require immediate 
payment.
Important    If you do not pay for your ticket online, your airfare is not guaranteed and your reservation will be 
canceled if the ticket is not purchased by the specified ticketing deadline.

To select a ticketing option for your itinerary:
1. In the Pricing Summary dialog box, choose the Reserve button.    The Ticketing Options 

dialog box appears.    One or more of the following ticketing options will be available:
Electronic Ticket
First Class Mail Delivery
Express Delivery (2 to 3 Business Days)
United Ticketing Locations
Apollo travel agency

2. In the Options list, highlight a ticketing option to see a description of that option.
3. To see information about United ticketing offices in your area, choose the Offices button.  

See Finding United ticketing locations for more information.
4. Select the desired ticketing option and choose the Next> button.

The Payment Method and Delivery Address dialog box appears.    See Selecting a credit 
card for information about using this dialog box.

See also
Ticketing options 
Ticketing Options dialog box 



Electronic Ticket
Electronic ticketing eliminates paper tickets by storing your ticket electronically in United 
Airlines' reservation system.    If you choose this option, you will be required to pay for your
ticket online with a credit card and your airfare will be guaranteed once your reservation is
confirmed.    United Connection  displays the electronic ticket receipt information after the
transaction has completed successfully.    You can also print a copy of this receipt for your 
records.    See Electronic ticketing for more information.
Important    If you purchase electronic tickets, each traveler will be required to show photo ID at check-in.    Also, 
the credit card used to purchase the electronic ticket MUST be presented by the cardholder at check-in.



First Class Mail Delivery
Choose this option to have your ticket delivered via first class mail within seven days.    You
will be required to pay for your ticket online with a credit card, and your airfare will be 
guaranteed once your reservation is confirmed.    This option is available if the departure 
date of the first flight in your itinerary is at least ten days from the current date.    First 
class mail delivery is available for U.S. addresses only.    Your ticket will be delivered to the 
billing address of the credit card used for payment.
Note    United Connection  assumes no responsibility for tickets that may be lost or stolen when shipping via First 
Class Mail with the U.S. Postal Service.    If tickets are lost or stolen in the mail, the traveler will be responsible for 
filing a lost ticket application with the appropriate airline.



Express Delivery (2 to 3 Business Days)
Choose this option to have your ticket arrive by express delivery (for example, Federal 
Express), normally within two to three business days.    You will be required to pay for your 
ticket online with a credit card, and your airfare will be guaranteed once your reservation 
is confirmed.    This option is available if the departure date of the first flight in your 
itinerary is at least three days from the current date.    Express delivery is available for U.S.
addresses only, excluding Hawaii and Puerto Rico.    Your ticket will be delivered to the 
billing address of the credit card used for payment.    A signature will be required at time of
delivery.



United Ticketing Locations
If you choose this option, you will need to go a United Airlines city ticket office or airport 
ticket office to purchase your ticket.    Note that your airfare is not guaranteed, and your 
reservation will be canceled unless you purchase your ticket before the ticketing deadline. 
This ticketing option is always available.    To find ticket office locations in your area, 
choose the Offices button.    See Finding United ticketing locations for more information.



Apollo travel agency
This option only appears if you have specified the travel agency code for your preferred 
Apollo travel agency in the System Options dialog box.    If you choose this option, you will 
need to purchase your ticket through the specified Apollo travel agency.    Note that your 
airfare is not guaranteed, and your reservation will be canceled unless you purchase your 
ticket before the ticketing deadline.    After you reserve your itinerary, it will be available 
for viewing only.    If you want to change or cancel the itinerary you will need to contact the
travel agency directly.



    Ticketing options
United Connection  provides up to five ticketing options, depending on your itinerary and 
the information you provided.    Each of these ticketing options is described below.
Important    If you choose an option that does not require you to pay for your ticket online with a credit card, your 
airfare is not guaranteed and your reservation will be canceled if the ticket is not purchased by the specified ticketing 
deadline.

Ticketing options

Electronic Ticket
Electronic ticketing eliminates paper tickets by storing your ticket electronically in United 
Airlines' reservation system.    If you choose this option, you will be required to pay for your
ticket online with a credit card and your airfare will be guaranteed once your reservation is
confirmed.    United Connection displays the electronic ticket receipt information after the 
transaction has completed successfully.    You can also print a copy of this receipt for your 
records.    See Electronic ticketing for more information.
Important    If you purchase electronic tickets, each traveler will be required to show photo ID at check-in.    Also, 
the credit card used to purchase the electronic ticket MUST be presented by the cardholder at check-in.

First Class Mail Delivery
Choose this option to have your ticket delivered via first class mail within seven days.    You
will be required to pay for your ticket online with a credit card, and your airfare will be 
guaranteed once your reservation is confirmed.    This option is available if the departure 
date of the first flight in your itinerary is at least ten days from the current date.    First 
class mail delivery is available for U.S. addresses only.    Your ticket will be delivered to the 
billing address of the credit card used for payment.
Note    United Connection assumes no responsibility for tickets that may be lost or stolen when shipping via First 
Class Mail with the U.S. Postal Service.    If tickets are lost or stolen in the mail, the traveler will be responsible for 
filing a lost ticket application with the appropriate airline.

Express Delivery (2 to 3 Business Days)
Choose this option to have your ticket arrive by express delivery (for example, Federal 
Express), normally within two to three business days.    You will be required to pay for your 
ticket online with a credit card, and your airfare will be guaranteed once your reservation 
is confirmed.    This option is available if the departure date of the first flight in your 
itinerary is at least three days from the current date.    Express delivery is available for U.S.
addresses only, excluding Hawaii and Puerto Rico.    Your ticket will be delivered to the 
billing address of the credit card used for payment.    A signature will be required at time of
delivery.

United Ticketing Locations
If you choose this option, you will need to go a United Airlines city ticket office or airport 
ticket office to purchase your ticket.    Note that your airfare is not guaranteed, and your 
reservation will be canceled unless you purchase your ticket before the ticketing deadline.  
This ticketing option is always available.    To find ticket office locations in your area, 
choose the Offices button.    See Finding United ticketing locations for more information.

Your preferred Apollo travel agency
This option only appears if you have specified the travel agency code for your preferred 



Apollo travel agency in the System Options dialog box.    If you choose this option, you will 
need to purchase your ticket through the specified Apollo travel agency.    Note that your 
airfare is not guaranteed, and your reservation will be canceled unless you purchase your 
ticket before the ticketing deadline.    After you reserve your itinerary, it will be available 
for viewing only.    If you want to change or cancel the itinerary you will need to contact the
travel agency directly.

See also
Selecting a ticketing option 
Ticketing Options dialog box 



    Finding United ticketing locations
If you choose the United Ticketing Locations option, you need to go a United Airlines city 
ticket office or airport ticket office to purchase your ticket.    You can get information about 
nearby locations simply by entering your zip code.

To find a United ticketing location:
1. In the Ticketing Options dialog box, choose the Offices button.    The United Ticketing 

Offices dialog box appears.
2. In the Zip Code field, type the zip code in which you want to find ticketing offices.
3. Choose the Find button.    United Connection  displays the names and addresses of all 

available ticketing offices located in or near the zip code you entered.
4. To see details for a particular ticketing office (for example, office hours), highlight that 

office.    Additional information about the ticketing office appears in the Details area.
5. Choose Close to return to the Ticketing Options dialog box.

See also
Ticketing options 
United Ticketing Offices dialog box 
Ticketing Options dialog box 



    Selecting a credit card
You must select a credit card each time you reserve an itinerary (even if you are not paying 
for your ticket online).    United Connection  uses the billing address of the selected credit 
card as a contact address.    If you chose a ticketing option that requires you to pay for your 
ticket online, your airfare will be charged to the selected credit card.    Tickets delivered by 
First Class Mail or Express Delivery will be sent to the billing address associated with that 
card.
You select a credit card in the Payment Method And Delivery Address dialog box, which 
appears automatically after you select a ticketing option.

To select a credit card:
1. In the Payment Method and Delivery Address dialog box, select the person who will be 

paying for the ticket.    (If you are not paying for your ticket now, select the individual you
want to designate as the contact person.)    The credit cards entered for that person in 
the Traveler Editor are displayed.
Note    The person you select does not have to be included in the itinerary.

2. Highlight the credit card you want to select:
· If you chose a ticketing option that requires you to pay for your ticket online, your 

airfare will be charged to this credit card.    These options are Electronic Ticket, First 
Class Mail Delivery, and Express Delivery.

· If you chose a ticketing option that does not require you to pay for your ticket online, 
this credit card will NOT be charged.    These options are United Ticketing Locations 
and Preferred Apollo Travel Agency.

3. If your itinerary includes hotel reservations that require a deposit or guarantee, select 
the Guarantee Hotel tab and choose a credit card to guarantee your hotel 
accommodations.    See Guaranteeing hotel rooms for more information.

4. To continue, choose the Next> button.
The Confirm Reservation dialog box appears.    See Confirming your reservation for more 
information about this dialog box.

See also
Payment Method And Delivery Address dialog box 
Ticketing options 



    Guaranteeing hotel rooms
You must select a credit card to guarantee your hotel room if:
· The hotel requires a deposit.
· The hotel requires a credit card to guarantee your room.
· You selected the Guarantee Room For Late Arrival option for one or more hotels.
If a credit card is required by one or more hotels in your itinerary, the Guarantee Hotel tab 
appears automatically in the Payment Method and Delivery Address dialog box.    Note that if
your itinerary includes more than one hotel requiring a guarantee, the same credit card 
must be used to guarantee all hotels.

To guarantee your hotel room:
1. In the Payment Method and Delivery Address dialog box, select the Guarantee Hotel tab.
2. In the Choose A Credit Card From This Traveler field, select the person whose credit card 

you want to use to guarantee your hotel room.    The credit cards entered for that person 
in the Traveler Editor are displayed.
Note    The person you select does not have to be included in the itinerary.

3. Highlight the credit card you want to select and choose the Next> button.
The Confirm Reservation dialog box appears.    See Confirming your reservation for more 
information about this dialog box.

See also
Payment Method And Delivery Address dialog box 
Guarantee Hotel tab 



    Confirming your reservation
After selecting a ticketing option and providing a credit card, you're ready to finalize your 
reservation and forward it to the reservation system.    You complete the reservation process 
in the Confirm Reservation dialog box, which appears automatically after you select a credit 
card in the Payment Method and Delivery Address dialog box.

To confirm your reservation:
1. In the descriptive name field, type a name for your itinerary.    You may use up to 15 

characters.    Spaces are permitted.
Note    This is only a descriptive name, not a file name.    You must also save your itinerary by choosing Save (or 
Save As) from the File menu and entering a file name.

2. Carefully review the reservation summary information.    You may need to scroll down to 
review the entire summary.

3. To finalize your reservation, choose the Finish button.    United Connection  
immediately sends your itinerary to the reservation system.

Note    Airlines do not release their inventory until you confirm your reservation.    Therefore, it is possible that
the flights and/or fare that you selected will no longer be available.    If this occurs, United Connection displays a 
message informing you of your options.

4. When the reservation system has finished processing your itinerary, a Confirmation 
dialog box displays a message indicating how you will receive your ticket.    You are also 
informed if the reservation system was unable to confirm any part of your itinerary.

5. To return to the Itinerary Window, choose Done.    United Connection updates the 
Itinerary Window as follows:
· The Notices area displays the itinerary name and confirmation number.    If you have 

not paid for your ticket, the ticketing deadline is also displayed.
· The Totals area displays the total airfare, estimated total hotel cost, and Mileage Plus

 miles.    Note that the estimated rental car cost is not displayed (this information is 
not returned by the reservation system).

· If you paid for your ticket online, the status of all flights is Ticketed.
· If you did not pay for your ticket, the status of all flights is Reserved.
· The status of all rental car and hotel items is Reserved.

6. Save your itinerary by choosing Save from the File menu.    If you have not saved your 
itinerary before now, you will need to enter a file name.    See Saving an itinerary for 
more information.

7. To print a trip report of your itinerary, choose Print from the File menu.    See Printing an 
itinerary for more information.

See also
Confirm Reservation dialog box 



    Pricing Summary dialog box
You access the Pricing Summary dialog box to review your itinerary in detail before sending 
it to the reservation system.    This dialog box can include up to four tabs, depending upon 
the items you included in your itinerary.    Select one of the 

Tab Options below to see more information about that tab.

How to display the Pricing Summary dialog box

Dialog Box Options
Select this tab To review the following information

Fares/Rules tab Traveler names and types, airfare by traveler, total 
airfare, fare rules

Flight tab Summary of the selected flights.    If you wish, you can 
change the Acceptable Fare Restrictions to see if a 
lower fare is available. This tab only appears if you 
have selected one or more flights.

Car tab Summary of the selected rental cars and an estimated 
rental car total (if available).    This tab only appears if 
you have selected one or more rental cars.

Hotel tab Summary of the selected hotels and an estimated hotel
total (if available).    This tab only appears if you have 
selected one or more hotel rooms.

Reserve button
When you are satisfied with the information displayed in the Pricing Summary dialog box, 
choose the Reserve button to continue.    The Ticketing Options dialog box appears.

See also
Reserving your itinerary 
Changing Acceptable Fare Restrictions 



To display the Pricing Summary dialog box:
· In the Itinerary Window, choose the Reserve icon from the toolbar.



    Fares/Rules tab
(Pricing Summary dialog box)

The Fares/Rules tab displays the names of all travelers in your itinerary, the airfare for those 
travelers, and the rules and restrictions associated with that airfare.    You may need to scroll 
down to review all of the information.

 How to display the Fares/Rules tab

Tab Options

Travelers
Displays the name of each traveler in your itinerary, their Traveler Type (Adult, Senior, or 
Child), and the airfare for that traveler.

Fare Total
Displays the total airfare for all travelers in your itinerary, as well as the ticketing deadline. 
This is the date by which you must purchase your ticket in order to qualify for the 
displayed airfare.

Fare Rules
Displays all rules, restrictions, and penalties associated with the quoted airfare.    For 
example, to receive a particular fare a Saturday stay might be required.

Reserve button
When you are satisfied with the information displayed in the Pricing Summary dialog box 
tabs, choose the Reserve button to continue. The Ticketing Options dialog box appears.

See also
Reserving your itinerary 
Pricing Summary dialog box 



To display the Fare/Rules tab:
· In the Itinerary Window, choose the Reserve icon from the toolbar.    The Fares/Rules 

tab of the Pricing Summary dialog box appears.



    Flight tab
(Pricing Summary dialog box)

The Flight tab of the Pricing Summary dialog box displays information about the flights 
selected for this itinerary.    You may need to scroll down to see all of the information.    If you 
wish, you can change the Acceptable Fare Restrictions and re-price your itinerary to see if a 
lower fare is available.

How to display the Flight tab

Tab Options

Date/Time
Displays the airline, flight number, departure date and time, and arrival date and time for 
each flight.

Location
Displays the departure and arrival airports and city locations for each flight.    If the flight is
operated by another carrier, that airline's name is also shown.

Details
Displays the service class you selected (First, Business, or Coach/Economy), and the 
number of stops for each flight.

Flight Total
Displays the total airfare for all travelers in the itinerary.

Restrictions button
If you want to change the fare restrictions associated with your itinerary (to see if a lower 
fare is available), choose the Restrictions button.    The Flight Preferences dialog box 
appears.    See Changing Acceptable Fare Restrictions for more information.

Reserve button
When you are satisfied with the information displayed in the Pricing Summary dialog box 
tabs, choose the Reserve button to continue. The Ticketing Options dialog box appears.

See also
Reserving your itinerary 
Pricing Summary dialog box 



To display the Flight tab:
· In the Itinerary Window, choose the Reserve icon from the toolbar.    The Pricing 

Summary dialog box appears.    Select the Flight tab.



    Car tab
(Pricing Summary dialog box)

The Car tab of the Pricing Summary dialog box displays information about all rental cars 
selected for this itinerary.    An estimated total appears at the bottom of the tab.

How to display the Car tab

Tab Options

Date/Time
Displays the rental car company, pick-up date and time, and drop-off date and time for 
each rental car.

Location
Displays the pick-up and drop-off locations for each rental car.

Details
Displays the car type, rate type, rate, and mileage information.

Estimated Car Total
Displays the estimated total cost of all rental cars included in this itinerary.
Note    If you selected the Discount Program option for any rental car, United Connection  will not be able to 
display an estimated total (program rate information is not available).

Reserve button
When you are satisfied with the information displayed in the Pricing Summary dialog box 
tabs, choose the Reserve button to continue. The Ticketing Options dialog box appears.

See also
Reserving your itinerary 
Pricing Summary dialog box 



To display the Car tab:
· In the Itinerary Window, choose the Reserve icon from the toolbar.    The Pricing 

Summary dialog box appears.    Select the Car tab.



    Hotel tab
(Pricing Summary dialog box)

The Hotel tab of the Pricing Summary dialog box displays information about all hotel rooms 
selected for this itinerary.    An estimated total appears at the bottom of the tab.

How to display the Hotel tab

Tab Options

Date/Time
Displays the hotel chain, check-in date and time, and check-out date and time for each 
hotel.

Location
Displays the location of each hotel.

Details
Displays the room type, rate category, late arrival guarantee request, room occupancy 
(single or double), and rate.

Estimated Hotel Total
Displays the estimated total cost of all hotel rooms included in this itinerary.
Note    If you selected the Discount Program option for any hotel room, United Connection  will not be able to 
display a estimated total (program rate information is not available).

Reserve button
When you are satisfied with the information displayed in the Pricing Summary dialog box 
tabs, choose the Reserve button to continue.    The Ticketing Options dialog box appears.

See also
Reserving your itinerary 
Pricing Summary dialog box 



To display the Hotel tab:
· In the Itinerary Window, choose the Reserve icon from the toolbar.    The Pricing 

Summary dialog box appears.    Select the Hotel tab.



    Ticketing Options dialog box
You use the Ticketing Options dialog box to indicate how you want to receive your ticket.    
Choose Electronic Ticket to create an electronic ticket that is stored in United Airlines' 
reservation system.    You can also have your ticket delivered, or arrange to pick it up at a 
United ticketing office or an Apollo travel agency.    Depending on the option you choose, you
may be required to pay for your ticket online with a credit card.
Note    If you do not pay for your ticket online, your airfare is not guaranteed and your reservation will be canceled if 
the ticket is not purchased by a specified ticketing deadline.

How to display the Ticketing Options dialog box

Dialog Box Options

Options
United Connection  provides up to five ticketing options, depending on your itinerary and 
the information you provided.    These options are:
Electronic Ticket
First Class Mail Delivery
Express Delivery (2 to 3 Business Days)
United Ticketing Locations
Apollo travel agency

Description
Displays information about the highlighted ticketing option.    For example, whether the 
fare is guaranteed, or any delivery restrictions.

Next> button
After selecting a ticketing option, choose this button to continue.    The Payment Method 
And Delivery Address dialog box appears.

<Previous button
Choose this button to go back to the Pricing Summary dialog box.

Offices button
Choose this button to find United ticket offices in your area.    The United Ticketing Offices 
dialog box appears.

Cancel button
Choose this button to exit the booking process and return to the Itinerary Window.

See also
Selecting a ticketing option 
Payment Method And Delivery Address dialog box 
Pricing Summary dialog box 



To display the Ticketing Options dialog box:
· In the Pricing Summary dialog box, choose the Reserve button.



    United Ticketing Offices dialog box
You access the United Ticketing Offices dialog box to find United ticketing locations in your 
area.    Simply enter a zip code to see a list of ticket offices in that vicinity.

How to display the United Ticketing Offices dialog box

Dialog Box Options

Zip Code
Enter the zip code in which you want to find ticketing offices.

Find button
After entering a zip code, choose this button to search for United ticketing offices.

Office
Displays the names and addresses of all available United ticketing offices in or near the zip
code you entered.

Details
Displays additional information about the highlighted ticketing office (for example, office 
hours).

See also
Finding United ticketing locations 
Selecting a ticketing option 
Ticketing Options dialog box 



To display the United Ticketing Offices dialog box:
· In the Ticketing Options dialog box, choose the Offices button.
· From the Tools menu, choose United Ticketing Offices.



    Payment Method And Delivery Address dialog box
You must select a credit card each time you reserve an itinerary (even if you are not paying 
for your ticket online).    United Connection  uses the billing address of the selected credit 
card as a contact address.    If you chose a ticketing option that requires you to pay for your 
ticket online, your airfare will also be charged to the selected credit card and your ticket (or 
receipt) will be mailed to the billing address associated with that card.
· If you chose Electronic Ticket, First Class Mail Delivery, or Express Delivery, your airfare 

will be charged to the credit card you select.
· If you chose United Ticketing Locations or your preferred Apollo travel agency, the 

selected credit card will NOT be charged.
Note    If your itinerary includes one or more hotels that require a credit card to guarantee the room, you must 
also select a credit card on the Guarantee Hotel tab.

How to display the Payment Method And Delivery Address dialog box

Dialog Box Options

Choose a credit card from this traveler
Select the person who will be paying for the ticket.    If you are not paying for your ticket 
now, select the individual you want to designate as the contact person.    The person you 
select does not have to be included in the itinerary.

Credit Card
Displays the name and expiration date of each credit card entered for the selected 
individual in the Traveler Editor.    Select the credit card you want to use.

Billing/Delivery Address
Displays the credit card billing address. United Connection uses the billing address of the 
selected card as a contact address.    If you select either First Class Mail Delivery or Express
Delivery as your ticketing option, your ticket will be delivered to this address.

Next> button
After selecting a credit card, choose this button to continue.    The Confirm Reservation 
dialog box appears.

<Previous button
Choose this button to go back to the Ticketing Options dialog box.

Cancel button
Choose this button to exit the booking process and return to the Itinerary Window.

See also
Selecting a credit card 
Guarantee Hotel tab 
Ticketing Options dialog box 



To display the Payment Method And Delivery Address dialog box:
· In the Ticketing Options dialog box, choose the Next> button.    The Flight tab of the 

Payment Method And Delivery Address dialog box appears.



    Flight tab
(Payment Method And Delivery Address dialog box)

When you reserve an itinerary, you must select a credit card to guarantee your airfare.    Your
airfare will be charged to the selected credit card and your ticket (or receipt) will be mailed 
to the billing address associated with that card.
Note    If your itinerary includes one or more hotels that require a credit card to guarantee the room, you must also 
select a credit card on the Guarantee Hotel tab.

How to display the Flight tab

Tab Options

Choose a credit card from this traveler
Select the person who will be paying for the ticket.    The person you select does not have 
to be included in the itinerary.

Credit Card
Displays the name and expiration date of each credit card entered for the selected 
individual in the Traveler Editor.    Select the credit card you want to use.

Billing/Delivery Address
Displays the credit card billing address.    Your ticket will be delivered to this address.

Next> button
After selecting a credit card, choose this button to continue.    The Confirm Reservation 
dialog box appears.

<Previous button
Choose this button to go back to the Ticketing Options dialog box.

See also
Selecting a credit card 
Guarantee Hotel tab 
Ticketing Options dialog box 



To display the Flight tab:
· In the Ticketing Options dialog box, choose Electronic Ticket, First Class Mail Delivery, 

or Express Delivery, then choose the Next> button.    The Flight tab of the Payment 
Method And Delivery Address dialog box appears.



    Address tab
(Payment Method And Delivery Address dialog box)

You must select a credit card each time you reserve an itinerary (even if you are not paying 
for your ticket online).    United Connection  uses the billing address of the selected credit 
card as a contact address.
Note    If your itinerary includes one or more hotels that require a credit card to guarantee the room, you must also 
select a credit card on the Guarantee Hotel tab.

How to display the Address tab

Dialog Box Options

Choose a credit card from this traveler
Select the individual you want to designate as the contact person.    The person you select 
does not have to be included in the itinerary.

Credit Card
Displays the name and expiration date of each credit card entered for the selected 
individual in the Traveler Editor.    Select the credit card you want to use.

Billing/Delivery Address
Displays the credit card billing address. United Connection uses the billing address of the 
selected card as a contact address.

Next> button
After selecting a credit card, choose this button to continue.    The Confirm Reservation 
dialog box appears.

<Previous button
Choose this button to go back to the Ticketing Options dialog box.

See also
Selecting a credit card 
Guarantee Hotel tab 
Ticketing Options dialog box 



To display the Address tab:
· In the Ticketing Options dialog box, choose United Ticketing Locations or your preferred

Apollo travel agency, then choose the Next> button.    The Address tab of the Payment 
Method And Delivery Address dialog box appears.



    Guarantee Hotel tab
(Payment Method And Delivery Address dialog box)

The Guarantee Hotel tab appears in the Payment Method and Delivery Address dialog box if 
a credit card is required by one or more hotels in your itinerary, or if you selected the 
Guarantee Room For Late Arrival option.    Select a credit card to guarantee your hotel 
reservations.
Note    If your itinerary includes more than one hotel requiring a guarantee, the same credit card must be used to 
guarantee all hotels.

How to display the Guarantee Hotel tab

Tab Options

Choose a credit card from this traveler
Select the person whose credit card you want to use to guarantee your hotel room.    The 
person you select does not have to be included in the itinerary.

Credit Card
Displays the name and expiration date of each credit card entered for the selected 
individual in the Traveler Editor.    Select the credit card you want to use to guarantee your 
hotel room.

Billing Address
Displays the credit card billing address.

Next> button
After selecting credit cards in both the Flight and the Guarantee Hotel tabs, choose this 
button to continue.    The Confirm Reservation dialog box appears.

<Previous button
Choose this button to go back to the Ticketing Options dialog box.

See also
Guaranteeing hotel rooms 
Payment Method And Delivery Address dialog box 
Ticketing Options dialog box 



To display the Guarantee Hotel tab:
1. In the Ticketing Options dialog box, choose the Next> button.    The Payment Method 

And Delivery Address dialog box appears.
2. Select the Guarantee Hotel tab.



    Confirm Reservation dialog box
You finalize your itinerary in the Confirm Reservation dialog box.    When you choose Finish, 
United Connection  immediately forwards your itinerary to the reservation system.
When the reservation system has finished processing your itinerary, a Confirmation dialog 
box displays a message indicating how you will receive your ticket.    You are also informed if 
the reservation system was unable to confirm any part of your itinerary.
Note    Airlines do not release their inventory until you confirm your reservation.    Therefore, it is possible that the 
flights and/or fare that you selected will no longer be available.    If this occurs, United Connection displays a message
informing you of your options.

How to display the Confirm Reservation dialog box

Dialog Box Options

Descriptive name for this itinerary
Type a name for your itinerary.    You may use up to 15 characters.    Spaces are permitted.
Note    This is a descriptive name, not a file name.    You must also save your itinerary by choosing Save (or Save 
As) from the File menu and entering a file name.

Itinerary information
Displays a summary of your itinerary, including the ticketing option, airfare, selected credit
card and billing/delivery address, and ticketing deadline (if you are not paying for your 
ticket online).    You may need to scroll down to review the entire summary.

Finish button
Choose this button to send your itinerary to the reservation system.

<Previous button
Choose this button to go back to the Payment Method And Delivery Address dialog box.

Cancel button
Choose this button to exit the booking process and return to the Itinerary Window.

See also
Confirming your reservation 



To display the Confirm Reservation dialog box:
· In the Payment Method And Delivery Address dialog box, choose the Next> button.



    Electronic ticketing
When you choose Electronic Ticket as your ticketing option and complete your reservation, 
United Connection  sends your electronic ticket request to the reservation system.    If the 
request is successful, United Connection displays a dialog containing your electronic ticket 
receipt information.    This information includes:
· The reservation number and name
· The name of each traveler and their ticket number
· The price of each ticket (including detailed fare basis information)
· The Mileage Plus  number of each traveler (if available)
· The date the ticket was issued
· The credit card used to purchase the ticket(s)
· Passenger notices
You can view or print your electronic ticket receipt information at any time by selecting 
Electronic Ticket Information from the View menu.
Note    United's Electronic Ticket option is not available for all flights.    See Electronic Ticket rules for details.

Important    If you purchase electronic tickets, each traveler will be required to show photo ID at check-in.    Also, the 
credit card used to purchase the electronic ticket MUST be presented by the cardholder at check-in.

Credit card validation
Before issuing an electronic ticket request, United Connection  validates your credit card 
information.    If a problem is detected during validation (for example, an invalid address), 
United Connection gives you the option of changing your credit card information or choosing
a different credit card.    See Credit card validation problems for more information.

Saving your receipt information
Electronic ticket receipt information is saved along with your itinerary when you choose Save
or Save As from the file menu.    We recommend that you save your itinerary before exiting 
United Connection.

Retrieving updated receipt information
When you select Electronic Ticket Information from the View menu, United Connection 
automatically retrieves the current receipt information from the reservation system and 
displays this information in the dialog box.    The reservation system stores your electronic 
ticket receipt information until three days after travel is complete.    After that, United 
Connection will display the electronic ticket receipt information from your saved itinerary.

Ticket exchanges and refunds
United Airlines’ standard cancellation, refund, and exchange policies apply to electronic 
tickets purchased through United Connection .    Changes to a ticketed itinerary that results 
in a fare difference and/or a service charge will require you to contact United Airlines 
Reservations or a United Airlines city or airport ticket office to exchange the ticket.

See also
Electronic Ticket Information dialog box 
Ticketing options 



Confirming your reservation 



Electronic Ticket rules
· All flights must be on United or United Express
· All flights must be within the U.S. and/or San Juan
· The itinerary can include a maximum of 4 segments
Other restrictions may also apply in certain markets.



    Electronic Ticket Information dialog box
The Electronic Ticket Information dialog box displays information about your electronic 
ticket(s), and allows you to print an electronic ticket receipt or a copy of the passenger 
notices.
Important    If you purchase electronic tickets, each traveler will be required to show photo ID at check-in.    Also, the 
credit card used to purchase the electronic ticket MUST be presented by the cardholder at check-in.

How to display the Electronic Ticket Information dialog box

Dialog Box Options

Reservation number
Displays six-character confirmation number for this itinerary.

Reservation name
Displays the name you entered for this itinerary in the Confirm Reservation dialog box.

Party of ( )
Indicates the number of travelers in this itinerary.    The name of each traveler appears 
below this heading.

Ticket number
Displays the ticket number for each traveler.

Base
Displays the base fare for each traveler (detailed fare basis information is provided below).

Taxes
Displays all applicable taxes for each traveler.    These can include U.S. tax, transportation 
fees, and facility taxes.

Total
Displays the total fare for each traveler (base + tax).

Mileage Plus  number
Displays the traveler’s Mileage Plus account number (if available).

Ticket issued
Displays the date on which the electronic ticket was issued.

Credit card number
Displays the credit card number used to purchase the electronic ticket.

Fare details
Displays the fare basis information.    This includes:
· Fare basis code
· Departure date of the first flight
· Origin, carrier, and destination codes
· Fare for each segment
· Total fare



· Departure tax (if applicable)
If the same fare applies to all travelers, the fare basis information is displayed once.    If 
any fare is different, the fare details are displayed for each traveler.

United Airlines Passenger Notices
Displays the text of the United Airlines passenger notices.    Scroll down to read the full 
text.    To print the notices, click the Print Notices button.

Print Receipt button
Choose this button to print your electronic ticket receipt.

Print Notices button
Choose this button to print the passenger notices.

See also
Electronic ticketing 



To display the Electronic Ticket Information dialog box:
If you chose Electronic Ticket as your ticketing option, the Electronic Ticket Information 
dialog box appears automatically after you click the Finish button in the Confirm 
Reservation dialog box.
To display the Electronic Ticket Information dialog box at a later time, choose Electronic 
Ticket Information from the View menu.
 



    Entering traveler information

Adding a traveler 

Personal information 

Payment credit card information 

Travel program information 

Discount program information 



    Changing traveler information

Personal information
Changing a traveler's name, address, or phone numbers 
Changing a traveler's home airport 

Credit card information
Changing credit card information 

Changing the expiration date 

Deleting a payment credit card 

Travel program information
Changing travel program information

Deleting a travel program 

Discount program information
Changing discount program information 

Deleting a discount program



    Entering profile information

Adding a profile 

Flight preferences 

Flight service requests

Rental car preferences

Rental car service requests

Hotel preferences

Hotel service requests



    Changing profile information

Changing flight preferences and services

Changing rental car preferences and services

Changing hotel preferences and services



    Changing flight preferences and services

Flight preferences
Changing the Preferred Airlines option

Changing the Preferred Service Class option 

Changing the Acceptable Fare Restrictions option

Flight services
Changing the Preferred Seating option

Changing the Preferred Meal option

Changing the Special Services option



    Changing rental car preferences and services

Rental car preferences
Changing the Preferred Rental Companies option

Changing the Preferred Car Types option

Changing the Acceptable Rate Range option

Changing the Unlimited Mileage option

Changing the In Terminal Facilities option

Rental car services
Changing the Infant or Toddler Car Seat options

Changing the Car Equipped for Physically Challenged Driver option

Changing the Mobile Phone Requested option

Changing the Ski-Equipped Car option

Changing the Associated Frequent Flyer Program option



    Changing hotel preferences and services

Hotel preferences

Changing the Preferred Hotel Chains option

Changing the Preferred Occupancy option 

Changing the Preferred Amenities option

Changing the Preferred Rate Category option

Changing the Acceptable Rate Range option

Changing the Which Is Most Important To You? option 

Hotel services
Changing the Guarantee Room For Late Arrival option

Changing the Additional Adults/Children In Room option

Changing the Roll-Away Beds/Cribs Required option

Changing the Associated Frequent Flyer Program option



Overview: Entering traveler and profile information

You need to provide two types of information for each traveler you want to include in a 
United Connection  itinerary: Traveler Information and Profile Information.    You enter this 
information in the Traveler Editor dialog box.
    Traveler information includes:

· Personal information
· Payment credit card information
· Travel program information
· Discount program information

You enter Traveler Information once for each traveler.    See Adding a traveler for details.    
After entering traveler information, you need to create one or more profiles for that traveler.
    Profile information includes:

· Flight preferences
· Flight service requests
· Rental car preferences
· Rental car service requests
· Hotel preferences
· Hotel service requests

You must create at least one profile for each traveler.    You can also create multiple profiles 
for each traveler, for example a Business Trip profile, a Family Vacation profile, etc.    By 
choosing different preferences and service requests for different trip types, you can 
streamline the travel planning process with a minimum of effort.    See Adding a profile for 
more information.
Note    If you do not create a profile for a traveler, United Connection will supply the traveler with a default profile 
automatically.    You can edit or rename this profile using the Traveler Editor.

How does United Connection use this information?
To add a traveler to an itinerary, you select one of that traveler's profiles.    You also specify 
one traveler as the primary traveler.    United Connection uses the primary traveler's 
preferences and service requests to customize the itinerary.

Can I change this information?
You can change traveler information and profile information using the Traveler Editor  just 
highlight the traveler or profile name in the Traveler Editor dialog box and choose the Edit 
button.
United Connection also lets you change the primary traveler's preferences on the fly, as you 
select flights, rental cars, and hotel rooms for your itinerary.    You can save these changes in 
the primary traveler's profile, or use them for the current itinerary only.

See also
Using the Traveler Editor 



Traveler Editor dialog box 
Traveler Information dialog box 
Trip Profiles dialog box 



Personal information includes:
· Traveler's name
· Traveler's business phone and/or home phone
· Traveler type
· Traveler's home airport



Payment credit card information includes:
· Credit card name
· Credit card type
· Account number
· Expiration date
· Series number (American Express/Optima only) 
· Billing address

Note    Enter credit card information for at least one person in the Traveler Editor. A credit card is required to 
reserve an itinerary, even if you are not purchasing your tickets online.



Travel program information includes:
· Name of travel program (for example, Mileage Plus)
· Account number
· Sponsor type (Airline, Rental Agency, Hotel Chain) 
· Company name

Note    If the traveler is a Mileage Plus  member, be sure to enter their Mileage Plus account number in the 
Travel Programs tab.



Discount program information includes:
· Name of discount program
· Account number
· Sponsor type (Rental Agency or Hotel Chain) 
· Company name



Flight preferences include:
· Preferred Airlines (United Airlines plus two additional)
· Preferred Service Class (First, Business, Coach/Economy, or Any) 
· Acceptable Fare Restrictions (Minimum Stay Required, Maximum Stay Required, 

Advance Purchase Required) 



Flight service requests include:
· Preferred Seating (for example, Aisle)
· Preferred Meal (for example, Low Sodium) 
· Special Services (for example, Wheelchair) 



Rental car preferences include:
· Preferred Rental Companies (up to three)
· Preferred Car Types (up to three) 
· Acceptable Rate Range
· In-Terminal Facilities
· Unlimited Mileage



Rental car service requests include:
· Infant Car Seat
· Toddler Car Seat
· Car Equipped for Physically Challenged Driver (Left-Hand Controls or Right-Hand 

Controls) 
· Mobile Phone Requested
· Ski-Equipped Car (ski rack, snow tires, etc.) 
· Associated Frequent Flyer Program



Hotel preferences include:
· Preferred Hotel Chains (up to three)
· Preferred Occupancy
· Preferred Amenities (up to eight) 
· Preferred Rate Category (for example, Corporate) 
· Acceptable Rate Range
· Most Important Preference (Hotel Chain, Room Rates, or Amenities) 



Hotel service requests include:
· Guarantee Room For Late Arrival
· Additional Adults in Room
· Additional Children in Room
· Roll-Away Beds Required
· Cribs Required
· Associated Frequent Flyer Program



    Using the Traveler Editor
The Traveler Editor dialog box lets you create, edit, and delete both traveler information and 
profile information.    You must provide traveler information and create at least one profile for
each traveler you want to include in a United Connection  itinerary.

How to display the Traveler Editor dialog box
To Do this

Enter information for a 
new traveler

Choose the Add Traveler button

Change information for 
an existing traveler

Select a traveler and choose the Edit 
button

Delete a traveler Select the traveler you want to remove
and choose the Delete button

Create a new profile for
a traveler

Select a traveler and choose the Add     
Profile button

Change profile 
information

Select the profile you want to change 
and choose the Edit button

Delete a profile Select the profile you want to remove 
and choose the Delete button

See also
Overview 
Traveler Editor dialog box 



    Adding a traveler
You need to enter traveler information for each person you want to include in a United 
Connection  itinerary.    Traveler information includes traveler type and home airport, credit 
card information, travel program information, and discount program information.

To enter information for a new traveler:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Choose the Add Traveler button.    The Personal tab of the Traveler Information dialog box 

appears.
3. To enter traveler information, select the appropriate tab.    Information on the Personal 

tab is required and must be entered first  all other information is optional.
Select this tab To enter the following information

Personal Traveler name, phone number(s), traveler type, and 
home airport.

Payment Credit card type, account number, expiration date, 
and billing address for each credit card that will be 
used to pay for itinerary costs.
Note    Remember to enter credit card information 
for at least one person. A credit card is required to 
reserve an itinerary, even if you are not purchasing 
your tickets online.

Travel Programs Travel program name, account number, sponsor 
type, and sponsor name. If the traveler is a Mileage 
Plus  member, be sure to enter their Mileage Plus 
account number.

Discount Programs Discount program name, account number, sponsor 
type, and sponsor name.

4. When you have finished entering traveler information, choose OK.    The Traveler Editor 
dialog box appears. 
You can continue to add or edit traveler information, or you can return to the Itinerary 
Window by choosing Close.

See also
Overview 
Traveler Information dialog box 



    Entering personal information
Follow these steps to enter personal information for a traveler.    The traveler's name, phone 
number, and traveler type are required.    All other information is optional.

How to display the Personal tab

To enter personal information:
1. Display the Personal tab of the Traveler Information dialog box.
2. Complete the Personal information as follows:

In this field You can

Title Select a title (optional).

First Name and 
Last Name

Enter the traveler’s first name and last name.

Business and 
Home Phone

Enter the traveler’s business and/or home phone 
number.
At least one telephone number is required.    Be sure
to include the area code in front of the phone 
number, for example: (555) 123-4567.

Type Select Child, Adult, or Senior Citizen using the 
following age categories:

Age Range Type
0-11 years Child
12-64 years Adult
65 or more years Senior Citizen

Note    Children under 2 are automatically classified 
as infants.

Birthdate If you choose Child or Senior, a date field appears.   
Enter the traveler's birthdate using the format 
MM/DD/YYYY.    For example, 08/10/1922.

You can also choose the        icon and select the 
birthdate. 

Home Airport Enter or select the home airport for this traveler.    
This is the airport that he or she will be departing 
from most frequently.
If you don't know the airport name, you can click on 
the down arrow next to the Home Airport field to 
search by city, airport, or airport code.    See Using 
the Airport Search option for more information.

3. To continue, choose the Payment tab and enter the traveler's payment credit card 
information.

4. When you have finished entering traveler information, choose OK to return to the 
Traveler Editor dialog box.

See also
Personal tab 



Entering traveler information 
Adding a traveler 



To display the Personal tab:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Do one of the following:

· To enter personal information for a new traveler, choose the Add Traveler button.
· To update personal information for an existing traveler, select that traveler from the

list and choose the Edit button.
The Personal tab of the Traveler Information dialog box appears.



    Entering payment credit card information
Follow these steps to enter information for each credit card that the traveler might want to 
use to pay for airline tickets or reserve hotel rooms.

How to display the Payment tab

To enter payment credit card information:
1. Display the Payment tab of the Traveler Information dialog box.
2. Choose the Add button.    The Credit Card Information dialog box appears.
3. Complete the Credit Card Information fields as follows:

In this field You can

Card Name Enter a descriptive name for the credit card.    For 
example, Corporate American Express.

Type of Card Select the type of credit card you want to use.

Account Number Enter the credit card account number.    Do not enter
spaces or dashes between numbers. 
For your security, the number will not be displayed 
after credit card validation is complete.

Expiration Date Enter the credit card expiration date using the 
format MM/YY or MM/DD/YY.    For example, 12/99 
or 12/31/99.

Series Number If displayed, enter the four-digit credit card series 
number (also referred to as the CID, or Customer 
ID).    This field only appears if you selected the 
American Express/Optima card.

Company If the credit card billing statement is sent to the 
traveler’s company, enter the company name 
exactly as it appears on the statement.    Otherwise, 
leave this field blank.
Note    When completing this field, refer to the 
traveler’s credit card billing statement.

Address, City, 
State, and Zip

Enter the traveler's billing address exactly as it is 
shown on the credit card billing statement.
Note    This is the address to which the credit card 
company sends your billing statements.    Refer to 
the traveler’s credit card billing statement.

4. When you are finished entering credit card information, choose OK to return to the 
Payment tab.

5. To enter another payment credit card, repeat steps 2-4.
6. To continue, choose the Travel Programs tab and enter the traveler's travel program 

information.
7. When you have finished entering traveler information, choose OK to return to the 

Traveler Editor dialog box.



See also
Credit Card Information dialog box 
Payment tab 
Entering traveler information 



To display the Payment tab:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Select a traveler from the list and choose the Edit button.    The Traveler Information 

dialog box appears.
Note    To add a new traveler, choose the Add Traveler button.

3. Select the Payment tab.



    Entering travel program information
Follow these steps to enter information for each flight, rental car, and hotel travel program in
which this traveler is a member.
Note    You cannot apply for membership to new programs through United Connection  

 only enter travel programs in which the traveler is already a member.

How to display the Travel Programs tab

To enter travel program information:
1. Display the Travel Programs tab of the Traveler Information dialog box.
2. Choose the Add button.    The Frequent Traveler Program Information dialog box appears.
3. Complete the Frequent Traveler Program Information fields as follows:

In this field You can

Name Type the name of the travel program that you 
want to include for this traveler.    For example, 
Mileage Plus.

Account Type the traveler's account number or 
membership number.

Type Select the type of company that sponsors the 
travel program.    Options are Airline, Hotel Chain,
and Rental Agency.

Company Select the sponsor company name.    For 
example, United Airlines sponsors Mileage Plus
.

4. When you have finished entering travel program information, choose OK to return to the 
Travel Programs tab.

5. To enter another travel program, repeat steps 2-4.
6. To continue, choose the Discount Programs tab and enter the traveler's discount program

information.
7. When you have finished entering traveler information, choose OK to return to the 

Traveler Editor dialog box.

See also
Frequent Traveler Program Information dialog box 
Travel Programs tab 
Entering traveler information 



To display the Travel Programs tab:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Select a traveler from the list and choose the Edit button.    The Traveler Information 

dialog box appears.
Note    To add a new traveler, choose the Add Traveler button.

3. Select the Travel Programs tab.



    Entering discount program information
Follow these steps to enter information for each rental car and hotel discount program in 
which this traveler is a member.
Note    You are limited to one discount program per sponsor.

How to display the Discount Programs tab

To enter discount program information:
1. Display the Discount Programs tab of the Traveler Information dialog box.
2. Choose the Add button.    The Discount Program Information dialog box appears.
3. Complete the Discount Program Information fields as follows:

In this field You can

Name Type the name of the discount program that you
want to include for this traveler.    For example, 
"TownLine Bank Employee Discount."

Account Type the traveler’s account or membership 
number.

Type Select the type of company that sponsors the 
discount program.    Options are Hotel Chain 
and Rental Agency.

Company Select the company that sponsors the discount 
program.

4. When you have finished entering discount program information, choose OK to return to 
the Discount Programs tab.

5. To enter another discount program, repeat steps 2-4.
6. When you have finished entering traveler information, choose OK to return to the 

Traveler Editor dialog box.

See also
Discount Program Information dialog box 
Discount Programs tab 
Entering traveler information 



To display the Discount Programs tab:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Select a traveler from the list and choose the Edit button.    The Traveler Information 

dialog box appears.
Note    To add a new traveler, choose the Add Traveler button.

3. Select the Discount Programs tab.



    Changing a traveler's name, address, or phone number
If a traveler's name, address, work or business phone numbers change, follow these steps to
update that traveler's personal information.

To change a traveler's name, address, or phone number:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Select the traveler whose personal information you want to change, then choose the Edit

button.    The Traveler Information dialog box for that traveler appears.
3. In the Personal tab, change the appropriate fields.
4. To return to the Traveler Editor dialog box, choose OK.
5. To return to the Itinerary Window, choose Close.

See also
Personal tab 
Changing traveler information 



    Changing a traveler's home airport
If a traveler wants to specify a different home airport (the airport that he or she departs from
most frequently), follow these steps to update that traveler's personal information.

To change a traveler's home airport:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Select the traveler whose home airport you want to change, then choose the Edit button. 

The Traveler Information dialog box for that traveler appears.
3. In the Personal tab, enter or select a new home airport.

If you don't know the airport name, you can click on the down arrow next to the Home 
Airport field to search by city, airport, or airport code.    See Using the Airport Search 
option for more information.

4. To return to the Traveler Editor dialog box, choose OK.
5. To return to the Itinerary Window, choose Close.

See also
Personal tab 
Changing traveler information 



    Changing the credit card expiration date
When a traveler's credit card is reissued with a new expiration date, you must change the 
expiration date stored in the Traveler Editor before that credit card can be used to purchase 
airline tickets or reserve hotel rooms.

To change the expiration date for a payment credit card:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Select the traveler whose credit card expiration date you want to change, then choose 

the Edit button.    The Traveler Information dialog box for that traveler appears.
3. Select the Payment tab.
4. Select the credit card that you want to update and choose the Edit button.    The Credit 

Card Information dialog box appears.
5. In the Expiration Date field, type the new expiration date for that credit card using the 

format MM/YY or MM/DD/YY.    For example, 12/99 or 12/31/99.
6. Choose OK.    The Payment tab appears.
7. To return to the Traveler Editor dialog box, choose OK.
8. To return to the Itinerary Window, choose Close.

See also
Payment Credit Card Information dialog box 
Changing traveler information 



    Changing credit card information
You can modify information associated with a payment credit card, such as the card name or
billing address.

To modify payment credit card information:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Select the traveler whose credit card information you want to modify, then choose the 

Edit button.    The Traveler Information dialog box for that traveler appears.
3. Select the Payment tab.
4. Select the credit card that you want to modify and choose the Edit button.    The Credit 

Card Information dialog box appears.
5. Change the appropriate fields.    A description of each field is provided in the Payment 

Credit Card Information dialog box. 
6. When you are finished, choose OK.    The Payment tab appears.
7. To return to the Traveler Editor dialog box, choose OK.
8. To return to the Itinerary Window, choose Close.

See also
Payment tab 
Changing traveler information 



    Deleting a payment credit card
You can remove a traveler's payment credit card from the list of credit cards available to that
traveler.

To delete a traveler's payment credit card:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Select the traveler whose credit card you want to delete, then choose the Edit button.    

The Traveler Information dialog box for that traveler appears.
3. Select the Payment tab.
4. Select the credit card that you want to delete, then choose the Delete button.    The 

credit card is removed from the list.
5. To return to the Traveler Editor dialog box, choose OK.
6. To return to the Itinerary Window, choose Close.

See also
Payment tab 
Changing traveler information 



    Changing travel program information
Follow these steps to change travel program information.

To change travel program information:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Select the traveler whose travel program information you want to change, then choose 

the Edit button.    The Traveler Information dialog box for that traveler appears.
3. Select the Travel Programs tab.
4. Select the travel program that contains the information you want to change and choose 

the Edit button.    The Frequent Traveler Program Information dialog box appears.
5. Change the travel program information as necessary.    A description of each field is 

provided in the Frequent Traveler Program Information dialog box. 
6. When you are finished, choose OK.    The Travel Programs tab appears.
7. To return to the Traveler Editor dialog box, choose OK.
8. To return to the Itinerary Window, choose Close.

See also
Travel Programs tab 
Changing traveler information 



    Deleting a travel program
If a traveler no longer participates in a travel program, delete that program from the traveler
information.

To delete a travel program:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Select the traveler whose travel program you want to delete, then choose the Edit 

button.    The Traveler Information dialog box for that traveler appears.
3. Select the Travel Programs tab.
4. Select the travel program that you want to delete, then choose the Delete button.    

Choose Yes to confirm your action.    The travel program is removed from the list.
5. To return to the Traveler Editor dialog box, choose OK.
6. To return to the Itinerary Window, choose Close.

See also
Travel Programs tab 
Changing traveler information 



    Changing discount program information
Follow these steps to change discount program information.

To change discount program information:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Select the traveler whose discount program information you want to change, then 

choose the Edit button.    The Traveler Information dialog box for that traveler appears.
3. Select the Discount Programs tab.
4. Select the discount program that contains the information you want to change and 

choose the Edit button.    The Discount Program Information dialog box appears.
5. Change the discount program information as necessary.    A description of each field is 

provided in the Discount Program Information dialog box. 
6. When you are finished, choose OK.    The Discount Programs tab appears.
7. To return to the Traveler Editor dialog box, choose OK.
8. To return to the Itinerary Window, choose Close.

See also
Discount Programs tab 
Changing traveler information 



    Deleting a discount program
If a traveler no longer participates in a discount program, delete that program from the 
traveler information.

To delete a discount program:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Select the traveler whose discount program you want to delete, then choose the Edit 

button.    The Traveler Information dialog box for that traveler appears.
3. Select the Discount Programs tab.
4. Select the discount program that you want to delete, then choose the Delete button.    

Choose Yes to confirm your action.    The discount program is removed from the list.
5. To return to the Traveler Editor dialog box, choose OK.
6. To return to the Itinerary Window, choose Close.

See also
Discount Programs tab 
Changing traveler information 



    Deleting a traveler
You might want to delete a traveler from the Traveler Editor if you will no longer be including 
that traveler in your itineraries.
Important    When you delete a traveler, all profiles associated with that traveler are also 
deleted.

To delete a traveler and all associated profiles:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Select the name of the traveler that you want to delete, then choose the Delete button.    

When prompted, verify that you want to delete the traveler.    The traveler's name and all
associated profiles are removed from the list.

3. To return to the Itinerary Window, choose Close.

See also
Traveler Editor dialog box 
Deleting a traveler's profile 



    Deleting a traveler's profile
If you have created a profile that you do not intend to use again, you can delete it from the 
Traveler Editor.    For example, you might have created a "Sales Meeting" profile for your 
monthly sales meeting in Chicago.    However, you have now delegated the responsibility of 
attending this meeting to someone else.    Since the Sales Meeting profile no longer meets 
your travel needs, you can delete it from the Traveler Editor.
Note    Each traveler must have at least one profile.    If a traveler has only one profile, you cannot delete it.

To delete a traveler's profile:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Select the profile that you want to delete.
3. Choose the Delete button.    When prompted, verify that you want to delete the selected 

profile.    The profile is removed from the list.
4. To return to the Itinerary Window, choose Close.

See also
Traveler Editor dialog box 
Deleting a traveler 



    Traveler Editor dialog box
You use the Traveler Editor dialog box to maintain two types of information: traveler 
information and traveler profiles.    You must create a traveler information entry and at least 
one profile for each traveler that you want to include in a United Connection  itinerary.

How to display the Traveler Editor dialog box

Dialog Box Options

Travelers and Profiles
Displays a list of travelers and their associated profiles.

Edit button
This button performs two functions, depending on the item selected:
· If you select a traveler and choose the Edit button, the Traveler Information dialog box 

appears.    From this dialog box, you can enter or edit traveler information for the 
selected traveler.

· If you select a profile and choose the Edit button, the Trip Profiles dialog box appears.    
From dialog box, you can enter or edit flight, car, and hotel preferences and service 
requests for the selected profile.

Close button
Choose this button to return to the Itinerary Window.

Delete button
This button performs two functions, depending on the item selected:
· If you select a traveler and choose the Delete button, the selected traveler and all 

profiles associated with that traveler are deleted.
· If you select a profile and choose the Delete button, the selected profile is deleted.    

The traveler information for this traveler is unchanged.

Add Traveler button
Choose this button when you want to create a traveler information entry for a new 
traveler.    The Traveler Information dialog box appears.

Add Profile button
Choose this button when you want to create a new profile for an existing traveler.    The 
Trip Profiles dialog box appears.

See also
Using the Traveler Editor 
Adding a traveler 
Adding a profile 



To display the Traveler Editor dialog box:
· From the Tools menu, choose Traveler Editor.



    Traveler Information dialog box
You access the Traveler Information dialog box to enter or edit traveler information, including
traveler type and home airport, credit card information, travel program information, and 
discount program information.

How to display the Traveler Information dialog box

Dialog Box Options

Tabs
The Traveler Information dialog box consists of four tabs:
Select this tab To enter the following information

Personal Traveler name, phone number(s), traveler type, and 
home airport.

Payment Credit card type, account number, expiration date, 
and billing address for each credit card that will be 
used to pay for itinerary costs.

Travel Programs Travel program name, account number, sponsor 
type, and sponsor company.

Discount Programs Discount program name, account number, sponsor 
type, and sponsor company.

See also
Adding a traveler 
Entering traveler information 
Changing traveler information 



To display the Traveler Information dialog box:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. To display the Traveler Information dialog box, do one of the following:

· To enter traveler information for a new traveler, choose the Add Traveler button.
· To enter traveler information for an existing traveler, select that traveler from the 

list and choose the Edit button.



    Personal tab
(Traveler Information dialog box)

The Personal tab contains the traveler's identification information and home airport.    You 
must enter this information for each traveler.

How to display the Personal tab

Tab Options

Title
Select a title from the list provided (optional).

First Name and Last Name
Enter the traveler's first name and last name in the fields provided.

Business Phone and Home Phone
Enter the traveler's business phone number and/or home phone number in the fields 
provided.    Each phone number must include the area code, for example: (555) 123-4567.
Note    Each traveler must provide at least one phone number (Business or Home).

Type
Specify whether the traveler is a child, adult, or senior using the following age ranges:
Age Range Type

0-11 years Child

12-64 years Adult

65 or more years Senior Citizen

Note    Children under 2 are automatically classified as infants.

Birthdate
If you choose Child or Senior Citizen, a Birthdate field appears.    Enter the traveler's 
birthdate using the format MM/DD/YYYY.    For example, 08/10/1922.
You can also choose the        icon and select the birthdate. 

Home Airport
Select the airport from which this traveler usually departs.
If you don't know the airport name, you can click on the down arrow next to the Home 
Airport field to search by city, airport, or airport code.    See Using the Airport Search option
for more information.

See also
Entering personal information 
Changing traveler information 
Traveler Information dialog box 



    Payment tab
(Traveler Information dialog box)

The Payment tab contains a list of credit cards that the traveler can use to pay for airline 
tickets and reserve hotel rooms.

How to display the Payment tab

Tab Options

Credit Cards and Billing Addresses
Displays the name and billing address of each credit card entered for this traveler.

Add button
Choose this button to add a credit card to the list.    The Credit Card Information dialog box 
appears.

Edit button
Choose this button to edit information for the selected credit card.

Delete button
Choose this button to remove the selected credit card from the list.

See also
Entering payment credit card information 
Changing traveler information 
Traveler Information dialog box 



    Credit Card Information dialog box
You use the Credit Card Information dialog box to enter or edit credit card information.    This 
includes the card name, account number, expiration date, and billing address.

How to display the Credit Card Information dialog box

Dialog Box Options

Card Name
Enter a unique name for the credit card.    For example, Corporate American Express.    The 
name you enter in this field, rather than the credit card account number, is displayed when
United Connection  prompts you to select a credit card.

Type of Card
Select the card type.
Note    To pay for itinerary costs using the United Airlines Travel Card, your itinerary must include at least one 
United flight.

Account
Enter the credit card account number.    Do not enter any spaces or dashes between the 
numbers.    To prevent unauthorized access, United Connection will not display the account 
number after credit card validation is complete.

Expiration Date
Enter the credit card expiration date.    Use the format MM/YY or MM/DD/YY.    For example, 
12/99 or 12/31/99.    Note that you must update the expiration date when a new credit card
is issued.

Series Number
If you selected American Express/Optima, the Series Number field appears.    Enter the 4-
digit credit card series number (also referred to as the CID, or Customer ID).

Address on Billing Statement
Note    The billing address is the address to which the credit card company mails the traveler's billing statements.    
Please refer to a billing statement from the credit card company when completing the following fields.

Company
If the traveler is using a company credit card, enter the company name exactly as shown 
on the credit card billing statement.    If the billing statement is sent to the traveler's home 
address, leave this field blank.

Address
Enter the street address shown in the billing address on the credit card statement.

City
Enter the city shown in the billing address.

State
Enter or select the state shown in the billing address.



Zip
Enter the 5- or 9-digit zip code shown in the billing address.

See also
Entering payment credit card information 
Changing traveler information 
Payment tab 



To display the Credit Card Information dialog box:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Select a traveler and choose the Edit button.    The Traveler Information dialog box 

appears.
3. Select the Payment tab, then do one of the following:

· To add a credit card, choose the Add button.    The Credit Card Information dialog 
box appears.

· To change the information for a listed credit card, select the credit card and choose 
the Edit button.    The Credit Card Information dialog box appears.



    Travel Programs tab
(Traveler Information dialog box)

The Travel Programs tab contains a list of travel programs in which the traveler is a member 
(for example, frequent flyer programs).    This information is optional.    If provided, it will be 
forwarded to the appropriate sponsor (airline, rental car company, or hotel chain) when the 
traveler's itinerary includes a reservation with that sponsor.

How to display the Travel Programs tab

Tab Options

Frequent Traveler Programs
Displays the name and account number of each traveler program entered for this traveler.

Add button
Choose this button to add a travel program to the list.    The Frequent Traveler Program 
Information dialog box appears.

Edit button
Choose this button to edit information for the selected travel program.

Delete button
Choose this button to remove the selected travel program from the list.

See also
Entering travel program information 
Changing traveler information 
Traveler Information dialog box 



    Frequent Traveler Program Information dialog box
You use the Frequent Traveler Program Information dialog box to enter travel program 
membership information.
Note    You cannot apply for membership to new programs through United Connection  

 only enter travel programs in which the traveler is already a member.

How to display the Frequent Traveler Program Information dialog box

Dialog Box Options

Name
Enter the name of the travel program.    For example, Mileage Plus.

Account
Enter the traveler's account or membership number for this program.

Type
Select the type of company that sponsors the travel program.    Options are Airline, Hotel 
Chain, and Rental Agency.

Company
Select the company that sponsors the travel program.    For example, United Airlines is the 
sponsor for Mileage Plus .

Example
To enter travel program information for a spouse (named Glenn) that you are identifying as a
traveler, you would complete these fields as follows:
Field Sample Contents

Name Glenn's Mileage Plus

Account account number

Type Airline

Company United Airlines

See also
Entering travel program information 
Changing traveler information 
Travel Programs tab 



To display the Frequent Traveler Program Information dialog box:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Select a traveler and choose the Edit button.    The Traveler Information dialog box 

appears.
3. Select the Travel Programs tab, then do one of the following:

· To add a travel program, choose the Add button.    The Frequent Traveler Program 
Information dialog box appears.

· To change the information for a listed travel program, select the travel program 
and choose the Edit button.    The Frequent Traveler Program Information dialog box
appears.



    Discount Programs tab
(Traveler Information dialog box)

The Discount Programs tab contains a list of discount programs in which the traveler is a 
member.    This information is optional.    If provided, it will be forwarded to the appropriate 
sponsor (rental car company or hotel chain) when the traveler's itinerary includes a 
reservation with that sponsor.

How to display the Discount Programs tab

Tab Options

Hotel and Rental Car Discount Programs
Displays the name and account number of each discount program entered for this traveler.

Add button
Choose this button to add a discount program to the list.    The Discount Program 
Information dialog box appears.

Edit button
Choose this button to edit information for the selected discount program.

Delete button
Choose this button to remove the selected discount program from the list.

See also
Entering discount program information 
Changing traveler information 
Traveler Information dialog box 



    Discount Program Information dialog box
You use the Discount Program Information dialog box to enter discount program membership
information.
Note    You cannot apply for membership to new programs through United Connection  

 only enter discount programs in which the traveler is already a member.

How to display the Discount Program Information dialog box

Dialog Box Options

Name
Enter the name of the discount program.

Account
Enter the traveler's account or membership number for this program.

Type
Select the type of company that sponsors the discount program.    Options are Hotel Chain 
and Rental Agency.

Company
Select the company that sponsors the discount program.

Example
To enter information for a Hertz rental car discount program provided by Discover Card, you 
would complete these fields as follows:
Field Sample Contents

Name Discover Card discount

Account discount program number

Type Rental Agency

Company Hertz Rent-a-Car Systems

See also
Entering discount program information 
Changing traveler information 
Discount Programs tab 



To display the Discount Program Information dialog box:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Select a traveler and choose the Edit button.    The Traveler Information dialog box 

appears.
3. Select the Discount Programs tab, then do one of the following:

· To add a discount program, choose the Add button.    The Discount Program 
Information dialog box appears.

· To change the information for a listed discount program, select the program and 
choose the Edit button.    The Discount Program Information dialog box appears.



    What is a profile?
A profile consists of a traveler's preferences and service requests for flights, cars, and hotels.
These include:
· Airlines

Flight preferences
Flight service requests

· Rental Cars
Rental car preferences
Rental car service requests

· Hotels
Hotel preferences
Hotel service requests

You supply this information by creating a profile in the Traveler Editor.    See Adding a profile 
for more information.
Note    You must create at least one profile for each traveler.    If you do not create a profile after adding a new 
traveler, United Connection  automatically creates a default profile for that traveler.    You can edit a default profile as 
you would any other.

Creating multiple profiles
You can create as many profiles for each traveler as you wish.    For example, a traveler living
in Minneapolis might want to create three profiles: one for routine business trips, one for 
monthly sales meetings in Chicago, and one for vacation and weekend leisure travel.

How are profiles used?
You add a traveler to an itinerary by selecting one of that traveler's profiles.    If you also 
specify that traveler as the primary traveler, United Connection can use his or her 
preferences and service requests to customize the itinerary.
During planning, United Connection allows you to change the primary traveler's preferences 
on the fly.    You can save these changes in the primary traveler's profile, or use them for the 
current trip only.    Flight requests can be modified for each traveler in your itinerary.

Customizing your profiles
As you specify preferences and services, consider the purpose of the profile you are 
creating.    Then, tailor your choices to suit the trip type.    For example:
· For trips where dates are flexible:    Select all fare restrictions and choose Coach/Economy

as your service class to get a better fare.
· For trips that could require travel on short notice:    Create a profile with few fare 

restrictions and choose Any as your service class.
· For business trips:    Choose your company's preferred rental car company, and hotels 

with meeting facilities.
· For leisure travel with the family:    Request car seats for the kids, and hotels that provide 

a pool and baby-sitting services.



See also
Overview 
Trip Profiles dialog box 



    Adding a profile
You need to create at least one profile for each traveler.    Profiles contain a traveler's 
preferences and service requests for flights, rental cars, and hotels.    You can create multiple
profiles for each traveler, choosing different preferences and services for different trip types.
Note    The Trip Profiles dialog box appears automatically after you create a new traveler.    If you do not create a 
profile, United Connection  creates a default profile automatically.

To create a profile:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. Select the traveler for whom you want to create a profile and choose the Add Profile 

button.    The Trip Profiles dialog box appears.
3. In the Profile Name field, type a unique name for this profile.    For example, Business 

Meetings or Weekend Trips.
4. To enter preferences and service requests, select the appropriate tab.    All information is 

optional.
Select this tab To enter the following information

Flight Preferred airlines, service class, acceptable fare 
restrictions

Flight Requests Preferred seating, special meal, special services 
(i.e., a wheelchair at the airport)

Car Preferred rental companies, car types, acceptable 
rate range, in-terminal facilities, unlimited mileage

Car Requests Infant/toddler car seats, car phone, ski-equipped 
car, handicap controls

Hotel Preferred hotel chains, occupancy, amenities, rate 
category, acceptable rate range

Hotel Requests Late arrival guarantee, additional guests in hotel 
room, extra beds or cribs

5. When you have finished entering trip profile information, choose OK.    The Traveler Editor
dialog box appears.
You can continue to add or edit traveler information, or you can return to the Itinerary 
Window by choosing Close.

See also
Overview 
What is a profile? 
Trip Profiles dialog box 



    Specifying flight preferences
Flight preferences include preferred airlines, preferred service class, and acceptable fare 
restrictions.    At your option, United Connection  can use the primary traveler's flight 
preferences to narrow the search for acceptable flights.    You specify flight preferences in the
Flight tab of the Trip Profiles dialog box.
Important    When adding a flight to an itinerary, you must indicate that you want to use flight preferences by 
choosing the Use Preferences option in the Select Flight dialog box.

How to display the Flight tab

To specify flight preferences:
1. Display the Flight tab of the Trip Profiles dialog box.
2. Enter the traveler’s flight preferences as follows:

In this field You can

Preferred Airlines Select the traveler’s preferred airlines.    To remove a
preferred airline without replacing it, choose the 
"None" option.
Note    United Airlines is preset as one of the 
preferred airlines.    This selection cannot be 
changed.    You can select two additional preferred 
airlines.

Preferred Service 
Class

Select a class.    Options include First, Business, 
Coach/Economy, and Any.    The default is Any.

Acceptable Fare 
Restrictions

Select the fare restrictions the traveler is willing to 
accept when pricing a flight.    These include:

· Minimum Stay Required
· Maximum Stay Required
· Advance Purchase Required
By default, all fare restrictions are selected.

3. To continue entering profile information, select the Flight Requests tab and enter the 
traveler's flight service requests.

4. When you have finished entering profile information, choose OK to return to the Traveler 
Editor dialog box.

See also
Flight tab 
Entering profile information 
Adding a profile 



Minimum Stay Required
Include fares that require you to stay at least a certain number of days.    For example, 
over a weekend.



Maximum Stay Required
Include fares that require you to return within a specific time frame.    For example, within 
30 days.



Advance Purchase Required
Include fares that require you to purchase tickets within a specific time frame.    For 
example, 21 days before departure.



To display the Flight tab:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. To display the Trip Profiles dialog box, do one of the following:

· To create a new profile for a traveler, select that traveler and choose the Add Profile
button.

· To edit information in an existing profile, select that profile and choose the Edit 
button.

The Flight tab of the Trip Profiles dialog box appears.



    Specifying flight service requests
Flight services include preferred seating, preferred meal, and special services.    All travelers'
service requests are forwarded to the appropriate airlines when you reserve an itinerary.    
You specify flight service requests in the Flight Requests tab of the Trip Profiles dialog box.
Important    United Connection  cannot guarantee flight service requests 

 please call the airline directly to confirm your requests.

How to display the Flight Requests tab

To request flight services:
1. Display the Flight Requests tab of the Trip Profiles dialog box.
2. Enter the traveler’s flight service requests as follows:

In this field You can

Preferred Seating Select the traveler's seating preference.    Seating 
options include:
· None

· Aisle seat

· Any seat

· Window seat
The default option is Aisle seat.

Preferred Meal Select the traveler's special meal preference.    The 
default option is No Special Request.
Certain restrictions apply to special meal requests.    
Special meals must be requested at least 24 hours 
prior to departure.
Note    See Requesting special meals for information
about available meals, dietary guidelines, and 
restrictions on special meals.

Special Select any special services the traveler requires.    
For example, you can request a wheelchair for use 
at the airport.
Note    Wheelchair users must be able to ascend 
and descend stairs.    If further assistance is 
required, please contact the airline directly.

3. To continue entering profile information, select the Car tab and enter the traveler's rental
car preferences.

4. When you have finished entering profile information, choose OK to return to the Traveler 
Editor dialog box.

See also
Flight Requests tab 
Entering profile information 



To display the Flight Requests tab:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. To edit information in an existing profile, select that profile and choose the Edit button. 

The Trip Profiles dialog box appears.
Note    To create a new profile for a traveler, select that traveler and choose the Add Profile button.

3. Select the Flight Requests tab.



    Requesting special meals
United Airlines and other carriers provide special meals to meet the dietary needs of their 
customers.    A variety of special meals are available, including:

Medical/dietary meals

Vegetarian meals

Religious meals

Children's meals

Lighter choice and other special meals

Medical guidelines for special meals served by United Airlines are based on the latest 
information from the American Dietetic Association, the American Heart Association, the 
American Diabetes Association, and the American Cancer Society.    In addition, most of the 
special meals offered by United meet the Heart Smart  guidelines 

 see Heart Smart
 meals for more information about this program.

Note    It is recommended that individuals with sensitive allergies or severe medical conditions consult a 
nutritionist/dietitian for assistance with special meal selections.

Special meal restrictions
Certain restrictions apply to special meal requests:
· All special meals must be requested at least 24 hours prior to departure.
· No special meals are offered on United or United Express flights under 90 minutes (1  

hours).    Special meals may be requested from other airlines on flights of less than 90 
minutes, but may not be available.    Please contact the airline directly for more 
information.

· Special meals are not available on flights for which the meal service is designated as "No
service" (as displayed in the Flight Details dialog box).

· McDonald's Friendly Skies children's meals are available on departures from certain U.S. 
cities only  see Children's meals for a complete listing.

· The following special meals are offered as the primary meal service on each flight 
segment: Seafood, Chicken, Chef Salad, Fruit Plate, Obento, and McDonald's Friendly 
Skies meals.    The regular provisioned menu selection will be boarded for any additional 
meals.

· Seafood, Chicken, and Chef Salad meals are not available on breakfast flights.
· Obento meals are only offered in First Class and Connoisseur (Business) Class on certain 

Pacific routes  see Lighter choice and other special meals for a complete listing.

Confirmation of special meal requests
Special meal requests on United and United Express flights are confirmed (or denied) 
immediately when you reserve your itinerary.    To confirm a special meal request on another 
airline, please contact the airline directly.



See also
Specifying flight service requests 



    Heart Smart
 meals

United Airlines has joined efforts with Heart Smart Restaurants International  to provide 
nutritional analysis for all special meals served by United.    The Heart Smart

 seal appears next to all special meals that meet the Heart Smart
 guidelines listed below:

30% or less calories from total fat
10% or less calories from saturated fat
150 mg. or less cholesterol
1100 mg. or less sodium

All medical/dietary, vegetarian, religious (except Kosher), and lighter choice special meals 
(Seafood, Chef Salad, Fruit Plate, and Chicken meals) served by United Airlines meet the 
Heart Smart  guidelines.    The following meals do not meet these guidelines:    Children's 
meal, Toddler meal, Baby meal, Obento meal, and Kosher meal.
For a listing of Heart Smart  approved restaurants in your area, call 1-800-SMART-19.
Note    The Heart Smart  designation applies only to special meals served by United Airlines and United Express.    
To obtain nutritional information about special meals served by other airlines, please contact the airlines directly.

See also
Specifying flight service requests 
Medical/Dietary meals 



    Medical/Dietary meals
The following medical/dietary meals are available from United Airlines:

Meal type Description

Diabetic Meals are low in fat and relatively high in complex 
carbohydrates, with a controlled distribution of fat, 
protein, and carbohydrates.

Gluten-free Meals are free from all products containing wheat, 
barley, rye, and oats.    This includes breads, cakes, 
pasta, sauces, soups, and pastries.

Low sodium Meals eliminate foods with high sodium content 
(including cheese and cured meats) and do not 
contain added salt or MSG.    Meals are not salt-free.

Low cholesterol/
Low fat

Meals include lean meat and fish, low-fat dairy 
products, complex carbohydrates, and fresh fruits and
vegetables.    Saturated fats are restricted.

Low calorie Meals provide reduced fat and protein portions using 
lean meat and fish, low-fat dairy products, complex 
carbohydrates, and fresh fruits and vegetables.

Low protein Meals exclude complete protein foods such as meat, 
fish, eggs, and dairy products while increasing fats 
and carbohydrates to ensure adequate calorie intake.

High fiber Meals emphasize the use of unrefined cereals and 
grains, raw fruits and vegetables, nuts, and legumes.  
Products made from white flour are restricted.

Bland Meals provide a moderation of fiber, texture, and 
seasoning.    Foods that are fried or highly seasoned, 
as well as strong tea, coffee, alcohol are excluded.

Low purine Meals are free from foods which are rich in purine and
fat, including liver, herring and fish with scales, 
shrimp, crab, anchovies, gravy mixes, and bouillon.

Non-lactose Meals are free from milk and dairy products, including
butter, cheese, cream, and yogurt.    Milk products 
(casein, whey, etc.) are also restricted.

Note    Because individual medical/dietary needs can vary greatly, United Airlines cannot guarantee that any meal will 
meet 100% of your requirements.    Nutritional analysis is provided with each meal so that you can regulate your 
individual nutritional requirements.

See also
Specifying flight service requests 
Heart Smart meals 



    Vegetarian meals
The following vegetarian meals are available from United Airlines:

Meal type Description

Lacto-ovo Meals follow strict vegan requirements (no meat, 
poultry, fish, shellfish, eggs, dairy products, or other 
animal products) but may be supplemented with milk 
and other dairy products as available.

Vegan Meals follow strict vegan requirements and exclude 
meat, poultry, fish, shellfish, eggs, dairy products, 
gelatin, honey, whey, and other animal products.

Asian vegetarian Meals follow strict vegan requirements (no meat, 
poultry, fish, shellfish, eggs, dairy products, or other 
animal products) but are more spicy than the Lacto-
Ovo or Vegan vegetarian meals.

See also
Specifying flight service requests 



    Religious meals
The following religious meals are available from United Airlines:

Meal type Description

Kosher Meals are purchased from a certified Kosher vendor 
and are prepared under rabbinical supervision, 
wrapped, and sealed.    Special Passover meals are 
served during Passover.

Moslem Meals exclude pork, ham, and other pork products, 
animal fats, and alcohol.    Main meals include poultry 
entrees.    If locally available, poultry may be 
slaughtered according to the specified Halal methods.

Hindu Meals follow strict vegan requirements (no meat, 
poultry, fish, shellfish, eggs, dairy products, or other 
animal products), but do not contain root vegetables 
and are spicy in content.

See also
Specifying flight service requests 



    Children's meals
The following children's meals are available from United Airlines:

Meal type Description

McDonald's 
Friendly Skies

The McDonald's Friendly Skies meal is available for 
seat-occupying children age 18 months or older.    
Lunch/dinner services include a cheeseburger, 
applesauce, raisins, 2% milk, McDonald's cookies, and
a puzzle box with a toy.    This meal is available as the 
primary meal on multiple meal service flights.    A 
regular meal will be provided for additional services.

Note    This meal is only available on departures from 
certain U.S. cities  see McDonald's meal availability 
for a complete list of these cities.

Children's Children's meals are available for seat-occupying 
children age 18 months or older, and are served on 
flights departing from cities that do not provide 
McDonald's meals (see above).    Meals include soft, 
easy-to-chew foods and are not highly seasoned.    2% 
milk and juices are available onboard.

Toddler Toddler meals are available for children between the 
ages of one and two who are sharing a seat with an 
adult traveler (and are therefore not eligible for full tray 
meal service).    Meals can include Cheerios, cheese 
sticks, graham crackers, 2% milk, and juice.

Baby Baby meals are available for children up to two years 
of age who are sharing a seat with an adult traveler 
(and are therefore not eligible for full tray meal 
service).    Meals include commercially prepared baby 
foods (strained fruits, vegetables, and meats).    2% 
milk and juices are available onboard.

See also
Specifying flight service requests 



    Lighter choice and other special meals
The following lighter choice and other meals are available from United Airlines:

Meal type Description

Seafood Cold seafood meals are available on dinner, lunch, or 
snack services.    This meal is not available for 
breakfast.

Chef salad Chef salads include fresh vegetables, meats, and 
cheeses and are available on dinner, lunch, and snack 
services.    This meal is not available for breakfast.

Fruit plate Chilled fresh fruit plates are available on all meal 
services.

Chicken Chicken meals are available on dinner, lunch, and snack
services.    This meal is not available for breakfast.

Obento 
(Japanese)

Obento meals are available on lunch or dinner services 
in First Class and Connoisseur Class on the following 
routes: U.S.A.  Japan  U.S.A., Narita  Hong Kong

 Narita, and Narita  Singapore.    These meals 
feature Japanese specialty food items presented in a 
lacquered box.

Note    These meals are available as the primary meal on multiple meal service flights.    A regular meal will be 
provided for additional services.

See also
Specifying flight service requests 



McDonald's meal availability
McDonald's Friendly Skies Children's meal is available on United Airlines flights departing 
from the following cities/airports only:

Baltimore, MD Newark, NJ

Boston, MA O'Hare Airport, Chicago, IL

Dallas/Ft. Worth, TX Oakland, CA

Denver, CO Orlando, FL

Detroit, MI Philadelphia, PA

Dulles, DC-VA Phoenix, AZ

Hartford, CT Portland, OR

J. F. Kennedy Airport, NY San Diego, CA

La Guardia Airport, NY San Francisco, CA

Los Angeles, CA Seattle-Tacoma, WA

Miami, FL Washington, DC

New Orleans, LA

    Specifying rental car preferences
Rental car preferences include preferred rental companies, preferred car types, acceptable 
rental rate range, in-terminal facilities, and unlimited mileage.    At your option, United 
Connection  can use the primary traveler's rental car preferences to narrow the search for 
acceptable cars.    You specify rental car preferences in the Car tab of the Trip Profiles dialog 
box.
Important    When adding a rental car to an itinerary, you must indicate that you want to use rental car preferences by
choosing the Use Preferences option in the Select Rental Car dialog box.

How to display the Car tab

To specify rental car preferences:
1. Display the Car tab of the Trip Profiles dialog box.
2. Enter the traveler’s rental car preferences as follows:

In this field You can

Preferred Rental 
Companies

Select the three rental companies the traveler most 
prefers.    The default is None.

Preferred Car 
Types

Select the three car types the traveler most prefers.  
The default is None.

Search Within 
Price Range

Select this option if the traveler wants United 
Connection to display only rental companies that 
offer rates within a specified price range.    Then, do 
the following:
a. In the Highest Rate field, enter the highest daily 

rate the traveler wants to pay for a car.
b. In the Lowest Rate field, enter the lowest daily 



rate the traveler wants to pay for a car.
Note    To have United Connection ignore the rate 
range search option, de-select the Search Within 
Price Range option.

In Terminal 
Facilities

Select this option if the traveler prefers to rent cars 
from companies that have service desks located in 
the airport terminal, rather than at a remote airport 
location (that may require shuttle service).

Unlimited Mileage Select this option if the traveler prefers to rent from 
car companies that offer an unlimited mileage plan.

3. To continue entering profile information, select the Car Requests tab and enter the 
traveler's rental car service requests.

4. When you have finished entering profile information, choose OK to return to the Traveler 
Editor dialog box.

See also
Car tab 
Entering profile information 



To display the Car tab:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. To edit information in an existing profile, select that profile and choose the Edit button. 

The Trip Profiles dialog box appears.
Note    To create a new profile for a traveler, select that traveler and choose the Add Profile button.

3. Select the Car tab.



    Specifying rental car service requests
Rental car services include infant and toddler car seats, controls for physically challenged 
drivers, ski-equipped car, mobile phone, and associated frequent flyer program.    Rental car 
service requests are forwarded for the primary traveler only.    You specify rental car service 
requests in the Car Requests tab of the Trip Profiles dialog box.
Important    United Connection  cannot guarantee rental car service requests 

 please call the rental car company directly to confirm your requests.

How to display the Car Requests tab

To request car services:
1. Display the Car Requests tab of the Trip Profiles dialog box.
2. Enter the traveler’s rental car service requests as follows:

In this field You can

Infant Car Seat Select an infant car seat.

Toddler Car Seat Select a toddler car seat.

Car Equipped for 
Physically 
Challenged Driver

Select a rental car equipped for a physically 
challenged driver.    You then select either:
· Left Hand Controls
· Right Hand Controls

Mobile Phone Select a car equipped with a mobile phone.

Ski-Equipped Car Select a car with a ski rack, snow tires, etc.

Associated 
Frequent Flyer 
Program

Select the frequent flyer program that the traveler 
wants to associate with rental cars.
Frequent Flyer Program Notes

3. To continue entering profile information, select the Hotel tab and enter the traveler's 
hotel preferences.

4. When you have finished entering profile information, choose OK to return to the Traveler 
Editor dialog box.

See also
Car Requests tab 
Entering profile information 



To display the Car Requests tab:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. To edit information in an existing profile, select that profile and choose the Edit button. 

The Trip Profiles dialog box appears.
Note    To create a new profile for a traveler, select that traveler and choose the Add    Profile button.

3. Select the Car Requests tab.



    Specifying hotel preferences
Hotel preferences include preferred hotel chains, occupancy, amenities, rate category, 
acceptable rate range, and most important preference.    At your option, United Connection  
can use the primary traveler's hotel preferences to narrow the search for acceptable hotel 
accommodations.    You specify hotel preferences in the Hotel tab of the Trip Profiles dialog 
box.
Important    When adding a hotel to an itinerary, you must indicate that you want to use hotel preferences by 
choosing the Use Preferences option in the Select Hotel dialog box.

How to display the Hotel tab

To specify hotel preferences:
1. Display the Hotel tab of the Trip Profiles dialog box.
2. Enter the traveler’s hotel preferences as follows:

In this field You can

Preferred Hotel
Chains

Select the three hotel chains the traveler most prefers.    
The default is None.

Preferred 
Occupancy

Select Single or Double occupancy.

Preferred 
Amenities

Select up to eight amenities (health club, meeting rooms, 
baby-sitting, pool, etc.).

Preferred Rate
Category

Select one of the following options: Standard, Corporate, 
Senior Citizen, Club Level, or Weekend.    The default is 
Standard.

Search Within 
Price Range

Select this option if the traveler wants United Connection to 
display only hotels that offer rates within a specified price 
range.    Then, do the following:
a. In the Highest Rate field, enter the highest rate (per 

night) the traveler wants to pay for a hotel room.
b. In the Lowest Rate field, enter the lowest rate (per night)

the traveler wants to pay for a hotel room.
Note    To ignore the rate range search option, de-select the
Search Within Price Range option.

Which Is Most 
Important To 
You

Select the preference that is most important to the traveler 
when searching for a hotel.    Options are Hotel Chain, 
Room Rates, or Amenities.    The default is Hotel Chain.
United Connection will try to find hotels that meet all of the 
specified preferences.    However, a higher priority is placed
on finding hotels that meet the Most Important preference.

3. To continue entering profile information, select the Hotel Requests tab and enter the 
traveler's hotel service requests.

4. When you have finished entering profile information, choose OK to return to the Traveler 
Editor dialog box.

See also
Hotel tab 



Entering profile information 



To display the Hotel tab:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. To edit information in an existing profile, select that profile and choose the Edit button. 

The Trip Profiles dialog box appears.
Note    To create a new profile for a traveler, select that traveler and choose the Add Profile button.

3. Select the Hotel tab.



    Specifying hotel service requests
Hotel services include guarantee for late arrival, additional guests in room, additional beds 
and/or cribs in room, and associated frequent flyer program.    Hotel service requests are 
forwarded for the primary traveler only.    You specify hotel service requests in the Hotel 
Requests tab of the Trip Profiles dialog box.
Important    United Connection  cannot guarantee hotel service requests 

 please call the hotel directly to confirm your requests.

How to display the Hotel Requests tab

To specify preferred hotel services:
1. Display the Hotel Requests tab of the Trip Profiles dialog box.
2. Enter the traveler’s hotel requests as follows:

In this field You can

Guarantee Room 
For Late Arrival

Select this option to hold the room regardless of 
your arrival time. 
Important    You will need to provide a credit card 
when you reserve the itinerary.

Additional Adults 
In Room

Specify the number of additional adults that will be 
sharing the room.
Note    This applies to double-occupancy rooms 
only.    Do not include the first two occupants.    To 
request double occupancy, enter a "2" in the 
Occupancy field (Hotel tab).

Additional Children
In Room

Specify the number of additional children that will be
sharing the room.
Note    This applies to double-occupancy rooms 
only.    Do not include the first two occupants.    To 
request double occupancy, enter a "2" in the 
Occupancy field (Hotel tab).

Roll-Away Beds 
Required

Specify the number of additional beds required.

Cribs Required Specify the number of cribs required.

Associated 
Frequent Flyer 
Program 

Select the frequent flyer program you want to 
associate with hotel reservations.
Frequent Flyer Program Notes 

3. When you have finished entering profile information, choose OK to return to the Traveler 
Editor dialog box.

See also
Hotel Requests tab 
Entering profile information 



To display the Hotel Requests tab:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. To edit information in an existing profile, select that profile and choose the Edit button. 

The Trip Profiles dialog box appears.
Note    To create a new profile for a traveler, select that traveler and choose the Add profile button.

3. Select the Hotel Requests tab.



    Changing the Preferred Airlines option
Flight preferences include up to two of the traveler's preferred airlines (in addition to United 
Airlines).    If you use preferences to find flights, United Connection  displays only flights 
operated by the primary traveler's preferred airlines.

To change preferred airlines:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the flight preferences you

want to change.
3. Choose the Edit button.    The Flight tab of the Trip Profiles dialog box appears.
4. In the Preferred Airlines fields, select the traveler's preferred airlines.    To remove a 

preferred airline without replacing it, choose the "None" option.
Note    United Airlines is preset as one of the preferred airlines.    This selection cannot be changed.    You can 
select two additional preferred airlines.    If preferences are used to find flights and the primary traveler has not 
selected second and third preferred airlines, only United Airlines flights will appear.

5. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
6. To return to the Itinerary Window, choose Close.

See also
Flight tab 
Changing flight preferences and services 



    Changing the Preferred Service Class option
Flight preferences include the traveler's preferred service class.    If you use preferences to 
find flights, United Connection  displays only flights that have seats available in the primary 
traveler's preferred service class.

To change preferred service class:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the flight preference you 

want to change.
3. Choose the Edit button.    The Flight tab of the Trip Profiles dialog box appears.
4. In the Preferred Service Class field, select one of the following options:    First, Business, 

Coach/Economy, or Any.
5. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
6. To return to the Itinerary Window, choose Close.

See also
Flight tab 
Changing flight preferences and services 



    Changing the Acceptable Fare Restrictions option
Flight preferences include the traveler's acceptable fare restrictions.    If you use preferences 
to find flights, United Connection  will look for fares based on the primary traveler's 
acceptable fare restrictions.

To change acceptable fare restrictions:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the flight preference you 

want to change.
3. Choose the Edit button.    The Flight tab of the Trip Profiles dialog box appears.
4. In the Acceptable Fare Restrictions field, select the fare restrictions the traveler is willing 

to accept when pricing a flight.    These include:
· Minimum Stay Required
· Maximum Stay Required
· Advance Purchase Required
By default, all fare restrictions are selected.

5. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
6. To return to the Itinerary Window, choose Close.

See also
Flight tab 
Changing flight preferences and services 



    Changing the Preferred Seating option
Flight services include the traveler's preferred seat type.    When you reserve a flight, each 
traveler's seating requests are forwarded to the airlines.

To change the seating preference:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the flight service request 

you want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Flight Requests tab.
5. In the Preferred Seating field, select the traveler's seating preference.    Seating options 

include:
· Any seat
· Aisle seat
· Window seat

6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Flight Requests tab 
Changing flight preferences and services 



    Changing the Preferred Meal option
If the traveler requires a special meal (for example, for medical or religious reasons), select 
their special meal preference in the Preferred Meal field.    When you reserve a flight, each 
traveler's meal requests are forwarded to the airlines.    Special meals must be requested at 
least 24 hours prior to departure.    Note that certain restrictions apply to special meal 
requests  see Requesting special meals for information about available meals, dietary 
guidelines, and restrictions.

To change the meal preference:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the flight service request 

you want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Flight Requests tab.
5. In the Preferred Meal field, select the traveler's meal preference.
6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Flight Requests tab 
Changing flight preferences and services 



    Changing the Special Services option
Special services available through United Connection  include requesting a wheelchair for 
use at the airport.    When you reserve a flight, each traveler's special service requests are 
forwarded to the airlines.
Note    Wheelchair users must be able to ascend and descend stairs.    If you need further assistance, please contact 
the airline directly.

To change special services:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the flight service request 

you want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Flight Requests tab.
5. In the Special field, select any special services the traveler requires.
6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Flight Requests tab 
Changing flight preferences and services 



    Changing the Preferred Hotel Chains option
Hotel preferences include up to three of the traveler's preferred hotel chains.    If you use 
preferences to find hotel accommodations, United Connection  displays only the primary 
traveler's preferred hotel chains.

To change preferred hotel chains:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the hotel preference you 

want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Hotel tab.
5. In the Preferred Hotel Chains fields, select the traveler's preferred hotel chains.    To 

remove a preferred hotel chain without replacing it, choose the "None" option.
6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Hotel tab 
Changing hotel preferences and services



Changing the Preferred Occupancy option

Hotel preferences include the traveler's preferred occupancy for hotel rooms (Single or 
Double).    If you use preferences to find hotel accommodations, United Connection  displays
only hotels that offer the primary traveler's preferred occupancy.

To change the preferred occupancy type:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the hotel preference you 

want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Hotel tab.
5. In the Preferred Occupancy field, select the traveler's preferred occupancy type (Single 

or Double).
6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Hotel tab 
Changing hotel preferences and services



    Changing the Preferred Rate Category option
Hotel preferences include the traveler's preferred rate category.    If you use preferences to 
find hotel accommodations, United Connection  displays hotels that have rooms available in
either of the following rate categories:
· Standard rate
· Primary traveler's preferred rate category (for example, Weekend)

To change the preferred hotel rate category:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the hotel preference you 

want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Hotel tab.
5. In the Preferred Rate Category field, select the one of the following options: Standard, 

Corporate, Senior Citizen, Club Level, or Weekend.
6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Hotel tab 
Changing hotel preferences and services



    Changing the Acceptable Rate Range option for hotels
Hotel preferences include the traveler's preferred rate range.    If you use preferences to find 
hotel accommodations and the Search Within Price Range option is selected in the primary 
traveler's profile, United Connection  displays only hotels that offer rates within the rate 
range specified in the primary traveler's profile.

To change the acceptable hotel rate range:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the hotel preference you 

want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Hotel tab.
5. If you have not selected the Search Within Price Range box, do so now.    Then, do the 

following:
a. In the Highest Rate field, type the highest acceptable room rate (per night).
b. In the Lowest Rate field, type the lowest acceptable room rate (per night).
Note    To see all available room rates, de-select the Search Within Price Range box.

6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Hotel tab 
Changing hotel preferences and services



    Changing the Preferred Amenities option
Hotel preferences include the traveler's preferred amenities.    If you use preferences to find 
hotel accommodations, United Connection  displays only hotels that offer all the primary 
traveler's preferred amenities.

To change the preferred hotel amenities:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the hotel preference you 

want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Hotel tab.
5. In the Preferred Amenities list, select up to eight amenities.
6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Hotel tab 
Changing hotel preferences and services



    Changing the Which is Most Important To You? option
Hotel preferences include an option that lets the traveler specify which preference is most 
important: Hotel Chain, Room Rates, or Amenities.    The default option is Hotel Chain.    If 
you use preferences to find hotel accommodations, United Connection  will try to find hotels
that meet all the primary traveler's preferences.    However, it places a higher priority on 
finding hotels that meet the Most Important preference.

To change the most important hotel preference:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the hotel preference you 

want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Hotel tab.
5. In the group labeled Which Is Most Important To You?, select the traveler's most 

important hotel preference: Hotel Chain, Room Rates, or Amenities.
6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Hotel tab 
Changing hotel preferences and services



    Changing the Late Arrival Guarantee option
Hotel service requests include a late arrival guarantee.    When you reserve hotel 
accommodations and the primary traveler's profile includes a request for a late arrival 
guarantee, United Connection  forwards this request to the hotel.    Hotel service requests 
are forwarded for the primary traveler only.

To change the late arrival guarantee option:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the hotel service request 

you want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Hotel Requests tab.
5. To hold the room regardless of arrival time, select the Guarantee Room For Late Arrival 

option.
Note    If this option is selected, a credit card will be required to guarantee the room.

6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Hotel Requests tab 
Changing hotel preferences and services



    Changing the number of additional guests and/or beds
Hotel services include requests for additional guests, beds, or cribs in the hotel room.    When
you reserve hotel accommodations and the primary traveler's profile includes a request for 
additional guests, beds, or cribs, United Connection  forwards this request to the hotel.    
Hotel service requests are forwarded for the primary traveler only.

To change the number of additional guests and/or beds:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the hotel service request 

you want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Hotel Requests tab.
5. In the Additional Adults In Room field, specify the number of additional adults that will be

sharing the room.
Note    This applies to additional adults in a double-occupancy room only.    Do not include the first two occupants 
in this field.    For example, if three adults will be sharing a double-occupancy room, select "1" for Additional 
Adults in Room.

To request double occupancy, select "2" in the Occupancy field (Hotel tab).
6. In the Additional Children In Room field, specify the number of children that will be 

sharing the room.
Note    This applies to additional children in a double-occupancy room only.    Do not include the first two 
occupants in this field.    For example, if one adult and two children will be sharing a double-occupancy room, 
select "1" for Additional Children in Room.

To request double occupancy, select "2" in the Occupancy field (Hotel tab).
7. In the Roll-Away Beds Required, specify the number of roll-away beds required.
8. In the Cribs Required field, specify the number of cribs required.
9. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
10. To return to the Itinerary Window, choose Close.

See also
Hotel Requests tab 
Changing hotel preferences and services



    Changing the frequent flyer program associated with hotel 
reservations
Hotel services include selecting a frequent flyer program to associate with hotel 
reservations.    When you reserve a hotel room and the primary traveler's profile includes an 
associated frequent flyer program for hotels, United Connection  will forward the primary 
traveler's frequent flyer membership number to the hotel.
If the selected frequent flyer program has a promotional agreement with the hotel, the 
primary traveler may be eligible for any benefits offered under that promotion.    Hotel 
service requests are forwarded for the primary traveler only.

To change the frequent flyer program associated with hotel reservations:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the hotel service request 

you want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Hotel Requests tab.
5. In the Associated Frequent Flyer Program field, select the frequent flyer program the 

traveler wants to associate with hotel reservations.
Note    The Associated Frequent Flyer Program field contains a list of frequent flyer programs entered for the 
current traveler.    For help entering frequent flyer account information, see Entering travel program information 

6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Hotel Requests tab 
Changing hotel preferences and services



    Changing the Preferred Rental Companies option
Rental car preferences include up to three of the traveler's preferred rental companies.    If 
you use preferences to find a rental car, United Connection  displays only the primary 
traveler's preferred rental companies.

To change preferred rental companies:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the rental car preference 

you want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Car tab.
5. In the Preferred Rental Companies fields, select the traveler's preferred rental 

companies.    To remove a preferred airline without replacing it, choose the "None" option.
6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Car tab 
Changing rental car preferences and services 



    Changing the Preferred Car Types option
Rental car preferences include up to three of the traveler's preferred car types.    If you use 
preferences to find a rental car, United Connection  displays only rental companies that 
offer the primary traveler's preferred car types.

To change preferred car types:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the rental car preference 

you want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Car tab.
5. In the Preferred Car Types fields, select the traveler's preferred car types.    To remove a 

preferred airline without replacing it, choose the "None" option.
6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Car tab 
Changing rental car preferences and services 



    Changing the Acceptable Rate Range option for rental cars
Rental car preferences include the traveler's preferred rate range.    If you use preferences to
find a rental car and the Search Within Price Range option is selected in the primary 
traveler's profile, United Connection  displays only rental companies that offer rates within 
the rate range specified in the primary traveler's profile.

To change the acceptable rental car rate ranges:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the rental car preference 

you want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Car tab.
5. If you have not selected the Search Within Price Range box, do so now.    Then, do the 

following:
a. In the Highest Rate field, type the highest acceptable rate amount.
b. In the Lowest Rate field, type the lowest acceptable rate amount.
Note    To see all available rates, de-select the Search Within Price Range box.

6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Car tab 
Changing rental car preferences and services 



    Changing the In Terminal Facilities option
If you prefer rental companies that have facilities inside the airport terminal, select the In 
Terminal Facilities option.    If you use preferences to find a rental car and the In Terminal 
Facilities option is selected in the primary traveler's profile, United Connection  displays only
rental companies that have a service desk inside the airport terminal.

To change the in-terminal facilities preference:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the rental car preference 

you want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Car tab.
5. If you prefer to rent a car from companies that have a desk inside the airport terminal, 

select the In Terminal Facilities option.
6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Car tab 
Changing rental car preferences and services 



    Changing the Unlimited Mileage option
If you prefer rental companies that offer unlimited mileage rental plans, select the Unlimited 
Mileage option.    If you use preferences to find a rental car and the Unlimited Mileage option 
is selected in the primary traveler's profile, United Connection  displays only rental 
companies that offer unlimited mileage rental plans.

To change the unlimited mileage preference:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the rental car preference 

you want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Car tab.
5. If you prefer to rent a car on an unlimited mileage plan only, select the Unlimited Mileage

option.
6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Car tab 
Changing rental car preferences and services 



    Changing the Infant/Toddler Car Seat request
If the primary traveler's profile includes a request for an infant and/or child car seat, United 
Connection  forwards this request to the rental car company when you reserve a car.    
Rental car service requests are forwarded for the primary traveler only.

To change the infant/toddler car seat option:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the rental car service 

request you want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Car Requests tab.
5. If you need an infant car seat, select the Infant Car Seat option.
6. If you need a toddler car seat, select the Toddler Car Seat option.
7. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
8. To return to the Itinerary Window, choose Close.

See also
Car Requests tab 
Changing rental car preferences and services 



    Changing the Car Equipped for Physically Challenged Driver 
option
If the primary traveler's profile includes a request for a car equipped for a physically 
challenged driver, United Connection  forwards this request to the rental car company when
you reserve a car.    Rental car service requests are forwarded for the primary traveler only.

To change the Car Equipped for Physically Challenged Driver option:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the rental car service 

request you want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Car Requests tab.
5. To request a car equipped for a physically challenged driver, select the Car Equipped for 

Physically Challenged Driver option.    Then, select one of the following options:
· Left Hand Controls
· Right Hand Controls

6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Changing rental car preferences and services 
Car Requests tab 



    Changing the Mobile Phone Requested option
If the primary traveler's profile includes a request for a car equipped with a mobile phone, 
United Connection  forwards this request to the rental car company when you reserve a car. 
Rental car service requests are forwarded for the primary traveler only.

To change the Mobile Phone Requested option 
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the rental car service 

request you want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Car Requests tab.
5. To request a car equipped with a mobile phone, select the Mobile Phone Requested 

option.
6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Changing rental car preferences and services 
Car Requests tab 



    Changing the Ski-Equipped Car option
If the primary traveler's profile includes a request for a ski-equipped car, United Connection
forwards this request to the rental car company when you reserve a car.    Rental car service 
requests are forwarded for the primary traveler only.

To change the Ski-Equipped Car option:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the rental car service 

request you want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Car Requests tab.
5. To request a rental car equipped with a ski rack, snow tires, etc., select the Ski-Equipped 

Car option.
6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Changing rental car preferences and services 
Car Requests tab 



    Changing the frequent flyer program associated with car 
reservations
If the primary traveler's profile includes an associated frequent flyer program for rental cars, 
United Connection  will forward the primary traveler's membership number to the rental car
company when you reserve a car.
If the selected frequent flyer program has a promotional agreement with the rental 
company, the primary traveler may be eligible for any benefits offered under that promotion.
Rental car service requests are forwarded for the primary traveler only.

To change the frequent flyer program associated with car reservations:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. In the Travelers and Profiles list, select the profile that contains the rental car service 

request you want to change.
3. Choose the Edit button.    The Trip Profiles dialog box appears.
4. Select the Car Requests tab.
5. In the Associated Frequent Flyer Program field, select the frequent flyer program the 

traveler wants to associate with rental car reservations.
Note    The Associated Frequent Flyer Program field contains a list of frequent flyer programs entered for the 
current traveler.    For help entering frequent flyer account information, see Entering travel program information 

6. To update the profile, choose OK.    The Traveler Editor dialog box appears. 
7. To return to the Itinerary Window, choose Close.

See also
Changing rental car preferences and services 
Car Requests tab 



    Trip Profiles dialog box
You access the Trip Profiles dialog box to add or edit a traveler profile.    Profiles contain a 
traveler's preferences and service requests for flights, rental cars, and hotels.    You must 
create at least one profile for each traveler.    You can also create multiple profiles for each 
traveler, choosing different preferences and services for different trip types.
Note    The Trip Profiles dialog box appears automatically after you enter information for a new traveler.    If you do not
create a profile, United Connection  creates a default profile automatically.

How to display the Trip Profiles dialog box

Dialog Box Options

Traveler
Displays the name of the traveler associated with this profile.

Profile Name
For a new profile, enter the name of the profile.
For an existing profile, the name can be modified, if necessary.    For example, you might 
want to rename a default profile.    Simply delete the Default Profile text and type a 
meaningful name, such as Quarterly Sales Meetings.

Tabs
The Trip Profiles dialog box also includes six tabs:
Select this tab To enter the following information

Flight Preferred airlines, service class, acceptable fare 
restrictions

Flight Requests Preferred seating, special meal, special services 
(i.e., a wheelchair at the airport)

Car Preferred rental companies, car types, acceptable 
rate range, in-terminal facilities, unlimited mileage

Car Requests Infant/toddler car seats, car phone, ski-equipped 
car, handicap controls

Hotel Preferred hotel chains, occupancy, amenities, rate 
category, acceptable rate range

Hotel Requests Late arrival guarantee, additional guests in hotel 
room, extra beds or cribs

See also
Adding a profile 
Entering profile information 
Changing profile information 



To display the Trip Profiles dialog box:
1. From the Tools menu, choose Traveler Editor.    The Traveler Editor dialog box appears. 
2. To display the Trip Profiles dialog box, do one of the following:

· To create a new profile for a traveler, select that traveler and choose the Add Profile
button.

· To edit information in an existing profile, select that profile and choose the Edit 
button.



    Flight tab
(Trip Profiles dialog box)

The Flight tab contains the traveler's flight preferences, including his or her preferred 
airlines, preferred service class, and acceptable fare restrictions.    At your option, United 
Connection  can use the primary traveler's flight preferences to narrow the search for 
acceptable flights.    You can also change flight preferences on the fly 

 see Editing preferences for this flight for more information.
Important    When adding a flight to an itinerary, you must indicate that you want to use flight preferences by 
choosing the Use Preferences option in the Select Flight dialog box.

How to display the Flight tab

Dialog Box Options

Traveler
Displays the name of the traveler associated with this profile.

Profile Name
Enter a name for the profile.    For example, Quarterly Sales Meetings.

Tab Options

Preferred Airlines
Select the traveler's preferred airlines.    To remove a preferred airline without replacing it, 
choose the "None" option.    If you use preferences to find flights, United Connection 
displays only flights operated by the primary traveler's preferred airlines.
Note    United Airlines is preset as one of the preferred airlines.    This selection cannot be changed.    If the primary 
traveler has not selected second and third preferred airlines and preferences are used to find flights, only United 
Airlines flights will appear.

Preferred Service Class
Select a service class.    Options include First, Business, Coach/Economy, and Any.    The 
default option is Any.    If you use preferences to find flights, United Connection  displays 
only flights that have seats available in the primary traveler's preferred service class.

Acceptable Fare Restrictions
Select the fare restrictions the traveler is willing to accept when pricing a flight.    These 
include:
· Minimum Stay Required
· Maximum Stay Required
· Advance Purchase Required

By default, all fare restrictions are selected.    If you use preferences to find flights, United 
Connection searches for fares based on the primary traveler's fare restrictions.

See also
How flight preferences are used 



Specifying flight preferences 
Entering profile information 
Changing flight preferences and services 
Trip Profiles dialog box 



    Flight Requests tab
(Trip Profiles dialog box)

The Flight Requests tab contains the traveler's flight service request information, including 
preferred seating, special meals, and special services.    When you reserve a flight, each 
traveler's flight requests are forwarded to the airline.    You can also change flight service 
requests when you add a flight to an itinerary  see Requesting flight services for more 
information.
Important    United Connection  cannot guarantee flight service requests 

 please call the airline directly to confirm your requests.

How to display the Flight Requests tab

Dialog Box Options

Traveler
Displays the name of the traveler associated with this profile.

Profile Name
Enter a name for the profile.    For example, Quarterly Sales Meetings.

Tab Options

Preferred Seating
Select the traveler's seating preference.    Seating options include:
· Any Seat
· Aisle Seat
· Window Seat
The default is Aisle Seat.

Preferred Meal
If the traveler requires a special meal (for example, for medical or religious reasons), select
their special meal preference in the Preferred Meal field.    The default option is No Special 
Request.    When you reserve a flight, each traveler's meal requests are forwarded to the 
airlines.    Special meals must be requested at least 24 hours prior to departure.
Note    Certain restrictions apply to special meal requests  see Requesting special meals for information about 
available meals, dietary guidelines, and restrictions.

Special
Select any special services the traveler requires.    For example, you can request a 
wheelchair for use at the airport.
Note    Wheelchair users must be able to ascend and descend stairs.    If the traveler needs further assistance, 
please contact the airline directly.

See also
Specifying flight service requests 
Entering profile information 



Changing flight preferences and services 
Trip Profiles dialog box 



    Car tab
(Trip Profiles dialog box)

The Car tab contains the traveler's rental car preferences, including preferred rental 
companies, preferred car types, acceptable rental rate range, in-terminal facilities, and 
unlimited mileage.    At your option, United Connection  can use the primary traveler's rental
car preferences to narrow the search for acceptable rental cars.    You can also change rental 
car preferences on the fly 

 see Editing preferences for the current rental car for more information.
Important    When adding a rental car to an itinerary, you must indicate that you want to use car preferences by 
choosing the Use Preferences option in the Select Rental Car dialog box.

How to display the Car tab

Dialog Box Options

Traveler
Displays the name of the traveler associated with this profile.

Profile Name
Enter a name for the profile.    For example, Quarterly Sales Meetings.

Tab Options

Preferred Rental Companies
Select the three rental companies the traveler most prefers.    The default option is None.    
If you use preferences to find rental cars, United Connection displays only the primary 
traveler's preferred rental companies.

Preferred Car Types
Select the three car types the traveler most prefers.    The default option is None.    If you 
use preferences to find rental cars, United Connection displays only rental companies that 
offer the primary traveler's preferred car types.

Search Within Price Range
Select this option if the traveler wants United Connection to display only rental companies 
that offer rates within a specified price range.    After selecting this option, you must enter 
dollar amounts in the Highest Rate and Lowest Rate fields.
Note    If this option is de-selected, any amounts specified in the Highest Rate and Lowest Rate fields are ignored.

Highest Rate
Enter the highest daily rate the traveler wants to pay for a rental car.

Lowest Rate
Enter the lowest daily rate the traveler wants to pay for a rental car.

If you use preferences to find rental cars, United Connection displays only rental 
companies that offer rates within the rate range specified in the primary traveler's profile.

In Terminal Facilities



Rental car company service desks are located either inside the airport terminal or at a 
remote airport location (which may require shuttle service).    Select this option if the 
traveler prefers to rent a car from companies that have a desk inside the airport terminal.   
If you use preferences to find rental cars, United Connection displays only rental 
companies that have a service desk inside the airport terminal.

Unlimited Mileage
Select this option if the traveler prefers to rent from companies that offer an unlimited 
mileage plan.    If you use preferences to find rental cars, United Connection displays only 
rental companies that offer unlimited mileage rental plans.

See also
How rental car preferences are used 
Specifying rental car preferences 
Entering profile information 
Changing rental car preferences and services 
Trip Profiles dialog box 



    Car Requests tab
(Trip Profiles dialog box)

The Car Requests tab contains the traveler's car request profile information, including 
requests for infant/toddler car seats, a mobile phone, a car equipped with hand controls for a
physically challenged driver, or a car equipped for handling skis.

When you reserve a rental car and the primary traveler's profile includes rental car requests,
United Connection  forwards those requests to the rental car company.    You can also 
change rental car service requests when you add a rental car to an itinerary 

 see Requesting rental car services for more information.
Important    United Connection cannot guarantee rental car service requests  please call the rental car company 
directly to confirm your requests.

How to display the Car Requests tab

Dialog Box Options

Traveler
Displays the name of the traveler associated with this profile.

Profile Name
Enter a name for the profile.    For example, Quarterly Sales Meetings.

Tab Options

Infant Car Seat
Select this option to request an infant car seat.

Toddler Car Seat
Select this option to request a toddler car seat.

Car Equipped for Physically Challenged Driver
Select this option to request a car equipped for a physically challenged driver.    You must 
also specify whether the traveler will need left-hand or right-hand controls.

Left-Hand Controls
Select this option to request a car with left-hand controls.

Right-Hand Controls
Select this option to request a car with right-hand controls.

Mobile Phone Requested
Select this option to request a car equipped with a mobile phone.

Ski-Equipped Car
Select this option to request a rental car equipped with a ski rack, snow tires, etc.

Associated Frequent Flyer Program
Select the frequent flyer program the traveler wants to associate with rental cars.
When you reserve a rental car and the primary traveler's profile includes an associated 



frequent flyer program for rental cars, United Connection will forward the primary 
traveler's membership number to the rental car company.    If the selected frequent flyer 
program has a promotional agreement with the rental company, the primary traveler may 
be eligible for any benefits offered under that promotion.
Important    Other restrictions may apply  please contact the rental car company or your frequent flyer program 
for details.    You may be required to show proof of program membership (for example, your frequent flyer card) at 
pick-up.

Note    The Associated Frequent Flyer Program field contains a list of frequent flyer programs entered for the current 
traveler.    For help entering frequent flyer account information, see Entering travel program information. 

See also
Specifying rental car service requests 
Entering profile information 
Changing rental car preferences and services 
Trip Profiles dialog box 



    Hotel tab
(Trip Profiles dialog box)

The Hotel tab contains the traveler's hotel profile information, including preferred hotel 
chains, occupancy, amenities, rate category, acceptable rate range, and most important 
preference.    At your option, United Connection  can use the primary traveler's hotel 
preferences to narrow the search for acceptable hotel accommodations.    You can also 
change hotel preferences on the fly 

 see Editing preferences for the current hotel room for more information.
Important    When adding hotel accommodations to an itinerary, you must indicate that you want to use hotel 
preferences by choosing the Use Preferences option in the Select Hotel dialog box.

How to display the Hotel tab

Dialog Box Options

Traveler
Displays the name of the traveler associated with this profile.

Profile Name
Enter a name for the profile.    For example, Quarterly Sales Meetings.

Tab Options

Preferred Hotel Chains
Select the three hotel chains the traveler most prefers.    The default option is None.    If you
use preferences to find hotel rooms, United Connection displays only the primary traveler's
preferred hotel chains (if available).

Preferred Occupancy
Select the traveler's preferred room occupancy (Single or Double).    The default is double 
occupancy.    If you use preferences to find hotel rooms, United Connection displays only 
hotels that offer the primary traveler's preferred occupancy type (if available).

Preferred Amenities
Select up to eight of the traveler's preferred amenities.    If you use preferences to find 
hotel rooms, United Connection displays only hotels that offer all the primary traveler's 
preferred amenities (if available).

Preferred Rate Category
Select the traveler's preferred rate category for this profile.    The default option is 
Standard.    If you use preferences to find hotel rooms, United Connection displays hotels 
that have rooms available in either of the following rate categories:
· Standard rate
· Primary traveler's preferred rate category

Search Within Price Range
Select this option if the traveler wants hotels that offer rates within a specified price range.
After selecting this option, you must enter dollar amounts in the Highest Rate and Lowest 



Rate fields.
Note    If this option is de-selected, any amounts specified in the Highest Rate and Lowest Rate fields are ignored.

Highest Rate
Enter the highest acceptable room rate (per night).

Lowest Rate
Enter the lowest acceptable room rate (per night).

If you use preferences to find hotel rooms, United Connection displays only hotels that 
offer rates within the rate range specified in the primary traveler's profile (if available).

Which Is Most Important To You?
Select the hotel preference that is most important to the traveler: Hotel Chain, Room 
Rates, or Amenities.    The default option is Hotel Chain.    When United Connection checks 
for available hotels, it tries to find hotels that meet all the primary traveler's preferences.    
However, it places a higher priority on finding hotels that meet the Most Important 
preference.

See also
How hotel preferences are used 
Specifying hotel preferences 
Entering profile information 
Changing hotel preferences and services 
Trip Profiles dialog box 



    Hotel Requests tab
(Trip Profiles dialog box)

The Hotel Requests tab contains the traveler's hotel profile information, including late arrival
guarantee, number of additional guests in room, and number of additional beds required.

When you reserve a hotel room and the primary traveler's profile includes hotel requests, 
United Connection  forwards those requests to the hotel.    You can also change hotel service
requests when you add hotel accommodations to an itinerary 

 see Requesting hotel services for more information.
Important    United Connection cannot guarantee hotel service requests  please call the hotel directly to confirm 
your requests.

How to display the Hotel Requests tab

Dialog Box Options

Traveler
Displays the name of the traveler associated with this profile.

Profile Name
Enter a name for the profile.    For example, Quarterly Sales Meetings.

Tab Options

Guarantee Room For Late Arrival
Select this option to hold the hotel room regardless of arrival time at the hotel.    A credit 
card will be required to guarantee the room.    See Guaranteeing hotel rooms for more 
information.

Additional Adults In Room
Specify the number of additional adults that will be sharing the room.
Note    This applies to additional adults in a double-occupancy room only.    Do not include the first two occupants in
this field.    For example, if three adults will be sharing a double-occupancy room, select "1" for Additional Adults in 
Room.

To request double occupancy, select "2" in the Occupancy field (Hotel tab).

Additional Children In Room
Specify the number of children that will be sharing the room.
Note    This applies to additional children in a double-occupancy room only.    Do not include the first two occupants 
in this field.    For example, if one adult and two children will be sharing a double-occupancy room, select "1" for 
Additional Children in Room.

To request double occupancy, select "2" in the Occupancy field (Hotel tab).

Roll-Away Beds Required
Specify the number of roll-away beds required.

Cribs Required
Specify the number of cribs required.



Associated Frequent Flyer Program
Select the frequent flyer program you want to associate with hotel reservations.
When you reserve a hotel room and the primary traveler's profile includes an associated 
frequent flyer program for hotels, United Connection will forward the primary traveler's 
membership number to the hotel.    If the selected frequent flyer program has a 
promotional agreement with the hotel, the primary traveler may be eligible for any 
benefits offered under that promotion.
Important    Other restrictions may apply  please contact the hotel or your frequent flyer program for details.    You
may be required to show proof of program membership (for example, your frequent flyer card) at check-in.

Note    The Associated Frequent Flyer Program field contains a list of frequent flyer programs entered for the current 
traveler.    For help entering frequent flyer account information, see Entering travel program information. 

See also
Specifying hotel service requests 
Entering profile information 
Changing hotel preferences and services 
Trip Profiles dialog box 
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Overview:    Adding flights

Adding flights to your itinerary is a two-step process: flight planning, followed by flight 
selection.    You plan a flight by specifying an origin, destination, departure date, and 
departure time.    Once this information is complete, you're ready to select a flight.

United Connection  gives you two ways to select flights:
· Based on schedule  choose flights that depart and arrive when it is most convenient for 

you.
· Using FareShopper  

 choose an acceptable fare, then select from flights available at that fare.

Choosing flights based on schedule gives you the most flexibility.    If fare is not an issue, 
simply choose the flight that best meets your scheduling needs.    After you select your 
flights, United Connection quotes a fare for those flights based on the service class and fare 
restrictions you specify.
If getting a low fare is important, use FareShopper .    When you select this option, United 
Connection finds a range of low fares for your itinerary and then displays flights offering that
fare.    Note that lower fares may have more restrictions, and may offer a limited selection of 
flights.

See also
Planning a flight 
Selecting flights based on schedule 
Using FareShopper  to select flights 



Planning a flight

After you select travelers for your itinerary, you are ready to begin planning your flights.

To plan a flight:
1. In the Itinerary Window, choose the Add Flight icon from the toolbar.    The Add Flight 

dialog box appears.
2. Complete the Add Flight fields as follows:

In this field You can

From Enter or select the departure city/airport.
If you don't know the airport name, click on the down
arrow next to the Airport field to search by city, 
airport, or airport code.    See Using the Airport 
Search option for more information.
Tip The primary traveler's home airport is supplied 
as the departure airport for the first flight in your 
itinerary.    If necessary, edit the primary traveler's 
personal information and supply a home airport.

To Enter or select the destination city/airport.

Date Enter or select the departure date.

Time Enter or select your preferred departure time.
Note    United Connection  searches for flights that 
depart up to 30 minutes before the time you specify, 
as well as flights at or after that time.

3. To continue, do one of the following:
· To view a list of available flights, choose the Find Flights button.    See Selecting flights

based on schedule for more information.
· If you plan to use FareShopper  (or simply want to leave the flight in Planned status 

for now), choose OK.    The Itinerary Window is updated to include the planned flight.

Note    If you create your own connecting flights, you must leave at least 60 minutes between flights (90 minutes for 
connections to or from international locations) to allow adequate time to change planes.    If you select a flight that 
does not adhere to these guidelines you will not be able to add it to your itinerary.

See also
Add Flight dialog box 
Selecting flights based on schedule 
Using FareShopper to select flights 



Using the Airport Search option

United Connection  lets you search for airports by city name, airport name, or airport code.   
The Airport Search option appears automatically when you click on the down arrow next to 
any field in which you need to specify a location.    This includes:
Dialog box: Field name
Personal tab (Traveler Information dialog box) Home Airport

Add Flight dialog box From, To

Add Car dialog box Airport

Add Hotel dialog box Location

Check Flight Status dialog box From

Mileage Plus  Miles Between Cities dialog box From, To

To search for an airport (or location):
1. Click on the down arrow next to one of the fields listed above.    The Airport Search option

appears.
Note    The United Airlines logo appears next to airports and cities served by United or United Express.

2. To search for airports or locations in the United States only, select the U.S. Only option.    
If you do not select this option, the list will display both U.S. and foreign locations.
Setting the default: To choose U.S. Only as the default, double-click on this option. The
text is displayed in blue when the default state is selected.

3. Select one of the following search options:
· Cities.    The left column displays a list of cities in alphabetical order.    The right 

column displays the airport(s) associated with that city.
· Airports.    The left column displays a list of airport names in alphabetical order.    The

right column displays the city in which the airport is located.
· Location Codes.    The left column displays a list of three-letter airport and location 

codes in alphabetical order.    The right column displays the airport name and the city 
in which the airport is located.

Setting the default: The name of the default search option is displayed in blue text.    
Double-click on the option you want to set as the default.

4. Scroll down the list to find the airport or location you want to select.    To scroll quickly to 
a particular section of the list, type the first few letters of the city name, airport name, or
airport code you are looking for.

5. When you find the airport or location you want to select, click on that entry to select it.

See also
Personal tab 
Add Flight dialog box 
Add Car dialog box 



Add Hotel dialog box 



Selecting flights based on schedule

Follow these steps to view and select flights based on your schedule.
Tip    If finding a low fare is more important than schedule, use FareShopper  to select your flights.    See Using 
FareShopper to select flights for more information.

To select a flight based on schedule:
1. In the Itinerary Window, choose the Add Flight icon from the toolbar and enter planning 

information for this flight.    See Planning a flight for more information.
2. Choose the Find Flights button.    The Select Flight dialog box appears.

Note    If you are not already connected to the reservation system, you will be prompted to connect in order to 
display the Select Flight dialog box.

3. Review the list of available flights and determine whether one meets your needs.    
Flights are displayed by number of stops (non-stops, 1-stops, etc.), then by time.    See 
the Select Flight dialog box for a full description of this dialog box.
Important    To display flights based on the primary traveler's flight preferences, you must select the Use 
Preferences option.    If Use Preferences is not selected, United Connection  displays all flights to your 
destination that have seating available.

4. To view operation and service details for a flight, highlight that flight and choose the 
Details button.    The Flight Details dialog box appears.    Choose Close to return to the 
Select Flight dialog box.

5. After reviewing the flight list, do one of the following:
· If you find a flight that meets your needs, highlight it and continue with step 6.

Note    If you create your own connecting flights, you must leave at least 60 minutes between flights (90 
minutes for connections to or from international locations) to allow adequate time to change planes.    If you 
select a flight that does not adhere to these guidelines you will not be able to add it to your itinerary.

· If none of the flights meets your needs, you can modify the flight list by adding, 
removing, or changing flight preferences.    See Changing the list of available flights 
for more information.

6. If you selected a United Airlines or United Express flight, you can use the seat map to 
select specific seat assignments for that flight.
Choose the Seat Map button, then select seats for all travelers in your itinerary.    See 
Selecting seats using the seat map for more information.    After selecting your seats from
the seat map, continue with step 9.

7. If you are not using the seat map to select seats, choose OK in the Select Flight dialog 
box to select the highlighted flight.    The Confirm Service Class dialog box appears.

8. Select a service class for this flight and choose OK.    The Flight Service Requests 
Summary dialog box appears.

9. View and/or edit the flight services for each traveler.    See Requesting flight services for 
more information.
Note The Sit Together option is automatically selected as the default seating option in all itineraries with two or 
more travelers.    On airlines other than United and United Express, this is the only available seating option.



10. When you are satisfied with the service requests, choose OK.    United Connection 
prompts you to add another flight:
· To plan another flight, choose Yes.    The Add Flight dialog box appears.    Enter the 

planning information for your next flight.
· To return to the Itinerary Window without adding another flight, choose No.

Note    The airfare for your itinerary is displayed in the Totals area of the Itinerary Window.    This airfare is 
not guaranteed until you pay for your tickets.

See also
Viewing flight details 
Selecting seats 
Selecting a service class 
Select Flight dialog box 



To display the Select Flight dialog box, do one of the following:
· To add a new flight to your itinerary:

a. Choose the Add Flight icon from the toolbar.
b. In the Add Flight dialog box, enter the required planning information and choose 

the Find Flights button.

· To modify a Planned or Selected flight:
In the Itinerary Window, highlight the flight and choose the Find icon from the toolbar.

Note    If you are not already connected to the reservation system, you will be prompted to connect in order to 
display the Select Flight dialog box.



Use Preferences option
If you want to use preferences to limit the flights displayed by United Connection , you 
must select the Use Preferences option in the Select Flight dialog box.    When you select 
this option, United Connection displays only flights operated by the primary traveler's 
preferred airlines that have seating available in the primary traveler's preferred service 
class.    If you wish, you can edit these preferences for the current flight.    See Editing 
preferences for the current flight for more information.



Sit Together option
Sit Together is the default seating option in all itineraries with two or more travelers.    
When you reserve your itinerary, United Connection  will forward the primary traveler's 
seating preference (for example, Aisle) to the airline and request adjoining seats for all 
other travelers in the itinerary.    If you choose this option for a connecting flight, the airline
will attempt to assign adjoining seats on all segments of that flight.
Note    Selecting this option will remove any seats selected from the seat map.



    How flight preferences are used
Flight preferences are specified in the Flight tab of the traveler profile.    United Connection  
uses the flight preferences from the primary traveler's profile as the defaults.    If you wish, 
you can change flight preferences on the fly 

 as you add flights to your itinerary.    See Editing preferences for the current flight for more 
information.
Important    When adding a flight to your itinerary, you must indicate that you want to use flight preferences by 
choosing the Use Preferences option in the Select Flight dialog box (or in the Select FareShopper  Fares dialog 
box).

Preferences are used as follows:

Preferred Airlines
Select Flight dialog box:    United Connection displays only flights operated by the primary 
traveler's preferred airlines.    If no flights are available on any preferred airline, United 
Connection displays available flights on other airlines.
Select FareShopper  Fares dialog box: United Connection displays only fares available on 
flights operated by the primary traveler's preferred airlines.

Preferred Service Class
Select Flight dialog box:    United Connection displays only flights that have seats available in
the primary traveler's preferred service class.    If no flights have seats available in the 
preferred service class, or if the primary traveler has not selected a preferred service class, 
United Connection displays flights with availability in any service class.
The Preferred Service Class option is ignored in FareShopper, which returns the lowest 
available fares regardless of class.
Note    If Business class is requested, the reservation system may also return First Class fares that are close in price 
to the Business class fares.

Acceptable Fare Restrictions

Fare restrictions include:
· Minimum Stay Required
· Maximum Stay Required
· Advance Purchase Required
United Connection prices the itinerary based on the primary traveler's fare restrictions.    If 
no available fare meets all of the selected restrictions, United Connection will return a less 
restrictive fare (it will never return a more restrictive fare.)

See also
Editing preferences for the current flight 
Flight Preferences dialog box 
Select Flight dialog box 



Changing the list of available flights

If the flights listed in the Select Flight dialog box do not meet your needs, you can update 
the list of available flights using one or more of the following options:
· If available, choose the More Flights button.    United Connection  displays additional 

flights to your destination.
· If the Use Preferences option is not selected, select this option.    United Connection 

updates the flight list to display all flights to your destination that conform to the flight 
preferences in the primary traveler's profile.

· If the Use Preferences option is selected, de-select this option.    United Connection 
updates the flight list to display all flights to your destination that have seating available.

· Change flight preferences for this flight.    See Editing preferences for the current flight 
for more information.
Note    The Use Preferences option must be selected for the changes to take effect.

· If your schedule allows, consider planning your flight on a different date when more 
flights might be available.    Choose Cancel to display the Add Flight dialog box, then 
change the specified departure date.

See also
How flight preferences are used 
Selecting flights based on schedule 
Select Flight dialog box 



Requesting flight services

After selecting a flight, you can request flight services for all travelers.    Flight services 
include seating, meals, and special services.    The flight service requests from each 
traveler's profile are used as the default services for that traveler.    When you reserve your 
itinerary, United Connection  forwards each traveler's service requests to the appropriate 
airline(s).    You request flight services from the Flight Service Requests Summary dialog box.

How to display the Flight Service Requests Summary dialog box

To request flight services:
1. Display the Flight Service Requests Summary dialog box.
2. To request specific seats using the seat map, choose the Seat Map button.    See 

Selecting seats using the seat map for more information.
Note    Seat maps are only available for United Airlines and United Express flights.

3. The Sit Together option is automatically selected as the default seating option for all 
itineraries with two or more travelers.    On airlines other than United and United Express,
Sit Together is the only available seating option.

4. To change a traveler's seating preference, meal request, or special service request, 
select that traveler in the Flight Services For field.    That traveler's service requests are 
displayed.

5. Select the flight segment whose services you want to change and choose the Edit 
button.    The Flight Service Requests dialog box appears.
Note  For connecting flights, services apply to individual flight segments.    Be sure to select and modify the 
services for each segment.

6. Select the desired flight service requests:

In this field You can

Seating Select the traveler's preferred seating option.    If you
have already selected a specific seat for this 
traveler, that seat number appears in the list.

Meal If the traveler requires a special meal (for example, 
for medical or religious reasons), select their special
meal preference in the Meal field.    The default 
option is No Special Request.    Special meals must 
be requested at least 24 hours prior to departure.
Note    See Requesting special meals for information
about available meals, dietary guidelines, and 
restrictions on special meals.

Special If the traveler requires any special services, select 
those services in the Special field.    For example, 
you can request a wheelchair for use at the airport.
Note    Wheelchair users must be able to ascend 
and descend stairs.    If further assistance is 
required, please contact the airline directly.

7. Choose OK.    The Flight Service Requests Summary dialog box appears.



8. Repeat this process as necessary for each flight segment and traveler.
9. To exit the Flight Service Requests Summary dialog box, choose OK.

See also
Selecting seats 
Reviewing flight services 
Flight Service Requests Summary dialog box 
Flight Service Requests dialog box 



Reviewing flight services

You can review service requests for any flight in your itinerary.    Service requests include 
seating, meals, and special services.

To review flight service requests:
1. In the Itinerary Window, double-click on the flight whose services you want to review.    

The Edit Flight dialog box appears.
2. Choose the Requests button.    The Flight Service Requests Summary dialog box appears.
3. In the Flight Services For field, select the traveler whose flight services you want to 

review.    That traveler's services are displayed.
Note    For connecting flights, services are displayed for each segment.

4. If you arranged any special services directly through the airline (for example, allowance 
for excess or oversized baggage), choose the More Info button to display those services.

5. You can change seating, meal, or special service requests for any traveler.    Select one of
the following options to see more information about that option:
Changing a seat assignment 
Changing a meal request 
Changing a wheelchair request 

6. To exit the Flight Service Requests Summary dialog box, choose OK.

See also
Selecting seats 
Flight Service Requests Summary dialog box 
Flight Service Requests dialog box 



To display the Flight Service Requests Summary dialog box:
· If you are selecting a flight based on schedule, the Flight Service Requests Summary 

dialog box appears automatically after you select a flight.
· In the Select FareShopper  Flights dialog box, highlight a flight and choose the 

Requests button.
· From the Itinerary Window, double-click on a selected flight.    The Edit Flight dialog box

appears.    Choose the Requests button.



Selecting seats

United Connection  gives you two ways to request seating on a flight:
· By specific seat number.    The Seat Map option lets you choose specific seats for each 

traveler in the itinerary.    This option is only available for United Airlines and United 
Express flights.

· By seat preference.    Each traveler's seating preference is specified in his or her profile
but can be changed for the current flight.

Note    Some airlines, such as Shuttle by United, do not assign advance seating.    If you need additional information, 
please contact the airline directly.

About the Seat Map option
United Connection's Seat Map option displays the aircraft seating layout.    Available seats 
are shown in white.    Separate "maps" are provided for each available service class.    Note 
that you must select seats in the same service class for everyone in the itinerary.
Premier travelers can select seats in the Premier seating area (when available).    If a Premier
traveler is accompanied by a single non-Premier companion, both travelers may select seats
in the Premier area.
You access the Seat Map option from either the Select Flight dialog box or the Flight Service 
Requests Summary dialog box.    See Selecting seats using the seat map for additional 
information.

Exit row seat restrictions
On the seat map, exit rows are marked with an arrow.    FAA safety rules require that 
passengers sitting in exit row seats must be able-bodied and willing to assist the crew in the 
event of an emergency.    See Exit row seat restrictions for more information.

Seating preferences
When the Seat Map option is not available, or if you choose not to use it, the seating 
preference specified in each traveler's profile is forwarded to the airline.    Seating 
preferences can be changed at the time of flight selection.    See Requesting flight services 
for more information.

Sit Together option
United Connection provides a Sit Together option, which appears in the Flight Service 
Requests Summary dialog box.    The Sit Together option is automatically selected as the 
default seating option in all itineraries with two or more travelers.    On airlines other than 
United and United Express, this is the only available seating option.
When you reserve your itinerary, United Connection will forward the primary traveler's 
seating preference (for example, Aisle) to the airline, and request adjoining seats for all 
other travelers in the itinerary.    If you choose this option for a connecting flight, the airline 
will attempt to assign adjoining seats on all segments of that flight.
Note    Selecting this option will remove any specific seats selected from the seat map.



Seating options for infants (under the age of 2)
You are not required to purchase a seat for a child under the age of 2.    However, certain 
restrictions apply:
· Each adult may hold only one infant in his or her lap.
· You will not be able to reserve your seats through United Connection if your itinerary 

includes more than one infant who will be sitting in a parent or guardian's lap.    Safety 
guidelines require that you contact the airline directly for your seat assignments.

You specify whether you wish to purchase a seat for an infant in the Select Travelers dialog 
box, when you add the infant to your itinerary.    See Seating options for infants for more 
information.

See also
Select Seats dialog box 
Flight Service Requests Summary dialog box 
Flight Service Requests dialog box 



Selecting seats using the seat map

United Connection's Seat Map option lets you choose specific seats using a seating layout of 
the aircraft associated with the selected flight (for example, a 747 or DC-10).
The seat map appears in the Select Seats dialog box.    Separate maps are provided for each 
available service class.    Premier travelers can select seats in the designated Premier seating
area (if available), as can a single non-Premier companion.
Note    Seat maps are available for United Airlines and United Express flights only.

To select specific seats using the seat map:
1. Display the Select Seats dialog box.
2. In the From field, select the flight segment for which you want to choose seats.

Note    If the selected flight is a Non-Stop flight, a single flight segment appears.

3. In the Traveler list, select the Traveler for whom you want to select a seat.
4. Select a tab (First, Business, or Coach/Economy) to display the seat map for that service 

class.    You must select seats in the same service class for all travelers in the itinerary.
Note    If you are selecting seats from FareShopper , only the Coach seat map will be available (unless the 
primary traveler has specified a preference for Business or First Class).

5. Click on the seat you want to choose.    Available seats are shown in white.    Unavailable 
seats are shown in gray.    You can also select from the list of Available Seats.
Note    Exit rows are marked with an arrow.    FAA safety rules require that passengers sitting in exit row seats 
must be able-bodied and willing to assist the crew in the event of an emergency.    See Exit row seat restrictions 
for more information.

6. Repeat this process to select a seat for each traveler on each flight segment.
7. When you are finished, choose OK.
Note    If you change your seat assignment after receiving your ticket, your boarding pass will be invalid.    Please 
contact the gate agent at check-in for a new boarding pass.

See also
Selecting seats 
Changing a seat assignment 
Select Seats dialog box 



To display the Select Seats dialog box, do one of the following:
· In the Select Flight dialog box, highlight a flight and choose the Seat Map button.
· In the Select FareShopper  Flights dialog box, highlight a flight and choose the Seat 

Map button.
· In the Flight Service Requests Summary dialog box, choose the Seat Map button.
· In the Itinerary Window:

a. Double-click on a selected flight.
b. In the Edit Flight dialog box, choose the Requests button.
c. In the Flight Service Requests Summary dialog box, choose the Seat Map button.



Viewing flight details

Flight details include operation and service information about a selected flight.

How to display the Flight Details dialog box

To view the flight details:
1. Display the Flight Details dialog box.
2. Review the flight information.

Note    Columns are resizable.    If a column contains more information than can be displayed in the current width,
an ellipsis (...) appears after the text.    To re-size the column, use the mouse to drag the column divider left or 
right.

3. To exit the dialog box, choose Close.

See also
Flight Details dialog box 
Select Flight dialog box 



To display the Flight Details dialog box, do one of the following:
· In the Select Flight dialog box, highlight a flight and choose the Details button.
· In the Select FareShopper  Flights dialog box, highlight a flight and choose the Details 

button.
· In the Itinerary Window, double-click on a selected flight.    In the Edit Flight dialog box,

choose the Details button.



Editing preferences for the current flight

At your option, United Connection  can use flight preferences to narrow the search for 
acceptable flights (in the Select Flight dialog box) or fares (in FareShopper

).    Flight preferences include Preferred Airlines, Preferred Service Class, and Acceptable 
Fare Restrictions.    Flight preferences from the primary traveler's profile are used as the 
defaults.    If you wish, you can edit these preferences as you add flights to your itinerary.
Important    When adding a flight to your itinerary, you must indicate that you want to use flight preferences by 
choosing the Use Preferences option in the Select Flight dialog box (or in the Select FareShopper  Fares dialog 
box).

To edit preferences for the current flight:
1. Display the Flight Preferences dialog box.
2. Update the flight preference fields as follows:

In this field You can

Preferred Airlines Select the traveler's second and third preferred 
airlines.
Note    United Airlines is preset as the first preferred 
airline and cannot be changed.

Preferred Service 
Class

Select a service class.    Options are First, Business,
Coach/Economy, or Any.
Note    Because FareShopper is designed to find the
lowest available fares, it ignores the Preferred 
Service Class option.

Acceptable Fare 
Restrictions

Select the fare restrictions the traveler is willing to 
accept when pricing a flight.    These include:
· Minimum Stay Required

· Maximum Stay Required

· Advance Purchase Required

United Connection will look for fares based on the 
specified fare restrictions.    If no available fare 
meets all of the selected restrictions, United 
Connection will return a less restrictive fare (it will 
never return a more restrictive fare).

3. If you want to save the new preferences in the primary traveler's profile, choose the 
Update Profile button (this is optional).

4. To apply the new preferences, choose OK.    An updated list appears.

See also
How flight preferences are used 
Flight Preferences dialog box 
Select Flight dialog box 
Select Fare Shopper Fares dialog box 





Selecting a service class

You must specify a service class for each flight in your itinerary.    Service class is used to 
price your airfare and assign seats (if you do not select them from the seat map).    You can 
select a service class in one of two ways:
· In the Select Seats dialog box (by selecting seats in that class)
· In the Confirm Service Class dialog box (after selecting a flight)

To select a service class in the Select Seats dialog box:
1. In the Select Flight dialog box, highlight the flight you want to select and choose the Seat

Map button.    The Select Seats dialog box appears.
2. Seat maps are displayed by service class.    Select the seat map for the service class you 

want to choose.
3. Select seats for all travelers in your itinerary.    All travelers in an itinerary must sit in the 

same service class.    If you selected a connecting flight, be sure to select seats for all 
flight segments.

4. Choose OK to display the Flight Service Requests Summary dialog box.    The seats you 
selected are displayed in the table.

See Selecting seats using the seat map for more information.

To select a service class in the Confirm Service Class dialog box:
1. In the Select Flight dialog box, highlight the flight you want to select and choose OK.    

The Confirm Service Class dialog box appears.
2. Select the desired service class.    Unavailable service class options are grayed.
3. Choose OK to continue.

See also
Flight Preferences dialog box 
Select Seats dialog box 
Confirm Service Class dialog box 



To display the Flight Preferences dialog box:
· In the Select Flight dialog box or the FareShopper  Fares dialog box:

1. Select the Use Preferences option (if it is not already selected).
2. Choose the Edit button.    By default, United Connection  displays the flight 

preferences from the primary traveler's profile.

· In the Pricing Summary dialog box:
1. Select the Flight tab.
2. Choose the Restrictions button.    By default, United Connection displays the flight 

preferences from the primary traveler's profile.



Using FareShopper

FareShopper is a service provided exclusively by United Airlines to help you quickly find low 
fares for a specified itinerary.    Use this option if your schedule is flexible, and if finding a low
fare is more important than arriving or departing at a specific time.    FareShopper also 
includes the SuperShopper  option, which allows you to extend your search for low fares 
over a full 24-hour period, or even over a range of days.

Planning your flights
To use FareShopper, simply enter basic planning information for each flight in your itinerary

 that is, origin, destination, and departure date and time.    FareShopper searches the 
reservation system for available low fares based on the information you provided, then 
shows you a list of these fares.
Planning a flight 

Choosing a fare
For each displayed fare, United Connection  also shows you the airlines offering that fare, 
and the applicable fare restrictions 

 for example, minimum or maximum stay requirements, purchasing deadline, change fees, 
and refundability.    If you wish, you can use flight preferences (preferred airlines and fare 
restrictions) to limit the available flights and fares.    Choose the fare that best meets your 
needs.
Selecting a fare in FareShopper 

Using SuperShopper
If your schedule is flexible, use the SuperShopper option to search for low fares over a full-
24-hour period (midnight to midnight on the dates you selected).    You can even extend this 
search over a range of days  up to two days before and after your planned travel dates.    
Note that this option is only available for itineraries of one or two segments.
Using SuperShopper

Choosing flights
Once you choose a fare, United Connection displays lists of flights available at that fare.    
You can view flight details, view and edit flight service requests, and even select seats using 
a seat map (on United and United Express flights only).    A separate list of available flights is
provided for each planned flight in your itinerary.    (Note that lower fares may offer a limited 
selection of flights.)    Choose the flights that best meet your needs.
Selecting flights in FareShopper 

See also
Overview: Adding flights 
Planning a flight 
Selecting flights based on schedule 



Selecting a fare in FareShopper

The first step in the FareShopper process is selecting a fare.

To select a fare in FareShopper:
1. After planning all of your flights, choose the FareShop icon from the Itinerary Window 

toolbar.    The Select FareShopper  Fares dialog box appears.
2. Review the list of available fares.    Fares are display from lowest to highest.    If 

necessary, scroll down to view more fares.    Next to each fare is shown:
· The restrictions associated with that fare
· The carriers offering that fare
· The days of the week on which the fare is available
Note    By default, United Connection  displays the most restricted Coach fares on all available airlines.    To 
display fares based on the primary traveler's flight preferences, you must select the Use Preferences option (the 
Preferred Service Class preference will be ignored).

3. To see detailed fare restrictions for a particular fare, highlight that fare.    The associated 
fare restrictions and change fees are displayed at the bottom of the dialog box.
Note    Change fee information is not available for international flights.    Please contact the airlines directly to 
obtain this information.

4. The setting of the Use Preferences option determines which fares and restrictions are 
displayed.    See using flight preferences for more information about setting this option.

5. If your schedule is flexible (and your itinerary includes no more than two segments), 
choose the SuperShop button to shop for low fares over a full 24-hour period or over a 
range of days. See Using SuperShopper  for more information.

6. To choose a fare, highlighted that fare and choose the Next button.    The Select 
FareShopper  Flights dialog box appears.    See Selecting flights in FareShopper for more 
information.

See also
Overview: Adding flights 
Planning a flight 
Editing preferences for the current flight 
Select FareShopper Fares dialog box 



To display the Select FareShopper  Fares dialog box:
1. Plan all flights in your itinerary.    See Planning a flight for more information.
2. In the Itinerary Window, select the FareShop icon from the toolbar.



Using flight preferences

The fares listed in the Select FareShopper  Fares dialog box are directly affected by the 
setting of the Use Preferences option:
· When the Use Preferences option is selected, United Connection  displays all available 

fares that conform to the primary traveler's Preferred Airlines and Acceptable Fare 
Restrictions.    Because FareShopper is designed to find the lowest available fares, it 
ignores the Preferred Service Class option.

· When the Use Preferences option is not selected, United Connection displays the most 
restricted fares on all available airlines.
See Editing preferences for the current flight for more information about changing flight 
preferences.

See also
How flight preferences are used 
Selecting a fare in FareShopper 
Flight Preferences dialog box 



Using SuperShopper
United Connection's SuperShopper feature extends the power of FareShopper  by allowing 
you to shop for low fares over a greater time period.    Normally, FareShopper looks for low 
fares within a limited time window, based on the departure times you selected in the Plan 
Flight dialog box.    SuperShopper searches for low fares over a full-24-hour period, from 
midnight to midnight on your planned departure dates.    You can even extend this search 
over a range of days 

 up to two days before and after your planned travel dates.
Note    This option is only available if your itinerary includes no more than two segments.

To use SuperShopper :
1. After planning your flights, choose the FareShop icon from the toolbar.    The Select 

FareShopper  Fares dialog box appears.
Note    For helpful hints about SuperShopper, choose the Hints button.

2. Choose the SuperShop button.    The SuperShopper  dialog box displays a date range 
selector for each flight, initially set to the planned date for that flight.

3. To search over the full 24-hour period on your original planned dates, choose the OK 
button without changing the date controls.

4. You can also extend your search over a range of days:
a. Move the Outbound slide controls left and right to specify the date range in which 

United Connection should search for outbound flights.    You can set the controls up to 
two days before and after the original planned departure date.

b. Repeat this process with the Inbound slide controls to specify the date range in which
to search for inbound flights.    United Connection searches the full 24-hour period for 
each day.

c. To begin searching for low fares, choose the OK button.
Note The greater the date range, the longer it will take United Connection to find flights.    The retrieval process 
may be quite lengthy if you choose the full 5-day range for both flights.

5. The Retrieving Fares dialog box shows the progress of the retrieval, and the lowest fare 
found so far.    When the retrieval process is complete, all available fares are displayed in 
the Select FareShopper  Fares dialog box.

6. To stop the retrieval process before it is complete, choose the Stop button.    The Select 
FareShopper  Fares dialog box displays the fares retrieved up to that point.

7. Review the fares displayed in the Select FareShopper  Fares dialog box.    The days on 
which each fare is available appear in the Outbound/Inbound column.

8. To choose a fare, highlighted that fare and choose the Next button.    The Select 
FareShopper  Flights dialog box appears.    See Selecting flights in FareShopper for more 
information.

See also
Selecting a fare in FareShopper 
Select Fare Shopper  Fares dialog box 

SuperShopper  dialog box 



Retrieving Fares dialog box 



Shopping hints

FareShopper  hints
· Shopping your preferred airlines
· Can I request a specific service class?
· How are flights displayed?
· Options that affect the fare display
· Cities with multiple airports
· Shopping for international itineraries 
· Change fees

SuperShopper  hints
· What is SuperShopper?
· When should I use SuperShopper?
· How long will it take?

See also
Using Fare Shopper
Using SuperShopper



Shopping for international itineraries

Flights from the U.S. to international destinations often depart at a specific time of day.    If 
you are traveling to an international destination, you may have better luck finding available 
flights if you enter the recommended departure time for that destination in the Plan Flight 
dialog box.    See the table below for recommended departure times.

Traveling West Coast Midwest East Coast

Via Atlantic 11 am - 1 pm 1-3 pm 3-5 pm

Via North Pacific 6 am 6 am 6 am

Via South Pacific 5-7 pm 3-5 pm 1-3 pm

To Central America 6-8 pm 2-4 pm 11 am - 1 pm

To South America 10 am - 12 pm 2-4 pm 4-6 pm

To the Caribbean 6-8 am or 8-10 pm 6-8 am 6-8 am

Also note:
· For flights to Europe via the Atlantic, lower fares are often displayed if you select the Use 

Preferences option in the Select FareShopper  Fares dialog box.
· For flights departing from India or Pakistan, select 1 AM as your departure time.
· For travel via both Atlantic and Pacific, or via both North Pacific and South Pacific, contact

the over-water carrier to see if a lower published fare is available.
           Print This Topic  

See also
Using Fare Shopper
Using SuperShopper



What is SuperShopper ?

United Connection s SuperShopper feature extends the power of FareShopper
 by allowing you to shop for low fares over a greater time period.

FareShopper looks for low fares within a limited time window, based on the departure times 
you selected in the Plan Flight dialog box.    SuperShopper searches for low fares over a full-
24-hour period, from midnight to midnight on your planned departure dates.    You can even 
extend this search over a range of days  up to two days before and after your planned 
travel dates.
Note    SuperShopper is only available if your itinerary includes no more than two flight segments.

           Print This Topic  

See also
Using Fare Shopper
Using SuperShopper



When should I use SuperShopper ?

Unless you need to depart or arrive at specific times, you can use SuperShopper to find 
lower fares for just about any itinerary.    SuperShopper searches for low fares over the entire
day (from midnight to midnight), so it is able to find low fares that might otherwise be 
missed.
If you need to travel on specific days, just leave the SuperShopper date controls set to your 
original planned dates.    If your schedule is more flexible, use the full power of SuperShopper
to search over a full 5-day range for each flight.
Note    SuperShopper is only available if your itinerary includes no more than two flight segments.

           Print This Topic  

See also
Using Fare Shopper
Using SuperShopper



How long will it take?

Because SuperShopper  is searching for low fares over a wide selection of flights (up to 
4,800), retrieval time may be lengthy.    Using a 14,400 baud modem, the approximate 
retrieval time for a two-person itinerary can range from 3 to 30 minutes, depending on the 
number of days you are searching.
Retrieval time can be affected by:
· Number of days.    The greater the range of dates you are searching, the longer your 

search will take.    You specify date ranges in the SuperShopper  dialog box. 
· Number of travelers.    The more travelers in your itinerary, the longer it will take to 

retrieve fares.
· Time of day.    Response time may be faster if you use SuperShopper during off-peak 

hours, from 7PM to 7AM.
Note    This refers to the time at which you are using your computer, not the departure time you select for your 
flights.

· Selected cities.    Retrieval time can vary widely from market to market.    In particular, 
shopping for international fares will take longer than shopping for domestic fares.

· Flight preferences.    Using flight preferences (select the Use Preferences option in the 
Select Fareshopper  Fares dialog box) can reduce retrieval times.

           Print This Topic  

See also
Using Fare Shopper
Using SuperShopper



How are flights displayed?

Flights are not sorted in any particular order, so be sure to scroll down to view the entire list 
when choosing flights.    You may find non-stop flights listed after connections, or earlier 
flights listed after flights that leave later in the day.

           Print This Topic  

See also
Using Fare Shopper
Using SuperShopper



Can I request a specific class?

You cannot shop for low fares in a specific class of service... for example, Business or First 
Class.
Because SuperShopper  is looking for the lowest fares it can find (regardless of service 
class), all available Coach fares will be displayed first.    Business and/or First Class fares will 
be displayed if no Coach fares are available.    If you specify a preference for Business or First
Class the preference will be ignored.

           Print This Topic  

See also
Using Fare Shopper
Using SuperShopper



Cities with multiple airports

For cities with multiple airports, be sure to specify the airport you want to use.
If you specify only the city name for a city with more than one airport (for example, New 
York), you may get flights that depart from one airport and return to another.    You specify 
departure and arrival airports in the Add Flight dialog box.

           Print This Topic  

See also
Using Fare Shopper
Using SuperShopper



Shopping your preferred airlines

Limiting the FareShopper  display to your preferred airlines will increase your chances of 
finding lower fares on those airlines.
If you prefer to travel with specific airlines, specify those airlines in the Flight Preferences 
dialog box (and be sure to select the Use Preferences option in the Select FareShopper  
Fares dialog box).    United Connection

 will display only fares that are available on your preferred airlines.
           Print This Topic  

See also
Using Fare Shopper
Using SuperShopper



Options that affect the fare display

United Connection  initiates a new search for low fares each time you:
· Select or de-select the Use Preferences option in the Select FareShopper Fares  dialog 

box
· Change your flight preferences
· Change one or both date ranges in the SuperShopper  dialog box and click OK
If you change one of these options and cannot find a previously displayed fare, return that 
option to its previous setting and repeat the search.

           Print This Topic  

See also
Using Fare Shopper
Using SuperShopper



Change fees

For domestic itineraries, the change fee information for a particular fare is displayed below 
the fares list when you highlight that fare.

If your itinerary includes international flights, United Connection  may not be able to show 
the change fee information.    If this information is not displayed when you highlight a fare, 
please contact the airlines directly to obtain it.

           Print This Topic  

See also
Using Fare Shopper
Using SuperShopper



Selecting flights in FareShopper

After selecting a fare in FareShopper, you are ready to select your flights.    You will need to 
select a separate flight for each planned flight in your itinerary.    For example, if you have 
planned a round trip itinerary, you will need to select two flights.
Note    If you selected a low fare with multiple restrictions, a limited number of flights may be available.

To select flights in FareShopper :
1. Highlight a fare in the Select FareShopper  Fares dialog box and choose the Next button. 

The Select FareShopper
 Flights dialog box appears.

This dialog box displays a list of available flights to the first destination in your itinerary.   
A separate tab appears for each day of the week.

2. If you used the SuperShopper  option to search over a range of days, more than one day
may be available.    Choose a tab to see the available flights for that day.    The tabs are 
disabled for days on which no flights are available.

3. Review the list of available flights to find one that meets your needs.    If necessary, scroll
down to view all available flights.
Tip    Click here to find out how United Connection  can automatically choose flights for you.

4. To view operation and service details for a flight, highlight that flight and choose the 
Details button.    The Flight Details dialog box appears.    Choose Close to return to the 
Select FareShopper  Flights dialog box.

5. After reviewing flights, do one of the following:
· If you find a flight that meets your needs, highlight it and continue with step 6.
· If none of the flights meets your needs, choose the Fares button to return to the 

Select FareShopper  Fares dialog box.    Select a different fare, then choose the Next 
button to view an updated flight list.

6. To see service requests for the selected flight, choose the Requests button. The Flight 
Service Requests Summary dialog box appears.
View and/or edit the flight services for each traveler.    See Requesting flight services for 
more information.

7. If you selected a United Airlines or United Express flight, you can use the seat map to 
select specific seat assignments for that flight.    See Selecting seats using the seat map 
for more information.

8. When you are ready to select your next flight, choose the Next button.    The Select 
FareShopper  Flights dialog box displays flights to the next destination in your itinerary.
Important    If you create your own connecting flights, you must leave at least 60 minutes between flights (90 
minutes for connections to or from international locations) to allow adequate time to change planes.    If you 
select a flight that does not adhere to these guidelines you will not be able to add it to your itinerary.

9. Repeat steps 2-8 for each flight in your itinerary.    When you have selected all flights in 
your itinerary, choose the Finish button to return to the Itinerary Window.



See also
Viewing flight details 
Selecting seats using the seat map 
Requesting flight services 
Select FareShopper  Flights dialog box 



Letting FareShopper  choose your flights automatically
If you wish, United Connection  can automatically choose flights for you in FareShopper.    
Simply choose Finish in the Select FareShopper

 Flights dialog box, then choose Yes when prompted to continue.    United Connection will 
select flights closest to the departure times you specified.



Changing a seat assignment

In most cases, you can change your seat assignment up to one hour before departure 
(provided that seats are still available).    Note that if you change seats after reserving your 
itinerary, the new seats must be selected from the same service class as the previous seats 
(Coach/Economy, Business, or First).
Note    For more information about seating options, see Selecting seats. 

To change a seat assignment:
1. Open the itinerary that contains the flight you want to change.
2. In the Itinerary Window, double-click on the flight you want to edit.
3. In the Edit Flight dialog box, choose the Requests button.    The Flight Service Requests 

Summary dialog box appears.
4. Do one of the following:

· To select a different seat using the seat map, choose the Seat Map button.    The 
Select Seats dialog box appears.    Select a traveler, then click on the seat you want 
to choose.    See Selecting seats using the seat map for more information.

· To request that all travelers in the itinerary sit in adjoining seats, choose the Sit 
Together option. This option is automatically selected as the default seating option in 
all itineraries with two or more travelers.    On airlines other than United and United 
Express, this is the only available seating option.

· To change a traveler's seating preference:
a. Select that traveler in the Flight Services For field.    The traveler's service 

requests are displayed.
b. Select the flight segment in which you want to change the seating preference and

choose the Edit button.    The Flight Service Requests dialog box appears.
Note For connecting flights, services apply to individual flight segments.    Be sure to select and modify 
services for each segment.

c. In the Seating field, select the traveler's preferred seating option.
d. Choose OK.    The Flight Service Requests Summary dialog box appears.
e. Repeat steps b-d for each flight segment in which you want to change a seating 

request.
5. To exit the Flight Service Requests Summary dialog box, choose OK.
6. In the Itinerary Window, choose the Reserve icon from the toolbar.    The Pricing Summary

dialog box appears.
7. Choose the Reserve button.    The Confirm Reservation dialog box appears.
8. To finalize your seating change request, choose Finish.    The Confirmation dialog box 

appears.    Choose OK.
Note    If you requested seating changes on a United Airlines or United Express flight, you will get an immediate 
response on the status of your request(s).    The response from other airlines may be delayed.    In this case, you 
should check your itinerary at a later time.



See also
Select Seats dialog box 
Flight Service Requests Summary dialog box 
Flight Services Requests dialog box



Changing a meal request

If the traveler requires a special meal (for example, for medical or religious reasons), you 
can select their special meal preference in the Preferred Meal field.    You can change a meal 
request up to 24 hours before departure.    When you request a special meal, United 
Connection  forwards this information to the appropriate airline but does not verify that the 
airline offers the requested meal type.    After a meal request is made, United Connection will
indicate whether the request has been confirmed or denied.
Note    Certain restrictions apply to special meal requests  see Requesting special meals for information about 
available meals, dietary guidelines, and restrictions.

To change your meal request:
1. Open the itinerary that contains the flight you want to change.
2. In the Itinerary Window, double-click on the flight you want to edit.
3. In the Edit Flight dialog box, choose the Requests button.    The Flight Service Requests 

Summary dialog box appears.
4. In the Flight Services For field, select the traveler whose meal request you want to 

change.    That traveler's service requests are displayed.
5. Select the flight segment you want to change the meal request for and choose the Edit 

button.    The Flight Service Requests dialog box appears.
Note    For connecting flights, services apply to individual flight segments.    Be sure to select and modify services
for each segment.

6. In the Meal field, select the traveler's preferred meal.    To cancel a special meal request, 
choose the No Special Request option.

7. Choose OK.    The Flight Service Requests Summary dialog box appears.
8. Repeat steps 5-7 for each flight segment in which you want to change a meal request.
9. To exit the Flight Service Requests Summary dialog box, choose OK.
10. In the Itinerary Window, choose the Reserve icon from the toolbar.    The Pricing Summary

dialog box appears.
11. Choose the Reserve button.    The Confirm Reservation dialog box appears.
12. To finalize your meal request, choose Finish.    The Confirmation dialog box appears.    

Choose OK.
Note    If you requested a special meal on a United Airlines or United Express flight, you will get an immediate 
response on the status of your request.    The response from other airlines may be delayed.    In this case, you 
should check your itinerary at a later time.

See also
Flight Service Requests Summary dialog box 
Flight Services Requests dialog box



Changing a request for a wheelchair

One of the special services offered through United Connection  is the ability to request a 
wheelchair for use at the airport.    Note that the traveler requiring the wheelchair must be 
able to ascend and descend stairs.    If the traveler will need additional assistance, please 
contact the airline directly.

To change a request for a wheelchair:
1. Open the itinerary that contains the flight you want to change.
2. In the Itinerary Window, double-click on the flight you want to edit.
3. In the Edit Flight dialog box, choose the Requests button.    The Flight Service Requests 

Summary dialog box appears.
4. In the Flight Services For field, select the traveler whose service request you want to 

change.    That traveler's service requests are displayed.
5. Select the flight segment you want to change the wheelchair request for and choose the 

Edit button.    The Flight Service Requests dialog box appears.
Note    For connecting flights, services apply to individual flight segments.    Be sure to select and modify services
for each segment.

6. In the Special field, select (or deselect) the Wheelchair option.
7. Choose OK.    The Flight Service Requests Summary dialog box appears.
8. Repeat steps 5-7 for each flight segment in which you want to change a wheelchair 

request.
9. To exit the Flight Service Requests Summary dialog box, choose OK.
10. In the Itinerary Window, choose the Reserve icon from the toolbar.    The Pricing Summary

dialog box appears.
11. Choose the Reserve button.    The Confirm Reservation dialog box appears.
12. To finalize your service request, choose Finish.    The Confirmation dialog box appears.    

Choose OK.
Note    If you requested a wheelchair in conjunction with a United Airlines or United Express flight, you will get an 
immediate response on the status of your request.    The response from other airlines may be delayed.    In this 
case, you should check your itinerary at a later time.

See also
Flight Service Requests Summary dialog box 
Flight Services Requests dialog box



Add Flight dialog box

You access the Add Flight dialog box to specify the required flight planning information.    
This includes origin, destination, departure date, and departure time.    Once you enter this 
information, you can either return to the Itinerary Window (leaving the flight in Planned 
status) or proceed immediately to flight selection.
Note    After you select a flight, this dialog box is renamed "Edit Flight."

How to display the Add Flight dialog box

Dialog Box Options

From
Enter or select a departure city/airport.    See Using the Airport Search option if you need 
help finding an airport name.

To
Enter or select a destination city/airport.

Date
Enter or select the departure date.

Time
Enter or select the desired departure time.
Note    United Connection  will search for flights that depart up to 30 minutes before the time you specify, as well 
as flights at or after that time.

Find Flights button
Choose this button to display the Select Flight dialog box, which displays a list of available 
flights using the specified planning information.

Requests button
Choose this button to display the Flight Service Requests Summary dialog box, which 
displays each traveler's flight services (seating, meals, special services) for the selected 
flight.    This button is not available until a flight has been selected.

Details button
Choose this button to display the Flight Details dialog box, which displays operation and 
service information for the selected flight.    This button is not available until a flight has 
been selected.

See also
Planning a flight 
Selecting flights based on schedule 
Reviewing flight services 
Viewing flight details 



To display the Add Flight dialog box:
· From the toolbar in the Itinerary Window, choose the Add Flight icon.    The Add Flight 

dialog box appears.
Tip    If you have already planned or selected a flight, you can review the planning information by double-
clicking on that flight in the Itinerary Window.    The Edit Flight dialog box appears.



Select Flight dialog box

You access the Select Flight dialog box to choose a flight based on your flight plan.    The 
Select Flight dialog box displays flights to your destination that have seats available.    
Flights are displayed by number of stops (non-stops, 1-stops, etc.), then by time (earliest to 
latest).    At your option, United Connection  can display only flights that conform to 
specified flight preferences 

 that is, Preferred Airlines and Preferred Service Class.

How to display the Select Flight dialog box

Dialog Box Options

Flight Information
Displays available flights that match the specified flight plan.    Select the flight that best 
meets your needs.    The following information appears for each flight:

Heading Information

Flight Airline and flight number
Flights preceded by an asterisk (*) are operated by United Express or
under a code share agreement.

Time Scheduled departure and arrival times.

Location Departure airport/city, Arrival airport/city

Class Service classes with seating available.    Classes are listed in order 
from left to right, using the codes below.

F First
B Business/Connoisseur
C Coach/Economy

A dash indicates that seating is not available in that class.    For 
example:    F-C indicates that seating is available in First and Coach 
classes.

Meal Indicates what meal is offered in each class.

Information Contains the following details:

Stops The number of stops between the departure and 
destination city.

On 
Time

A percentage indicates how regularly this flight arrives at
its destination on time.

Aircraft The type of aircraft scheduled for the flight, such as a 
DC-10 or B727.

Advisory Information
If the U.S. State Department issues a Travel Advisory for travel to the selected destination, 
United Connection displays this message immediately below the flight list.

Flight Plan
Displays the following information:



From The departure airport and city

To The destination airport and city

Date The departure date

Time The planned departure time

Use Preferences
Choose this option to display only those flights that conform to the flight preferences 
specified in the Flight Preferences dialog box.    The flight preferences from the primary 
traveler's profile are used as the defaults.    If no flights are found that meet the specified 
preferences, United Connection displays all available flights.    To edit preferences for the 
current flight, choose the Edit button.    See How flight preferences are used for more 
information.

Include Full Flights
Choose this option to display all scheduled flights for the specified date, including flights 
that do not have seats available and those that have already departed.    Full flights and 
departed flights appear in gray and cannot be selected.    If the Use Preferences option is 
also selected, United Connection will limit the display to flights that meet the specified 
preferences.

Edit button
Choose this button to display the Flight Preferences dialog box.    The flight preferences 
from the primary traveler's profile appear in this dialog box by default.    If you wish, you 
can change these preferences for the current flight.    If you want United Connection to use 
the flight preferences to find flights and fares, select the Use Preferences option in the 
Select Flight dialog box.

Seat Map button
Choose this button to display the Select Seats dialog box, which provides seat maps for all 
segments of the selected flight.    The seat maps show the seating layout of the associated 
aircraft.    Separate seat maps are provided for each service class.    Available seats are 
shown in white.
Note    Seat maps are available for United Airlines and United Express flights only.

Details button
Choose this button to display the Flight Details dialog box, which contains operation and 
service information for the selected flight.

Print button
Choose this button to print the current flight list.    The Print dialog box appears.

More Flights button
United Connection can display up to 16 flights at a time.    If more than 16 flights are 
available, the More Flights button is enabled.    Choose this button to view the additional 
flights.    Scroll up to view the previous flights.

See also
Selecting flights based on schedule 
Editing preferences for the current flight 



Selecting seats using the seat map 
Viewing flight details 



Select FareShopper  Fares dialog box

You access the Select FareShopper  Fares dialog box to choose a fare for your itinerary.    
United Connection

 displays all available fares, the restrictions associated with those fares, and the airlines on 
which the fares are available.    The default display shows the most restricted Coach fares on 
all available airlines.    At your option, United Connection can display only fares that conform 
to the flight preferences specified in the primary traveler's profile (preferred airlines, service 
class, and fare restrictions).

How to display the Select FareShopper  Fares dialog box 

Dialog Box Options

Available Fares and Restrictions
Displays available fares for your itinerary.    Select the fare that best meets your needs.    
The following information appears for each fare:

Heading Information

Fare Displays the total fare for all travelers and all flights in your 
itinerary.

Min Stay Displays Y or N to indicate whether a minimum stay is required.

Max Stay Displays Y or N to indicate whether a maximum stay is required.

Purchase By If the fare has an advance purchase requirement, the last 
purchase date is displayed.

Non-Refundable Displays Y or N to indicate whether the fare is non-refundable

Carriers Displays all carriers that offer one or more flights at the specified 
fare.

Note that a particular carrier may not have available flights for 
the entire itinerary.    For example, if you planned a round trip 
flight, you may be required to use one carrier for the outbound 
flight and another carrier for the return flight.

Outbound
Inbound

Displays the days of the week on which flights are available.    
Outbound availability is displayed in the first row.    Inbound (i.e., 
return) availability is displayed in the second row.

Fare Restriction Details
Displays detailed fare restriction information for the highlighted fare.    For domestic 
itineraries, change fee information is also displayed.    Change fee information is not 
available for international itineraries  please contact the airlines directly to obtain this 
information.

Use Preferences
Choose this option to display fares that conform to the flight preferences specified in the 
Flight Preferences dialog box.    The flight preferences from the primary traveler's profile 
are used as the defaults.    To edit flight preferences for the current itinerary, choose the 
Edit button.    See How flight preferences are used for more information.



Edit button
Choose this button to display the Flight Preferences dialog box.    The flight preferences 
from the primary traveler's profile appear in this dialog box by default.    If you wish, you 
can change these preferences for the current itinerary.    If you want United Connection to 
use the flight preferences to find flights and fares, be sure to select the Use Preferences 
option in the Select FareShopper  Fares dialog box.

SuperShop button
Choose this button to display the SuperShopper  dialog box. This dialog box allows you to 
shop for low fares over a full-24-hour period (from midnight to midnight on your planned 
departure dates), or over a range of days 
 up to two days before and after your planned travel dates.
Note    The SuperShopper option is only available for itineraries of one or two segments.

Next button
Highlight the flight you want to select, then choose this button to display the Select 
FareShopper  Flights dialog box.    This dialog box displays a list of available flights to the 
first destination in your itinerary.

See also
Selecting a fare in FareShopper 
Using SuperShopper  

Editing preferences for the current flight 



Select FareShopper  Flights dialog box

You access the Select FareShopper  Flights dialog box to choose a flight to each destination 
in your itinerary.    This dialog box displays all flights that are available for the fare you chose.
If necessary, scroll down to view all available flights.
A separate tab appears for each day of the week.    If you used the SuperShopper  option to 
search over a range of days, more than one day may be available.    Choose a tab to see the 
available flights for that day.    The tabs are disabled for days on which no flights are 
available.

How to display the Select FareShopper  Flights dialog box 

Dialog Box Options

FareShopper Flight Availability
Displays available flights that match the specified flight plan and fare.    Select the flight 
that best meets your needs.    The following information appears for each flight:

Heading Information

Flight Airline and flight number
Flights preceded by an asterisk (*) are operated by United Express or 
under a code share agreement.

Time Scheduled departure and arrival times.

Location Departure airport/city, Arrival airport/city

Class Displays the service class associated with the selected fare.    Class 
codes are:
F First
B Business/Connoisseur
C Coach/Economy

Meal Indicates what meals are offered.

Information Contains the following details:

Stops The number of stops between the departure and destination
city.

On 
Time

A percentage indicates how regularly this flight arrives at its 
destination on time.

Aircraft The type of aircraft scheduled for the flight, such as a DC-
10 or B727.

Advisory Information
If the U.S. State Department issues a Travel Advisory for travel to the selected destination, 
United Connection  displays this message immediately below the flight list.

Flight Plan
Displays the following information:

From The departure airport and city



To The destination airport and city

Date The departure date

Time The planned departure time

Details button
Highlight a flight and choose this button to display the Flight Details dialog box, which 
contains operation and service information for the selected flight.

Seat Map button
Highlight a flight and choose this button to display the Select Seats dialog box, which 
provides seat maps of the selected service class for all segments of the selected flight.    
The seat maps show the seating layout of the associated aircraft.    Available seats are 
shown in white.
Note    Seat maps are available for United Airlines and United Express flights only.

Requests button
Highlight a flight and choose this button to display the Flight Service Requests Summary 
dialog box, which displays each traveler's flight services (seating, meals, special services) 
for the selected flight.

Fares button
Choose this button to return to the Select FareShopper  Fares dialog box, which displays a 
list of available fares for your itinerary.

Prev button
Choose this button to display the Select FareShopper  Flights dialog box for the previous 
flight in your itinerary.

Next button
Choose this button to display the Select FareShopper  Flights dialog box for the next flight 
in your itinerary.

Finish button
Choose this button to finalize your selections and return to the Itinerary Window.
Note    If you wish, United Connection can automatically choose flights for you in FareShopper.    Simply choose 
Finish in the FareShopper Flights dialog box, then choose Yes when prompted to continue.    United Connection will
select flights closest to the departure times you specified.

See also
Selecting flights in FareShopper 
Viewing flight details 
Selecting seats using the seat map 
Requesting flight services 



To display the Select FareShopper  Flights dialog box:
· In the Select FareShopper  Fares dialog box, highlight the fare you want to select and 

choose the Next button.



Flight Preferences dialog box

At your option, United Connection  can use flight preferences to narrow the search for 
acceptable flights (in the Select Flight dialog box) or fares (in FareShopper

).    Flight preferences include Preferred Airlines, Preferred Service Class, and Acceptable 
Fare Restrictions.    The default flight preferences are those specified in the primary traveler's
profile.    You can save your changes in the primary traveler's profile, or apply them to the 
current flight only.
Important    When adding a flight to your itinerary, you must indicate that you want to use flight preferences by 
choosing the Use Preferences option in the Select Flight dialog box (or in the Select FareShopper  Fares dialog 
box).

How to display the Flight Preferences dialog box

Dialog Box Options

Using Primary Traveler's Preferences
Displays the primary traveler's name, and the profile selected for this itinerary.

Preferred Airlines
Select second and third preferred airlines.    The first preference is United Airlines, which 
cannot be changed.    If you use flight preferences, United Connection will display only 
flights operated by the preferred airlines.
Note    If second and third preferred airlines are not selected and preferences are used to find flights, only United 
Airlines flights will appear.

Preferred Service Class
Select a preferred service class.    Options include:    First, Business, Coach/Economy, and 
Any.    If you use flight preferences, United Connection will display only flights that have 
seats available in the preferred service class.
Note    The Preferred Service Class option is ignored in FareShopper, which returns the lowest available fares 
regardless of class.

Acceptable Fare Restrictions
In the Acceptable Fare Restrictions field, select the fare restrictions you are willing to 
accept when pricing a flight.    These include:
· Minimum Stay Required
· Maximum Stay Required
· Advance Purchase Required
United Connection will look for fares based on the specified fare restrictions.    If no 
available fare meets all of the selected restrictions, United Connection will return a less 
restrictive fare (it will never return a more restrictive fare).

OK button
Choose this button to apply the changes to the current flight.

Update Profile button



Choose this button to save the changes in the primary traveler's profile.

See also
How flight preferences are used 
Editing preferences for the current flight 



Select Seats dialog box

You access the Select Seats dialog box to choose specific seats for a selected flight, either by
seat number or from a seat map.    Separate seat maps are provided for each service class.    
Available seats are displayed in white.    You choose seats for all travelers in your itinerary.    If
you have chosen a connecting flight, you will need to select seats on each flight segment.
Note    Seat maps are only available for United Airlines and United Express flights.

How to display the Select Seats dialog box

Dialog Box Options

From
Displays the departure airport and city.    For connecting flights, a list of the flight segments
appears.    Highlight each flight segment to select seats for that segment.

To
Displays the destination airport and city.

Depart
Displays the departure date and time of the selected flight.

Arrive
Displays the arrival date and time of the selected flight.

Traveler
Select the traveler whose seat you want to choose.

Seats
Displays all available seat numbers and the associated seat type (Window, Middle, or 
Aisle).    If you wish, you can select a seat from this list instead of using the seat map.

Seat Map Tabs
Displays a seat map for each service class in the selected flight segment.    Select a tab to 
display the seating for that class.    Seating may not be available in all classes.    If you are 
using FareShopper , only the class associated with the selected fare is displayed.
Available seats are shown in white.    Click on a seat to select that seat.    To de-select a 
seat, click on it again.
Important    Exit rows are marked with an arrow.    FAA safety rules require that passengers sitting in exit row seats 
must be able-bodied and willing to assist the crew in the event of an emergency.    See Exit row seat restrictions for 
more information.

First
Displays seats in First class for this flight segment.
Business
Displays seats in Business class for this flight segment.
Coach/Economy
Displays seats in Coach/Economy class for this flight segment.



See also
Selecting seats 
Selecting seats using the seat map 
Changing a seat assignment 



The following travelers may not sit in exit row seats:
· Travelers who are not willing to assist in the event of an emergency
· Travelers who lack the strength, dexterity, mobility, or balance required to open the 

emergency exit and assist the crew in evacuating other passengers
· Travelers who cannot speak or understand English
· Elderly travelers, or those traveling with children
· Travelers with any other condition which would prevent them from assisting in the 

event of an emergency
If an exit row seat assignment is in question, airline personnel will have final authority in 
deciding how seats are assigned.



Flight Details dialog box

You access the Flight Details dialog box to view operation and service information for a 
selected flight.    For connecting flights, information is provided for each flight segment.
Note    Columns are resizable.    If a column contains more information than can be displayed in the current width, an 
ellipsis (...) appears after the text.    To re-size the column, use the mouse to drag the column divider left or right.

How to display the Flight Details dialog box

Dialog Box Options

Depart
Displays the scheduled departure date and time.

Arrive
Displays the scheduled arrival date and time.

Flight
The first line displays the airline abbreviation and flight number.    The second line displays 
the full airline name.

Location
The first line displays the departure airport and city.    The second line displays the 
destination airport and city.

Time
The first line displays the scheduled departure time.    The second line displays the 
scheduled arrival time.

Information
Displays a summary of available flight services for this flight, including meals (by service 
class), aircraft type, movie, and audio.

See also
Viewing flight details 



Flight Service Requests Summary dialog box

You access the Flight Service Requests Summary dialog box to view service requests for a 
selected flight.    Service requests include seating, meals, and special services (for example, 
a wheelchair for use at the airport).    You can view service requests for each traveler in the 
itinerary.    For a connecting flight, separate services are displayed for each flight segment.    
If you wish, you can change a traveler's service requests for the current flight.

How to display the Flight Service Requests Summary dialog box

Dialog Box Options

Flight Services For
Displays all travelers in the current itinerary.    Select the traveler whose flight services you 
want to view and/or edit.

Flight Segment
Displays the departure and destination airports and cities.

Seating
Displays the traveler's seating option for this flight segment.    The seating preference from
the traveler's profile is supplied by default.    If a specific seat has been selected (or 
assigned), the actual seat number will appear.
Note    If a seat cannot be assigned, the message "Available at Airport" is displayed.

Meal
Displays the traveler's meal request for this flight segment.    The meal preference from the
traveler's profile is supplied by default.
Note    Certain restrictions apply to special meal requests  see Requesting special meals for information about 
available meals, dietary guidelines, and restrictions.

Special Services
Displays any special services requested by the traveler for this flight segment (for 
example, a wheelchair for use at the airport).    Special services selected in the traveler's 
profile are supplied by default.

Sit Together
The Sit Together option is automatically selected as the default seating option in all 
itineraries with two or more travelers.    On airlines other than United and United Express, 
this is the only available seating option.    When you reserve your itinerary, United 
Connection  will forward the primary traveler's seating preference (for example, Aisle) to 
the airline and request adjoining seats for all other travelers in the itinerary.    If you choose
this option for a connecting flight, the airline will attempt to assign adjoining seats on all 
segments of that flight.
Note    Selecting this option will remove any seats selected from the seat map.

More Info button
If you arranged any special services directly through the airline (for example, allowance for



excess or oversized baggage), choose this button to display those services.    This 
information is available for viewing only.

Seat Map button
Choose this button to display the Select Seats dialog box.    This dialog box allows you to 
choose specific seats for the selected flight, either by seat number or from a seat map.    
You choose seats for all travelers in your itinerary.    If you have chosen a connecting flight, 
you will need to select seats for each flight segment.
Note    Seat maps are only available for United Airlines and United Express flights.

Edit button
Choose this button to display the Flight Service Requests dialog box, which allows you to 
change seating, meal, and special service requests for the selected traveler on the 
selected flight segment.

Show This Summary After Each Flight Selection
Select this option to display the Flight Service Requests Summary dialog box automatically
after you select a flight.    If you de-select this option, you will need choose the Requests 
button in the Edit Flight dialog box to access this information.
Note    You can also select or de-select this option from the System Options dialog box.    To display this dialog box, 
choose System Options from the Tools menu.

See also
Selecting seats using the seat map 
Requesting flight services 
Reviewing flight services 
Changing a seat assignment 
Changing a meal request 
Changing a wheelchair request 



Flight Service Requests dialog box

You access the Flight Service Requests dialog box to edit a traveler's service requests for a 
selected flight segment.

How to display the Flight Service Requests dialog box

Dialog Box Options

Traveler
Displays the name of the traveler whose flight requests appear in the dialog box.

From
Displays the departure airport and city.

To
Displays the destination airport and city.

Seating
Select the traveler's seating preference for this flight segment.    If a specific flight has 
already been selected or assigned, that seat number will appear in the list.

Meal
If the traveler requires a special meal (for example, for medical or religious reasons), select
their special meal preference for this flight segment.    When you reserve a flight, each 
traveler's meal requests are forwarded to the airlines.    Special meals must be requested 
at least 24 hours prior to departure.
Note    Certain restrictions apply to special meal requests  see Requesting special meals for information about 
available meals, dietary guidelines, and restrictions.

Special
Select any special services that the traveler requires for this flight segment, such as a 
wheelchair (for use at the airport). 
Note    If you request a wheelchair, the traveler requiring the wheelchair must be able to ascend and descend 
stairs.    If additional assistance is needed, please contact the airline directly.

See also
Requesting flight services 
Changing a seat assignment 
Changing a meal request 
Changing a wheelchair request 



To display the Flight Service Requests dialog box:
· In the Flight Service Requests Summary dialog box:

a. Select the traveler whose services you want to edit.
b. Highlight the flight segment you want to edit, then choose the Edit button.

· In the Itinerary Window:
a. Double-click on a flight segment.
b. In the Edit Flight dialog box, choose the Requests button.
c. In the Flight Service Requests Summary dialog box, select the traveler whose 

services you want to edit.
d. Highlight the flight segment you want to edit, then choose the Edit button.



Confirm Service Class dialog box

After you select a flight, United Connection  displays the Confirm Service Class dialog box 
and prompts you to select a service class.    Unavailable service class options are grayed.    
United Connection uses the service class you select to price your airfare and reserve seats.
Note    If you selected specific seats using the seat map, you have already chosen a service class.    Therefore, the 
Confirm Service Class dialog box does not appear.

Dialog Box Options

First Class
Select this option to choose First class.

Business Class
Select this option to choose Business class.

Coach/Economy Class
Select this option to choose Coach/Economy class.

See also
Selecting a service class 



Plan Another Flight dialog box

After you add a flight to your itinerary, the Plan Another Flight dialog box prompts you to add
another flight.    If the Remind Me To Plan Another Flight option is selected, this dialog box 
will appear automatically each time you select a flight.

Dialog Box Options

Yes button
Displays the Add Flight dialog box for the next flight.

No button
Displays the Itinerary Window.

Remind Me To Plan Another Flight
Select this option if you want to be prompted to plan another flight each time you add a 
flight to your itinerary.
Note    If you de-select this option, you will need to access the System Options dialog box to select it again.    To 
display this dialog box, choose System Options from the Tools menu.    In the Flight Options area, select the Prompt
For Return Flights option and choose OK.

See also
Planning a flight 
Add Flight dialog box 



SuperShopper  dialog box

The SuperShopper  dialog box appears when you choose the SuperShop button in the Select
FareShopper

 Fares dialog box.    This dialog box allows you to shop for low fares over a full-24-hour 
period, or over a range of days.
To search over the full 24-hour period on your original planned dates, choose the OK button 
without changing the date controls.    To extend your search over a range of days, use the 
controls to specify the date range in which United Connection  should search for flights.    
You can search up to two days before and after your original travel dates.
Note    The SuperShopper option is only available for itineraries of one or two segments.

Dialog Box Options

Outbound Plan
Move the slide controls left and right to specify the range of dates within which United 
Connection should search for Outbound flights.

Inbound Plan
Move the slide controls left and right to specify the range of dates within which United 
Connection should search for Inbound flights.

OK button
Choose this button to begin searching for low fares.    If you choose OK without changing 
the date ranges, United Connection searches for fares from midnight to midnight on your 
original planned dates.

See also
Using SuperShopper  

Select Fare Shopper  Fares dialog box 
Retrieving Fares dialog box 



Retrieving Fares dialog box

The Retrieving Fares dialog box appears when you choose the OK button in the 
SuperShopper  dialog box.    This dialog box shows you the status of your SuperShopper 
retrieval.

Dialog Box Options

Status bar
Visually indicates the elapsed and remaining time for the current retrieval.

Lowest fare found
Displays the lowest fare found for this itinerary during the current retrieval.

Searching for fares from
Displays the Outbound/Inbound date pair currently being checked for low fares.    
SuperShopper checks all possible combinations of Outbound and Inbound dates.

Stop button
Choose this button to stop the fare retrieval process.    United Connection  displays the 
fares retrieved up to that point in the Select FareShopper
 Fares dialog box.

See also
Using SuperShopper  

SuperShopper  dialog box 
Select Fare Shopper  Fares dialog box 

 



    United Connection
 Technical Support

If you have questions about United Connection, first look in the online Help for the 
information you need.    For solutions to common problems, see Troubleshooting.    To search 
for Help on a specific topic, choose Search For Help On... from the Help menu.    Also, be sure
to check all README files included with the application.    If you still cannot resolve your 
problem, call the United Connection Support Desk at:

1-800-4UA-CNXN (1-800-482-2696)

Before you call the Support Desk:
When you call the Support Desk, please have the following information available:
· Your Mileage Plus  number
· Computer make and model
· Operating system (Windows 3.1, 3.11, NT, or Windows 95)
· Modem type and speed
· What you were doing when the problem occurred
· The exact text of any error messages, and when those messages are displayed (at 

startup, during connection, etc.)
· The access numbers you are using to connect to the Reservation System

The Support Desk is available seven days a week from 6 a.m. to 1 a.m. (CT).

After hours
To contact the Support Desk after hours, you can send a fax to 847-427-6157. Please include
the following information:
· Your name, address, and Mileage Plus number.
· Detailed descriptions of the problem and your operating environment.
· A phone number (and fax number, if possible) where we can contact you.    Please 

indicate the best day and time to call you.
 



    Adding Rental Cars
Overview

Rental Car Planning and Selection

Planning a rental car 

Selecting a rental car company 

Viewing rental car company details

Selecting a rental car type 

Viewing rental car rate details

Rental Car Preferences

How rental car preferences are used 

Editing preferences for the current rental car

Rental Car Services

Requesting rental car services

Reviewing rental car service requests

Changing rental car service requests



    Overview: Adding rental cars
Adding a rental car to your itinerary is a four step process:
· Entering planning information
· Selecting a rental car company
· Selecting a car type and rate
· Specifying car service requests
You can view a range of available rental car companies and car types, or use car preferences
to limit the display to companies and car types that meet the specified preferences.    If the 
primary traveler belongs to one or more rental car discount programs and has entered this 
information in the Traveler Editor, you also have the option of selecting a rental car that 
qualifies for one of these programs.
Once you have selected a rental company and car type, you indicate any special service 
requests that you would like to have forwarded to the rental company  for example, a 
request for a car seat or a mobile telephone.
All rental cars must be rented at airport locations, and all cars must be returned to the 
location where they are picked up.    In addition, some rental companies require an airline 
ticket for rental.    See the Rental Car Rate Details dialog box for the selected car type, or 
contact the rental company for more information.
When you reserve your itinerary, your rental car selection and service requests are 
forwarded to the appropriate rental company.    A confirmation number will appear in the 
Notices area of the Itinerary Window after your reservation has been confirmed.
Note    Any changes to a rental car reservation must be made directly through the rental company, not through United 
Connection .

See also
Planning a rental car 
Selecting a rental car company 
Selecting a rental car type 
Requesting rental car services 



    Planning a rental car
Before you can select a rental car, you need to indicate where and when you want to pick it 
up.

To plan a rental car:
1. In the Itinerary Window, choose the Add Car icon from the toolbar.    The Add Car dialog 

box appears.
2. Complete the Add Car fields as follows:

In this field You can

Airport Enter or select the airport at which you will pick up 
the rental car.
If you don't know the airport name, click on the down
arrow next to the Airport field to search by city, 
airport, or airport code.    See Using the Airport 
Search option for more information.
Tip    The destination of the last flight without an 
associated rental car is displayed by default.

Pick-Up Date Enter or select a pick-up date.

Pick-Up Time Enter or select a pick-up time.

Drop-Off Date Enter or select a drop-off date.

Drop-Off Time Enter or select a drop-off time.

3. To continue, do one of the following:
· To view a list of available car companies at the specified airport, choose the Find Cars

button.    See Selecting a rental car company for more information.
· To leave the rental car in Planned status for now, choose OK.    The Itinerary Window 

displays the rental car planning information you entered.

See also
Add Car dialog box 
Selecting a rental car company 



    How rental car preferences are used
Rental car preferences are specified in the Car tab of the traveler profile.    To use rental car 
preferences, choose the Use Preferences option in the Select Rental Car Company dialog 
box.    United Connection  uses the rental car preferences from the primary traveler's profile 
as the defaults.    If you wish, you can change car preferences for the current rental car.

Preferences are used as follows:

Preferred Rental Companies
United Connection displays only the primary traveler's preferred rental companies.    If none 
of the primary traveler's preferred rental companies are available, you will need to select 
different rental companies.    If the primary traveler has not selected any preferred rental 
companies, United Connection displays all available rental companies.

Preferred Car Types
United Connection displays only rental car companies that offer the primary traveler's 
preferred car types.    If none of the primary traveler's preferred car types are available, you 
will need to select different car types.    If the primary traveler has not selected any preferred
car types, United Connection displays all available car types.

Search Within Price Range
United Connection displays only rental car companies that offer rates within the rate range 
specified in the primary traveler's profile.    If no available rental car companies offer rates 
within the specified range, you will need to change the rate range.    If the primary traveler 
has not selected the Search Within Price Range option, United Connection displays a range 
of rates from low to high.

In Terminal Facilities
United Connection displays only rental car companies that have a service desk inside the 
airport terminal.    If no available rental car company offers in-terminal facilities, you will 
need to de-select this option.    If the primary traveler has not selected the In Terminal 
Facilities option, United Connection displays rental companies that have either in-terminal or
remote facilities.

Unlimited Mileage
United Connection displays only rental car companies that offer unlimited mileage rental 
plans.    If no available rental car company offers unlimited mileage plans, you will need to 
deselect this option.    If the primary traveler has not selected the Unlimited Mileage option, 
United Connection displays rental companies that offer various mileage plans.    See Viewing 
rental car rate details for more information.

See also
Editing preferences for the current rental car 
Car Preferences dialog box 



    Selecting a rental car company
After you enter your rental car planning information, you are ready to select a rental car 
company.    You do this in the Select Rental Car Company dialog box, which displays a list of 
available companies at the location you specified.
Important    To display companies based on the primary traveler's car preferences, select the Use Preferences 
option.    If Use Preferences is not selected, United Connection  displays all rental car companies that have cars 
available at the specified location.

How to display the Select Rental Car Company dialog box

To select a rental car company:
1. Display the Select Rental Car Company dialog box.
2. Review the list of available rental car companies.    Note that the list contains only rental 

agencies which have cars available for the dates you specified.
Companies are listed by rate range for the specified rental period, from lowest to 
highest.    The planning information you entered and the total number of days for this 
rental appear at the bottom of the dialog box.
Note    The Location column indicates whether the rental car company service desk is located inside the airport 
terminal or at a remote airport location (which may require shuttle service).

3. If the primary traveler's identification information includes a discount program number 
for one or more rental car companies, the notation "Discount program rate applies" 
appears below the table and an asterisk is displayed next to those company names.    
Choose one of those companies if you want to reserve a rental car at the primary 
traveler's discount rate for that company.

4. To see the address, hours of operation, additional charges, and other information for a 
particular rental car company, highlight that company and choose the Details button.    
The Rental Car Company Details dialog box appears.    Choose Close to return to the 
Select Rental Car Company dialog box.

5. If you find a company that you want to select, highlight it and continue with step 6.    If 
none of the rental car companies meet your needs, you can change the list using one of 
the following options:
· Change car preferences for this rental.    See Editing preferences for the current rental

car for more information.
· If the Use Preferences option is selected, de-select this option.    United Connection 

ignores the primary traveler's car preferences and updates the list to display all 
rental companies at the specified location that have cars available.

6. Highlight the rental car company you want to select and choose OK.    The Select Rental 
Car Type dialog box appears.

See also
Select Rental Car Company dialog box 
Editing preferences for the current rental car 
Viewing rental car company details 





How to display the Select Rental Car Company dialog box:
· To add a new rental car to your itinerary:

a. Choose the Add Car icon from the toolbar.
b. In the Add Car dialog box, enter the required planning information and choose the 

Find Cars button.

· To modify a Planned or Selected rental car:
In the Itinerary Window, highlight the car and choose the Find icon from the toolbar.

Note    If you are not already connected to the reservation system, you will be prompted to connect in order to 
display the Select Rental Car Company dialog box.



Use Preferences option
If you want to use preferences to limit the rental cars displayed by United Connection , 
select the Use Preferences option in the Select Rental Car Company dialog box.    When 
you select this option, United Connection displays only rental cars that meet the primary 
traveler's car preferences.    If you wish, you can edit these preferences for the current 
rental car.    See Editing preferences for the current rental car for more information.

Note    No rental companies will be displayed if one or more preferences cannot be met.    To display a list of 
available rental companies you will need to change the affected preferences.



    Viewing rental car company details
You can view detailed information for any rental car company.    This includes address and 
hours, extra charges, and other information.
Note    All information is provided directly by the rental car company.    United Airlines makes no claim of its accuracy.

How to display the Rental Car Company Details dialog box

To view rental car company details:
1. Display the Rental Car Company Details dialog box.
2. From the Type of Information list, select Address and Hours to view this information. If 

necessary, scroll down to view all the information.
3. From the Type of Information list, select Extra Charges to view this information. If 

necessary, scroll down to view all the information.
4. From the Type of Information list, select Miscellaneous to view this information. If 

necessary, scroll down to view all the information.
5. Choose Close to return to the Select Rental Car Company dialog box.

See also
Rental Car Company Details dialog box 
Selecting a rental car company 



Extra Charges includes:
· Applicable state and local taxes
· Refueling policies
· Loss damage waiver information



Miscellaneous includes:
· Shuttle service schedule and instructions (if applicable)
· Accepted credit cards
· Driver's license requirements
· Authorized drivers
· Age requirement
· Available car types/models



Address and Hours includes:
· Rental company address
· Hours of operation
· Telephone number



    Editing preferences for the current rental car
When you add a rental car to your itinerary, you indicate whether you want to use the 
primary traveler's rental car preferences to narrow the search for acceptable cars.    If you 
use preferences, United Connection  attempts to find rental car companies that meet all the
specified preferences.    You can edit these preferences during the rental car selection 
process.
Note    No rental companies will be displayed if one or more preferences cannot be met.    To display a list of available
rental companies you will need to change your preferences.

To edit preferences for the current rental car:
1. In the Select Rental Car Company dialog box, choose the Edit button.    The Car 

Preferences dialog box appears.
2. Update the rental car preference fields as follows:

In this field You can

Preferred Rental 
Companies

Select the three rental car companies the traveler 
most prefers.

Preferred Car 
Types

Select the three car types the traveler most prefers. 
The default option is None.

Search Within 
Price Range

Select this option if you want United Connection to 
display only rental car companies that offer rates 
within a price range you specify.    Then, do the 
following:
a. In the Highest Rate field, enter the highest daily 

rate you want to pay for a rental car.
b. In the Lowest Rate field, enter the lowest daily 

rate you want to pay for a rental car.
Note    To have United Connection ignore the rate 
range search option, de-select the Search Within 
Price Range option.

In Terminal 
Facilities

Select this option if you prefer to rent from 
companies that have service desks inside the airport
terminal, rather than at a remote airport location 
(that may require shuttle service).

Unlimited Mileage Select this option if you prefer to rent from 
companies that offer an unlimited mileage plan.

3. If you want to save the updated preferences in the primary traveler's profile, choose the 
Update Profile button (this is optional).

4. To apply the updated preferences to the current rental car, choose OK.    An updated list 
of rental car companies appears.

See also
Car Preferences dialog box 
How rental car preferences are used 



    Selecting a rental car type
After you enter your rental car planning information and select a rental car company, you 
are ready to select a rental car type.    You make your selection in the Select Rental Car Type 
dialog box, which displays a list of available car types for the company you selected.
Note    If the primary traveler's identifying information includes a discount program number for the selected rental car 
company, United Connection  by default displays only discount program options in the Select Rental Car Type dialog
box.    No discount program rates are displayed, since rates can vary between programs.    To see standard rates, de-
select the Discount Program Rates option.

To select a rental car type:
1. In the Select Rental Car Company dialog box, highlight a rental company and choose OK. 

The Select Rental Car Type dialog box appears.
2. Review the list of available rental cars.    The following information is displayed for each 

car:
· Car Type
· Rate Type
· Total for rental period
· Mileage options
Cars are listed by total rate for the specified rental period, from lowest to highest.    The 
planning information you entered, the selected rental car company, and the total number
of rental days appear at the bottom of the dialog box.

3. If the Discount Program Rates option is selected and you wish to see other available car 
types and rates, de-select this option.
Note    This option is only available if the primary traveler's identifying information includes a discount program 
number for the selected rental car company.

4. To see additional information about the rate and mileage options for a particular car 
type, highlight that car and choose the Rate Details button.    The Rental Car Rate Details 
dialog box appears.    Choose Close to return to the Select Rental Car Type dialog box.
Note    If you selected a discount program option, the Rate Details button will not be available (United Connection
does not have specific rate and rules information for each discount program).

5. Highlight the rental car you want to select and choose OK.    The Rental Car Service 
Requests dialog box appears.
Note    If this dialog box does not appear after you select a rental car type, choose System Options from the Tools
menu and select the Display Rental Car Service Requests After Planning option.

See also
Select Rental Car Type dialog box 
Viewing rental car rate details 



Car Types include:
· Mini · Luxury

· Economy · Sports Car

· Compact · Convertible

· Intermediate · Station Wagon

· Standard · Van

· Full Size · 4-Wheel Drive

· Premium · Pick-Up

Rate Types include:
· Daily
· Weekend
· Weekly
· Monthly
· Hourly
· Package



    Viewing rental car rate details
Rental car rate information includes the rate calculation, mileage information, and rules and 
conditions for the selected car.
Note    All information is provided directly by the rental car company.    United Airlines makes no claim of its accuracy.

To view rental car rate details:
1. From the Select Rental Car Type dialog box, highlight a car type and choose the Rate 

Details button.
2. Review the rate information for the selected car.    You may need to scroll down to see all 

the rules information.    Car rate information can include:
· Total rate, and a breakdown of the total by rate type
· Mileage information, including the cents/mile cost (if applicable)
· Late fees
· Availability restrictions (i.e., must keep over a Saturday night)
· Advance reservation requirements
· Rate guarantees
· Whether an airline ticket is required for rental
· Maximum rental period

3. Choose Close to return to the Select Rental Car Type dialog box.

See also
Rental Car Rate Details dialog box 
Selecting a rental car type 



    Requesting rental car services
After selecting a rental car, you can request rental car services.    Rental car services include 
infant and toddler car seats, controls for physically challenged drivers, mobile phone, ski-
equipped car, and associated frequent flyer program.    You specify these service requests in 
the Rental Car Service Requests dialog box.
Important    United Connection  cannot guarantee rental car service requests 

 please call the rental car company directly to confirm your requests.    Once you reserve a rental car, any changes 
must be made directly through the rental car company.

How to display the Rental Car Service Requests dialog box 

To request car services:
1. Display the Rental Car Service Requests dialog box.    The default services are those 

specified in the primary traveler's profile.
2. Select the desired rental car service requests:

In this field You can

Infant Car Seat Request an infant car seat.

Toddler Car Seat Request a toddler car seat.

Car Equipped for 
Physically 
Challenged Driver

Request a car equipped for a physically challenged 
driver.    Then, select one of the following options:
· Left Hand Controls
· Right Hand Controls

Mobile Phone Request a car equipped with a mobile phone.

Ski-Equipped Car Request a car with a ski rack, snow tires, etc.

Associated 
Frequent Flyer 
Program

Select one of the primary traveler's frequent flyer 
programs to send that program number to the rental 
company.
See About the Associated Frequent Flyer Program 
for more information.

3. Choose OK to return to the Itinerary Window, which is updated to display the rental car 
you selected.
Note    When you are ready to reserve the selected flights, rental cars, and hotel rooms in your itinerary, choose 
the Reserve button from the toolbar.    See Reserving your itinerary for more information.

See also
Rental Car Service Requests dialog box 
Reviewing rental car service requests 
Changing rental car service requests 



How to display the Rental Car Service Requests dialog box:
· From the Itinerary Window, double-click on a selected rental car.    The Edit Car dialog 

box appears.    Choose the Requests button.

Note    The Rental Car Service Requests dialog box appears automatically after you select a car type.    If it 
does not appear automatically, choose System Options from the Tools menu and select
the Display Rental Car Service Requests After Planning option.



About the Associated Frequent Flyer Program:
When you reserve a rental car and select one of the primary traveler's frequent flyer 
program as the Associated Frequent Flyer Program, United Connection  will forward the 
primary traveler's membership number for that program to the rental car company.    If the
selected frequent flyer program has a promotional agreement with the rental company, 
the primary traveler may be eligible for any benefits offered under that promotion.
Other restrictions may apply  please contact the rental car company or your frequent 
flyer program for details.    You may be required to show proof of program membership (for
example, your frequent flyer card) at pick-up.
Note    The Associated Frequent Flyer Program field contains a list of frequent flyer programs entered for the 
primary traveler.    For help entering frequent flyer account information, see Entering travel program information. 



    Reviewing rental car service requests
You can review service requests for any rental car in your itinerary.    Rental car services 
include infant and toddler car seats, controls for physically challenged drivers, ski-equipped 
car, mobile phone, and associated frequent flyer program.

To review rental car service requests:
1. In the Itinerary Window, double-click on the rental car whose services you want to 

review.    The Edit Car dialog box appears.
2. Choose the Requests button.    The Rental Car Service Requests dialog box appears.
3. Review the selected services.

Note    You can make changes to rental car services only if you have not yet reserved the car.    After a rental car 
has been reserved, you will need to contact the rental car company directly to make any changes.

4. Choose OK to exit the Rental Car Service Requests dialog box.

See also
Rental Car Service Requests dialog box 

Requesting rental car services 
Changing rental car service requests 



    Changing rental car service requests
You can make changes to rental car services only if you have not yet reserved the car.    After
a rental car has been reserved, you will need to contact the rental car company directly to 
make any changes.

To change rental car service requests:
1. In the Itinerary Window, double-click on the rental car whose services you want to 

change.    The status of the rental car must be SELECTED.
2. In the Edit Car dialog box, choose the Requests button.    The Rental Car Service Requests

dialog box appears.
3. Make any desired changes to the rental car services.
4. Choose OK to exit the Rental Car Service Requests dialog box.

See also

Rental Car Service Requests dialog box 
Requesting rental car services 
Reviewing rental car service requests 



    Add Car dialog box
You access the Add Car dialog box to specify the required rental car planning information.    
This includes the pick-up airport, the pick-up date and time, and the drop-off date and time.   
Once you enter this information, you can either return to the Itinerary Window (leaving the 
rental car in Planned status) or proceed immediately to rental car selection.
Note    After you select a rental car, this dialog box is renamed "Edit Car."

How to display the Add Car dialog box

Dialog Box Options

Airport
Enter or select the airport at which you will pick up the rental car.    Cars may only be 
rented at airport locations.    If you don't know the airport name, you can click on the down 
arrow next to the Airport field to search by city, airport, or airport code.    See Using the 
Airport Search option for more information.
Tip    The destination of the last flight without an associated rental car is displayed by default.

Pick-Up
Enter or select the pick-up date.

Time
Enter or select the desired pick-up time.

Drop-Off
Enter or select the drop-off date.

Time
Enter or select the desired drop-off time.

Car Selection
After a rental car has been selected, this area displays the rental company and the car 
type.    The rate is displayed after the rental car has been reserved.

Find Cars button
Choose this button to display the Select Rental Car Company dialog box, which displays a 
list of available rental car companies using the specified planning information.

Requests button
Choose this button to display the Rental Car Service Requests dialog box, which displays 
requested services for the selected rental car.    This button is not available until a rental 
car has been selected.

Details button
Choose this button to display the Rental Car Company Details dialog box, which displays 
address and hours, extra charges, and other information for the selected rental car 
company.    This button is not available until a rental car has been selected.

See also



Planning a rental car 
Selecting a rental car company 
Reviewing rental car service requests 
Viewing rental car company details 



To display the Add Car dialog box:
· From the toolbar in the Itinerary Window, choose the Add Car icon.    The Add Car 

dialog box appears.
Tip    If you have already planned or selected a rental car, you can review the planning information by double-
clicking on that car in the Itinerary Window.    The Edit Car dialog box appears.



    Select Rental Car Company dialog box
The Select Rental Car Company dialog box displays a list of rental car companies at the 
specified airport that have cars available.    At your option, United Connection  can display 
only companies that conform to the primary traveler's car preferences 

 for example, Preferred Rental Companies and Acceptable Rate Range.    You select a rental 
car company, then choose OK to view available car types for that company.
Note    The list contains only rental agencies which have cars available for the dates you specified.

How to display the Select Rental Car Company dialog box

Dialog Box Options

Car Company Information
Displays available rental car companies at the specified airport.    Companies are listed by 
rate range for the specified rental period, from lowest to highest.    The following 
information appears for each company:

Heading Information

Rental Car Company Rental company name.

Location Location of the rental company's service desk.    
Options include Airport Terminal or Off-Airport. 
Off-Airport indicates a location at the airport but 
outside the terminal, requiring shuttle service.

Range of Total Rental The rental company's range of available rates for
the specified rental period.    (For non-U.S. 
locations, rates are display in local currency.)

Discount Program Rate Applies
If the primary traveler's identification information includes a discount program number for 
one or more rental car companies, the notation "Discount program rate applies" appears 
below the table and an asterisk is displayed next to those company names.    Choose one 
of those companies if you want to reserve a rental car at the primary traveler's discount 
rate for that company.

Rental Car Plan
Displays the following information:

Field Information

Airport Airport at which you will pick up the rental car.

Pick-Up Planned pick-up date and time.

Drop-Off Planned drop-off date and time.

Days Total number of days for this rental.

Use Preferences
Choose this option to display only those rental car companies that conform to the primary 
traveler's rental car preferences.    To change car preferences for this rental, choose the 
Edit button.    See Editing preferences for the current rental car for more information.



Note    No rental companies will be displayed if one or more preferences cannot be met.    To display a list of 
available rental companies you will need to change the affected preferences.

Edit button
Choose this button to display the Car Preferences dialog box.    The car preferences from 
the primary traveler's profile appear in this dialog box by default.    If you wish, you can 
change these preferences for the current rental car.    If you want United Connection to use 
car preferences to find rental cars, select the Use Preferences option in the Select Rental 
Car Company dialog box.

Details button
Highlight a rental company and choose this button to display the Rental Car Company 
Details dialog box, which includes the address, hours of operation, additional charges, and 
other information for the selected company.

See also

Selecting a rental car company 
Editing preferences for the current rental car 
Viewing rental car company details 



    Car Preferences dialog box
The Car Preferences dialog box lets you view and/or edit preferences for the current rental 
car.    The default car preferences are those specified in the primary traveler's profile.    You 
can save your changes in the primary traveler's profile, or apply them to the current rental 
car only.

If you opt to use car preferences, United Connection  attempts to find rental car companies 
that meet all the specified preferences.    Note that no rental companies will be displayed if 
one or more preferences cannot be met.    To display a list of available rental companies you 
will need to change the affected preferences.
Important    If you want United Connection to use the specified car preferences to find rental cars, select the Use 
Preferences option in the Select Rental Car Company dialog box.

How to display the Car Preferences dialog box

Dialog Box Options

Preferred Rental Companies
Select your three preferred rental car companies.    United Connection will display only the 
specified rental companies.

Preferred Car Types
Select your three preferred car types. United Connection will display only rental car 
companies that offer the specified car types.

Search Within Price Range
Select this option if you want United Connection to display only rental car companies that 
offer rates within a specified price range.    After selecting this option, enter dollar amounts
in the Highest Rate and Lowest Rate fields.
Note    If this option is de-selected, any amounts specified in the Highest Rate and Lowest Rate fields are ignored.

Highest Rate
Enter the highest daily rate you want to pay for a rental car.

Lowest Rate
Enter the lowest daily rate you want to pay for a rental car.

In Terminal Facilities
Rental car company service desks are located either inside the airport terminal or at a 
remote airport location (which may require shuttle service).    Select this option to display 
only rental car companies that have a service desk inside the airport terminal.

Unlimited Mileage
Select this option if you prefer to rent from companies that offer an unlimited mileage 
plan. United Connection will display only rental car companies that offer unlimited mileage 
rental plans.

OK button
Choose this button to apply the changes to the current rental car.



Update Profile button
Choose this button to save the changes in the primary traveler's profile.

See also
How rental car preferences are used
Editing preferences for the current rental car 



To display the Car Preferences dialog box:
· In the Select Rental Car Company dialog box, choose the Edit button.    United 

Connection  displays the car preference from the primary traveler's profile.



    Rental Car Company Details dialog box
The Rental Car Company Details dialog box shows you the address, hours of operation, 
additional charges, and other information for the selected rental company.
Note    All information is provided directly by the rental car company.    United Airlines makes no claim of its accuracy.

How to display the Rental Car Company Details dialog box

Dialog Box Options

Type of Information
Select the type of information you want to see:
· Address and Hours
· Extra Charges
· Miscellaneous
The corresponding information is displayed in the Description box.

Description
Displays the selected information.    All information is provided directly by the rental 
company.    If necessary, scroll down to view all the information.    This can include:

Address and Hours
· Rental company address
· Hours of operation
· Telephone number

Extra Charges
· Applicable state and local taxes
· Refueling policies
· Loss damage waiver information

Miscellaneous
· Shuttle service schedule and instructions (if applicable)
· Accepted credit cards
· Driver's license requirements
· Authorized drivers
· Age requirement
· Available car types/models

See also
Viewing rental car company details 
Select Rental Car Company dialog box 



To display the Rental Car Company Details dialog box, do one of the following:
· In the Select Rental Car Company dialog box, highlight the desired rental car company 

and choose the Details button.
· In the Edit Car dialog box, choose the Details button.    This button is not available until 

you select a rental car.



    Select Rental Car Type dialog box
The Select Rental Car Type dialog box displays a list of available rental cars for the rental 
company you selected.
Note    If the primary traveler's identifying information includes a discount program number for the selected rental car 
company, United Connection  by default displays only discount program options in the Select Rental Car Type dialog
box.

How to display the Select Rental Car Type dialog box

Dialog Box Options

Car Type Information
Displays available car types for the selected rental company.    Cars are listed by total rate 
for the specified rental period, from lowest to highest.    The following information is 
displayed:

Heading Information

Car Type For example, Compact or Standard.    Click here to see 
available car types.

Rate Type For example, Daily or Weekend.    Click here to see 
available rate types.

Total Total rate for the specified rental period.    Note that 
taxes and other charges may apply  see the Rental 
Car Company Details dialog box for more information 
about additional charges.

Mileage Mileage information.    For example, Unlimited Mileage, 
or the cost/mile cost.

Discount Program Rates
This option is available (and is selected by default) if the primary traveler's identification 
information includes a discount program number for the selected rental car company.    
When this option is selected, United Connection displays discount program options only.    
De-select this option to display standard car types and rates.
Note    Since United Connection cannot display specific discount program rates, "N/A" appears in the Total column 
when this option is selected.

Rental Car Plan
Displays the following information:

Field Information

Airport The airport at which you will pick up the rental car.

Pick-Up The planned pick-up date and time.

Drop-Off The planned drop-off date and time.

Company The rental company you selected.

Days The total number of days for this rental.



Rate Details button
Highlight a car type and choose this button to display the Rental Car Rate Details dialog 
box, which contains additional information about the rate and mileage options for that car 
type.
Note    This button is not available if the Discount Program Rates option is selected (United Connection does not 
have specific rate and rules information for individual discount programs).

See also
Selecting a rental car type 
Viewing rental car rate details 



How to display the Select Rental Car Type dialog box:
· In the Select Rental Car Company dialog box, highlight the desired rental car company 

and choose OK.



    Rental Car Rate Details dialog box
The Rental Car Rate Details dialog box displays rate information for the selected car type, 
including the rate calculation, mileage information, and rules and conditions.
Note    All information is provided directly by the rental car company.    United Airlines makes no claim of its accuracy.

How to display the Rental Car Rate Details dialog box

Dialog Box Options

Rate Calculation
Displays the total rate for the selected car type, and a breakdown of the total by rate type. 
Also displays the mileage policy, including the cost/mile (if applicable).
Note    Taxes and other charges may apply  see the Rental Car Company Details dialog box for more information 
about additional charges.

Rules and Conditions
Displays the rules associated with the selected car type.    You may need to scroll down to 
see all the rules information.    This can include:
· Late fees
· Availability restrictions (i.e., must keep over a Saturday night)
· Advance reservation requirements
· Rate guarantees
· Whether an airline ticket is required for rental
· Maximum rental period

See also
Viewing rental car rate details 
Select Rental Car Type dialog box 



How to display the Rental Car Rate Details dialog box:
· In the Select Rental Car Type dialog box, highlight a car type and choose the Rate 

Details button.



    Rental Car Service Requests dialog box
The Rental Car Service Requests dialog box lets you indicate which services you want to 
request for the current rental car.    By default, United Connection  displays the service 
requests from the primary traveler's profile.    When you make a rental car reservation, 
United Connection forwards your service requests to the rental car company.
Important    United Connection cannot guarantee rental car service requests  please call the rental car company 
directly to confirm your requests.

How to display the Rental Car Service Requests dialog box

Dialog Box Options

Infant Car Seat
Select this option to request an infant car seat.

Toddler Car Seat
Select this option to request a toddler car seat.

Car Equipped for Physically Challenged Driver
Select this option to request a car equipped for a physically challenged driver.    You must 
also specify whether the traveler will need left-hand or right-hand controls.

Left-Hand Controls
Select this option to request a car with left-hand controls.

Right-Hand Controls
Select this option to request a car with right-hand controls.

Mobile Telephone
Select this option to request a car equipped with a mobile phone.

Ski-Equipped Car
Select this option to request a rental car equipped with a ski rack, snow tires, etc.

Associated Frequent Flyer Program
Select one of the primary traveler's frequent flyer programs to send that program number 
to the rental company.
When you reserve a rental car and select one of the primary traveler's frequent flyer 
program as the Associated Frequent Flyer Program, United Connection will forward the 
primary traveler's membership number for that program to the rental car company.    If the
selected frequent flyer program has a promotional agreement with the rental company, 
the primary traveler may be eligible for any benefits offered under that promotion.
Other restrictions may apply  please contact the rental car company or your frequent 
flyer program for details.    You may be required to show proof of program membership (for
example, your frequent flyer card) at pick-up.
Note    The Associated Frequent Flyer Program field contains a list of frequent flyer programs entered for the 
primary traveler.    For help entering frequent flyer account information, see Entering travel program information. 

Show these options after choosing a rental car



Select this option to display the Rental Car Service Requests dialog box each time you 
select a rental car.    De-select this option if you do not wish to see this dialog box each 
time.    Once this option has been turned off, you can turn it back on again by choosing 
System Options from the Tools menu and selecting the Display Rental Car Service 
Requests After Planning option.

See also
Requesting rental car services 
Reviewing rental car service requests 
Changing rental car service requests 
 



    Adding Hotels
Overview

Hotel Planning and Selection

Planning a hotel stay 

Selecting a hotel 

Viewing hotel details 

Selecting a room type 

Hotel Preferences

How hotel preferences are used 

Editing preferences for the current hotel room 

Hotel Services

Requesting hotel services 

Reviewing hotel service requests 

Changing hotel service requests 



    Overview: Adding hotels
Adding a hotel room to your itinerary is a four step process:
· Entering planning information
· Selecting a hotel
· Selecting a room type and rate
· Specifying hotel service requests
You can view a range of available hotels and room types, or use hotel preferences to limit 
the display to hotels and room types that meet the specified preferences.    If the primary 
traveler belongs to one or more hotel discount programs and has entered this information in 
the Traveler Editor, you also have the option of selecting a hotel that qualifies for one of 
these programs.
Once you have selected a hotel and room type, you indicate any special service requests 
that you would like to have forwarded to the hotel  for example, a request for a late arrival 
guarantee or additional beds.
When you reserve your itinerary, your room selection and service requests are forwarded to 
the appropriate hotel.    A confirmation number will appear in the Notices area of the 
Itinerary Window after your reservation has been confirmed.
Note    Any changes to a hotel reservation must be made directly through the hotel, not through United Connection .

See also
Planning a hotel stay 
Selecting a hotel 
Selecting a room type 
Requesting hotel services 



    Planning a hotel stay
Before you can select a hotel, you need to specify a location, distance from reference point, 
and check-in and check-out dates.

To plan a hotel stay:
1. In the Itinerary Window, choose the Add Hotel icon from the toolbar.    The Add Hotel 

dialog box appears.
2. Complete the Add Hotel fields as follows:

In this field You can

Location Enter or select the airport or city where you wish to 
stay.
If you don't know the exact name, click on the down 
arrow next to the Location field to search by city, 
airport, or airport code.    See Using the Airport 
Search option for more information.
Tip    The destination of the last flight without an 
associated hotel is displayed by default.

Within Indicate (in number of miles) the greatest distance 
you are willing to stay from your reference point.    
The default is 20 miles.

Miles Of Select the reference point you want to stay near.    
The default is the airport at the selected location.    
References points vary by location.

Check-In Date Enter or select a check-in date.

Check-Out Date Enter or select a check-out date.

3. To continue, do one of the following:
· To view a list of available hotels at or near the specified location, choose the Find 

Hotels button.    See Selecting a hotel for more information.
· To leave the hotel in Planned status for now, choose OK.    The Itinerary Window 

displays the hotel planning information you entered.

See also
Add Hotel dialog box 
Selecting a hotel 



    How hotel preferences are used
Hotel preferences are specified in the Hotel tab of the traveler profile.    To use hotel 
preferences, choose the Use Preferences option in the Select Hotel dialog box.    United 
Connection  uses the hotel preferences from the primary traveler's profile as the defaults.    
If you wish, you can change hotel preferences for the current hotel.

Preferences are used as follows:

Preferred Hotel Chains
United Connection displays only the primary traveler's preferred hotel chains.    If no 
preferred hotels are available, or if the primary traveler has not selected any preferred hotel 
chains, United Connection displays hotels that meet the primary traveler's other 
preferences.

Preferred Occupancy
United Connection displays only hotels that offer the preferred occupancy type.    If no 
available hotels offer the preferred occupancy, United Connection displays hotels that meet 
the primary traveler's other preferences.

Preferred Amenities
United Connection displays only hotels that offer all the primary traveler's preferred 
amenities.    If no available hotels offer all preferred amenities, or if the primary traveler has 
not selected any amenities, United Connection displays hotels that meet the primary 
traveler's other preferences.

Preferred Rate Category
United Connection displays hotels that have rooms available in either the Standard rate 
category or the primary traveler's preferred rate category.

Search Within Price Range
United Connection displays only hotels that offer rates within the rate range specified in the 
primary traveler's profile.    If no available hotels offer rates within the specified range, or if 
the primary traveler has not selected the Search Within Price Range option, United 
Connection displays hotels that meet the primary traveler's other preferences and offer 
varying rate ranges.

Which Is Most Important To You?
United Connection places a higher priority on finding hotels that meet the Most Important 
preference.    For example, if you specify Amenities as your most important preference, 
United Connection will place a lower priority your other preferences (preferred rate range, 
rate category, and hotel chains) in order to find available hotels that offer all of your 
preferred amenities.

See also
Editing preferences for the current hotel room 
Hotel Preferences dialog box 



    Selecting a hotel
After you enter your hotel planning information, you are ready to select a hotel.    You do this 
in the Select Hotel dialog box, which displays a list of available hotels at the location you 
specified.    A message appears if one or more hotels do not meet the primary traveler's 
hotel preferences, including the distance from the specified reference point.
Important    To display companies based on the primary traveler's hotel preferences, select the Use Preferences 
option.    If Use Preferences is not selected, United Connection  displays a range of available hotels at the specified 
location.

How to display the Select Hotel dialog box

To select a hotel:
1. Display the Select Hotel dialog box.
2. Review the list of available hotels.    Note that the list contains only hotels which have 

rooms available for the dates you specified.
Hotels are listed by rate, from lowest to highest.    The planning information you entered 
and the total number of nights for this stay appear at the bottom of the dialog box.
Note    The Distance column indicates the number of miles and direction from the reference point for each hotel.

3. If the primary traveler's identification information includes a discount program number 
for one or more hotels, the notation "Discount program rate applies" appears below the 
table and an asterisk is displayed next to those hotel names.    Choose one of those 
hotels if you want to reserve a hotel room at the primary traveler's discount rate for that 
hotel.

4. To see the address, phone number(s), policies, location, services, and other information 
for a particular hotel, highlight that hotel and choose the Details button.    The Hotel 
Details dialog box appears.    Choose Close to return to the Select Hotel dialog box.

5. If you find a hotel that you want to select, highlight it and continue with step 6.    If none 
of the hotels meet your needs, you can change the list using one of the following 
options:
· If available, choose the More Hotels button.    United Connection displays additional 

hotels at the specified location.    Hotels are sorted by rate range from low to high.
· Change hotel preferences for this stay.    See Editing preferences for the current hotel 

room for more information.
· If the Use Preferences option is selected, de-select this option.    United Connection 

ignores the primary traveler's hotel preferences and updates the list to display a 
range of hotels at the specified location that have rooms available.

6. Highlight the hotel you want to select and choose OK.    The Select Room Type dialog box 
appears.    See Selecting a room type for more information.

See also
Select Hotel dialog box 
Editing preferences for the current hotel room 
Viewing hotel details 





How to display the Select Hotel dialog box:
· To add a new hotel to your itinerary:

a. Choose the Add Hotel icon from the toolbar.
b. In the Add Hotel dialog box, enter the required planning information and choose 

the Find Hotels button.

· To modify a Planned or Selected hotel:
In the Itinerary Window, highlight the hotel and choose the Find icon from the toolbar.

Note    If you are not already connected to the reservation system, you will be prompted to connect in order to 
display the Select Hotel dialog box.



Use Preferences option
If you want to use preferences to limit the hotels displayed by United Connection , select 
the Use Preferences option in the Select Hotel dialog box.    When you select this option, 
United Connection displays only hotels that meet the primary traveler's hotel preferences. 
If you wish, you can edit these preferences for the current hotel room.    See Editing 
preferences for the current hotel room for more information.

Note    If one or more preferences cannot be met, United Connection displays available hotels that meet other 
specified preferences.



    Viewing hotel details
You can view detailed information for any hotel.    This includes the hotel address, phone 
number(s), policies, location, services, and other information.
Note    All information is provided directly by the hotel.    United Airlines makes no claim of its accuracy.

How to display the Hotel Details dialog box

To view hotel details:
1. Display the Hotel Details dialog box.
2. In the Type of Information list, select General Information to view this information. If 

necessary, scroll down to view all the information.
3. In the Type of Information list, double-click on one of the remaining topics to display a list

of available options for that topic.    These topics are:
Policies
Location
Services
Highlight a topic to display the corresponding information. If necessary, scroll down to 
view all the information.

4. Choose Close to return to the Select Hotel dialog box.

See also
Hotel Details dialog box 
Selecting a hotel 



General Information includes:
· Full property name
· Address
· Phone number
· Fax number
· Check-in and check-out times
· AAA rating (if available)
· Descriptive text



Policies includes:
· Cancellation policies
· Credit cards accepted
· Deposit requirements
· Guarantee policy
· Taxation



Location includes:
· Directions
· Location
· Transportation



Services include:
· Facilities
· Services
· Other



    Editing preferences for the current hotel room
When you add a hotel room to your itinerary, you indicate whether you want to use the 
primary traveler's hotel preferences to narrow the search for acceptable hotel rooms.    If you
opt to use preferences, United Connection  attempts to find hotels that meet all the 
specified preferences.    You can edit these preferences during the hotel selection process.
Note    If one or more preferences cannot be met, United Connection displays available hotels that meet other 
specified preferences.

To edit preferences for the current hotel:
1. In the Select Hotel dialog box, choose the Edit button.    The Hotel Preferences dialog box 

appears.
2. Update the hotel preference fields as follows:

In this field You can

Preferred Hotel 
Chains

Select the three hotel chains the traveler most 
prefers.

Preferred 
Occupancy

Select Single or Double occupancy.

Preferred 
Amenities

Select up to eight amenities.

Preferred Rate 
Category

Select one of the following options:    Standard, 
Corporate, Senior Citizen, Club Level, Weekend.

Search Within 
Price Range

Select this option if you want United Connection to 
display only hotels that offer rates within a price 
range you specify.    Then, do the following:
a. In the Highest Rate field, enter the highest rate 

(per night) you want to pay for a room.
b. In the Lowest Rate field, enter the lowest rate 

(per night) you want to pay for a room.
Note    To have United Connection ignore the rate 
range search option, de-select the Search Within 
Price Range option.

Which Is Most 
Important To You?

Select the preference that is most important to you 
when searching for a hotel: Hotel Chain, Room 
Rates, or Amenities.
United Connection will try to find hotels that meet all 
of your preferences.    However, a higher priority is 
placed on finding hotels that meet the Most 
Important option.

3. If you want to save the new preferences in the primary traveler's profile, choose the 
Update Profile button (this is optional).

4. To apply the new preferences to the current hotel, choose OK.    An updated list of hotels 
appears.

See also
Hotel Preferences dialog box 



How hotel preferences are used 



    Selecting a room type
After you enter your hotel planning information and select a hotel, you are ready to select a 
room type.
Click here for more information about hotel discount programs.

To select a room type:
1. In the Select Hotel dialog box, highlight a hotel and choose OK.    The Select Room Type 

dialog box appears.
2. Review the list of available hotel rooms.    The following information is displayed for each 

room:
· Rate Category
· Room Type
· Room rate
· Total for stay
Hotels are listed by total cost, from lowest to highest.    The check-in and check-out 
dates, hotel name, address, and telephone number also appear at the bottom of the 
dialog box.

3. If the Discount Program Rates option is selected and you wish to see other available 
room types and rates, de-select this option.
Note    This option is only available if the primary traveler's identifying information includes a discount program 
number for the selected hotel.

4. If a late arrival guarantee or cancellation fee applies, a message will appear below the 
list of hotel rooms.    If you select a room, you will be required to provide a credit card to 
guarantee the room when you reserve your itinerary.    See Hotel room guarantee 
requirements for more information.

5. Highlight the room type you want to select and choose OK.    The Hotel Service Requests 
dialog box appears.
Note    If this dialog box does not appear after you select a room type, choose System Options from the Tools 
menu and select the Display Hotel Service Requests After Planning option.

See also
Select Room Type dialog box 



Hotel discount programs
If the primary traveler's identifying information includes a discount program number for 
the selected hotel chain, United Connection  by default displays only discount program 
options in the Select Room Type dialog box.    No discount program rates are displayed, 
since rates can vary between programs.    To see standard rates, de-select the Discount 
Program Rates option.



Rate Category includes:
· Standard (Rack)
· Corporate
· Senior Citizen
· Club Level
· Weekend



Room Type includes:
· Standard
· Moderate
· Superior
· Deluxe
· Junior Suite
· 1 Bedroom Suite
· 2 Bedroom Suite
· Non-Smoking
Room types will also provide a choice of one or two beds in one or more of the following 
sizes: Twin, Double, Queen, or King.



Hotel room guarantee requirements

Some hotels require a credit card to guarantee a room for late arrival.    Others require a 
credit card to guarantee any room reservation.    Still others require a credit card and will 
apply a cancellation fee if you do not show up.    If a guarantee is required, you will need to 
provide a credit card number for the hotel when you reserve your itinerary.    See 
Guaranteeing hotel rooms for more information.

The following messages can appear below the list of available hotel rooms in the Select 
Room Type dialog box:

"Late arrival guarantee required for check-in after xx p.m."
If you plan to arrive after the specified check-in time you will need to provide a credit card 
to hold your reservation.    To guarantee your room, select the Guarantee Room For Late 
Arrival option in the Hotel Service Requests dialog box.    See Requesting hotel services for 
more information.

"Room must be guaranteed.    See cancellation policy for details."
You will need to provide a credit card to hold your reservation.    If you choose this hotel, 
the Guarantee Room For Late Arrival option in the Hotel Service Requests dialog box will 
be selected automatically.

"Cancellation fee applies.    Please contact the hotel for details."
If you reserve a room at this hotel and do not keep the reservation, the credit card you 
provide will be charged for one night's stay at the requested rate.    If you choose this 
hotel, the Guarantee Room For Late Arrival option in the Hotel Service Requests dialog box
will be selected automatically.

More information about a particular hotel's cancellation policy, guarantee policy, deposit 
requirements, and accepted credit cards may be available in the Hotel Details dialog box.

To see guarantee and cancellation policies for a hotel:
1. Choose the Details button in the Select Hotel dialog box.    The Hotel Details dialog box 

appears.
2. Double-click on the Policies option.
3. Highlight one or more of the following options to display the corresponding information 

on the right side of the dialog box:
· Cancellation Policy
· Guarantee Policy
· Deposit Requirements
· Credit Cards Accepted

4. When you have finished reviewing the information, choose Close to return to the Select 
Hotel dialog box.

See also
Viewing hotel details 



Select Hotel dialog box 
Select Room Type dialog box 



    Requesting hotel services
After selecting a hotel, you can request hotel services.    Hotel services include guarantee for 
late arrival, additional guests in room, additional beds and/or cribs in room, and associated 
frequent flyer program.    You specify these service requests in the Hotel Service Requests 
dialog box.
Important    United Connection  cannot guarantee hotel service requests 

 please call the hotel directly to confirm your requests.    Once you reserve a hotel room, any changes must be 
made directly through the hotel.

How to display the Hotel Requests Service Requests dialog box

To request hotel services:
1. Display the Hotel Service Requests dialog box.    The default services are those specified 

in the primary traveler's profile.
2. Select the desired hotel service requests:

In this field You can

Guarantee Room 
For Late Arrival

Select this option to hold the room regardless of 
your arrival time.
Important    If you select this option, a credit card 
will be required to guarantee the room.

Additional Adults 
In Room

Specify the number of additional adults that will be 
sharing the room.
Note    The "Additional Adults In Room" option 
applies to double-occupancy rooms only.    Do not 
include the first two occupants.

Additional Children
In Room

Specify the number of additional children that will be
sharing the room.
Note    The "Additional Children In Room" option 
applies to double-occupancy rooms only.    Do not 
include the first two occupants.

Roll-Away Beds 
Required

Specify the number of additional beds required.

Cribs Required Specify the number of cribs required.

Associated 
Frequent Flyer 
Program

Select one of the primary traveler's frequent flyer 
programs to send that program number to the hotel.
See About the Associated Frequent Flyer Program 
for more information.

3. Choose OK to return to the Itinerary Window, which is updated to display the hotel room 
you selected.
Note    When you are ready to reserve the selected flights, rental cars, and hotel rooms in your itinerary, choose 
the Reserve button from the toolbar.    See Reserving your itinerary for more information.

See also
Hotel Service Requests dialog box 



Reviewing hotel service requests 
Changing hotel service requests 



How to display the Hotel Service Requests dialog box:
· From the Itinerary Window, double-click on a selected hotel.    The Edit Hotel dialog box

appears.    Choose the Requests button.

Note    The Hotel Service Requests dialog box appears automatically after you select a room type.    If it 
does not appear automatically, choose System Options from the Tools menu and select
the Display Hotel Service Requests After Planning option.



About the Associated Frequent Flyer Program:
When you reserve a hotel room and select one of the primary traveler's frequent flyer 
program as the Associated Frequent Flyer Program, United Connection  will forward the 
primary traveler's membership number for that program to the hotel.    If the selected 
frequent flyer program has a promotional agreement with the hotel, the primary traveler 
may be eligible for any benefits offered under that promotion.
Other restrictions may apply  please contact the hotel or your frequent flyer program for 
details.    You may be required to show proof of program membership (for example, your 
frequent flyer card) at pick-up.
Note    The Associated Frequent Flyer Program field contains a list of frequent flyer programs entered for the 
primary traveler.    For help entering frequent flyer account information, see Entering travel program information. 



    Reviewing hotel service requests
You can review service requests for any hotel in your itinerary.    Hotel services include 
guarantee for late arrival, additional guests in room, additional beds and/or cribs in room, 
and associated frequent flyer program.

To review hotel service requests:
1. In the Itinerary Window, double-click on the hotel whose services you want to review.    

The Edit Hotel dialog box appears.
2. Choose the Requests button.    The Hotel Service Requests dialog box appears.
3. Review the selected services.

Note    You can make changes to hotel services only if you have not yet reserved the hotel room.    After a hotel 
room has been reserved, you will need to contact the hotel directly to make any changes.

4. Choose OK to exit the Hotel Service Requests dialog box.

See also
Hotel Service Requests dialog box 
Requesting hotel services 
Changing hotel service requests 



    Changing hotel service requests
You can make changes to hotel services only if you have not yet reserved the hotel room.    
After a hotel room has been reserved, you will need to contact the hotel directly to make any
changes.

To change hotel service requests:
1. In the Itinerary Window, double-click on the hotel whose services you want to change.    

The status of the hotel must be SELECTED.
2. In the Edit Hotel dialog box, choose the Requests button.    The Hotel Service Requests 

dialog box appears.
3. Make any desired changes to the hotel services.
4. Choose OK to exit the Hotel Service Requests dialog box.

See also
Hotel Service Requests dialog box 
Requesting hotel services 
Reviewing hotel service requests 



    Add Hotel dialog box
You access the Add Hotel dialog box to specify the required hotel planning information.    This
includes the location (airport or city), distance from reference point, and check-in and check-
out dates.    Once you enter this information, you can either return to the Itinerary Window 
(leaving the hotel in Planned status) or proceed immediately to hotel selection.
Note    After you select a hotel, this dialog box is renamed "Edit Hotel."

How to display the Add Hotel dialog box

Dialog Box Options

Location
Enter or select the airport or city where you wish to stay.    If you don't know the exact 
name, you can click on the down arrow next to the Location field to search by city, airport, 
or airport code.    See Using the Airport Search option for more information.
Tip    The destination of the last flight without an associated hotel is displayed by default.

Within
Select the greatest distance you are willing to stay from your reference point (in miles).    
The default is 20 miles.

Miles Of
Select the reference point you want to stay near.    The default is the destination airport of 
the most recent flight.
Note    Reference points vary by location.

Check-In
Enter or select a check-in date.    The default is the arrival date of the most recent flight.

Check-Out
Enter or select a check-out date.    The default is one day after the check-in date.

Hotel Selection
After a hotel has been selected, this area displays the hotel name, address, telephone 
number, and room rate.

Find Hotels button
Choose this button to display the Select Hotel dialog box, which displays a list of available 
hotels using the specified planning information.

Requests button
Choose this button to display the Hotel Service Requests dialog box, which displays 
requested services for the selected hotel room.    This button is not available until a hotel 
room has been selected.

Details button
Choose this button to display the Hotel Details dialog box, which displays the address, 
phone number(s), policies, location, services, and other information for the selected hotel.  
This button is not available until a hotel room has been selected.



See also
Planning a hotel stay 
Selecting a hotel 
Reviewing hotel service requests 
Viewing hotel details 



To display the Add Hotel dialog box:
· From the toolbar in the Itinerary Window, choose the Add Hotel icon.    The Add Hotel 

dialog box appears.
Tip    If you have already planned or selected a hotel, you can review the planning information by double-
clicking on that hotel in the Itinerary Window.    The Edit Hotel dialog box appears.



    Select Hotel dialog box
The Select Hotel dialog box displays a list of hotels at the specified location that have rooms 
available.    At your option, United Connection  can display only hotels that conform to the 
primary traveler's hotel preferences 

 for example, Preferred Hotel Chains and Acceptable Rate Range.    You select a hotel, then 
choose OK to view available room types for that hotel.
Note    The list contains only hotels which have rooms available for the dates you specified.

How to display the Select Hotel dialog box

Dialog Box Options

Hotel Information
Displays available hotels at the specified location.    Hotels are listed by rate, from lowest 
to highest.    The following information appears for each hotel:

Heading Information

Hotel Hotel chain.

Property Name Name of hotel property.

Location Street address or other location information.

Distance Number of miles and direction from the reference
point.

Rate Range Rate or range of available rates.    (For non-U.S. 
locations, rates are display in local currency.)

Discount Program Rate Applies
If the primary traveler's identification information includes a discount program number for 
one or more hotels, the notation "Discount program rate applies" appears below the table 
and an asterisk is displayed next to those hotel names.    Choose one of those hotels if you 
want to reserve a hotel room at the primary traveler's discount rate for that hotel.

Hotel Plan
Displays the following information:

Located Selected location and distance from reference point.

Check-In Planned check-in date.

Check-Out Planned check-out date.

Nights Total number of nights for this hotel stay.

Use Preferences
Choose this option to display only those hotels that conform to the primary traveler's hotel
preferences.    To change hotel preferences for this rental, choose the Edit button.    See 
Editing preferences for the current hotel room for more information.
Note    If one or more preferences cannot be met, United Connection displays available hotels that meet other 
specified preferences.



Edit button
Choose this button to display the Hotel Preferences dialog box.    The hotel preferences 
from the primary traveler's profile appear in this dialog box by default.    If you wish, you 
can change these preferences for the current hotel room.

Details button
Highlight a hotel and choose this button to display the Hotel Details dialog box, which 
includes the address, phone number(s), policies, location, services, and other information 
for the selected hotel.

More Hotels button
If United Connection finds more hotels than it can display at one time, the More Hotels 
button is enabled.    Choose this button to display additional hotels.    Hotels are sorted by 
rate range from low to high.

See also
Selecting a hotel 
Editing preferences for the current hotel room 
Viewing hotel details 



    Hotel Preferences dialog box
The Hotel preferences dialog box lets you view and/or edit preferences for the current hotel.  
The default hotel preferences are those specified in the primary traveler's profile.    You can 
save your changes in the primary traveler's profile, or apply them to the current hotel only.
If you opt to use hotel preferences, United Connection  attempts to find hotels that meet all 
the specified preferences.    If one or more preferences cannot be met, United Connection 
displays available hotels that meet other specified preferences.
Important    If you want United Connection to use the specified hotel preferences to find hotels, select the Use 
Preferences option in the Select Hotel dialog box.

How to display the Hotel preferences dialog box

Dialog Box Options

Using Primary Traveler's Preferences
Displays the primary traveler's name, and the profile selected for this itinerary.

Preferred Hotel Chains
Select your three preferred hotel chains.    United Connection will display only the specified 
hotel chains (if available).

Preferred Occupancy
Select your preferred room occupancy.    United Connection will display only hotels that 
offer the specified occupancy type (if available).

Preferred Amenities
Select up to eight preferred amenities.    United Connection will display only hotels that 
offer all the specified amenities (if available).

Preferred Rate Category
Select your preferred rate category.    United Connection will display hotels that have rooms
available in either of the following rate categories:
· Standard rate
· Preferred rate category

Search Within Price Range
Select this option if you want United Connection to display only hotels that offer rates 
within a specified price range (if available).    After selecting this option, enter dollar 
amounts in the Highest Rate and Lowest Rate fields.
Note    If this option is de-selected, any amounts specified in the Highest Rate and Lowest Rate fields are ignored.

Highest Rate
Enter the highest acceptable room rate (per night).

Lowest Rate
Enter the lowest acceptable room rate (per night).

Which Is Most Important To You?



Select the hotel preference that is most important to you: Hotel Chain, Room Rates, or 
Amenities.    When United Connection checks for available hotels, it tries to find hotels that 
meet all the specified preferences.    However, it places a higher priority on finding hotels 
that meet the Most Important preference.

OK button
Choose this button to apply the changes to the current hotel.

Update Profile button
Choose this button to save the changes in the primary traveler's profile.

See also
How hotel preferences are used
Editing preferences for the current hotel room 



To display the Hotel Preferences dialog box:
· In the Select Hotel dialog box, choose the Edit button.    United Connection  displays 

the hotel preferences from the primary traveler's profile.



    Hotel Details dialog box
The Hotel Details dialog box shows you the address, phone number(s), policies, location, 
services, and other information for the selected hotel.
Note    All information is provided directly by the hotel.    United Airlines makes no claim of its accuracy.

How to display the Hotel Details dialog box

Dialog Box Options

Type of Information
Options include:
· General Information
· Policies
· Location
· Services
Select General Information to view this information in the Description box.    Double-click 
on one of the remaining options (Policies, Location, and Services) to display a list of 
available topics for that option.    Highlight a topic to display the corresponding information.
Topics are listed below.

Description
Displays the selected information.    All information is provided directly by the hotel.    If 
necessary, scroll down to view all the information.    This can include:

General Information
· Full property name
· Address
· Phone number
· Fax number
· Check-in and check-out times
· AAA rating (if available)
· Descriptive text

Policies
· Cancellation policies
· Credit cards accepted
· Deposit requirements
· Guarantee policy
· Taxation

Location
· Directions
· Location
· Transportation



Services
· Facilities
· Services
· Other

See also
Viewing hotel details 
Select Hotel dialog box 



To display the Hotel Details dialog box, do one of the following:
· In the Select Hotel dialog box, highlight the desired hotel and choose the Details 

button.
· In the Edit Hotel dialog box, choose the Details button.    This button is not available 

until you select a hotel.



    Select Room Type dialog box
The Select Room Type dialog box displays a list of available hotel rooms for the hotel you 
selected.
Note    If the primary traveler's identifying information includes a discount program number for the selected hotel, 
United Connection  by default displays only discount program options in the Select Room Type dialog box.

How to display the Select Room Type dialog box

Dialog Box Options

Room Type Information
Displays available room types for the selected hotel.    Rooms are listed by total cost, from 
lowest to highest.    The following information is displayed:

Heading Information

Rate Category For example, Standard or Weekend.    Click here 
to see available rate categories.

Room Type Room type and number and type of beds.    For 
example, Deluxe Room 2 King Beds.    Click here 
to see available room types.

Room Rate Applicable room rate, usually per day.

Room Total Total cost for the hotel stay.    Note that taxes and 
other charges may apply  see the Hotel Details 
dialog box for more information about additional 
charges.

Late arrival guarantee or cancellation fee message
If a late arrival guarantee or cancellation fee applies, a message will appear below the list 
of hotel rooms.    If you select a room, you will be required to provide a credit card to 
guarantee the room when you reserve your itinerary.    See Hotel room guarantee 
requirements for more information.

Discount Program Rates
This option is available (and is selected by default) if the primary traveler's identification 
information includes a discount program number for the selected hotel.    When this option 
is selected, United Connection displays discount program options only.    De-select this 
option to display standard room types and rates.
Note    Since United Connection cannot display specific discount program rates, "N/A" appears in the Room Cost 
column when this option is selected.

Hotel Plan
Displays the following information:

Check-In The planned check-in date.

Check-Out The planned check-out date.

Hotel Name The name of the selected hotel.

Address The address of the selected hotel.



Phone The telephone number of the selected hotel.

See also
Selecting a room type 



How to display the Select Room Type dialog box:
· In the Select Hotel dialog box, highlight the desired hotel and choose OK.



    Hotel Service Requests dialog box
The Hotel Service Requests dialog box lets you indicate which services you want to request 
for the current hotel room.    By default, United Connection  displays the service requests 
from the primary traveler's profile.    When you make a hotel reservation, United Connection 
forwards your service requests to the hotel.
Important    United Connection cannot guarantee hotel service requests  please call the hotel directly to confirm 
your requests.

How to display the Hotel Service Requests dialog box

Dialog Box Options

Guarantee Room For Late Arrival
Select this option to hold the hotel room regardless of arrival time at the hotel.    A credit 
card will be required to guarantee the room.    See Guaranteeing hotel rooms for more 
information.

Additional Adults In Room
Specify the number of additional adults that will be sharing the room.
Note    This applies to additional adults in a double-occupancy room only.    Do not include the first two occupants in
this field.    For example, if three adults will be sharing a double-occupancy room, select "1" for Additional Adults in 
Room.    To request double occupancy, select "2" in the Occupancy field of the Hotel Preferences dialog box.

Additional Children In Room
Specify the number of additional children that will be sharing the room.
Note    This applies to additional children in a double-occupancy room only.    Do not include the first two occupants 
in this field.    For example, if two adults and one child    will be sharing a double-occupancy room, select "1" for 
Additional Children in Room.    To request double occupancy, select "2" in the Occupancy field of the Hotel 
Preferences dialog box.

Roll-Away Beds Required
Specify the number of roll-away beds required.

Cribs Required
Specify the number of cribs required.

Associated Frequent Flyer Program
Select one of the primary traveler's frequent flyer programs to send that program number 
to the hotel.
When you reserve a hotel room and select one of the primary traveler's frequent flyer 
program as the Associated Frequent Flyer Program, United Connection will forward the 
primary traveler's membership number for that program to the hotel.    If the selected 
frequent flyer program has a promotional agreement with the hotel, the primary traveler 
may be eligible for any benefits offered under that promotion.
Other restrictions may apply  please contact the hotel or your frequent flyer program for 
details.    You may be required to show proof of program membership (for example, your 
frequent flyer card) at check-in.



Note    The Associated Frequent Flyer Program field contains a list of frequent flyer programs entered for the 
primary traveler.    For help entering frequent flyer account information, see Entering travel program information. 

Show these options after planning a hotel stay
Select this option to display the Hotel Service Requests dialog box each time you choose a 
hotel room.    De-select this option if you do not wish to see this dialog box each time.    
Once this option has been de-selected, you can select it again by choosing System Options
from the Tools menu and choosing the Display Hotel Service Requests After Planning 
option.

See also
Requesting hotel services 



Amenities include:
· Baby Sitting · Non-Smoking Rooms

· Concierge · Parking

· Airport Transportation · Pool

· Entertainment · Indoor Pool

· Golf · Outdoor Pool

· Handicap Facilities · Restaurant

· Health Club · Room Service

· Kitchenette · Small Pets

· Meeting Rooms · Secretarial Service

· Movies · Tennis Courts

 



Checking flight status

United Connection  lets you check the status of any flight in the reservation system 
 all you need to provide is the airline, flight number, and departure date.    United 

Connection can display actual operational information for all United and United Express 
flights leaving today, tomorrow, or yesterday.    This includes gate information, and whether 
the flight is early or delayed.    Schedule information is displayed for all other flights.

To check flight status:
1. From the Tools menu, choose Flight Status.    The Check Flight Status dialog box appears.
2. Complete the Check Flight Status fields as follows:

In this field You can

Airline Enter or select the name of the airline whose flight 
you want to check.

Flight # Enter the flight number whose status you want to 
check.

Date Enter or select the departure date.

From Enter or select the origin airport.    This information is
optional.    See Using the Airport Search option if you
need help selecting an airport name.

3. Choose OK.    The Flight Status dialog box appears.
4. Review the flight status information.    The flight number, airline, and departure date are 

displayed at the top of the dialog box.    The table displays information for each segment 
of the selected flight.
Operational information is displayed for all United and United Express flights departing 
on the current day, the following day, or the previous day.    Schedule information is 
displayed for all other flights.

Operational information

Schedule information

5. When you have finished reviewing the flight status information, choose Close to return to
the Check Flight Status dialog box.

6. If you wish, you can enter new information to view flight status for another flight.
7. To return to the Itinerary Window, choose Cancel.

See also
Check Flight Status dialog box 
Flight Status dialog box 



Operational information includes:
· Departure and arrival airports
· Departure and arrival gates
· Actual (or estimated) departure time
· Whether the departure is delayed or early, and by what length of time
· If the flight has left the gate
· Actual (or estimated) arrival time
· Whether the arrival is delayed or early, and by what length of time
· If the flight has landed or is at the gate
· Information about any delays or cancellations (for example, delays due to equipment 

substitution or weather)



Schedule information includes:
· Departure and arrival airports
· Scheduled departure time
· Scheduled arrival time



    Reviewing Mileage Plus
 summary information

United Connection  lets you review Mileage Plus account balance information for all 
individuals in the Traveler Editor whose traveler information includes a Mileage Plus account 
number.    This includes member level, Original Program Balance, New Program Balance, 
Year-to-Date Balance, and information about the last four credited flights.

To review Mileage Plus  summary information:
1. From the Tools menu, choose Mileage Plus  Summary.    The Mileage Plus

 Summary dialog box appears.
2. In the Name field, select the person whose Mileage Plus summary information you want 

to review.    The list contains the names of all individuals in the Traveler Editor whose 
traveler information includes a Mileage Plus account number.

3. Choose the Retrieve button.    United Connection displays the person's account number 
and Mileage Plus level, along with the Mileage Plus customer service telephone number.

4. In the Account Summary table, review the Mileage Plus balance information.    This 
includes:

Original Program Balance

New Program Balance

Year-To-Date Balance

5. In the Recent Account Activity table, review the last four flights for which Mileage Plus 
miles were credited.    Miles, bonus miles, and total miles are displayed for each flight.

6. Choose Close to return to the Itinerary Window.

See also
Mileage Plus Summary dialog box 



Mileage Plus  level
Mileage Plus membership levels include the following:
· 100,000 Mile Flyer (100,000+ miles)
· Premier Executive (50,000 - 99,999 miles)
· Premier (25,000 - 49,999 miles)
· Mileage Plus Member (less than 25,000 miles)
· Premier Emeritus (former Premier)



Original Program Balance
Displays the current balance in the selected member's original Mileage Plus  program 
account.    This only applies to members who accrued Mileage Plus frequent flyer miles 
before 7/1/89.



New Program Balance
Displays the current balance in the selected member's new Mileage Plus  program 
account.    This includes all Mileage Plus frequent flyer miles accrued since 7/1/89.



Year-To-Date Balance
Displays the total number of Mileage Plus  miles accrued in the current calendar year.



    Computing Mileage Plus
 miles between cities

United Connection  lets you compute the Mileage Plus frequent flyer miles between two 
airports served by United Airlines or United Express.    Mileage information is available for 
most larger domestic and international airports.
Note    Mileage is only available if United or United Express operates a scheduled non-stop flight between the 
specified airports.

To compute Mileage Plus  miles between cities:
1. From the Tools menu, choose Compute Mileage Plus  Miles.    The Mileage Plus Miles 

Between Cities dialog box appears.
2. In the From field, enter or select the desired origin airport.    See Using the Airport Search 

option if you need help finding an airport name.
3. In the To field, enter or select the desired destination airport.
4. Choose the Miles button.    United Connection displays the origin, destination, and 

Mileage Plus flight miles between the two airports.
Note    If you are not already connected to the reservation system, you will be prompted to connect in order to 
compute the mileage.

5. If you wish, you can repeat steps 2-4 to compute miles for additional origin/destination 
pairs.    United Connection displays the mileage for each pair, as well as a running total.

6. To clear the displayed mileage information, choose the Clear button.
7. To return to the Itinerary Window, choose Close.

See also
Mileage Plus Miles Between Cities dialog box 



    Reviewing United Information
United Connection  includes an information window that keeps you up-to-date with current 
promotions and special offers from United Airlines.    United Connection checks for new 
information each time you connect to the reservation system and informs you when an 
update is available.    You will have the opportunity to retrieve the new information 
immediately, or do so at a later time.

To review United Information:
1. Display the United Information window by doing one of the following:

· From the Welcome window, choose the United Information option.
· From the Tools menu, choose United Information.

2. Review the information.
3. Choose Close to return to the Itinerary Window.



    Reviewing system options
United Connection  lets you decide whether you want to display certain dialog boxes at 
startup and during planning.    You can also enter the travel agency code for your preferred 
Apollo travel agency.    You will need to provide this code if you want to pick up your tickets 
at that Apollo travel agency.

To review your system options:
1. In the Tools menu, choose System Options.    The System Options dialog box appears.
2. The following options are available:

· Display Flight Service Requests Summary after planning.
· Display prompt to plan another flight.
· Display Rental Car Service Requests after planning.
· Display Hotel Service Requests after planning.
· Display Welcome window at startup.
Select or de-select options by clicking in the boxes next to those options.    An "X" 
appears next to an option when it is selected.

3. In the Airport Selection List Options, specify the following information:
a. In the Default Sort Order list, choose the sort option you want to use as the default 

when searching for airport names.
b. To show only U.S. locations in the airport selection list, click in the box next to Show 

US Locations Only.
4. If you want the option of picking up tickets at your preferred Apollo travel agency, enter 

the code for that agency in the Agency Code field.
Note    Please contact your preferred Apollo travel agency to obtain their code.

5. Choose OK to save your changes and return to the Itinerary Window.

See also
System Options dialog box 



    Displaying the Welcome Window
The Welcome Window is normally the first screen you see after starting the program.    This 
screen allows you to go quickly to any of the following areas:
· Personal Profiles (Traveler Editor dialog box)
· Travel Planning (Itinerary Window)
· Mileage Plus (Mileage Plus  Summary dialog box)
· Flight Status (Check Flight Status dialog box)
· United Information (United Information window)

Select an icon to go directly to the associated dialog box.    Follow the steps below if the 
Welcome Window does not appear automatically after you start United Connection .

To display the Welcome Window:
1. In the Tools menu, choose System Options.    The System Options dialog box appears.
2. Click in the box next to Display Welcome Screen At Startup to select that option.
3. Choose OK to save your change and return to the Itinerary Window.    The Welcome 

Window will appear the next time you start United Connection.

See also
Reviewing system options 
System Options dialog box 



    Entering your preferred Apollo travel agency code
If you want the option of picking up airline tickets at your preferred Apollo travel agency, you
must enter the code for that agency in the System Options dialog box.    Please contact your 
Apollo travel agency to obtain their code.    See Ticketing options for more information about 
the ticketing options available through United Connection , including Electronic-Ticket.

To enter your preferred Apollo travel agency code:
1. In the Tools menu, choose System Options.    The System Options dialog box appears.
2. In the Agency Code field, enter the three- or four-character code for your preferred Apollo

travel agency.
3. Choose OK to save the new information and return to the Itinerary Window.

United Connection validates the code and displays the name of the specified agency.    
This travel agency name will appear in the Ticketing Options dialog box as an available 
ticketing option the next time you reserve an itinerary.

See also
Reviewing system options 
System Options dialog box 



Check Flight Status dialog box

You access the Check Flight Status dialog box to request arrival and departure information 
for a specific flight.    Actual operational data is available for all United and United Express 
flights leaving today, tomorrow, or yesterday.    This includes gate information, and whether 
the flight is early or delayed.    Schedule information is provided for all other flights.

How to display the Check Flight Status dialog box

Dialog Box Options

Airline
Enter or select name of the airline whose flight you want to check.    The list contains the 
names of all airlines stored in the reservation system, in alphabetical order.

Flight #
Enter the flight number whose status you want to check.

Date
Enter or select the departure date of the flight you want to check.

From
Enter or select the origin airport.    This information is optional.    See Using the Airport 
Search option if you need help selecting an airport name.

See also
Checking flight status 
Flight Status dialog box 



To display the Check Flight Status dialog box:
· From the Tools menu, choose Flight Status.



Flight Status dialog box

You access the Flight Status dialog box to view arrival and departure information for the 
specified flight.    Actual operational data is available for United and United Express flights 
leaving today, tomorrow, or yesterday.    This includes gate information, and whether the 
flight is early or delayed.    Schedule information is displayed for all other flights.

How to display the Flight Status dialog box

Dialog Box Options

Flight
Displays the flight number and airline name specified in the Check Flight Status dialog box.

Date
Displays the departure date specified in the Check Flight Status dialog box.

Location
Displays the departure and arrival airports and cities for each flight segment.

Actual Time/Sched Time
For United and United Express flights departing today, tomorrow, or yesterday, displays 
the actual (or estimated) departure and arrival times for each flight segment.    For all 
other flights, displays the scheduled departure and arrival times.

Gate
For United and United Express flights departing today, tomorrow, or yesterday, displays 
the departure and arrival gates for each flight segment.

Information
For United and United Express flights departing today, tomorrow, or yesterday, indicates 
whether the flight is delayed or early and by what length of time.
Note    Flights can be delayed or canceled for a variety of reasons.    For example, airport conditions, holding for 
inbound connections, equipment substitution, gate congestion, custom hall delays, weather, etc.    For United and 
United Express flights, any delay or cancellation information provided by the reservation system will be displayed 
below the flight segment.

See also
Checking flight status 
Check Flight Status dialog box 



To display the Flight Status dialog box:
1. In the Check Flight Status dialog box, enter the airline, flight number, and departure 

date of the flight whose status you want to check.
2. Choose the OK button.



    Mileage Plus
 Summary dialog box

You access the Mileage Plus  Summary dialog box to review Mileage Plus account balance 
information for any individual in the Traveler Editor whose traveler information includes a 
Mileage Plus account number.    Summary information includes member level, Original 
Program Balance, New Program Balance, Year-to-Date Balance, and information about the 
last four credited flights.

How to display the Mileage Plus  Summary dialog box 

Dialog Box Options

Name
Select the person whose Mileage Plus summary information you want to review.    The list 
contains the names of all individuals entered in the Traveler Editor whose traveler 
information includes a Mileage Plus account number.
Note    After selecting a name, you must choose the Retrieve button to display information for that person.

Account
Displays the selected person's Mileage Plus account number.

Phone Number
Displays the Mileage Plus customer service telephone number.

Level
Displays the selected person's Mileage Plus member level.    This can include:
· 100,000 Mile Flyer (100,000+ miles)
· Premier Executive (50,000 - 99,999 miles)
· Premier (25,000 - 49,999 miles)
· Mileage Plus Member (less than 25,000 miles)
· Premier Emeritus (former Premier)

Account Summary
Displays the following Mileage Plus account summary information:

Type of balance Description
Original Program Balance Displays the current balance in the selected 

person's original Mileage Plus program 
account. This only applies to members who 
accrued Mileage Plus frequent flyer miles 
before 7/1/89.

New Program Balance Displays the current balance in the selected 
person's new Mileage Plus program account.
This includes all Mileage Plus frequent flyer 
miles accrued since 7/1/89.

Year-To-Date Balance Displays the total number of Mileage Plus 
miles accrued in the current calendar year.



Recent Account Activity
Displays the last four flights for which the selected person received Mileage Plus miles.    
Information includes:

Column Information
Date Flight departure date

Description Origin airport/city and destination airport/city

Miles Mileage Plus miles awarded for that flight

Bonus Bonus miles awarded for that flight

Total Total miles awarded for that flight

Retrieve button
Choose this button to display Mileage Plus account balance information for the selected 
person.

Print button
Choose this button to print the displayed Mileage Plus account information.    The Print 
dialog box appears.

See also
Reviewing Mileage Plus Summary information 



How to display the Mileage Plus  Summary dialog box:
· From the Tools menu, choose Mileage Plus  Summary.



    Mileage Plus Miles Between Cities dialog box
You access the Mileage Plus Miles Between Cities dialog box to compute the Mileage Plus 
frequent flyer miles between two airports served by United Airlines or United Express.    
Mileage information is available for most larger domestic and international airports.
Note    Mileage is only available if United or United Express operates a scheduled non-stop flight between the 
specified airports.

How to display the Mileage Plus Miles Between Cities dialog box

Dialog Box Options

From
Enter or select the desired origin airport.    See Using the Airport Search option if you need 
help finding an airport name.

To
Enter or select the desired destination airport.

Miles button
Choose this button to compute the Mileage Plus miles between the specified airports.

Total Miles
Displays the total Mileage Plus miles for all displayed airport pairs.

Clear button
Choose this button to clear the displayed mileage information.

See also
Computing Mileage Plus miles between cities 



How to display the Mileage Plus Miles Between Cities dialog box:
· From the Tools menu, choose Compute Mileage Plus  Miles.



    System Options dialog box
You access the System Options dialog box to indicate whether or not you want to display 
certain dialog boxes at startup and during planning.    You can also enter the travel agency 
code for your preferred Apollo travel agency.    If you want to pick up your tickets at an Apollo
travel agency you will need to provide this code.

How to display the System Options dialog box

Dialog Box Options

Display Flight Service Requests Summary after planning
Choose this option to display the Flight Service Requests Summary dialog box after you 
select a flight in the Select Flight dialog box.

Display prompt to plan another flight
Choose this option to display the Plan Another Flight dialog box after each flight you add to
your itinerary.

Display Rental Car Service Requests after planning
Choose this option to display the Rental Car Service Requests dialog box after you select a 
rental car type/rate.

Display Hotel Service Requests after planning
Choose this option to display the Hotel Service Requests dialog box after you select a hotel
room/rate.

Display Welcome window at startup
Choose this option to display the United Connection Welcome Window after starting the 
program.

Default Sort Order
Choose the sort order you want to use by default when searching for an airport name.

Show US locations only
Choose this option to display only U.S. locations in the airport list.

Agency Code
If you want the option of picking up tickets at your preferred Apollo travel agency, enter 
the three- or four-character code for that agency.    See Entering your preferred travel 
agency code for more information.
Note    Please contact your preferred Apollo travel agency to obtain their code.

See also
Reviewing system options 



To display the System Options dialog box:
· From the Tools menu, choose System Options.



    Retrieving an itinerary from the reservation system
If you have saved a local copy of an itinerary file on you computer, you should open that 
itinerary by choosing Open from the File menu.    This ensures that United Connection  has 
all of the traveler information used to create the itinerary.
However, after you reserve an itinerary you can also retrieve that itinerary directly from the 
reservation system.    This allows you to view your reservation even if the itinerary file has 
been deleted from your computer, or if you are using United Connection on another 
computer that does not contain a copy of the file (for example, your work computer).
Note    You cannot retrieve your itineraries from someone else's system.    United Connection can only retrieve 
itineraries created on the current system, or on another system registered to the same user.

Dialog Box Options

Name
Displays the descriptive name of each reserved itinerary created on the current system (or
on another system registered to the same user).    This is the name entered in the Confirm 
Reservation dialog box.

Confirmation Number
Displays the confirmation number of each reserved itinerary.    This is the number assigned 
by the reservation system.

To retrieve an itinerary from the reservation system:
1. From the File menu, choose Retrieve From Reservation System.    The Retrieve From 

Reservation System dialog box appears.
2. Review the list of available itineraries.    The list shows the descriptive name and 

confirmation number of all reserved itineraries created on the current system (or on 
another system registered to the same user).

3. To retrieve an itinerary, highlight that itinerary name and choose OK.

Note    If any travelers in the retrieved itinerary are not included in the Traveler Editor, United Connection will create 
entries for those travelers automatically.

See also
Opening itineraries on different systems 



    Canceling a reserved itinerary
United Connection  lets you cancel a reserved itinerary at any time, with a few exceptions.   
You cannot cancel a reserved itinerary if:
· You chose to pick up your ticket at your preferred Apollo travel agency.    To cancel this 

type of itinerary, please contact your travel agency directly.
· The itinerary is in the process of being ticketed.
· Certain pricing modifications have occurred in the reservation system.
A message will appear if you attempt to cancel an itinerary which cannot be canceled.
Note    If you do not pay for your ticket online with a credit card and do not pick up your ticket by the ticketing 
deadline, the reservation system will cancel your reservation automatically.

Warning    Potential charges and refund restrictions may apply if you cancel a ticketed itinerary.    Please refer to the 
Notices area of the Itinerary Window, or contact the airline(s) for more information.

To cancel a reserved itinerary:
1. Open the itinerary you want to cancel.
2. Do one of the following:

· From the toolbar in the Itinerary Window, choose the Cancel icon.
· From the Itinerary menu, choose Cancel Reservation.

3. United Connection displays a message warning you that continuing will cancel all items 
(flights, rental cars, and hotel rooms) in your itinerary.

4. To cancel the itinerary, choose Yes.    The status of all items in the itinerary changes to 
CANCELED, and the message "Itinerary has been canceled" appears in the Notices area 
of the Itinerary Window.

Note    You can reinstate a canceled itinerary at any time prior to departure of the first flight  please call United 
Airlines Reservations for assistance.

See also
Canceling a reserved flight 
Canceling a reserved rental car 
Canceling a reserved hotel room 



    Opening an itinerary
You open an itinerary by opening the corresponding itinerary file stored on your computer.    
United Connection  itinerary files are saved with the file extension ITN.    By default, these 
files are stored in the United Connection directory which was created during installation.
When you open a reserved itinerary, United Connection needs to update the information by 
retrieving that itinerary from the reservation system.    If you are already connected to the 
reservation system, United Connection updates the itinerary automatically.    If you are not 
connected, you will be prompted to do so.
The local copy of a reserved itinerary will be view-only until you update it by connecting to 
the reservation system.    If you choose not to update your itinerary when prompted, you can
do so at any time simply by choosing Open from the File menu and reselecting that itinerary.
Note    You can also open a reserved itinerary directly from the reservation system using the Retrieve From 
Reservation System option in the File menu.    This allows you to view your reservation even if the itinerary file does 
not exist on your local system.    See Retrieving an itinerary from the reservation system for more information.

To open an itinerary:
1. From the File menu, choose Open.    The Open dialog box appears.

United Connection itinerary files have an extension of .ITN.    The File Name list displays 
all itinerary files in the current directory.    The default directory is the United Connection 
directory created during installation.

2. If you see the itinerary you want to open, select that file.    The selected file name 
appears in the File Name edit field.

3. If you do not see the itinerary you want to open, you can change drives and/or 
directories to display other itinerary files.

4. After selecting an itinerary file, choose OK to open that itinerary.    The selected itinerary 
appears in the Itinerary Window.

See also
Open dialog box 
Retrieving an itinerary from the reservation system 
Opening itineraries on different systems 



    Opening itineraries on different systems
Before you reserve an itinerary, you can view and edit that itinerary using any computer on 
which United Connection  is loaded. Just copy the itinerary file onto the computer's hard 
drive and open the file in United Connection as you normally would.
Once you reserve your itinerary, that itinerary can only be updated and modified using the 
computer on which it was created, or another computer registered to the same user.    
(Reserved itineraries can still be opened for viewing only on another person's computer.)
This restriction is imposed by the reservation system in order to ensure the privacy of your 
travel plans.    The same restriction applies to the Retrieve From Reservation System option.   
When you choose this option from the File menu, the reservation system displays only 
itineraries created on that computer (or on another computer registered to the same user).

See also
Opening an itinerary 
Retrieving an itinerary from the reservation system 



    Saving an itinerary
You must save all itineraries you want to retrieve at a later time.    When you save an 
itinerary, United Connection  stores the itinerary file on your computer system.    By default, 
these files are stored in the United Connection directory which was created during 
installation.    If you make any changes to the current itinerary, you will be prompted to save 
those changes before opening a new itinerary file or exiting United Connection.
Important    Once you reserve an itinerary, we strongly recommend that you do not create duplicate copies of that 
itinerary using the Save As option.    A reserved itinerary exists in two places: on your computer system, and in United 
Airlines' reservation system.    If you have more than one copy of a reserved itinerary on your computer, all copies will 
remain linked to the same file in the reservation system and changes made in one file will be reflected in all others.

To save an itinerary using the existing name:
· From the File menu, choose Save.

If you have already saved the current itinerary, the file will be saved automatically using 
the existing name.    If you have not already saved the current file, the Save As dialog box
appears.    See below for more information.

To save an itinerary using a new name:
1. From the File menu, choose Save As.    The Save As dialog box appears.    The File Name 

list displays all itinerary files in the United Connection directory.
2. In the File Name field, enter a name for the current itinerary file.    The default name is 

ITIN1.ITN.
Note    All United Connection itinerary files must use the file extension ITN.    If you do not enter the extension, 
United Connection will append it automatically.

3. By default, itinerary files are saved in the United Connection directory created during 
installation.    If you want to save the itinerary file in another directory, you can change 
the drive and/or the directory.

4. Choose OK to save the current itinerary file using the name specified in the File Name 
field.    The file name is displayed in the title bar of the Itinerary Window.

See also
Save As dialog box 



    Printing an itinerary
As you create your itinerary, United Connection  places the information in a trip report that 
can be printed at any time.    Choose one of the following options to see the type of 
information that can appear in the trip report:
Flights information
Rental car information
Hotel information

To view the trip report in Print Preview mode before printing, choose Print Preview from the 
File menu.    See Viewing an itinerary in Print Preview mode for more information.

To print a trip report:
1. Open the itinerary you want to print.
2. Choose the Print icon from the toolbar (or choose Print from the File menu).    The Print 

dialog box appears.
3. The name of the current printer appears at the top of the dialog box.

Window 3.1, 3.11, and NT 3.51: To select a different printer, choose the Setup button.
See Using the Print Setup option for more information.
Windows 95: To select a different printer, click on the arrow next to the Name field and 
select the printer you want to use.    To view and/or modify additional printer options, 
choose the Properties button.

4. Choose one of the Print Range options.    The default is All.    If you select the Pages 
option, be sure to specify the page range you want to print.

5. In the Print Quality field (Windows 3.1, 3.11 and NT 3.51 only), select the desired printer 
resolution.

6. If you want to print multiple copies of the trip report, enter the desired number of copies 
in the Copies field.    Choose Collate to have each copy collated automatically.

7. To print the trip report, choose OK.

See also
Print dialog box 



Flight information in the trip report includes:
· Airline and flight number
· Origin and destination
· Departure day, date, and time
· Arrival day, date, and time
· Number of stops
· Service class
· Aircraft type
· Seat requests (if applicable)
· Special meal requests (if applicable)
· Mileage Plus miles (for United and United Express)



Rental car information in the trip report includes:
· Rental company
· Pick-up airport
· Pick-up day, date, and time
· Drop-off day, date, and time
· Car type
· Rate and rate type
· Confirmation number (when reserved)
· Rental company phone number (when reserved)
· Unlimited mileage indicator (if applicable)



Hotel information in the trip report includes:
· Hotel name, address, and phone number
· Check-in day and date
· Check-out day and date
· Room type
· Rate
· Confirmation number (when reserved)
· Late arrival guarantee indicator (if applicable)



    Using the Print Setup option
United Connection  lets you define certain printer setup options, including:
· Printer
· Orientation
· Paper size
· Paper source
· Printer-specific options
Note    In order to select and configure a printer, you must have already installed the printer driver for that printer on 
your system using the Windows Control Panel.    Refer to your Windows documentation for more information about 
this process.

           Windows 95 Print Setup  
           Windows 3.1/3.11/NT 3.51 Print Setup  

See also
Viewing an itinerary in Print Preview mode 
Printing an itinerary 
Print Setup dialog box 



Windows 95 print setup

To setup your printer:
1. From the File menu, choose Print Setup.    The Print Setup dialog box appears.
2. Select the printer you want to use.    You can click on the arrow next to the Name field to 

display a list of installed printers.    The status, type, output location, and any comments 
related to the selected printer are displayed below the printer name.

3. To view and/or modify additional printer options, choose the Properties button.    Available
options vary by printer.

4. In the Size field, choose the size of the paper you will be using.    Available options vary 
by printer.

5. In the Source field, choose the paper source.    Available options vary by printer.
6. Choose one of the Orientation options:    Portrait (vertical orientation) or Landscape 

(horizontal orientation).    The default is Portrait.
7. To save the print setup information, choose OK.

See also
Printing options
Print Setup dialog box



Windows 3.1/3.11/NT 3.51 print setup

To setup your printer:
1. From the File menu, choose Print Setup.    The Print Setup dialog box appears.
2. Select the printer you want to use:

· To use your system's default printer (as specified in the Windows Control Panel), 
select the Default Printer option.    The name of the default printer is displayed below 
the option name.

· To select a different printer, select the Specific Printer option.    The list displays all 
printers whose printer drivers are currently installed on your system.    Select the 
printer you want to use.

3. Choose one of the Orientation options:    Portrait (vertical orientation) or Landscape 
(horizontal orientation).    The default is Portrait.

4. In the Size field, choose the size of the paper you will be using.    Available options vary 
by printer.

5. In the Source field, choose the paper source.    Available options vary by printer.
6. To view and/or modify additional printer options, choose the Options button.    Available 

options vary by printer.
7. To save the print setup information, choose OK.

See also
Printing options
Print Setup dialog box



    Viewing an itinerary in Print Preview mode
As you create your itinerary, United Connection  places the information in a trip report that 
can be printed at any time.    If you wish, you can view the trip report in Print Preview mode 
before printing.    The traveler names and itinerary status are displayed at the top of the 
report.    After you reserve an itinerary, the itinerary name and reservation number are also 
displayed.    Choose one of the following options to see additional trip report information:
Flight information
Rental car information
Hotel information

To view the trip report in Print Preview mode:
1. From the File menu, chose Print Preview.    The Print Preview window appears.    The trip 

report is displayed exactly as it will be printed.
2. To get a closer view of the text, choose the Zoom In button.    Choose this button again to

zoom in even closer.
Note    You can also zoom in by clicking on the area of the window you want to view.

3. To zoom out, choose the Zoom Out button.
4. If the trip report includes multiple pages, you can:

· Choose the Two Page button to display two pages at once.
· Choose the Next Page and Prev Page buttons to move from page to page.

5. To print the trip report, choose the Print button.    The Print dialog box appears.
6. To exit Print Preview mode, choose the Close button.

See also
Print Preview window 
Printing an itinerary 



    Open dialog box
(Windows 3.1/3.11/NT 3.51)

You access the Open dialog box to open the local copy of an itinerary.    By default, itinerary 
files are stored in the United Connection  directory which was created during installation.
When you open a reserved itinerary, United Connection needs to update the information by 
retrieving that itinerary from the reservation system.    If you are already connected to the 
reservation system, United Connection updates the itinerary automatically.    If you are not 
connected, you will be prompted to do so.
The local copy of a reserved itinerary will be view-only until you update it by connecting to 
the reservation system.    If you choose not to update your itinerary when prompted, you can
do so at any time simply by choosing Open from the File menu and reselecting that itinerary.
Note    You can also open a reserved itinerary directly from the reservation system using the Retrieve From 
Reservation System option in the File menu.    This allows you to view your reservation even if the itinerary file does 
not exist on your local computer system.    See Retrieving an itinerary from the reservation system for more 
information.

How to display the Open dialog box

Dialog Box Options

File Name
Displays all itinerary files in the current directory (itinerary files have the file extension 
ITN).    Select the itinerary file you want to open.

List Files of Type
Displays a list of available file types.    Select the type of file you want to display in the File 
Name list.    The default is Itineraries (files with the extension ITN).

Directories
Displays the current directory.    The default directory is the United Connection directory 
created during installation.    To choose a different directory, double-click on the directory 
names to navigate through your system and select the directory containing the itinerary 
file you want to open.

Drives
Displays the current drive.    The default drive is the drive on which United Connection is 
installed.    To choose a different drive, click on the arrow next to the Drives field and select
the drive containing the itinerary file you want to open.

Network button
Choose this button to display the Connect Network Drive dialog box.    If the itinerary you 
want to open is located on a network drive that does not appear in the Drives list, use this 
dialog box to connect to that drive.

See also
Opening an itinerary 
Opening itineraries on different systems 



To display the Open dialog box:
· From the File menu, choose Open.



    Save As dialog box
(Windows 3.1/3.11/NT 3.51)

You access the Save As dialog box to save the current itinerary file for the first time, or when
you want to save it under a new name.    When you save an itinerary, United Connection  
stores the itinerary file on your computer system.    By default, these files are stored in the 
United Connection directory which was created during installation.
Important    Once you reserve an itinerary, we strongly recommend that you do not create duplicate copies of that 
itinerary using the Save As option.    A reserved itinerary exists in two places: on your computer system, and in United 
Airlines' reservation system.    If you make a copy of a reserved itinerary on your computer system, both copies will 
remain linked to the same file in the reservation system and changes made in one file will be reflected in all others.

How to display the Save As dialog box

Dialog Box Options

File Name
Displays the file name of the current itinerary.    A list of all itinerary files in the current 
directory is displayed under the File Name field (itinerary files have the file extension ITN).  
Enter or select the name by which you want to save the current itinerary.

List Files of Type
Displays a list of available file types.    Select the type of file you want to display in the File 
Name list.    The default is Itineraries (files with the extension ITN).

Directories
Displays the current directory.    The default directory is the United Connection directory 
created during installation.    To choose a different directory, double-click on the directory 
names to navigate through your system and select the directory in which you want to save
the current itinerary file.

Drives
Displays the current drive.    The default drive is the drive on which United Connection is 
installed.    To choose a different drive, click on the arrow next to the Drives field and select
the drive on which you want to save the current itinerary file.

Network button
Choose this button to display the Connect Network Drive dialog box.    If you want to save 
the current itinerary on a network drive that does not appear in the Drives list, use this 
dialog box to connect to that drive.

See also
Saving an itinerary 



To display the Save As dialog box:
· From the File menu, choose Save As.

Note    The Save As dialog box also appears if you choose Save from the File menu and have not yet save the
current itinerary file.



Printing options

United Connection  lets you print the following information:

· Flight Availability
· Mileage Plus Summary
· Electronic Ticket Receipt
· Passenger Notices (for electronic tickets)
· Full Itinerary

See also
Print dialog box 
Print Setup dialog box 
Viewing your itinerary in Print Preview mode 



    Print dialog box
Choose one of the following options for more information:

           Windows 95 Print dialog box  
           Windows 3.1/3.11/NT 3.51 Print dialog box  

See also
Print Setup dialog box 
Printing an itinerary 
Other Topics 



    Print dialog box
(Windows 95)

The Print dialog box lets you review your printer options before printing.

Dialog Box Options

Name
Displays the name of the current printer.    To select a different printer, click on the arrow to
display a list of installed printers and select the printer you want to use.    The status, type, 
output location, and any comments related to the selected printer are displayed below the 
printer name.
Note    In order to select a printer, you must have already installed that printer driver on your system using the 
Windows Control Panel.    Refer to your Windows documentation for more information about this process.

Properties button
Choose this button to display the Properties dialog box for the selected printer.    You 
access the Properties dialog box to define printer options, including paper size, orientation,
paper source, graphics and font options, and other printer-specific options.

Print to file
Choose this option if you want to print to a file instead of to the selected printer.    You will 
be prompted to enter a file name when you choose OK.

Print Range
Displays the following print range options:

All
Select this option to print all pages in the current trip report.
Pages
Select this option to print a range of pages.    In the From field, enter the first page you 
want to print.    In the To field, enter the last page you want to print.
Selection
Select this option to print only the highlighted information.

Number of copies
Enter the number of copies you want to print.    The default is 1.

Collate
If you are printing more than one copy, choose this option to have the printer collate each 
copy automatically.    Collating is assembling in page order (1, 2, 3, etc.).

See also
Print Setup dialog box (Windows 95) 
Printing an itinerary 
Other Topics 



    Print dialog box
(Windows 3.1/3.11/NT 3.51)

The Print dialog box lets you review your printer options before printing.

Dialog Box Options

Printer
Displays the name of the current printer.    To select a different printer, choose the Setup 
button.    See Using the Print Setup option for more information.

Print Range
Displays the following print range options:

All
Select this option to print all pages in the current trip report.
Selection
Select this option to print only the highlighted information.
Pages
Select this option to print a range of pages.    In the From field, enter the first page you 
want to print.    In the To field, enter the last page you want to print.

Print Quality
Select the desired printer resolution.    Resolution is expressed in terms of dots-per-inch 
(DPI).    The options displayed in this list are dependent on the selected printer.

Setup button
Choose this button to display the Print Setup dialog box. 

Copies
Enter the number of copies you want to print.    The default is 1.

Collate Copies
If you are printing more than one copy, choose this option to have the printer collate each 
copy automatically.    Collating is assembling in page order (1, 2, 3, etc.).

See also
Print Setup dialog box (Windows 3.1/3.11/NT 3.51) 
Printing an itinerary 
Other Topics 



    Print Setup dialog box
Choose one of the following options for more information:

           Windows 95 Print Setup dialog box  
           Windows 3.1/3.11/NT 3.51 Print Setup dialog box  

See also
Print dialog box 
Printing an itinerary 
Other Topics 



    Print Setup dialog box
(Windows 95)

You access the Print Setup dialog box to define printer options, including:
· Printer
· Printer properties
· Paper size
· Paper source
· Orientation
Note    In order to select and configure a printer, you must have already installed that printer driver on your system 
using the Windows Control Panel.    Refer to your Windows documentation for more information about this process.

Dialog Box Options

Name
Displays the name of the current printer.    To select a different printer, click on the arrow to
display a list of installed printers and select the printer you want to use.    The status, type, 
output location, and any comments related to the selected printer are displayed below the 
printer name.

Properties button
Choose this button to display the Properties dialog box for the selected printer.    You 
access the Properties dialog box to define printer options, including paper size, orientation,
paper source, graphics and font options, and other printer-specific options.

Paper Size
Choose the size of the paper you will be using.    Available options vary by printer.

Paper Source
Choose the paper source.    Available options vary by printer.

Orientation
Choose one of the Orientation options:    Portrait (vertical orientation) or Landscape 
(horizontal orientation).    The default is Portrait.

See also
Print dialog box (Windows 95) 
Printing an itinerary 
Other Topics 



    Print Setup dialog box
(Windows 3.1/3.11/NT 3.51)

You access the Print Setup dialog box to define printer setup options, including:
· Printer
· Orientation
· Paper size
· Paper source
· Printer-specific options
Note    In order to select and configure a printer, you must have already installed that printer driver on your system 
using the Windows Control Panel.    Refer to your Windows documentation for more information about this process.

Dialog Box Options

Printer
Select the printer you want to use:

Default Printer
Select this option to use your system's default printer (as specified in the Windows 
Control Panel).    The name of the default printer is displayed below the option name.
Specific Printer
Select this option to choose a different printer.    The list displays all printers whose 
printer drivers are currently installed on your system.    Select the printer you want to 
use.

Orientation
Choose one of the Orientation options:    Portrait (vertical orientation) or Landscape 
(horizontal orientation).    The default is Portrait.

Size
Choose the size of the paper you will be using.    Available options vary by printer.

Source
Choose the paper source.    Available options vary by printer.

Options
Choose this button to view and/or modify additional printer options.    Available options 
vary by printer.

See also
Using the Print Setup option 
Print dialog box (Windows 3.1/3.11/NT 3.51) 
Printing an itinerary 
Other Topics 



    Print Preview window
You access the Print Preview window to view the trip report.    The initial display reduces the 
size of the text to show a full page.    Zoom in to read the text of the report.    The traveler 
names and itinerary status are displayed at the top of the report.    After you reserve an 
itinerary, the itinerary name and reservation number are also displayed.    Choose one of the 
following options to see additional trip report information:

Flight information
Rental car information
Hotel information

How to display the Print Preview window

Dialog Box Options

Print button
Choose this button when you want to print the current trip report.    The Print dialog box 
appears.

Next Page button
In a multiple-page report, choose this button to display the next page.

Prev Page button
In a multiple-page report, choose this button to display the previous page.

Two Page button
In a multiple-page report, choose this button to display two pages at once.

Zoom In button
Choose this button to get a closer view of the text.    Choose this button again to zoom in 
even closer.

Zoom Out button
Choose this button to display more of the trip report in the window at one time.    This 
option is only available if the display has been zoomed in.

Close button
Choose this button to close the Print Preview window.

See also
Viewing an itinerary in Print Preview mode 
Printing an itinerary 



To display the Print Preview window:
· From the File menu, choose Print Preview.

 



Troubleshooting

This section includes solutions to problems that may occur as you use United Connection .    
If you don't find the answers you need, you can contact the Support Desk for assistance at:

1-800-4UA-CNXN (1-800-482-2696)
Choose one of the topics below to see related troubleshooting information.

Not enough memory

Registration problems

Modem problems

Connection problems: Internet 

Connection problems: United Airlines Network 

Flights and fares 

Selecting rental cars

Selecting hotel accommodations

Reserving your itinerary

Windows 95

See also
United Connection Technical Support 
Comments and suggestions 



Connection problems: Internet

Choose one of the following topics for more information:

I get the message: "Unable to find an Internet Service Provider.    Please establish a 
connection with your Internet Service Provider before continuing."

I get the message: "Unable to establish a connection.    Make sure that you are connected to 
the Internet via your Internet Service Provider.    If you have a valid Internet connection but 
cannot access the reservation system, please try again later."

I get the message: "Internet connection has been lost.    Please reconnect to the Internet via 
your Internet Service Provider." 

I get the message: "A communication error has occurred.    Please try again." 

United Connection isn  ’  t using the Internet Service Provider I selected.  

Why am I still connected to the Internet after I close United Connection?

I keep getting disconnected.

Note    If you still have problems connecting to the reservation system via your Internet Service Provider after 
troubleshooting using this Help file, select "United Airlines Network" as your United Connection service provider.    
See Choosing a United Connection service provider for more information.

See also
Troubleshooting 
United Connection Technical Support 



I keep getting disconnected

If you keep getting disconnected from the reservation system, please check the following:

Is someone else at your location trying to use the same phone line?
If someone at your location picks up a telephone that is connected to the same line as your 
modem, you will be disconnected from the reservation system.

Do you have Call Waiting?
If you have Call Waiting, you should disable it before using United Connection .    Choose the
appropriate option below for more information.

If you are using the Internet

If you are using the United Airlines Network

See also
Troubleshooting 
United Connection Technical Support 



Disabling Call Waiting (Internet users)
If you are using the Internet to connect to the reservation system, you will need to use 
your Internet Service Provider's dialer to disable Call Waiting.    Contact your Internet 
Service Provider if you need additional information.



Disabling Call Waiting (United Airlines Network users)
If you are connecting to the reservation system via the United Airlines Network, you can 
disable Call Waiting in the Dialing Information dialog box by entering or selecting the 
appropriate code in the Dialing Prefix field.    See Changing your dialing information for 
details.



No Internet Service Provider

You must have an account with an Internet Service Provider in order to connect to the 
reservation system via the Internet.    If United Connection  cannot find the necessary 
Internet software on your computer, it displays the following message:
"Unable to find an Internet Service Provider.    Please establish a connection with your 
Internet Service Provider before continuing."

If you have an account with an Internet Service Provider, you should launch that service 
provider's dialer before proceeding.    Contact your Internet Service Provider if you need help 
launching or configuring their dialer.
If you do not have an account with an Internet Service Provider, you should choose the 
United Airlines Network option.    See Choosing a United Connection service provider for 
more information.

See also
Troubleshooting
United Connection Technical Support



Unable to establish a connection

If United Connection  is unable to connect to the reservation system via the Internet, it 
displays the following message:
"Unable to establish a connection.    Make sure that you are connected to the Internet via 
your Internet Service Provider.    If you have a valid Internet connection but cannot access 
the reservation system, please try again later."
If this message is displayed, please check the following information:

Is your Internet dialer up and running?

Are you connected to the Internet?

Is your modem configuration correct?

Is your dialing information correct?

If you are using MSN, is your MSN software configured for Internet access?

If you have Windows 95 or NT, are you using 32-bit Internet software?

Are you connecting to the Internet via a network (LAN or WAN)?

Note    If you still have problems connecting to the reservation system via your Internet Service Provider after 
troubleshooting using this Help file, select "United Airlines Network" as your United Connection service provider.    
See Choosing a United Connection service provider for more information.

See also
Troubleshooting
United Connection Technical Support



Is your Internet dialer up and running?

Windows 3.1, 3.11, or NT 3.51
If you are using Windows 3.1, 3.11, or NT 3.51 and your Internet service provider does not 
automatically launch its dialer when an Internet connection is required, you will need to 
launch the dialer yourself.    To verify whether your Internet dialer is running, press [Ctrl]
[Esc].    If your dialer is running, the name should appear in the Task List.    Contact your 
Internet Service Provider if you need help launching or configuring their dialer.

Windows 95
Windows 95 automatically launches the default dialer when an Internet connection is 
required.    The dialer should appear in the Windows 95 Taskbar.    Note that if the dialer is 
launched and you cancel it without connecting, Windows 95 will not automatically launch the
dialer the next time a connection is required.    If this occurs, or if your dialer does not launch
for any other reason, simply launch the appropriate dialer yourself.
Note    See United Connection  isn’t using the Internet Service Provider I selected if the correct dialer is not being 
launched.

See also
Troubleshooting
United Connection Technical Support



Are you connected to the Internet?

If you’re able to display your Internet Service Provider  ’  s dialer,   it should indicate whether or 
not you are connected to the Internet.    If your Internet service provider is unable to 
establish a connection to the Internet, you will not be able to connect to the reservation 
system.
If you are not connected to the Internet, click on Unable to establish a connection and review
the other items in the list to identify the source of the problem.
If you have verified that your Internet Service Provider is able to connect to the Internet, 
there may be a temporary problem connecting to the reservation system.    Try connecting 
again at a later time.    If you still experience problems after several attempts, please contact
the United Connection Support Desk at 1-800-4UA-CNXN (1-800-482-2696).

See also
Troubleshooting
United Connection Technical Support



Is your MSN software configured for Internet access?

To verify that MSN is setup for Internet access, click on the Settings button in the MSN Sign 
In dialog box (or choose Connection Settings from the Tools menu in MSN Central). If your 
service type is not listed as "Internet and the Microsoft Network", you will need to configure 
your MSN software for Internet access.    Refer to the MSN online Help or contact MSN 
Technical Support for more information.

See also
Troubleshooting
United Connection Technical Support



Is your modem configuration correct?

Access your Internet Service Provider's dialer and verify your modem settings.    If you are 
using an external modem, make sure that it is plugged in to a power source and turned on.

See also
Troubleshooting
United Connection Technical Support



Is your dialing information correct?

Access your Internet Service Provider's dialer and verify the dialing information you entered.

See also
Troubleshooting
United Connection Technical Support



Are you using 32-bit Internet software?

The software required to establish an Internet connection is supplied to you by your Internet 
Service Provider.    United Connection  requires 32-bit Internet software in Windows 95 and 
NT.    Some providers supply 16-bit Internet software, which United Connection supports only 
in Windows 3.1 and 3.11.    Contact your Internet Service Provider if you are not sure which 
type of Internet software you have, or to obtain the 32-bit Internet software.

Using Dial-Up Networking for 32-bit Internet access
Most Internet Service Providers use the Dial-Up Networking utility included with Windows 95 
(or the Remote Access Service utility in NT) to setup a 32-bit Internet connection.    Some 
providers automate the setup process for you, others do not.    Either way, you will need to 
ensure that Dial-Up Networking (or RAS in NT) has been installed on your system.
In Windows 95, double-click on My Computer to display the Dial-Up Networking folder.    If 
Dial-Up Networking is not present, you will need to install it.    Refer to Windows 95 Help for 
more information about installing and using Dial-Up Networking.
Note    Your Internet Service Provider will need to supply you with all of the information required by Dial-Up 
Networking.    This includes an access phone number, the host name and domain name, and the Domain Name 
Server (DNS) server address.    Contact your Service Provider for details.

See also
Troubleshooting
United Connection Technical Support



Are you connecting via a network (LAN or WAN)?

If you are connecting via a LAN (Local Area Network) or WAN (Wide Area Network), please 
contact your network administrator to verify that your system is properly configured for 
Internet access.    Network administrators should refer to the United Connection  
README.TXT file for additional information concerning LAN-based Internet access and United
Connection.

See also
Troubleshooting
United Connection Technical Support



Internet connection has been lost

If your service provider loses its Internet connection, United Connection  displays the 
following message:
"Internet connection has been lost.    Please reconnect to the Internet via your Internet 
Service Provider."

If you get this message, you will need to access your service provider's dialer and re-
establish your Internet connection.    Contact your service provider if you are unsure how to 
do this.

See also
Troubleshooting
United Connection Technical Support



A communication error has occurred

United Connection  will display the following message if it was unable to receive the 
requested information from the reservation system:
"A communication error has occurred.    Please try again."

If you get this message, you should request the information again by reselecting whatever 
option you had just selected in United Connection.    (For example, if you had just clicked on 
the Fareshop icon before the message appeared, click on this icon again.)    If this message 
continues to appear, contact the United Connection Support Desk.    Choose United 
Connection Technical Support below for more information.

See also
Troubleshooting
United Connection Technical Support



United Connection  isn’t using the Service Provider I selected

To ensure that United Connection uses a specific Internet Service Provider, you should 
launch that Service Provider’s dialer before starting United Connection.
When United Connection needs to connect to the reservation system, it will attempt to 
establish an Internet connection.    If an Internet channel is already open, United Connection 
will automatically use the open channel to connect to the reservation system (whether or 
not this channel corresponds to the United Connection service provider you have specified).
If an Internet channel is not open, United Connection will request one.    Windows 95 will 
then automatically launch the default dialer, which may or may not be the one you want to 
use with United Connection.    In Windows 3.1 and 3.11, some Internet Service Providers (for 
example, MSN and CompuServe) automatically launch their dialer when an Internet 
connection is required.    Others require you to launch the dialer yourself.

See also
Troubleshooting
United Connection Technical Support



Disconnecting from the Internet

If you are connected to the Internet, the following message is displayed when United 
Connection  disconnects from the reservation system:
"United Connection has disconnected from the reservation system.    However, your Internet 
connection may still be active.    If necessary, please access your Internet Service Provider to
disconnect from the Internet."
Disconnecting from the reservation system in United Connection (or exiting United 
Connection) does not automatically disconnect you from the Internet.    Because your 
Internet connection is managed by your service provider's dialer, you will need to access the
dialer to disconnect from the Internet.

See also
Troubleshooting
United Connection Technical Support



Not enough memory

When I try to start United Connection , I get the message "Not enough memory to
run application." What should I do?

· Verify that your system has a minimum of 8MB of RAM (memory):
If you don't know how much memory your system has, you can check it from DOS using 
the MEM command (DOS versions 5.0 and higher).    Click here for more information 
about using the MEM command.

· Make sure all other applications are closed:
Windows 3.1/3.11/NT 3.51 users can check this by displaying the Windows Task List 
(press the [Control] and [Escape] keys at the same time).    In Windows 95, press 
[Control] [Alt] [Delete] to display a list of open programs.    If any other programs are 
running, close them before attempting to install United Connection.

· Check your available memory, as follows:
In Program Manager (Windows 3.1/3.11/NT 3.51), click on the Help menu and choose the 
last option, About Program Manager.    An entry at the bottom of the dialog box indicates 
how much memory is free.
If this value is less than 12,000 KB, you will need to increase your virtual memory.

· Use MemMaker (a utility included with DOS 6.0 and higher) to load device 
drivers and memory-resident programs (TSRs) into high memory:
Do not use this command while Windows is running.    Exit to DOS and type HELP 
MEMMAKER for more information about this utility, or refer to the chapter entitled 
"Making More Memory Available" in the MS-DOS 6 User's Guide.

See also
United Connection Technical Support 
Checking memory using DOS 
Increasing virtual memory 



Checking memory using DOS (MEM)

One way to verify the amount of actual installed RAM (memory) on your system is to use the
MS-DOS command MEM (available in DOS versions 5.0 and higher).

To check memory using MEM:
1. Display a DOS prompt (Windows 3.1/3.11/NT 3.51 users should double-click on the MS-

DOS Prompt icon in the Main window).
2. Type the following command and press [Enter]: MEM
3. Find the amount of Total Contiguous Extended Memory (this is the number displayed in 

boldface type below):

651264 bytes total conventional memory
651264 bytes available to MS-DOS
439184 largest executable program size

 
19922944 bytes total contiguous extended memory

0 bytes available contiguous extended 
memory

1048576 bytes available XMS memory
MS-DOS resident in High Memory Area

4. The total contiguous extended memory value should be 7,000,000 or larger for the 
system to run properly.

5. After checking memory, type Exit and press [Enter] to return to the Windows Program 
Manager.

See also
United Connection Technical Support 
Not enough memory 
Increasing virtual memory 



Increasing virtual memory

Note: This information does not apply to Windows 95 users.
Virtual memory (also know as a "swapfile") is space on your hard drive that Windows 
3.1/3.11 uses as additional memory.
If you have an 8MB system, you will also need a fair amount of virtual memory (at least 
10,000 KB) to install and run United Connection .    If your virtual memory is already 20,000 
KB or higher, it probably won't help to increase it any further.
Disk Compression users: If you are running a disk compression program (for example, 
DoubleSpace, Stacker, or SuperStor), you will need to follow a different procedure.    Click 
here for more information.

How to increase Virtual Memory:
1. Close all open applications except Windows.

2. From Program Manager, display the Main 
program group and double-click on the 
Control Panel icon.

3. Double-click on the Enhanced icon.

4. Click on the Virtual Memory button and check the swapfile size and type.    The size 
should be at least 10,000 KB, and the type should be "Permanent".
Important: Make a note of your current settings in case you want to change them back.

5. Click on the Change>> button to display the Virtual Memory dialog box.    Look at the 
New Settings options (toward the bottom of the dialog box).
a. If the Type is set to None or Temporary, Change it to Permanent.
b. In the New Size edit field, type in a size somewhere between 10,000 KB and the 

Recommended Size (this is displayed immediately above the New Size field).
Note: The maximum value for the New Size is four times your installed memory (for 
example, 4 x 8MB = 32 MB).    However, the New Size can never be greater than 1/2 of
the available space on your hard drive.

6. Click on the OK button and respond Yes when asked if you are sure you want to change 
the Virtual Memory settings.

7. Click OK to complete the Virtual Memory settings change.
8. Choose Restart Windows.
9. Once Windows has restarted, start United Connection.
Note: If you decide to go back to the old settings, redo all steps using the old 
values.

See Also
United Connection Technical Support 
Not enough memory 



Increasing virtual memory on systems using disk compression 



Increasing virtual memory with disk compression

Note: This information does not apply to Windows 95 users.

If you are running a disk compression program on your computer (for example, 
DoubleSpace, Stacker, or SuperStor), you may have problems creating enough virtual 
memory to run United Connection .    To solve this problem, you will need to delete your 
current swapfile, then create a new swapfile on your "host" drive.

Deleting the current swapfile:
1. Close all open applications (except Windows).

2. From Program Manager, display the Main 
program group and double-click on the 
Control Panel icon.

3. Double-click on the Enhanced icon.

4. Click on the Virtual Memory button, then click on the Change>> button to display the 
Virtual Memory dialog box.

5. Look at the Swapfile Settings at the top of the dialog box.    Make a note of your current 
settings in case you want to change them back.

6. Look at the New Swapfile Settings options (toward the bottom of the dialog box).    Verify 
that the Drive field is set to C or D.    The Type will probably be Permanent.

7. Click on the arrow next to the Type field and select None.
8. Click on OK, then click on Yes to confirm the change.
9. You are now asked if you wish to restart Windows now.    Click on Restart Windows. Now

follow the steps below to create a new swapfile.

Creating a new swapfile:
1. From Program Manager, display the Main 

program group and double-click on the 
Control Panel icon.

2. Double-click on the Enhanced icon.

3. Click on the Virtual Memory button, then click on the Change>> button to display the 
Virtual Memory dialog box.

4. Look at the Swapfile Settings at the top of the dialog box.    They should be:
Drive blank
Size 0 KB
Type None

5. Now go to the New Swapfile Settings options (toward the bottom of the dialog box) and 
choose the following options:



Drive Click on the arrow next to the Drive field.    You should have an H: drive 
listed (or some letter other than C or D).    Select this drive.    Do not select 
C or D.

Type Permanent.
New Size Type in a size somewhere between 10,000 KB and the Recommended Size 

(this is displayed immediately above the New Size field).
Note:    If the Recommended Size is less than 10,000, you will need to 
either delete files from the host drive or reduce the size of the compressed
drive.    Click here for more information.

6. Click on OK, then click on Yes to confirm the change.    A message will inform you that a 
permanent swapfile has been created on the selected drive.

7. You are asked if you wish to restart Windows now.    Click on Restart Windows.
8. Click on the United Connection icon to start the application.

See Also
United Connection Technical Support 
Not enough memory 
Increasing virtual memory 
Increasing available space on a host drive 



Increasing available space on a host drive

Note: This information does not apply to Windows 95 users.

If you are running a disk compression program on your computer (for example, 
DoubleSpace, Stacker, or SuperStor), and cannot create a swapfile large enough to run 
United Connection , you can try one of the following options:

Delete files from the host drive:
On a system with disk compression, the host drive will be probably be defined as H: (or 
some drive letter above C:).    Delete as many unnecessary files as possible from this drive 
(for example, old documents, memos, programs you no longer use, etc.).    You can delete 
files from File Manager or from DOS.    Alternatively, you can compress files using a file 
compression program such as PKZIP (available as shareware).

Defragment/optimize the C: drive:
To increase available disk space, you can also try defragmenting your C: drive.    If you have 
DOS 6.0 or higher, exit Windows and type the following command at the DOS prompt, then 
press [Enter]:
defrag /h /q c:
You can also use any other defragmenter/disk optimization program (for example, the one 
supplied with Norton Utilities).

See Also
United Connection Technical Support 
Not enough memory 
Increasing virtual memory 
Increasing virtual memory on systems using disk compression 



Registration

Choose one of the following topics for more information:

I'm having modem/dialing problems. 

Connection problems: Internet 

Connection problems: United Airlines Network 

United Connection dials and connects but is unable to register. 

United Connection won't accept my credit card number. 

I  ’  m able to connect but I get a credit card error.   

I get a "Form of payment invalid" message. 

I get an "Address error" message. 

I already had a Mileage Plus  number, but I was assigned another one by United Connection
.    What should I do? 

I just registered and was instantly enrolled in Mileage Plus  why can't I use my new Mileage 
Plus number to register on another computer? 

How do I change my name in United Connection? 

See Also
United Connection Technical Support 



I already had a Mileage Plus  number...

If you were already a Mileage Plus member and received a new account number 
accidentally, you will need to contact Mileage Plus to deactivate one of the accounts.
To use the new Mileage Plus number exclusively, you will need to write to the Mileage Plus 
Service Center requesting that they close your old account and transfer all accrued miles 
and benefits (including earned Premier status) to your new account number.    The address 
is:
Mileage Plus Service Center
P.O.    Box 28870
Tucson, AZ 85726
Include your name, address, and a brief note indicating that you want to use the new 
Mileage Plus number exclusively.    The transaction will be complete in four to six weeks.
To retain your previous Mileage Plus number, you will need to re-install the software and re-
register using your original Mileage Plus number.
If you have earned any Mileage Plus miles with your new Mileage Plus number, you must 
write to the Mileage Plus Service Center at the address above to request consolidation of the
accounts.    Include your name, address, and a brief note indicating that you want to use 
your original Mileage Plus number exclusively.    The transaction will be complete in four to 
six weeks.    If you have purchased tickets with your new Mileage Plus number but have not 
completed the travel associated with those tickets, please contact United Airlines directly to 
ensure that the flight miles are credited to your original Mileage Plus account.

See Also
United Connection Technical Support 



Why can't I register on another computer?

After receiving a new Mileage Plus  number, you must wait 1-3 days before you will be able 
to register United Connection

 on another computer.    Please wait a few days and try again.

See Also
United Connection Technical Support 



How do I change my name in United Connection ?

If you are not the registered user, simply access your traveler information in the Traveler 
Editor and change your name.
If you are the registered user, you first need to call or write Mileage Plus  to inform them of 
the name change.    See Changing the name of the registered user for more information.

See Also
United Connection Technical Support 



United Connection  is unable to register

United Airlines Network users can try a different local access number.    If that fails, try 
connecting again later.

See Also
United Connection Technical Support 



United Connection  won't accept my credit card number

Make sure that you have entered your credit card number without any spaces or hyphens.

See Also
United Connection Technical Support 



I get a credit card error

If you are using a corporate credit card, you must enter the company name exactly as it 
appears on the credit card statement.
You must type your address exactly as it appears on the credit card statement or the card 
verification will fail.
Note: Try to fit the whole street address in the first line. It allows up to 20 characters. If the address is too long, delete
the text for Apt or Suite but retain the number.

See Also
United Connection Technical Support 



"Form of payment invalid" message

Please contact the United Connection Support Desk at 1-800-4UA-CNXN (482-2696).



"Address error" message

Please contact the United Connection Support Desk at 1-800-4UA-CNXN (482-2696).



Modem problems

Note    This information applies to United Airlines Network users only.

If you are having problems dialing or connecting, check the following items:

· Windows 3.1/3.11/NT 3.51 users: Did you test your modem using the Test Settings 
button?    If not, do this (from the Tools menu choose Communications/Modem 
Settings).    See Modem error messages if you get an error when you click on the Test 
Settings button.

· Other modem problems:
Modem not listed in the Modem Type dialog box

No response from the modem

Modem dials but can  ’  t connect  

Modem fails at "Connecting to VAN"

Modem connects but can  ’  t access United Connection  

See Also
Modem error messages 
Problems connecting to the reservation system 
United Connection Technical Support 



Modem not listed

Note    This information applies only if you have selected the United Airlines Network and are using Windows 
3.1/3.11/NT 3.51.

Follow these steps if your modem is not listed:
1. In the Modem Type dialog box choose Hayes Compatible from the Vendor list, and Any 

Hayes Compatible Modem (the only option) from the Modem list.
2. Click on OK.
3. In the Modem Settings dialog box, set the baud rate to 9600 and then click on the Test 

Settings button.    If you have problems at 9600, start at 2400 baud.    If this works try 
4800, then 9600.
Note: See Modem error messages if you get an error when you click on the Test 
Settings button.

See Also
Modem problems 
Modem error messages 
United Connection Technical Support 



Modem error messages

Note    This information applies only if you have selected the United Airlines Network and are using Windows 
3.1/3.11/NT 3.51.

Click on one of the following messages for more information:

Test Settings messages

The following messages can appear after you click on the Test Settings button in the 
Modem Settings dialog box:

"The port is currently in use.    Select another port or make sure the relinquish this port 
before connecting."

"The port is not present or is not responding.    Select another port."

"Unable to initialize the modem.    Make sure the modem is working properly or that the 
initialization string is valid."

"The port cannot handle the requested speed.    Select a lower speed for the modem."

"The initialization string is invalid.    Select another modem or modify the string."

Establishing Connection messages

The following messages can appear after you click on the Connect button in the Establish 
Connection dialog box:

Unable to establish connection.    Please try again.

Unable to connect to the reservation system.    Please try again.

"Reservation system not responding.    Please try later."

See Also
Modem problems 
United Connection Technical Support 



"The port cannot handle the requested speed."

Note    This information applies only if you have selected the United Airlines Network and are using Windows 
3.1/3.11/NT 3.51.

The full text of this message is:

"The port cannot handle the requested speed.    Select a lower speed for the modem."

This message appears if the speed (baud rate) you selected in the Modem Settings dialog 
box is too fast for your modem.

Troubleshooting:
1. Choose a lower Speed setting in the Modem Settings dialog box.    If you don’t know your 

modem speed, select 9600.
2. Click the Test Settings button.    If the settings pass at 9600, you can try a higher speed

and test them again.
Note: If 9600 doesn’t work, try starting at 2400, then 4800, then 9600.

See Also
Modem problems 
Modem error messages 
United Connection Technical Support 



"The port is currently in use."

Note    This information applies only if you have selected the United Airlines Network and are using Windows 
3.1/3.11/NT 3.51.

The full text of this message is:

"The port is currently in use.    Select another port or make sure to relinquish this port before 
connecting."

This message appears if the port you selected in the Modem Settings dialog box is being 
used by another device or application.

Troubleshooting:

1. Make sure you have selected the correct COM port.
· Internal modem: The correct COM port will probably be COM2 or COM3.
· External modem: The COM port will probably be COM1 or COM2.

Click here for information about testing the COM port using Terminal.

2. Make sure no other software is running that might be using the COM port.    Examples of 
this are Modem/Fax software or remote access programs.

See Also
Modem problems 
Modem error messages 
United Connection Technical Support 



"Unable to establish connection"

Note    This information applies to United Airlines Network users only.

The full text of this message is:

"Unable to establish connection.    Please try again."

This message appears if both the Primary and the Secondary access numbers fail when you 
attempt to connect to the reservation system.

Troubleshooting:

1. Select different phone numbers for your area (if available).
Note: Be sure to check the modem speed for the line you are selecting (a modem speed 
or range of speeds is displayed next to each number).    You should choose numbers that 
use the highest speed supported by your modem.    You should not select a telephone 
number whose modem speed is faster than your modem.

2. Try connecting again later.    Too many people may be trying to use that line at the 
present time.

See Also
Modem problems 
Modem error messages 
United Connection Technical Support 



Using Terminal to check modem settings

Note    This information applies only if you have selected the United Airlines Network and are using Windows 
3.1/3.11/NT 3.51.

Follow the steps below to test your modem settings using Terminal:

1. In Program Manager, go to the Accessories program group and double-click on the 
Terminal icon.    An empty Terminal window appears.

2. From the File menu, choose Open.    If you have already saved your modem settings in 
Terminal, you will see a file with the extension trm (for example, modem.trm).

3. Highlight a trm file and click on OK to open that file.
If no trm files appear, you will have to enter your modem settings.    From the Settings 
menu, choose Communications.    The Communications dialog box appears.
a. From the Connector list, choose the COM port your modem is attached to.
b. Select the highest Baud Rate supported by your modem.    Leave all other options at 

your default settings.
c. Click on OK to exit the Communications dialog box.

4. From the Phone menu, choose Dial.
5. In the Dial edit field, enter any phone number (it does not have to be a modem number) 

and click on OK.
6. If the modem dials and connects to that number, it is functioning properly.    If the modem

does not dial, you may have selected the wrong COM port.
a. From the Settings menu, choose Communications and select a different COM port.
b. Repeat steps 4 and 5 to test the COM port.

See Also
Modem problems 
Modem error messages 
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"The port is not present or is not responding"

Note    This information applies only if you have selected the United Airlines Network and are using Windows 
3.1/3.11/NT 3.51.

The full text of this message is:

"The port is not present or is not responding.    Select another port."

This message can appear when you click the Test Settings button in the Modem Settings 
dialog box.    If you get this message, check the following items:

Troubleshooting:

1. Make sure you have selected the correct COM port.
· Internal modem: The correct COM port will probably be COM2 or COM3.
· External modem: The COM port will probably be COM1 or COM2.

Click here for information about testing the COM port using Terminal.

2. Make sure no other software is running that might be using the COM port.    Examples of 
this are Modem/Fax software or remote access programs.

See Also
Modem problems 
Modem error messages 
United Connection Technical Support 



"Unable to initialize modem"

Note    This information applies only if you have selected the United Airlines Network and are using Windows 
3.1/3.11/NT 3.51.

The full text of this message is:

"Unable to initialize the modem.    Make sure the modem is working properly or that the 
initialization string is valid."

This message can appear when you click the Test Settings button in the Modem Settings 
dialog box.    If you get this message, check the following items:

Troubleshooting:

1. Make sure you have selected the correct COM port.
· Internal modem: The correct COM port will probably be COM2 or COM3.
· External modem: The COM port will probably be COM1 or COM2.

Click here for information about testing the COM port using Terminal.

2. Reset the modem, as follows:
· External modem: Turn the modem off and on.
· Internal modem: Close all applications, turn off your computer, turn it back on again, 

restart Windows, restart United Connection, then click on the Test Settings button.

3. Go to the Modem Type dialog box and make sure you have selected the correct vendor 
and modem type.

4. Try choosing Hayes Compatible for the Vendor and 9600 for the modem speed, then 
click on the Test Settings button again.    (Note: Selecting a slower speed will impact 
the performance of the application.)
Note: If 9600 baud doesn’t work try 2400, then 4800, then 9600.

5. In the Modem Settings dialog box, edit the Initialization String to just "AT&F" (get rid 
of rest).

See Also
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Modem error messages 
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"Initialization string is invalid"

Note    This information applies only if you have selected the United Airlines Network and are using Windows 
3.1/3.11/NT 3.51.

The full text of this message is:

"The initialization string is invalid.    Select another modem or modify the string."

This message can appear when you click the Test Settings button in the Modem Settings 
dialog box.    If you get this message, check the following items:

Troubleshooting:

1. Go to the Modem Type dialog box and make sure you have selected the correct vendor 
and modem type.

2. Try choosing Hayes Compatible for the Vendor and 9600 for the modem speed, then 
click on the Test Settings button again.    (Note: Selecting a slower speed will impact 
the performance of the application.)
Note: If 9600 baud doesn’t work try 2400, then 4800, then 9600.

3. In the Modem Settings dialog box, edit the Initialization String to just "AT&F" (get rid 
of rest).

See Also
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Modem error messages 
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No response from the modem

Note    This information applies only if you have selected the United Airlines Network and are using Windows 
3.1/3.11/NT 3.51.

Check the following items if your modem does not respond when you attempt to connect to 
the reservation system:

Troubleshooting:

1. Make sure that your modem is connected to the phone line.    If it is an external modem, 
make sure it is turned on.

2. Have you entered your modem settings? If not, click on the Modem button in the 
Establish Connection dialog box (or choose Communications/Modem Settings from 
the Tools menu) and enter this information.

3. Have you verified your modem setup information using the Test Settings button? If not,
click on the Modem button and choose the Modem Settings dialog box, then click on the
Test Settings button to verify that your modem setup is correct.    See Modem error 
messages for help resolving any problems.

4. Test your modem using Terminal, a program supplied with Windows.    Click here for more 
information about using Terminal.

See Also
Modem problems 
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Modem dials but can’t connect

Note    This information applies to United Airlines Network users only.

Try the suggestions listed below if your modem dials the access number you selected but is 
not able to connect to the reservation system.    You may not get past the "Dialing" message,
or may receive the message "Unable to connect to the reservation system" or "Reservation 
system not responding."

Troubleshooting:

1. Try to connect again and note exactly what message is displayed on the dialog box when
the problem occurs.

2. If you don’t get past the "Dialing" message, you can try changing the Flow Control 
setting to "Hardware".

3. Select different phone numbers for your area (if available).
Note: Be sure to check the modem speed for the line you are selecting (a modem speed 
or range of speeds is displayed next to each number).    You should choose numbers that 
use the highest speed supported by your modem.    You should not select a telephone 
number whose modem speed is faster than your modem.

4. Try connecting again later.    Too many people may be trying to use that line at the 
present time.

See Also
Modem problems 
Modem error messages 
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Changing the Flow Control setting

If your modem dials but cannot connect to the reservation system, you can try changing the 
Flow Control option as follows:

Changing the Flow Control option in Windows 3.  x  :  
1. Close United Connection.

2. From Program Manager, display the Main 
program group and double-click on the 
Control Panel icon.

3. Double-click on the Ports icon.

4. Click on the COM port their modem is using, then click on the Settings... button.
5. Click on the arrow next to the Flow Control field to display a list of options and select 

the Hardware option.
6. Click on OK, then click on Close.
7. Close the Control Panel window by choosing Exit from the Setting menu.
8. Restart United Connection and attempt to connect.

Changing the Flow Control option in Windows 95:
1. Close United Connection.
2. Click on Start and choose Settings, then choose Control Panel.

3. Double-click on the Modems icon.

4. Highlight the modem you are using and click on the Properties button.
5. Click on the Connection tab, then click on the Advanced... button.
6. Select the Use flow control option, then choose Hardware.
7. Click on OK.
8. Click on OK again, then click on Close.
9. Close the Control Panel window by clicking on the X in the upper right corner.
10. Restart United Connection and attempt to connect.

See Also
Modem problems 
Modem dials but can  ’  t connect   
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Modem connects but can’t access United Connection

Note    This information applies to United Airlines Network users only.

Try the suggestions listed below if your modem dials and connects ("Connecting to VAN" or 
"Connecting to TPE"), but is unable to access United Connection.

Troubleshooting:
1. Try to connect again and note exactly what message is displayed on the dialog box when

the problem occurs.
See Modem dials but can  ’  t connect   if you are stuck at "Connecting to VAN", then receive 
the message "Unable to connect to the reservation system" or "Reservation system not 
responding".

2. Select different phone numbers for your area (if available).
Note: Be sure to check the modem speed for the line you are selecting (a modem speed 
or range of speeds is displayed next to each number).    You should choose numbers that 
use the highest speed supported by your modem.    You should not select a telephone 
number whose modem speed is faster than your modem.

3. Try connecting again later.    Too many people may be trying to use that line at the 
present time.

See Also
Modem problems 
Modem error messages 
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Connection problems: United Airlines Network

Choose one of the following topics for more information:

I'm having a problem with my modem. 

I get the message: "Unable to establish connection.    Please try again."

I get the message: "Unable to connect to the reservation system.    Please try again."

I get the message: "Reservation system not responding.    Please try later."

I get the message: "A communication error has occurred.    Please try again." 

I keep getting disconnected.

See Also
Modem error messages 
United Connection Technical Support 



Flights and fares

Choose one of the following topics for more information:

What's the best way to find low fares? 

When I choose an international destination in the Add Flight dialog box, no flights are 
displayed.    What should I do? 

Why can't I select seats from a seat map for every flight? 

Why was my special meal request denied? 

Why did I get the wrong flight information when I requested Flight Status? 

FareShopper  couldn't fare quote my itinerary 
 what's wrong? 

FareShopper didn't display any flights for the fare I selected.    What should I do? 

Shopping hints 

See also
United Connection Technical Support 



What's the best way to find low fares?

· Use FareShopper .    You provide your travel plans and preferences, then United 
Connection searches for low fares to your destinations.    See Using Fare Shopper for 
information about using this option.

· Purchase your tickets as far in advance as possible.    Many low fares require that you 
purchase tickets 7, 14, or 21 days in advance.

· Select round-trip flights  one-way flights are usually more expensive.
· To meet minimum stay requirements, plan your trip so that you stay over a Saturday 

night.
· Check flights at different times of day.    Early morning and late evening flights can be 

less expensive.
· If your schedule permits, fly mid-week (flights are often less expensive).
· In Flight Preferences, make sure that you have selected all three Fare Restriction options 

(Minimum Stay Required, Maximum Stay Required, and Advance Purchase Required).    
See Editing preferences for the current flight for more information.

See also
United Connection Technical Support 



No flights are displayed.    What should I do?

International destinations have fewer scheduled flights.    Try selecting an earlier departure 
time or a different departure date.    See Shopping for international itineraries for suggested 
departure times.

See also
United Connection Technical Support 



Why can't I get a seat map for every flight?

· Seat maps are provided for United and United Express flights only.    If you have selected 
another airline, seat maps will not be available.

· If you can't display the seat map for a United or United Express flight, that seat map may
be temporarily unavailable.    If you wish, you can try to display the seat map again later 
and choose your seats at that time (even if you have already reserved the flight).

· Seat maps will not be available if you have selected connecting flights that require you to
change planes.

· Seat maps cannot be displayed if the flight you selected is scheduled to depart within 60 
minutes (seats will be assigned at the airport).

See also
Selecting seats 
United Connection Technical Support 



Why was my special meal request denied?

· You cannot request a special meal on flights that are scheduled to depart within 24 
hours.

· The meal you requested may not be offered by the selected airline.
· The flight you selected may not offer meal service (meal service is not offered on flights 

lasting less than 90 minutes).

See also
Requesting special meals 
United Connection Technical Support 



Why did I get the wrong Flight Status information?

If the flight originated at an international location or on a different day, you may not get 
status for the correct flight segment.    To ensure that you get the correct information, enter 
an origin airport in the From field.

See also
Checking flight status 
United Connection Technical Support 



FareShopper  couldn't fare quote my itinerary

If your itinerary includes more than four planned flights, FareShopper may not be able to 
return any fares.    If an error message is displayed in this situation, you will need to exit 
FareShopper and select each flight individually.    In the Itinerary Window, highlight a Planned
flight and choose the Find icon from the toolbar to display available flights.

See also
Using FareShopper 
Shopping hints 
United Connection Technical Support 



FareShopper  didn't display any flights

If FareShopper doesn't display any flights after you select a fare and choose Next, you need 
to select a different fare.    Choose the Fares button to return to the FareShopper  Fares 
dialog box.

See also
Using FareShopper 
Shopping hints 
United Connection Technical Support 



Selecting rental cars
I entered my rental car planning information and chose Find Cars, but no rental 
companies are displayed.    What should I do?

· United Connection  only displays rental car companies that meet all of the preferences 
specified in the primary traveler's profile.    If a message indicates that a particular 
preference could not be met, edit your rental car preferences to change that option.    You
can also turn off all preferences by de-selecting the Use Preferences option in the Select 
Rental Car Company dialog box.

See also
Editing preferences for the current rental car 
How rental car preferences are used 



Selecting hotel accommodations
I want to make reservations at a specific hotel.    Why don't I see it in the list when
I choose Find Hotels?

Because the reservation system contains a large number of hotel listings, United Connection
 will probably not be able to display all of the listings for a particular location at one time 

(especially in larger metropolitan areas).    To find the hotels you are looking for, do the 
following:
· Make sure that the hotel you want to choose is specified as one of the Preferred Hotel 

Chains in the primary traveler's profile.
· Make sure that the hotel is within the specified distance from the reference point you 

selected in the Add Hotel dialog box.    Different references points are provided for each 
location.

· In the Select Hotel dialog box, choose the More Hotels button to see additional properties
at that location.

See also
Selecting a hotel 



Reserving your itinerary
Why do I have to select a credit card if I'm not paying for my ticket now?

· United Connection  requires a contact address, in case we need to reach you concerning
changes to your itinerary.    The address of the credit card you select is used as the 
contact address.    If you are not paying for your tickets online, the credit card will not be 
charged.

I reserved my itinerary yesterday but didn't pay  why is the airfare higher today?

· Your airfare is not guaranteed until you pay for your tickets...    even if you reserve your 
itinerary.    To guarantee your airfare immediately, choose Electronic Ticket, Express 
Delivery, or First Class Mail Delivery as your ticketing option.    If you choose United 
Ticketing Locations or your preferred Apollo travel agency, your airfare is not guaranteed 
until you pay for your tickets.

United Connection couldn't confirm my reservation.    What should I do?

· If time is not critical, wait a while and then try again.    The reservation system may be 
able to confirm your reservation at a later time.

· If you are concerned about holding space on a flight or guaranteeing a particular airfare, 
you should call the airline directly.    If your itinerary includes any rental cars or hotel 
rooms, call these providers to make your reservations.

See also
Reserving your itinerary 



Windows 95
I am running Windows 95 and a software download was started.    Now it's stuck 
on an open window that displays the word PATCH, and indicates the number of 
files being processed.    What should I do?

· The open window has patched your software.    To continue the upgrade process, click the
"X" in the upper right corner of the window.

I am running Windows 95 and the download process stopped with an error saying 
that an invalid statement was being executed.    What should I do?

· You have run out of hard disk space and need to either delete some files from the 
Recycle Bin or delete obsolete files or programs.    Clear some space on your hard drive, 
then re-start United Connection  and select Connect To reservation system from the File 
menu to begin the software download process again.



We want your comments and suggestions...

As you use United Connection , you might have comments, suggestions, or experiences that
you would like to share with us.    We would particularly appreciate receiving your feedback 
on the issues listed below.

· Ease of use
· Features you frequently use
· Features you rarely use
· Your favorite product features
· Product features you dislike
· Anything you would like to see added to the product
· Features you would like to see improved
· Whether you used the online Help and the Quick Reference Guide
· If you could make one change, what would it be and why

To share your experiences with us, call 1-800-4UA-CNXN, choose the feedback option, and 
leave a voice mail message.
We are dedicated to making United Connection the travel reservation system of choice and 
we appreciate your ideas and suggestions.

See also
United Connection Technical Support 

 



    United Connection
 service providers

United Connection provides online access to the reservation system in one of two ways: via 
the Internet, or using the United Airlines Network (a private telephone network).    You can 
use any Internet Service Provider with whom you have an account, including MSN The 
Microsoft Network  and CompuServe

.    Choose one of the following options for more information about that provider:
Internet Service Provider
MSN The Microsoft Network
CompuServe
United Airlines Network

Note    If you are not sure who your current United Connection service provider is, choose About from the Help menu. 
The name of your current service provider is displayed in the About dialog box.

Using the Internet
When you choose Internet Service Provider, MSN, or CompuServe, you will be accessing the 
reservation system via the Internet.    In order to connect to the reservation system, you 
must first establish a connection to the Internet.    Some Internet Service Providers 
automatically launch their dialer when an Internet connection is required.    Others require 
you to launch the dialer yourself.    Before attempting to connect to the reservation system, 
United Connection will request an Internet connection and display a message if any further 
action is required.
Note that if an Internet communication channel is already open, United Connection will use 
the open channel to connect to the reservation system (whether or not this channel 
corresponds to the United Connection service provider you have specified).    Also note that 
your Internet connection is managed by your service provider's dialer, and that 
disconnecting from the reservation system or even exiting United Connection does not 
automatically disconnect you from the Internet.
Note to Windows 95 users:    Windows 95 automatically launches your Internet dialer when a connection is required.
If you have more than one Internet dialer, it uses the default dialer (the last dialer used).    To override this default, you
should launch the dialer you want to use before starting United Connection.

See also
Registration and Communication Options 
Changing your United Connection service provider 



MSN (Microsoft Network)
Choose this option if you have an MSN account and would like to use the Internet access 
provided by this service to connect to the reservation system.    If you do not have an MSN 
account and would like to obtain one, please call 1-800-386-5550.    MSN is only available 
through Windows 95.
Note    The only cost associated with using United Connection  will be any connection time charges assessed by 
your service provider in accordance with the terms of your agreement with that provider.    See Connection costs for 
details.



CompuServe
Choose this option if you have a CompuServe account and would like to use the Internet 
access provided by this service to connect to the reservation system.    If you do not have a 
CompuServe account and would like to obtain one, please call 1-800-848-8990.

Note    The only cost associated with using United Connection  will be any connection time charges assessed by 
your service provider in accordance with the terms of your agreement with that provider.    See Connection costs for 
details.



Internet Service Provider
Choose this option if you have an account with an Internet Service Provider and would like to
use this service provider to connect to the reservation system.

Note    The only cost associated with using United Connection  will be any connection time charges assessed by 
your service provider in accordance with the terms of your agreement with that provider.    See Connection costs for 
details.



Internet
The Internet is an interconnected system of public and private computer networks 
maintained by academic, military, government, and commercial entities from the United 
States and over 40 countries.    You need an account with an Internet Service Provider in 
order to access the Internet.



World Wide Web
The World Wide Web provides users with a way to explore the Internet using a graphical 
"point and click" interface.    Companies, organizations, and individuals can create their own 
web pages  informational screens containing text, graphics, and links to other web pages.



United Airlines Network
United Airlines Network is a private telephone network which allows United Connection  
users to access the reservation system without having to establish an account with an 
outside service provider.    Any user may connect to the reservation system using the United 
Airlines Network option 

 all you need is a modem and a phone line.
Note    Currently, there is no charge for using the United Airlines Network except for the cost of the telephone call to 
the network (usually a local call).    United reserves the right to change this policy at any time in the future.



    Changing your United Connection
 service provider

United Connection lets you change the service provider you are using to connect to the 
reservation system.    If you choose MSN or CompuServe, you must have an account with 
that online service.    If you choose Internet Service Provider, you must have an account with 
a specific Internet Service Provider and be prepared to connect to the Internet using that 
provider's dialer. No separate account is needed for the United Airlines Network option.
Note    You cannot change service providers while you are connected to the reservation system.

To change your United Connection service provider:
1. From the Tools menu, choose Communications/Service Provider.    The Choose United 

Connection Service Provider dialog box appears.    The list box displays your current 
service provider.

2. Click on the arrow to display the list of service providers.
3. Highlight the service provider you want to select and choose OK.

Important    Only choose MSN, CompuServe, or Internet Service Provider if you already have an account with 
the corresponding provider.

If you are switching to or from the United Airlines Network, a message informs you that 
you will need to register before you can connect to the reservation system using that 
provider.    See Registering with United Connection for more information.
Note    Choosing a service provider does not guarantee that United Connection will use that provider to connect 
to the reservation system.    To ensure the use of a specific provider, you will need to launch that provider’s dialer 
before starting United Connection.    See Connecting via the Internet for more information.

See also
United Connection service providers 
Choosing a United Connection service provider 
Registration and Communication Options 



Credit card validation problems

Credit card validation errors sometimes occur because the credit card address you entered 
does not match the mailing address that the credit card company has on file.    It is also 
possible that the issuing bank does not subscribe to VisaNet (the credit card validation 
service), in which case the credit card will never pass automated validation.

To troubleshoot credit card validation problems:
1. The easiest way to resolve a credit card validation problem is to choose the "Select 

another credit card" option and choose a different card.    If you do not want to use a 
different credit card, continue with Step 2.

2. Choose the "Change credit card information" option.    The Credit Card Information dialog 
box appears.

3. Verify that you have entered your mailing address exactly as it appears on the credit 
card statement.
If your street name includes a number, make sure you follow the exact format used by 
the credit card company (e.g. 17th St. vs. Seventeenth St.). Using the exact same 
punctuation (periods, spaces, etc.) is important, but capitalization is not.
If the mailing address on your credit card statement includes a company name or your 
spouse's name, you must include the name as part of the first address line (e.g. XYZ 
Company 1234 Anywhere St. in address line 1).

4. If you’re sure that the mailing address you have entered is correct, it is likely that the 
bank which issued the credit card does not subscribe to VisaNet, or that VisaNet has an 
invalid (or old) address.
In this case, you can call your credit card's customer service center and ask if the issuing
bank subscribes to VisaNet.    If it does, ask the credit card company to contact VisaNet 
and update your address information.
Note    If the issuing bank does not subscribe to VisaNet, your credit card will never pass validation.

5. If the credit card validation continues to fail, please contact the United Connection 
Support Desk at 1-800-4UA-CNXN (1-800-482-2696).

See Also
Selecting a credit card 
Changing credit card information 
Selecting a ticketing option 
 




